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Chapter 1. Preface
The Cadence® AWR Design Environment® platform incorporating Cadence Microwave Office® software and Cadence
Visual System Simulator™ (VSS) communications and radar systems design software, is a powerful fully-integrated
design and analysis tool for RF, microwave, millimeterwave, analog, and RFIC design that allows you to incorporate
circuit designs into system designs without leaving the suite.
Microwave Office software allows you to create complex circuit designs composed of linear, nonlinear, and EM structures,
and generate layout representations of these designs. They allow you to perform fast and accurate analysis of your designs
using linear, nonlinear harmonic balance, nonlinear Volterra-series, electromagnetic (EM), Cadence APLAC® HB
simulation, Cadence Analyst™ 3D FEM EM analysis, and Spectre simulation engines, and feature real-time tuning and
optimizing capabilities.
VSS software is the system level design component of the AWR Design Environment platform. With this software you
can analyze a complete communications system, from data encoding through transmission, reception, and data decoding.
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1.1. About This Book
This book describes how to perform simulations and analysis using the DC, linear (AC), harmonic balance, transient,
APLAC circuit envelope, and EM simulators the AWR Design Environment platform supports.
Chapter 2 provides an overview of simulation in the AWR Design Environment platform with information about simulation
basics. Chapters 3 through 8 describe individual simulators and provide details and tips on their use. Chapter 9 includes
information about remote and parallel simulations, and Chapter 10 provides information about the Job Scheduler, a
separate program that configures and schedules simulations in the AWR Design Environment platform. Chapters 11
through 17 provide general information about electromagnetic (EM) simulation, and detailed information about specific
simulators. Appendix A contains advanced analysis topics.
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About This Book

1.1.1. AWR Design Environment Limited Release
The current release includes some "Limited Release" features. In an effort to get customer feedback on features we are
developing, and to ensure that those features are successfully solving the full range of the intended real-world engineering
problems, Cadence is releasing select features in this "Limited Release" state. These features, while in the software, may
require a license to access. To use these features, contact your local Cadence Sales representative to obtain documentation
and the appropriate license(s). Cadence strongly encourages you to provide feedback to ensure that these features work
well and solve your engineering problems.

1.1.2. Additional Documentation
The AWR Design Environment platform includes the following additional documentation:
• What's New in AWR Design Environment v16? presents the new features, user interface, elements, system blocks, and
measurements for this release.
• The AWR Design Environment Installation Guide describes how to install the AWR Design Environment platform
and configure it for locked or floating licensing options. It also provides licensing configuration troubleshooting tips.
This document is downloadable from the Cadence AWR Knowledge Base.
• The AWR Design Environment Getting Started Guide familiarizes you with the AWR Design Environment platform
through Microwave Office software, VSS software, Cadence Analyst™ 3D FEM EM analysis software, and Monolithic
Microwave Integrated Circuit (MMIC) examples.
Microwave Office example projects show how to design and analyze simple linear, nonlinear, and EM circuits, and
how to create layouts. Visual System Simulator examples show how to design systems and perform simulations using
predefined or customized transmitters and receivers. Analyst software examples show how to create and simulate 3D
EM structures from Microwave Office, and MMIC examples show MMIC features and designs.
You can perform simulations using a number of simulators, and then display the output in a wide variety of graphical
forms based on your analysis needs. You can also tune or optimize the designs, and your changes are automatically
and immediately reflected in the layout.
• The AWR Design Environment User Guide provides an overview of the AWR Design Environment platform including
chapters on the user interface; using schematics/system diagrams, data files, netlists, graphs, measurements, and output
files; using variables and equations in projects, and more. In addition, an appendix providing guidelines for starting a
new design is included.
• The AWR Design Environment Dialog Box Reference provides a comprehensive reference of many AWR Design
Environment platform dialog boxes with dialog box graphics, overviews, option details, and information on how to
navigate to each dialog box.
• The AWR Microwave Office Layout Guide contains information on creating and viewing layouts for schematics and
EM structures, including use of the Layout Manager, Layout Process File, artwork cell creation/editing/properties,
Design Rule Checking, and other topics.
• The AWR Microwave Office Element Catalog provides complete reference information on the electrical element
model database that you use to build schematics.
• The AWR Visual System Simulator System Block Catalog provides complete reference information on all of the
system blocks that you use to build systems.
• The AWR Microwave Office Measurement Catalog provides complete reference information on the "measurements"
(computed data such as gain, noise, power, or voltage) that you can choose as output for your simulations.
• The AWR Visual System Simulator Measurement Catalog provides complete reference information on the measurements
you can choose as output for your simulations.
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• The AWR Visual System Simulator Modeling Guide contains information on simulation basics, RF modeling
capabilities, and noise modeling.
• The AWR API Scripting Guide explains the basic concepts of AWR Design Environment platform scripting and
provides coding examples. It also provides information on the most useful objects, properties, and methods for creating
scripts in the AWR Script Development Environment (AWR SDE). In addition, this guide contains the AWR Design
Environment platform Component API list.
• The AWR Design Environment Quick Reference document lists keyboard shortcuts, mouse operations, and tips and
tricks to optimize your use of the AWR Design Environment platform. This document is available within the program
by choosing Help > Quick Reference.

1.1.3. Typographical Conventions
This guide uses the following typographical conventions to help you follow instructions quickly and easily.
Item

Convention

Anything that you select (or click on) in the AWR Design Shown in a bold alternate font. Nested menu selections are
Environment program, such as menus, nested submenus, shown with a ">" to indicate that you select the first menu
menu options, dialog box options, buttons, and tab names item and then select the submenu item:
Choose File > New Project.
Text that you enter using the keyboard

Shown in a bold within quotation marks:
Enter "my_project" in Project Name.

Keys or key combinations that you press

Shown in a bold alternate font with initial capitals. Key
combinations using a "+" indicate that you press and hold
the first key while pressing the second key:
Press Alt+F1.

File names and directory paths

Shown in italics:
See the DEFAULTS.LPF file.

Contents of a file, fields within a file, command names,
Shown in a mono-spaced font:
command switches/arguments, or output from a command
Define this parameter in the $DEFAULT_VALUES field.
at the command prompt

1.2. Getting Online Help
The AWR Design Environment platform online Help provides information on the windows, menus, and dialog boxes
that compose the design environment, as well as on the concepts involved.
To access Help, choose the Help menu and the appropriate item from the drop-down menu, or press F1. The Help menu
includes the following choices:
Menu Choice

Description

Contents and Index

Open the online Help file to view AWR Design Environment platform Help
topics organized by book/subject, or to search the Help contents by index or
character string.

Help on Selected Item

Access Help on the currently selected item.
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Menu Choice

Description

Getting Started

View the "Getting Started Guide" that includes introductory material for all
products.

What's New

View the "What's New" document for information about new or enhanced
features, elements, and measurements in the latest release.

Quick Reference

View the AWR Design Environment Quick Reference document to learn keyboard
shortcuts, mouse operations, and tips and tricks to optimize your use of the AWR
Design Environment platform.

Home Page

Open the Cadence AWR web page in your internet browser to the AWR®
software products web page.

AWR e-Learning

Open the e-Learning portal login page in your internet browser to access AWR
software training videos.

Knowledge Base

Open the AWR Knowledge Base in your internet browser to access to a variety
of AWR software documentation and other resources.

Get Technical Support

Access the Cadence Learning and Support portal to search for answers to software
or licensing issues or file a Support case.

Check for Update

Check for Cadence AWR software updates using an Autoupdate utility.

Show Files/Directories

Display/open a list of the files and directories the program uses.

Open Example

Display the Open Example Project dialog box to locate a specific project in the
/Examples subdirectory by filtering by keywords or project name.

Show License Agreement

Display the AWR Design Environment platform End User License Agreement.

About

Display AWR software copyright, release, license, and registration information.

In addition, the following context-sensitive Help is available:
• Context-sensitive Help buttons in each dialog box. For example, to view Help for a specific measurement, select the
measurement in the Add Measurement dialog box, and click Meas. Help.
• Context-sensitive Help for each element or system block in the Elements Browser, accessed by right-clicking an
element and choosing Element Help. You can also access element Help by choosing Help > Help on Selected Item after
creating a schematic or system diagram, or by clicking Element Help in the Element Options dialog box.
• Context-sensitive Help for using the AWR Script Development Environment, accessed by selecting a keyword (for
example; object, object model, or Visual Basic syntax), and pressing F1.
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Chapter 2. Simulation Basics
This chapter provides a general overview of the Cadence® AWR Design Environment® platform simulation principles
and practices.

2.1. Measurement-based Simulation
The AWR Design Environment platform determines what simulators to run based on the types of measurements configured
in the project, so control blocks are not necessary on schematics to define simulations. Because of this architecture,
unnecessary simulation is avoided. Once a design is simulated, it does not simulate again until the design changes. You
can specify simulation of only a specific EM structure by right-clicking the EM document in the Project Browser and
choosing Simulate.
The following figure shows the various types of simulations you can set up.

Annotations

Graph measurement

Optimizer goal

Yield goal

The most common measurements are those on graphs. However, the other objects listed also cause simulation.
• Annotations: simulation results displayed directly on a schematic, such as DC currents. See “Annotations” for details.
• EM Structures: listed separately since they always simulate if they are enabled and have not changed since their last
simulation. They are not measurement-driven because typically their simulation times are long and their results are
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stored in the project for use as subcircuits. The only way to ensure an EM structure does not simulate is to disable the
EM structure.
• Output Equations: identical to measurements on graphs except they are assigned to a variable that can then be operated
on by equations. See “Using Output Equations” for details. Output equations are easily forgotten because the Output
Equations window must be open to know that they are in a project.
• Graph Measurements: the most common type used in designs. These plot simulation output on various types of
graphs. See “Graphs, Measurements, and Output Files” for details.
• Optimizer Goals: another way you can set up measurements. These goals are typically measurements on existing
graphs, but you can set up measurements only available to the optimize process. See “Optimization” for details.
• Yield Goals: another way you can set up measurements. These goals are typically measurements on existing graphs,
but you can set up measurements only available to the yield process. See “Graphs, Measurements, and Output Files”
for details.
• Output Files: simulation results written to a file. See “Working with Output Files ” for details.
• Data Sets: for storing/restoring simulation results for a given type of simulation See “Data Sets” for details.
For larger designs, it can be difficult to track all of the measurements configured for a project. Simulation filters are a
feature that prevents different types of simulations. See “Simulation Filters” for details.

2.2. Choosing a Simulator Type
When creating or modifying measurements, the available simulators display under Simulator in the Add/Modify
Measurement dialog box. Depending on the type of measurement and the licensing options with which the program is
started, there may be several simulators available for the measurement.
For example, with a full set of available features, the following options display for linear simulation.

The following options display for nonlinear simulation.
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The following options display for AC simulation.

Note that EM simulations are not set using this mechanism; they are set when an EM structure is created. See “EM: EM
Editor” for details.

2.3. Swept Parameter Analysis
Cadence Microwave Office® software provides the capability to sweep parameters in any type of simulation.
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2.3.1. Sweep Control Types
There are four basic types of sweep controls: frequency, power (for example, swept power ports), voltage/current (for
example, swept voltage and current sources) and variable. Each type is discussed in this section.
Frequency Sweep Control
The following schematic is referred to throughout this section.
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There are three ways to set up one-dimensional frequency sweeps in the AWR Design Environment software.
1. Project frequencies
2. Document frequencies
3. SWPFRQ frequencies
Project frequencies are the default frequencies used in any new project. Double-click the Project Options node in the
Project Browser and click the Frequencies tab to edit your project frequency list. Click the Apply button when complete.
See “Project Options Dialog Box: Frequencies Tab ” for details on this dialog box.
Document frequencies are a second frequency list that you can set on each simulation document (schematic, data file,
EM structure and netlists). For data files, these are frequencies included in the data file. For the others, these are set on
the options for that document. To access the document frequencies, right-click the document in the Project Browser,
choose Options and click the Frequencies tab. By default, the document frequencies are identical to the project frequencies.
Note the Use project defaults check box in the upper left of the dialog box. This check box must be cleared to enable
setting frequencies local to each document.
You can specify a third frequency sweep by using a SWPFRQ block on a schematic (from the Simulation Control category
in the Element Browser). The swept frequency values are entered in the Values column of the SWPFRQ Element Options
dialog box. If you want to specify frequency sweeps differently than a linear sweep, there are built-in equations that you
can easily use with the SWPFRQ block. See “Built-in Functions ” for details.
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When adding measurements, you can choose which frequency set to use. In the Add/Modify Measurement dialog box
Sweep Freq option you can click the arrow at the right to choose between the document and project frequencies.

The frequency range and number for points for the frequency range you are selecting also displays.
There are many frequency sweep control types, but the three most commonly used are:
• FDOC - document frequencies (the frequencies that are local to an individual schematic, data file, EM structure, etc.).
By default, a measurement uses the document frequencies as the swept parameter.
• FPRJ - project frequencies (the frequencies that are global to the project and set in the Project Options dialog box).
• Sweep defined by the SWPFRQ block - control placed in a schematic (identified by the ID of the control, typically
FSWPx where x is an integer).
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In addition to the three commonly used frequency sweep types, other possible frequency sweep types are:
• FDOCN - this option is available if the document referred to by the measurement contains noise data (such as a
Touchstone S-parameter file with a noise data block). The frequencies that are swept are the frequencies at which the
noise data are defined.
• F_SYMB - this option is available if the document contains a port that produces a digital bit stream and the symbol
rate is specified (for example, PORT_ARBS, PORT_PRBS). In this case, F_SYMB is the only option available,
regardless of other frequency sweep controls that may be associated with the document.
• F_OSC- this option is available if the document contains an oscillator analysis element that defines a frequency range
(such as OSCAPROBE). In this case, F_OSC is the only option available, regardless of other frequency sweep controls
that may be associated with the document.
• F_SPEC - this option is available if the document contains an element that has a frequency parameter (such as PORTF).
In this case, F_SPEC is the only option available, regardless of other frequency sweep controls that may be associated
with the document.
For DC-only simulations, no frequency sweep option is presented.
The frequency sweeps described above apply to all cases where only one frequency is independently swept. This includes
nonlinear simulations where an additional tone is swept as a function of tone 1 frequency; for example, a tracking LO
that varies with a mixer's input frequency to result in a constant output frequency.
Less common nonlinear simulations require the frequency of an additional tone to be swept independently in the same
simulation, resulting in nested frequency sweeps. For example, in a multi-channel frequency conversion circuit, the LO
frequency may need to be stepped to a new value after the input frequency is swept over its band. In such cases, Cadence
APLAC® HB simulators allow the frequency of the additional tone to be swept using the general variable sweep control.
See “Creating a Sweep with Variable Sweep Control (SWPVAR)” for more information.
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Power Sweep Control
Some electrical elements such as the swept power ports are used as sweep controls. If at least one of these elements is
present in a schematic, the swept parameter associated with that element is presented as a sweep option when adding or
modifying a measurement for that schematic.
The following shows the same schematic, except Port 1 is changed to a swept power port. When adding or modifying a
measurement, this additional power sweep displays as one of the swept parameter options. The available options specify
how the swept variables are displayed.
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Swept Parameter Analysis
Voltage/Current Sweep Control
Swept voltage and current sources (both AC and DC) can be used as sweep sources, and work in the same manner as
swept power ports discussed previously.
Creating a Sweep with Variable Sweep Control (SWPVAR)
In addition to frequency, power, voltage and current, any parameter and variable can be swept for a simulation.
To create a new sweep for a parameter or variable:
1. Right-click the parameter or variable and choose Setup Sweep.

2. In the Sweep Setup dialog box, specify the sweep values, then click OK to add the SWPVAR element to the document.

When setting up a sweep for a layout variable or parameter, the SWPVAR element is placed in the associated schematic
window.
3. Set the SWPVAR element UnitType parameter if necessary (see “Using Units with the Swept Variable Control
(SWPVAR)”).
4. Add/modify the appropriate measurement and specify how the swept variable results are to display.
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You can also manually set up the sweep by adding a SWPVAR element (in the Elements Browser Simulation Control
category). The following shows an example of using the SWPVAR simulation control in a schematic.

The swept parameter associated with the SWPVAR control is available as a sweep option when adding or modifying a
measurement for that schematic.

Modifying Existing Sweeps or Variables

To modify an existing sweep, right-click the parameter and choose Edit Sweep to display the Sweep Setup dialog box
for changes. You can also choose Disable Sweep or Enable Sweep to disable/enable a sweep. When a sweep is disabled,
the corresponding SWPVAR is disabled.
When renaming or deleting a swept variable, the associated SWPVAR does not change. If you rename a swept variable,
it is no longer swept since there is no SWPVAR associated with the new variable name. The SWPVAR still refers to the
old variable name. However, this behavior is different when editing variables in EM layout. Renaming or deleting a
swept variable deletes the associated SWPVAR.
Sweep Ordering
Sweep types are given the following priority/ordering during simulation:
• Frequency
• Power
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• Voltage/Current
• Variable
Within each category, sweeps are sorted alphabetically by ID.
In the Add/Modify Measurement dialog box, the sweeps are listed based on this ordering.
Using Units with the Swept Variable Control (SWPVAR)
The UnitType parameter of the SWPVAR control sets the unit type for the values specified by the Values parameter.
Note that the values are in base units, (MKS units - meters, ohms, volts, amps, etc.). For example, if the Values parameter
is set to stepped(1, 10, 1) and UnitType is set to Inductance, the variable is swept from 1 to 10 Henries in steps
of 1 Henry.
To simplify unit entry, you can append SPICE-convention unit modifiers to values. For example, you can enter "1n"
instead of "1e-9" to specify 1 nanohenry. In the previous example, you can set the Values parameter to stepped(1n,
10n, 1n) or stepped(1, 10, 1)*1n to sweep the variable from 1 to 10 nH in steps of 1 nH. These modifiers
follow SPICE rules; they are not case-sensitive, they must follow the number directly without a space in between, and
any characters directly following the modifier are ignored.
The x-axis of the graphs in the following figures illustrate the results of using the SWPVAR control with and without
units.

Finally, all dependent parameters should use base units. To specify base units, choose Options > Project Options and click
the Schematics/Diagrams tab on the Project Options dialog box, then select the Schematic dependent parameters use base
units check box.
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Specifying Swept Variable Values
The Microwave Office equation system provides an extremely flexible means of specifying the values to sweep. Several
examples follow. For more information about specifying vector values using the equation system, see “Equation Syntax”.
• Basic vector syntax - specify a vector of values by listing all of the values within curly brackets. For example:
x={3, 5, 7}
• stepped function - specify a vector of values. For example, to specify a vector of values that range from 0 to 10 in
steps of 2, use the following syntax:
x=stepped(0, 10, 2)
• points function - specify a vector of values. For example, to specify a vector of values that range from 1 to 10 with
a total of 10 points, use the following syntax:
x=points(1, 10, 10)
• data_file function - the values used for a swept variable can come from a data file. For example, if a text data
file named "df1.txt" contains a column of numbers, a vector of values can be specified using the following syntax:
x=data_file("df1.txt", "", "")
• vfile function - used in a similar manner as the data_file function:
x=vfile("df1.txt")

2.3.2. Displaying Swept Parameter Data
This section discusses how to specify the display of swept parameter data. The example shown previously shows how
to view different "slices" of multi-dimensional, swept-parameter data.
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Frequency Sweep Display Options
The following figure shows the display options available for a frequency sweep.
•

Use for x-axis

- Specifies that the frequency sweep is used for the x-axis. If no sweep parameter is specified, then the
first sweep parameter that either has a value assigned to it, or takes its value from Select with tuner is used for the
horizontal axis. Only the single, selected value is plotted.

•

Plot all traces

•

Select with tuner

•

Freq = xxx

- If another swept parameter is being used for the x-axis, selecting this option displays the swept data
evaluated at every frequency value (a separate trace for each frequency value displays on the graph).
- Adds the frequency parameter to the tuner. You can then use the slider control to view the sweep
at each frequency value separately.
- Represents each individual frequency. If another swept parameter is being used for the x-axis, selecting
a single frequency displays the swept data at only the selected frequency.

Variable Sweep Display Options
The following figure shows the display options available for a variable sweep.
•

Use for x-axis

- Specifies that the variable sweep is used for the x-axis. If no sweep parameter is specified, then the
first sweep parameter that either has a value assigned to it, or takes its value from Select with tuner is used for the
horizontal axis. Only the single, selected value is plotted.

•

Plot all traces - If another swept parameter (such as frequency) is being used for the x-axis, selecting this option displays

the swept data evaluated at every variable value (a separate trace for each variable value displays on the graph).
•

Select with tuner - Adds the variable parameter to the tuner. Only the trace(s) associated with the selected value display.

•

Disable sweep

•

Var = xxx

- By default, every permutation in a multi-dimensional sweep simulation is simulated. Selecting this
option prevents simulation at these sweep values. Since simulations are not performed at these values, this option can
be helpful in reducing simulation time. Anything that refers to that variable uses the actual variable value during the
simulation.
- Each individual swept variable value is presented. If another swept parameter is used for the x-axis (such
as frequency), selecting a single value displays the swept data at only the selected value.
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Example Graphs
The following figure shows the results of an S-parameter measurement, S(1,1), for the schematic. Document frequencies
are used for the x-axis. Each value of the swept variable Lswp defined by the SWPVAR block, is plotted by setting Plot
all traces. A frequency sweep is performed for each value of the swept variable Lswp.

The following figure shows similar results, except the swept inductance variable, Lswp, is used for the x-axis. A sweep
is performed at each frequency value.

The following figure shows the simulation results when the swept inductance variable, Lswp, is used for the x-axis and
a single frequency (5 GHz) is selected.
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The following figure shows the simulation results when frequency is used for the x-axis and the value of Lswp at which
the frequency sweep is selected by using the tuner (SWPVAR.SWP1 is set to Select with tuner).

Parameter Markers
You can display parameter (variable) markers on graph traces. Parameter marker settings are located on the Markers tab
of the Graph Options dialog box (see “Graph Options Dialog Box: Markers Tab”). Parameter markers are designated
with a 'p' and differ from normal data/trace markers. Parameter markers allow you to identify traces that are associated
with a particular swept variable value.
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Measurement Notation
The measurements on graphs use the following notation:
DocName.Simulator.~DisabledSweeps.$FreqSwp:MeasName(MeasArgs)[Swp1 display, Swp2
display, ...], where
• DocName - the name of the document (schematic, data file, etc.) referred to by the measurement.
• Simulator - the name of the simulator (APLAC, Spectre, or other) used by the measurement. This option is skipped
for the Default Linear and Harmonic Balance (Legacy) simulators.
• ~DisabledSweeps - the ID's of any SWPVAR controls whose sweeps are disabled (multiple sweeps may be
disabled).
• $FreqSwp - the name of the frequency sweep control ($FPRJ, $FSWP, etc.). If the document frequencies ($FDOC)
are used for the frequency sweep, the $FDOC identifier does not display in the measurement notation because $FDOC
is the default frequency sweep (this also keeps the measurement notation short).
• MeasName - the name of the measurement.
• MeasArgs - the arguments for the measurement (this may be empty).
• [Swp1 display, Swp2 display, ...] - each element of this set indicates how each sweep should display.
The number of elements equals the number of swept parameters present in the document. The possible options are:
• X - use this sweep for the x-axis.
• * - plot all traces.
• T - select with tuner.
• ~ - disable sweep.
•

- indicates the one-based index of a single sweep value, used to display a particular trace
associated with the swept parameter.
Positive integer number

For example, consider the following measurement associated with this schematic:
Schematic1.AP_HB.~SWP2.$FPRJ:DB(|Pcomp(PORT_2,1_0)|)[*,X,T,~]
Here, the document name is "Schematic1", the simulator is APLAC HB, the sweep associated with the SWPVAR control
with the ID of SWP2 is disabled, the project frequencies $FPRJ are used as the swept frequencies, and Pcomp is the
measurement (in dBm) with two arguments. Inside the square brackets, * indicates that traces are plotted for each
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frequency. X indicates that the second sweep (the power at port 1 in this case) is to be used for the x-axis. T indicates
that the third sweep (SWPVAR.SWP1) value is selected with the tuner. Finally, ~ indicates that the fourth sweep
(SWPVAR.SWP2) is to be disabled.
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2.3.3. Using a Marker to Define a Sweep Index
As noted, there are various ways to display swept parameters, such as using them for the x-axis, selecting with the tuner,
or selecting individual sweep points. Additionally, you can use a marker on a different graph to specify a sweep index
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on the current graph. As long as the marker is added to a graph that uses a measurement with the same data source name,
the marker is one of the choices for the swept data.
The following example circuit has a very simple input and output matching network for a FET device. The simulation
is set up to run IV curves as well as S-parameters. The IV curves are shown in the following figure.
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Using default settings for plotting S(1,1) plots one trace for each bias point.
Swp Max
12GHz

0.

4

2.

0

0.

6

0.8

1.0

InputMatch

3.

0

4.

0

5.0

0.2
10.0

4.0
5.0

3.0

2.0

1.0

0.8

0.6

0.4

0

0.2

10.0

-10.0
2
-0.

-4
.0
-5.
0

0

-3
.

.0
-2
-1.0

-0.8

-0
.6

.4
-0

Swp Min
8GHz

If you view the measurement controls for the sweeps for this measurement you see that for the "IVCURVE.IV1.SWP"
and "IVCURVE.IV1.STEP swept variable, the setting is "Plot all traces". Note the values that are available in the
drop-down menu for the sweeps.
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You can add a marker to the IV curves data on the graph named "Bias" by choosing Graph > Marker > Add Marker or by
pressing Ctrl + M.
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Now, when you look at the available values for the sweeps for the S-parameter measurement, one of the options is the
marker added to the IVCURVES.
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Notice the new "Marker: m1@Bias" option. The syntax indicates marker 1 on the "Bias" graph. If both the IVCURVE
sweeps are set to this value, then only one trace displays on the Smith Chart for the S-parameters.

2–20 AWR Design Environment

Swept Parameter Analysis

Swp Max
12GHz

4
0.

2.

0

0.

6

0.8

1.0

InputMatch

3.

0

4.

0

5.0

0.2
10.0

4.0
5.0

3.0

2.0

1.0

0.8

0.6

0.4

0

0.2

10.0

-10.0
2
-0.

-4
.0
-5.
0

0

-3
.

-1.0

-0.8

-0

.6

.
-2

0

.4
-0

Swp Min
8GHz

After the simulation is complete, you can click on the marker (not the marker display frame) and drag to watch the
S-parameter display update with the data from the closest simulation point to the location of the marker. In this example,
using the marker to choose the bias for the S-parameters is much more intuitive than other approaches since you can
visually see the mode of operation the transistor is working.

2.3.4. Number of Sweep Points vs. Number of Simulation Points
The number of sweeps obviously affects the total number of points used in a simulation. For example, assume that a
project has three sweeps - one frequency sweep and two variable sweeps. If there are 10 frequency points, 20 points for
the first variable and 30 points for the second variable, the total number of simulation points is:
Total number simulation points = 10 x 20 x 30 = 6,000
If the simulation involves a nonlinear measurement on a highly nonlinear circuit, the simulation time can become large.
Now assume that the frequency sweep is used for the x-axis and that single values are chosen for display for both variable
sweeps as shown in the following figure. Even though single values are specified for the variable sweeps, all 6,000 points
are still simulated.
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To mitigate the large number of simulation points, you can disable the two variable sweeps and the variables set to the
single values of interest to reduce the number of simulation points to 10, which is the number of frequency points.

2.3.5. Swept Variables and Extraction
You can set up a variable to sweep that is used on an element that is set up for extraction. For information on this special
setup, see “Extraction and Swept Variables”.
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2.4. Variable Browser
The Variable Browser displays the current value of variables and element parameters for schematic elements in the active
project. To open the Variable Browser choose View > Variable Browser, or click the Variable Browser button on the toolbar.
The Variable Browser provides different ways to find the desired variable and manage your project's variables, such as
changing the sort order of the variables, filtering on specific criteria such as an element type in a certain schematic, and
viewing Independent or All (independent and dependent) variables based on the tab selected, as shown in the following
figures.

When the All tab is selected, buttons control whether to display element parameters and equations, equations only, or
element parameters only. If element parameters are displayed, two additional buttons control whether all element
parameters or only the ID parameter display, and whether to display secondary parameters.

Simulation and Analysis Guide 2–23

Variable Browser

The Variable Browser uses the generic property grid to work with the data. See “Using Property Grids” for details on
the generic property grid functionality.

2.4.1. Show Secondary Parameters
Models in the AWR Design Environment platform have primary and secondary parameters. For example, the BSIM3
MOSFET model has primary parameters L and W for the geometry of the transistor. The additional hundreds of parameters
control how the model works.
Click the 2nd button on the Element Options dialog box toolbar to toggle on and off the display of secondary parameters
in the property grid. For example, without this button clicked (secondary parameters hidden) you see the following
parameters:

With this button clicked (secondary parameters displayed), you see many additional parameters.
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Note that secondary parameters display grayed in the property grid.

2.4.2. Linking to Elements or Equations
The Variable Browser lists all the variables in your project. In larger designs it can take a lot of time to navigate to a
specific element or equation that you want to inspect based on the entries in the Variable Browser. To simplify this
process you can click on the entry for an element or equation in the Element column, and the document that contains it
opens with the element or equation centered in the view.

2.4.3. Tagging
You can enter one or more user-defined tags in the Tag column to associate variables with certain performance
characteristics in their design. For example, if you have an input matching network you can tag a set of parameters with
"s11" to remind you that they affect s11 of your amplifier circuit.
Filtering is accomplished with a sub-string search that displays all variables that contain a tag that matches the filter text.
If tagging is set up properly, filtering and sorting allow you to see all of the variables that affect certain performance
characteristics. For more information about filtering and sorting, see “Property Grid Filtering Text Boxes” . You can
filter on tagged variables in both the Variable Browser and the Tuner. For more information about filtering items displayed
in the Tuner, see “Additional Tuning Details”.
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2.4.4. Finding and Replacing
Click the Find button to search on text in the All tab view of the Variable Browser. A floating window opens with various
search and replace options, as show in the following figure. You can only replace text in cells that are editable. You can
also use the Undo and Redo buttons to revert and reapply text changes.

2.4.5. Tuning, Optimizing, and Constraining Variable Values
You can specify in the Variable Browser that variables and independent equations are tuned or optimized by selecting
the Tune and/or Optimize check box for each. If tuning or optimization is enabled Cadence recommends that the variable
also be constrained. Note that most optimizers now require this. To enable constraints, select the Constrained check box
for the variable, and then in the Lower and Upper columns enter the lower and upper bounds for that variable, respectively.
You can also enter the lower and upper bounds as a percentage or absolute delta of the current value by following the
value with a "%", or "#", sign respectively. For example, to enter 10 percent you type "10%" or to enter +- 10 you type
"10#". Doing so in the respective column sets the constraint for that column; doing so in the Value column sets the limit
for both the Upper and Lower constraints. You can also set the allowable step size for that variable in the corresponding
Step Size column. Lastly, to clear any constraints on a variable or group of variables, type "0%" or "0#" as the Value for
that variable or group of variables. For more information about tuning and optimization, see “Tuning”.
The Variable Browser provides dynamic feedback based on the current value of a variable and the constraints that are
set for that variable. The Lower and Upper boxes display in red if the variable is at or beyond the constraint value set for
that variable, and they display in yellow if the current value of the variable is closer to either the Upper or Lower bound
than five percent of the delta between the Upper and Lower bounds.

2.4.6. Yield
The Variable Browser allows you to control the statistical analysis for a variable. By default, the yield-related columns
are hidden. To view them, toggle the associated toolbar button as shown in the following figure.
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For more information about setting up a variable for yield, see “Yield Analysis”.

2.5. Tuning
2.5.1. Tuning Basics
You can use the Tuner to tune a parameter value and observe the resulting response on the graph of that circuit.
To tune a parameter value and observe the resulting response:
1. Click on the schematic window to make it active.
2. Click the Tune Tool button on the toolbar.
3. Move the cursor over the desired element parameter or equation variable to see the complete name. A dark cross
cursor displays in a circle.
4. Click to activate the parameter for tuning. The parameter displays in an alternate color. To turn off tuning, click the
active parameter again. Alternatively, you can change the tune state in the Tune column of the Element Options dialog
box Parameters tab or in the Variable Browser.
5. Choose Simulate > Tune or click the Tune button on the toolbar. The Tuner displays. For more information about the
Tuner, see “Tuner Dialog Box”.
6. Click a tuning button and slide the tuning bar left and right. Observe the simulation change on the graph as the variables
are tuned.

2.5.2. Additional Tuning Details
The following tips and information are helpful for tuning operations:
• Environment settings in the AWR Design Environment platform control how variables and parameters set for tuning
display. See “Environment Options Dialog Box: Colors Tab ” for information on how to set these colors.
• Press Ctrl while dragging the tuning bar to continually update displayed variables and parameters and layout views.
• Press Shift while dragging a tuning bar to update results only when you release the mouse button. In this mode, you
can move to a specific value without needing to simulate at all of the points in between.
• To remove a variable from the tuner, clear the check box in the Tune column of the Tuner dialog box.
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• Filter displayed variables for tuning based on the variables tags. For more information about tagging a variable, see
“Tagging”.
• The Step control on the tuner always produces that value above or below the tuning nominal values as you move the
tuner up or down. Because of this, there are some step values that cannot precisely reach the Max or Min values. For
example, if Max=9, Min=0.5, Nom=2, and Step=2.5, while tuning, you cannot take 2.5 steps from 2 and get precisely
to 0.5 and 9, so the tuner comes as close as possible.

2.6. Optimization
Optimization is a process during which the AWR Design Environment platform automatically adjusts designated circuit
parameters such as circuit-element values, transmission-line lengths, and similar quantities to achieve user-specified
performance goals such as minimum noise figure and flat gain. The circuit parameters to be adjusted must be variables
or parameters with an assigned numeric value (not other variables) that have been selected for optimization. A variable
or parameter can be selected for optimization by editing its properties, or by setting the optimization property in the
Variable Browser.
Optimization is controlled by an error function, which provides a numerical error value based on the difference between
calculated and desired performance. The optimization process attempts to find the minimum of this function. Optimization
is an iterative process: The AWR Design Environment software calculates the error function, modifies the variables, and
calculates again. The optimizers use algorithms that cause the performance to move closer to the goals (so the error
decreases) after each iteration.
An important feature of the AWR Design Environment software is that noise, linear and nonlinear performance can be
optimized simultaneously.

2.6.1. Optimizer Operations
The Error Function
The AWR Design Environment software optimizers adjust the values of the optimization variables to achieve performance
goals defined by the goals displayed under Optimizer Goals in the Project Browser. They do this by minimizing the
following mean-square error function:
N

ε=

Qn

∑∑ WQ
n=1 q=1

n
n

| Gn( f q) − M n( f q)|

Ln

where the fq are the analysis frequencies and |Gn-Mn| is the error in a parameter. Mn is the magnitude of an S parameter,
noise figure, IM level, or similar quantity, Wn is a weight, and Ln is the order of the norm. Clearly, if parameter Mj has
a large weight Wj, the error for the parameter contributes heavily to the error function, so an optimizer reduces the error
in Mj more than in other less heavily-weighted parameters.
In the previous equation, N is the number of goals that are specified for the optimization, and Qn is the number of frequency
points that falls within the goals range.
The L factor used as part of the error function described previously is related to the definition of the norm of the error
vector (i.e. minimizing the L2 norm is equivalent to setting the value of L to 2). For the purpose of this discussion, the
error vector is considered a vector of scalar values that represent the error of a single parameter at a set of frequency
points. The true error function is a sum of the error function values determined by each goal.
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The most common value for L is 2, which is equivalent to a least squares optimization. A value of 1 optimizes the scalar
difference, while values higher than 2 tend to put a higher weight on the largest difference.
An exception is that a value of L=0 is used to specify the equivalent of the infinity norm which is defined as the maximum
element in the error vector. A value of L=0 effectively causes the optimization to minimize the maximum deviation from
the goal (this has been called a min-max optimizer in some programs).
The definition of the L factor can be set individually for each goal. This allows the optimization of one goal using a
least-squares criteria (L=2) and the optimization of another goal using a minimize the maximum criteria (L=0).

2.6.2. Optimization Guidelines
When optimizing circuits you should follow these guidelines:
Limit the number of frequencies
During optimization, the circuit is analyzed at each frequency in the project frequency list, so minimizing the number
of analysis frequencies makes the optimization proceed very rapidly. In a narrowband circuit, it is often adequate to use
only the band-edge frequencies, and even in broader circuits it is rarely necessary to use more than a few frequency
points.
Termination Criteria
An optimizer terminates in any of the following scenarios:
• after the desired number of iterations
• when the error function drops to zero
• when interrupted (when restarted, the optimizer simply begins with the variables it had when it terminated)
• when the optimizer determines that no further improvement is possible.
Speed
Optimizers often run for a long time while appearing idle. Be assured, the optimizer is working on your problem.
Frequency Selection
The selection of frequencies affects the optimization in much the same way as the selection of weights: a range having
many frequency points is effectively weighted more heavily than one having only a few points.
Conflicting Goals
Optimization is a powerful and useful tool that must be used properly. The greatest reason for the failure of an optimizer
to yield reasonable results is that a user attempts to make it do something that is impossible, such as forcing a simultaneous
conjugate match on a circuit having K<1, or something that is unreasonable, such as optimizing an amplifier simultaneously
for noise figure, input and output match, and gain, when the initial design is sloppy. The use of conflicting goals impedes
or prevents the optimizer's progress; it is often not obvious that goals are conflicting. For example, the following set of
goals usually gives poor results when applied to the design of a transistor amplifier:
Myamp:DB(|s[2,1]|) = 12
Myamp:DB(|s[2,2]|) = -30
Myamp:DB(NF)
< 1.0
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This set of constraints instructs the optimizer to minimize the noise figure and output return loss while achieving a specific
gain. This set of goals may seem reasonable, but in fact it puts three constraints on the matching circuit, while only two
can be met by the two degrees of freedom (source and load impedance) available. Such requirements are, of course, often
real and necessary, but they require trade-offs based on engineering judgment. The optimizer may be helpful in making
those trade-offs, but it cannot circumvent the need for them.
Noise/Intermodulation Goals
Minimizing noise and minimizing IM distortion are inherently conflicting goals. In fact, any optimization involving IM
performance is likely to introduce a subtle conflict with any other performance parameter.
Local and Global Minima
Local optimizers find only the local minimum of the error function; they generally cannot find the global minimum,
unless, of course, it is the same as the local one. As a result, the most successful optimization occurs when the initial
design is good enough that the best local minimum is the global minimum, and when you are willing to experiment with
optimization weights and frequency ranges, to limit the number of variables, and to try a different optimizer when one
fails to yield satisfactory results. The following example is a sensible approach to the design of a low-noise transistor
amplifier:
1. Design the input circuit and optimize it for noise figure using the transistor described by its S-parameters and noise
statements alone.
2. Calculate the output reflection coefficient.
3. Design the output matching circuit and optimize it for either a specific value of gain or a conjugate match (not both).
Optimize the amplifier circuit as a whole for gain or output match, and noise figure. By optimizing the circuit in parts,
the chance of achieving a successful design is much greater than it would be if the amplifier were optimized as a
whole at the outset.

2.6.3. S-parameter Fitting for FETs
The following process works well for extracting FET models. The best method is to determine the two most critical
items, the internal transconductance Gm and series resistance Rs, before beginning the fitting process, and to get good
initial estimates of other model parameters from low-frequency Y parameters. (These can be calculated easily because
series inductances can be ignored and other simplifying assumptions are reasonable.) It is much easier to fit a FET model
to a set of S-parameters when Rs is fixed at the outset.
1. Measure Rs and the internal Gm at dc (the internal Gm is dId/dVg, where Vg is the voltage across the gate-depletion
capacitance, not the gate-to-source terminal voltage). Assume initially that Rd=Rs. A good value of Rs is difficult to
obtain, but it is essential for successful fitting. Remember that the internal Gm is not the same as the Gm measured
at the FETs terminals.
2. Convert the measured S-parameters below 1 GHz to Y-parameters, and estimate the gate-to-source capacitance (Cgs),
the gate-to-drain capacitance (Cgd), the drain-to-source capacitance (Cds) and output resistance (Rds) from these.
(Do this analytically, not with the optimizer.) Also check Gm against Y21. If the device is packaged, you must divide
the input and output capacitances between the package parasitics and Cgs and Cgd. Assume that the package capacitances
at the input and output are 0.15 to 0.2 pF (70-mil ceramic package) and the package capacitance between the drain
and gate terminals is approximately 0.05 to 0.1 pF.
3. Perform the S-parameter fitting at microwave frequencies with relatively heavy weighting on the phases. Keep Gm,
Rds, and Rs constant (do not make them variables) and put fairly tight constraints on the capacitances (0.01 0.05 pF).
Use the Random optimizer initially, and when it slows, switch to the gradient or simplex. You can adjust the numbers
with the tune mode if necessary or experiment with weights and other optimizers.
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4. Ensure that the topology of your FET model is meaningful. The model of a chip FET is straightforward, but a model
of a packaged device can be difficult to generate. If the device is packaged, remember to include gate, source, and
drain inductances within the package; these may be surprisingly high: 0.4 to 0.6 nH for a 70-mil package. Even a chip
FET may have a few tens of picohenries of gate, source, and drain inductance.
5. If your results are nonsensical (element values are clearly incorrect), repeat the process with tighter constraints on the
variables. The best device model is not necessarily the one that reproduces the measured S-parameters the best; it is
the one that gives the most meaningful circuit element values.

2.6.4. Setting Element Parameters for Optimization
You need to specify which element parameters or variables to use during optimization. Lower bound and upper bound
limits (constraints) can also be configured for any parameter or variable. The optimizer does not increase the value of
the variable above the upper bound or decrease the value below the lower bound.
To set a parameter for optimization and set up constraint limits, double-click the element on the schematic to display the
Element Options dialog box. On the Parameters tab, select Optimize. To set optimization constraints, select Constrain and
enter values in Lower and Upper. You can also enter constraints by using the "%" or "#" modifier as described in the
“Variable Browser” section.

To set a variable for optimization and set up constraint limits, select the equation, right-click and choose Properties to
display the Edit Equation dialog box. Select Optimize, and to set optimization constraints, select Constraint and enter
values in Lower bound and Upper bound.
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An alternative and perhaps easier method for setting element parameters (including constraints) or variables for optimization
is through the Variable Browser (choose View > Variable Browser). You can change the values and the limits by typing
directly into the cells of the Variable Browser or by using any of the methods described in the “Variable Browser” section.

To select a variable for optimization, click in the Optimize column. To constrain the variable, click in the Constrained
column. To select a variable for tuning, click in the Tune column.
Environment settings in the AWR Design Environment platform control how variables and parameters set for optimization
display. See “Environment Options Dialog Box: Colors Tab ” for information on how to set these colors.

2.6.5. Setting Optimization Goals
Optimization goals can be associated with any measurement or output equation in a project.
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Adding Optimization Goals
The Optimizer Goals node in the Project Browser contains subnodes for each optimization goal that you create in the
AWR Design Environment platform for that project.

To add an optimization goal there must first be items in the project that can be measured (for example, schematics or
EM structures). Choose Project > Add Opt Goal or right-click Optimizer Goals in the Project Browser and choose Add
Optimizer Goal. You can also right-click a measurement on a rectangular graph legend and choose Add Optimization Goal,
then click and drag the mouse on the graph to define start and end points for the goal. The points snap to a grid that is
defined along the horizontal axis by the sweep points and along the vertical axis as one tenth of the division step size.
Holding down the Shift key while dragging disables this snap-to-grid feature. The end points also snap to this grid when
editing goals by dragging them on a graph, with the Shift key disabling the point snap.
Modifying and Managing Optimization Goals
The Goals window allows you to edit, view, and sort all optimization goals (even disabled goals) for a project. To access
this window choose Simulate > Optimize to display the Optimizer dialog box, then click the Goals tab at the bottom of the
dialog box. In the Goals window you can right-click the column header to choose which columns to display, rearrange
columns by dragging them to another column location, change the displayed column width, and click individual column
names to toggle an ascending/descending sort process.
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To modify an individual optimization goal, you also can right-click the goal in the Project Browser and choose Properties
to display the Modify Optimization Goal dialog box.
Deleting Optimization Goals
To delete an optimization goal, right-click the goal in the Project Browser and choose Delete Goal.
Disabling Optimization Goals
To disable/enable individual optimization goals, right-click the goal and choose Toggle Enable. When one or more goals
are disabled, you can right-click on Optimizer Goals and choose Toggle All Opt Goals to reverse the disabled/enabled status
of all goals.
To disable all optimization goals, right-click Optimizer Goals in the Project Browser and choose Disable All Opt Goals.
You can re-enable all optimization goals by choosing Enable All Opt Goals.
Optimization Goals on Graphs
If a measurement is placed on a graph and it is used by a goal as well, the goal displays on the graph in the same color
as the measurement. If you click the goal to select it, you can move, stretch, or delete it.
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2.6.6. Relationship Between Optimization Variables and Goals
The AWR Design Environment software automatically determines if a variable that is selected for optimization has any
effect on enabled optimization goals. This check determines if the enabled goals have a dependency on the variables
selected for optimization. If there is no dependency, the variable is excluded from the variables for optimization. If none
of the enabled goals depend on any of the variables selected for optimization, the optimizer reports an error indicating
that there is nothing to optimize. The automatic check does not change the optimization settings for individual goals, so
it provides a convenient method for controlling which variables are to be optimized on.
For example, in a project with two schematics where both have optimizable variables and optimization goals for
measurements, you can control which schematic is optimized by enabling and disabling the goals for each schematic. It
is not necessary to turn the optimization off for variables in schematics that you do not want to optimize. You can simply
disable any goals for the schematic.

2–34 AWR Design Environment

Optimization

2.6.7. Performing the Optimization
To optimize the circuit, choose Simulate > Optimize. The optimizers are controlled by entries in the Optimizer dialog box.

The Cost History is a small plot of the cost function as a function of the iteration number. This graph automatically "wraps"
and scales as the iteration progresses. The various optimization methods are described as follows; all dialog box options
are described in “Optimizer Dialog Box”.
controls what the optimizer does when a simulation error is encountered. When this option is
selected, if an error is found, the optimizer stops and displays the following dialog box.
Stop on simulation errors

In this mode, you can revert to the error state to investigate the error. When this option is not selected, simulation errors
are ignored and the optimization process continues. A good example of this use is two microstrip lines connected by a
step model, with the width of both lines set to optimize. Some combinations of the two widths violates the maximum
difference between the widths for the step model. In this case, you might want the optimizer to skip any cases where the
error is found to keep searching for a valid answer.
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2.6.8. Optimization Log
Selecting the Log to file check box creates a JSON formatted log file containing various optimization and variable
information. The Status Window displays a link to the file after optimization completion. The data in the file is split into
three sections:
• Setup: Contains optimizer settings information, a list of the optimization goals, and the names and initial values of
variables set for optimization.
• Iterations: Logs all iterations parameters and their values, their time of iteration, and individual and total goal costs
per iteration.
• Summary: Provides summary information, including the stop time, and the ten best iterations, including the iteration
number, iteration cost and parameter values.
The log file is written to the Logs directory at the path listed in the Directories dialog box (choose Help > Show
Files/Directories). The name of the log file is auto-generated based on the date and time of the optimization start, for
example 2020-05-11T18:50:43.344Z_optlog.json.

2.6.9. Optimization Methods
You can select the desired optimization method in the Optimization Methods drop-down list. There are many optimization
methods supported in the AWR Design Environment software, each of which may be preferred for a given problem in
regards to result quality or optimizer speed. Faster optimizers are often more sensitive to a problem’s characteristics and
parameters, while slower optimizers are frequently more robust.
The following table provides general guidance on selecting an optimizer. As each problem is different, your results may
vary. Optimizer details are provided in the sections that follow.
Optimizer Selection
Optimizer

Global/Locala Max No. Robust?c Discrete Notes/General Use Recommendation
of
Variables
Variablesb
OK?d

Pointer - Hybrid

Global/Local

Many or Yes
Few

Yes

Single and Parallel
Rec: Does well on a very wide range of
designs, good starting algorithm

Robust Simplex

Local

Few

Yes

Yes

Single and Parallel
Rec: OK initial guess and/or difficult design
space, highly-tuned design

Kapu

Local

Many

Yes

Yes

Single and Parallel
Rec: Many variables, an initial design of some
kind (for example, one found quickly by a
Global optimizer), and/or a very challenging
problem

Grid search

Global/Local

Few

Yes

Yes

Single and Parallel
Rec: Discrete variables, robust/insensitive
designs

Particle Swarm

Global

Many

Yes

Yes

Single and Parallel
Rec: Many variables, very challenging
problem, a good initial guess can be useful
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Optimizer

Global/Locala Max No. Robust?c Discrete Notes/General Use Recommendation
of
Variables
Variablesb
OK?d

Differential Evolution Global

Many

Yes

Yes

Single and Parallel
Rec: Design problem that has a highly-tuned
solution, poor or no initial guess

Advanced Genetic
Algorithm

Global

Many

Yes

Yes

Single and Parallel
Rec: Many variables, very challenging
problem, poor or no initial guess

Random

Global/Local

Many

Yes

Yes

Single and Parallel
Rec: Large number of variables, OK initial
design, other local methods fail

Gradient

Local

Few

No

No

Rec: Few variables, relatively uncomplicated
design space, good initial guess

Req'd

*Special-purpose method, designed to increase
yield on circuits with discrete-value
components
Rec: Circuit design with discrete component
values, yield is to be maximized

Lineup

a

Global/Local: Local optimizers generally need a good initial design, and they start out exploring this initial design. They can be effective at optimizing
performance of sensitive designs, but usually cannot handle too many local minima nor go too far from the starting point without getting trapped.
Global methods usually do not rely on an initial design, and can traverse the search space as a whole. They can search large design spaces effectively,
but may be very slow when converging to a final design.
b
Max No. of Variables: Most methods can handle a few variables, and all tend to optimize more slowly as variables are added, but the performance
of many methods drops off quickly as variables are added. "Few" variables is meant as less than about 10, although this depends on problem difficulty.
The easier it is to find a solution, the more variables an optimizer can handle. Optimizers that can handle "Many" variables do not have as great a
limitation on variable count, although it is possible to overwhelm even these optimizers.
c
Robust?: A robust optimizer is not easy to trap in local minima. This is related to the Global/Local characteristic. Optimizers that do not need a good
initial guess are also not easy to trap in local minima even when near a final solution. However, some local optimizers are also not easily trapped in
local minima.
d
Discrete Variables OK?: Indicates whether or not an optimizer can accommodate discrete variables. Some optimizers are only able to operate in
continuous domains.

Pointer - Hybrid
The Pointer optimizer combines the power and robustness of several global and local search methods. This hybrid, or
combination of optimizers, is even more robust than simple restarts of one scheme. The choice of algorithms and the
number of iterations, restarts, and step-sizes are determined automatically.
The Pointer optimizer requires that all optimization variables be constrained.
This optimizer has one parameter: Global Factor, which determines the split between global and local optimization stages.
A low value (0,1) means that the algorithm spends more of its budget on local search. A high value (4,5) weights the
global search portion more heavily. Values of 2 or 3 are a more even split, with 2 (which works well in many cases)
being the default.
Robust Simplex
The Robust Simplex optimizer uses a variation of the Nelder-Meade Downhill Simplex optimization methodology.
The canonical downhill simplex search is relatively slow, but reasonably robust for a local optimizer. A benefit of this
optimizer is that it follows difficult contours in the error function quite well, although more slowly than a Gradient
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optimizer. It also finds the precise optimum, in contrast to the Gradient optimizer, which tends to wander when it gets
close to the optimum; therefore, the Simplex optimizer is very good for finishing an optimization after the Gradient
optimizer "bottoms out." The Robust Simplex optimizer has a fairly long initialization process, requiring a number of
functional evaluations at least as large as the number of variables, and often more. After initialization, its speed is relatively
insensitive to the number of variables, but its improvement of the error function, per iteration, may be small when a large
number of variables are in use.
The Robust Simplex optimizer creates a constellation of N+1 points on the error surface, where N is the number of
variables selected for optimization. The N+1 points in the search space define a simplex. The method works by contracting
the highest point in the current simplex through the opposite face of the simplex (reflection). Other modifications to the
simplex that are performed during the search are expansion and contraction.
The method performs downhill moves until it reaches a local minimum. To avoid early convergence at a poor local
minima, the method is restarted periodically using N new random points, and the best point in the previous simplex.
There is a key difference between the Robust Simplex optimizer and the original Simplex optimizer. The canonical
method has rigidly-defined distances for finding the next point based on the points currently in its structure. In the Robust
method, the size of the steps are permitted to vary according to the Step Variation parameter. If the parameter is set to
zero, the algorithm behaves like the canonical Simplex optimizer. If it is set between 0 and 1, the distances traveled by
each step can vary from the canonical value. Higher values of the parameter produce more variation in the step sizes.
This variability allows more thorough and robust search of the space, but it can also slow the algorithm down, especially
on easier problems with few local minima. Cadence recommends not setting this parameter too high. A reasonable value
appears to be 0.1 or 0.2.
If more than one job is used in parallel, this optimizer becomes even more robust due to its parallel sampling of the design
space, however it tends not to converge faster. The same guideline applies to setting the Step Variation parameter. Note
that both versions display an "Optimization stagnated" message if restarting a sufficient number of times with no progress.
The Simplex method can converge to a very small region in the search space, and once it stagnates, even with multiple
restarts, it almost never moves further. Detection criteria are used to end the optimization when this occurs, rather than
continue to use resources.
The Robust Simplex optimizer requires that all optimization variables be constrained.
The Robust Simplex optimizer includes an Exploration parameter, which is the fraction of the available search space used
to initialize the simplex algorithm. A value of 0.01, for example, means that the initial variable range will be within 1%
of the original variable values. This can be useful if you are already close to the final solution in the search space. A
value of 1.0 means that the entire search space is used to initialize the genetic algorithm, and is expected to be most
useful when the best solution is unknown. Note that this parameter only involves the initialization of the algorithm, and
does not prevent the variable values from moving out of this initial range.
Kapu
The Kapu optimizer is a Cadence-proprietary algorithm that blends local optimization with high resistance to local
minima. It works well on a wide range of designs, from 3 to over 90 variables.
The Kapu optimizer requires that all optimization variables be constrained.
The Kapu optimizer has two parameters you can set:
•

Quality factor: This parameter is used to determine how quickly the search converges. The larger the number, the more

slowly the algorithm converges. If the quality factor is too low, the search may converge too quickly to a local minimum.
However, if the quality factor is too large, it may achieve sub-optimal results for a set number of simulations. The
default of 2.0 provides good results for a variety of problems.
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•

Exploration:

This parameter is the fraction of the available search space used to initialize the optimizer. A value of
0.01, for example, means that the initial variable range is within 1% of the original variable values. This can be useful
if you are already close to the final solution in the search space. A value of 1.0 means that the entire search space is
used to initialize the optimizer, and is expected to be most useful when the best solution is unknown. Note that this
parameter only involves the initialization of the optimizer, and does not prevent the variable values from moving out
of this initial range.

Recommendations:
• When there are many variables but no good initial guess, it helps to use a true global method for a small number of
iterations first. For example, on a design with 76 variables, just 100 iterations of the Advanced Genetic Optimizer
found a starting point that was sufficient for the Kapu optimizer to find an excellent solution.
• If the method is getting trapped in local minima even with a good initial guess, increase the quality factor.
Grid Search
The Grid Search algorithm, which is an upgraded version of the Discrete Local Search algorithm in previous releases,
searches over a grid of variable values. This optimizer is intended for use as an efficient search of continuous real variables,
where you want the end value rounded to a user- or auto-defined step size. By restricting the search space to discrete
values, the algorithm can perform a more efficient search, in addition to providing results rounded to a step size.
You can provide the step size for each variable being optimized. The step size is set on the Element Options dialog box
Parameters tab. Since variables are required to be constrained for this optimizer, the discrete values that are allowed are
computed starting from the lower bound (the values can be lower + i*step). Defining the step this way for constrained
variables provides an easy way to ensure that the end values are on a user-defined grid.
You can also use the Grid Search optimizer with discrete variables. When doing so, you do not need to apply a step size.
Since this optimizer is a local search method, any discrete variables should have ordered values (if the discrete variables
are not ordered, it is unlikely that the search yields a good minimum).
If you do not specify step sizes or discrete variables, the Auto # Steps parameter is used to discretize variables between
the maximum and minimum values.
The Grid Search optimizer requires that all optimization variables be constrained.
The Grid Search optimizer has two other parameters you can set:
•

Number Grid Levels:

The optimization can be performed over progressively finer grids. The ratio of the parameter
sampling grid from one level to the next is always 4, so if Number Grid Levels is set to 3, the search is first performed
on a grid that is sampled at step_size*16, then step_size*4, then step_size*1. The search is performed on a course grid
first, then the grid is refined (by a factor of 4 in each dimension) until you reach the final grid with a step_size of 1.

•

Allow Increase (0-1):

This factor controls how much searching is allowed over sample points that increase the cost. If
this value is set to 0, the search terminates when no cost improvement is found from any of the nearest neighbors.
Setting it to 0 can reduce the number of total iterations for cases where the cost function is well behaved with a
well-defined minimum. Setting this value to a higher number allows the optimizer to get out of local minimum (as
long as they are not too deep). The higher this value, the more exploration of higher cost values. By default, this
parameter is set to 0.5, which is a reasonable trade-off. Setting this value to a higher number does not guarantee a
better final result, as it is possible to result in a worse local minimum if too much exploration is done on the coarse
grid before refining. For values of this parameter of 0.5 or less, exploration of higher cost values is only done on the
finest grid, which is recommended if you think the solution is anywhere near the starting point.
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Since the search space grows exponentially with the number of optimizer variables, Cadence recommends that you try
to minimize the number of variables used with this optimizer. This optimizer is not expected to perform well with a large
number of variables. For expensive optimizations (such as EM optimization), you should generally try to restrict the
number of optimization variables to just a few.
One of the advantages of the Grid Search optimizer is that you can set up information for it that can help minimize the
number of evaluations needed to find an optimal solution. Choose as large a variable step size as possible and as small
a variable constraint range as possible. Also, try to minimize the number of variables over which you are optimizing.
When you are close to the optimal solution, setting Number Grid Levels to "1" and Allow Increase to "0" should minimize
the number of iterations without degrading the solution. If you are far from the solution, using more grid levels can
improve the efficiency of the search significantly. If the optimizer is getting stuck too early in local minimum, you can
try increasing the Allow Increase value. This optimizer can also be used to ‘snap’ values to a user-defined grid in an
optimal way. For example, if you want to keep an optimized line width on a 1um grid, you can use this optimizer to pick
the closest values that round to 1um that minimize the cost function. In this case, you should be close to the optimal
solution, so set Number Grid Levels to "1" and Allow Increase to "0".
Particle Swarm
The Particle Swarm is a nature-based algorithm that mimics swarming behavior to search a design space. This method
can work well with both physics-based design optimization as well as ideal component optimization. It can be used to
search globally or locally, depending on the parameter settings.
The Particle Swarm optimizer requires that all optimization variables be constrained.
The Particle Swarm optimizer has two parameters you can set:
•

Swarm Growth:

This parameter determines how quickly the swarm grows proportional to the number of unknowns.
The larger the swarm, the more searching is done in parallel. However, a swarm that is too large may achieve sub-optimal
results for a set number of simulations. The default of 2.0 provides good results for a variety of problems.

•

Exploration:

This parameter is the fraction of the available search space used to initialize the particle swarm. A value
of 0.01, for example, means that the initial variable range will be within 1% of the original variable values. This can
be useful if you are already close to the final solution in the search space. A value of 1.0 means that the entire search
space is used to initialize the swarm, and is expected to be most useful when the best solution is unknown. Note that
this parameter only involves the initialization of the swarm, and does not prevent the variable values from moving out
of this initial range.

Recommendations:
• Particle Swarm may not be as scalable as the Adv Genetic Algorithm optimizer, but it can search an entire design
space without a known initial guess at the solution, and thus is more general-purpose than a local optimizer.
• This method does not need to be combined with a local optimizer, as it converges well on its own. However, for some
problems, particularly those that use ideal or lumped components, it may be more efficient to use the particle swarm
to find hills to climb, then climb them quickly with a local method like the Robust Simplex optimizer.
Differential Evolution
Diff Evolution (DE) is a population-based optimizer (a variation of the standard Genetic Algorithms (GA)). The crucial
difference between DE and GA is its scheme for generating trial parameter vectors. Basically, DE adds the weighted
difference between two population vectors to a third vector.
Diff Evolution includes self-adapting parameters that determine values for population size and crossover in the background
based on the search space characteristics.
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The Differential Evolution optimizer requires that all optimization variables be constrained.
The single parameter, Pop Growth Factor, determines how quickly the population grows based on the number of variables
being optimized. A high number (for example, 4 or 5) increases the population more quickly than a low number (for
example, 0 or 1). This may help the algorithm search the design space more thoroughly, but also slows it down.
Advanced Genetic Algorithm
The Adv Genetic Algorithm combines various advanced methods of crossover, mutation, representation, and others that
are found to work well on a variety of electromagnetic design problems. The algorithm is shown to be particularly
effective on problems with large numbers of parameters, and design spaces involving physics simulation. It tends to find
areas of interest in the search space very well, but can be slow to exploit these fully (it is good at finding "hills" to climb,
but is slower at climbing them once found). In complicated search spaces involving physical simulation, however, this
algorithm can still be very effective even when climbing local hills, as it is more robust than true local-search methods.
The Adv Genetic Algorithm optimizer requires that all optimization variables be constrained, though they can be discrete
or continuous.
The Adv Genetic Algorithm optimizer has two parameters you can set:
•

Quality Factor:

This parameter sets the amount of computational resources used in the optimization. The lower the
number, the faster the convergence and the fewer function calls used for a given problem. The default of 2.0 is found
to provide good results for a variety of problems. Increasing the parameter often helps for very difficult or multi-goal
problems. Reducing the number can help with highly-tuned, simpler problems.

•

Exploration: This parameter is the fraction of the available search space used to initialize the genetic algorithm. A value

of 0.01, for example, means that the initial variable range will be within 1% of the original variable values. This can
be useful if you are already close to the final solution in the search space. A value of 1.0 means that the entire search
space is used to initialize the genetic algorithm, and is expected to be most useful when the best solution is unknown.
Note that this parameter only involves the initialization of the algorithm, and does not prevent the variable values from
moving out of this initial range.
Recommendations:
• Adv Genetic Algorithm works best with designs with large numbers of variables, many and competing criteria, and
noisy or physics-based simulations. This method also can work very well if an initial guess is not known.
• This method is not easy to trap in local minima, so it works very well for antennas and other physics-based devices.
However, local minima can still cause problems even when optimizing close to the final design.
• This method can be slow on more “pure” mathematical design spaces, such as simple filters with lumped ideal elements.
It is not necessarily the best method for designs for which a local search method like the simplex works well.
• A general strategy for optimization problems where the initial guess is not known and the solution will be highly tuned
is to first use the Adv Genetic Algorithm to find an approximate solution, and then switch to a local optimizer such
as Robust Simplex to finalize the solution. For these types of problems, the genetic optimizer finds a good hill to climb,
and the Robust Simplex optimizer then climbs it quickly.
Random Optimization
Random steps from an initial starting point in the search space, one variable at a time. This is a very simple optimizer,
but it works surprisingly well in some cases. It can do well particularly when the number of variables is large, because
it operates almost as efficiently with a large number of variables as with a small number. It is very inefficient by nature,
so is only recommended when other methods fail to produce desired results.
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The Random optimizer requires that all optimization variables be constrained.
The Random optimizer has one parameter you can set: Variation Factor. This is the maximum step size the optimizer may
take as a fraction of a given variable’s range. 0.1 is a typical value for this parameter. A value of 1.0 takes step sizes
using the full variable range, producing a more global but generally much slower search.
Gradient Optimization
This Davidon-Fletcher-Powell optimizer (also known as the Fletcher-Powell method) can be classified as a gradient
method; but precisely, it is a quasi-Newton optimizer. It is generally a good optimizer for simple circuits with
straightforward requirements: the larger number of functional evaluations does not slow the optimization appreciably,
but the optimizer converges on a solution very quickly.
The Gradient optimizer has two additional parameters you can set.
•

Convergence Tolerance:

This parameter is used to determine convergence. If the improvement from one step of the
optimization to the next does not improve more than this value, then the optimizer should stop.

•

Step Size: The step size is the amount the values are perturbed when you compute the gradients. For Cadence AXIEM®

3D planar EM analysis, since you snap points to a fine grid, you need to set this to a larger value than the default,
otherwise a small perturbation might result in a zero gradient.
NOTE: Cadence does not generally recommend using this optimizer. It does not tend to work well on search spaces
with multiple local optima (the most typical case) unless your design is close to the final answer. It also tends to wander
more than Robust Simplex when close to the final minimum.
Lineup Optimizer
The Lineup Optimizer is an optimization method to maximize the yield of a circuit or system network that is composed
of multiple elements. Each element can only take on a discrete set of values, and the Lineup Optimizer optimizes the
various combinations of element values to maximize the number of lineups that meet optimization goals. The following
example better explains this optimizer.
A typical application for this optimizer is to maximize the yield of a module manufactured from components that have
performance variation. For example, the following amplifier module is composed of three discrete amplifier components.
The available parts for each stage are measured, with S-parameter results stored in a MDIF file. See “MDIF File Format
” for more information. There is gain variation among the parts, so that not all combinations of available parts result in
the cascaded total gain of the module meeting specification. You can use the Lineup Optimizer to maximize the number
of modules that can be built that meet specifications, by optimizing the combinations or line up of existing parts.

PORT
P=1
Z=50 Ohm

SUBCKT
ID=S1
NET="stage1"
PartNo=20

SUBCKT
ID=S2
NET="stage2"
PartNo=16

SUBCKT
ID=S3
NET="stage3"
PartNo=11

PORT
P=2
Z=50 Ohm
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To use the Lineup Optimizer, you must add an optimizer goal. Optimized variables and parameters must be discrete. In
the previous example, the element parameter PartNo is the MDIF independent variable, and it is enabled for optimization.
See “Setting Element Parameters for Optimization” for more information. The MDIF file must only have one independent
variable, and it cannot be multi-dimensional.
After the optimizer is finished, a CSV file with the naming convention project_name_ordering_results.csv is generated
in the project directory. This file can easily be opened in a spreadsheet editor, and it represents the best lineup combinations
the optimizer finds. Each row of the file represents one lineup combination, and the last column represents the optimization
cost of that lineup. Lineups with zero cost meet the optimization goal.
Lineup Optimizer Details

Each optimized variable can take values from a bin of discrete values. When the optimizer starts, n lineups are evaluated
where n is the number of parts in the smallest bin. The first lineup consists of the first element of each bin. The second
lineup consists of all the second elements of each bin, and so on until n lineups are created. The cost is computed for all
n lineups, and the pass rate is calculated. The next step is to randomly swap parts within the same bin between the lineups,
and recalculate the costs and pass rate. If this swap improves the total pass rate (reduces the number of lineups with cost
greater than zero), then it is accepted, otherwise it is rejected (swap reversed), and a new swap is tried. Only the first n
elements of each variable bin are included in the swap process, so if a variable has bin size >n, not all of its parts are
included in the optimization process. The optimizer stops swapping when either the goals are met (zero cost for all
lineups), the maximum number of iterations is reached, or you cancel the optimizer.
The Lineup optimizer has two parameters that you can set:
•

Maximum Iteration is the maximum number of optimizer iterations to run before the optimizer is stopped. This number
is not the same as the Optimizer Iteration count that is updating as the optimizer runs. Two cost evaluations per iteration

are needed for the two lineups that swapped parts. Each cost evaluation is counted as an iteration in the display, so
the Optimizer Iteration count is twice the Max Iteration value plus n (the number of cost evaluations needed for the initial
lineups) if the maximum limit is reached.
•

influences how the optimizer picks parts to swap with. If the parameter is set to 0, then the optimizer
only tries to swap parts between two lineups that are both failing (for example, with a cost greater than zero). If the
value is 1, then approximately half the time, one of the lineups in the swap is failing. The larger the value, the more
likely the swap occurs between any two randomly chosen lineups, and not just failing lineups. The default value of 1
is normally sufficient.
Swap control

2.6.10. Discrete Optimization
The following optimizers support discrete optimization: Pointer-Hybrid, Robust Simplex, Kapu, Grid Search, Particle
Swarm, Diff Evolution, Adv Genetic Algorithm, and Random. These optimizers support discrete variables, and also the
use of the step-size parameter in the Variable table.
Variables are discrete when they reference a vector. For example, to optimize a width of microstrip line you can declare
a vector widths=stepped(20,50,1) variable and then use the vector for all w parameters of the MLIN element, like
w=widths[10]. The optimizer optimizes the index. You can declare discrete quantities with any available vector notation.
The Discrete_Filter_Optimization.emp project in the \Examples subdirectory of the AWR Design Environment platform
program directory is provided as a discrete optimization example.
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2.6.11. Parallel Optimization
The following optimizers are able to run parallel jobs: Pointer-Hybrid, Robust Simplex, Kapu, Grid Search, Particle
Swarm, Diff Evolution, Adv Genetic Algorithm, and Random. Parallel-capable optimizers have an extra parameter: Num
of Parallel Jobs. When you start the optimizer with Num of Parallel Jobs equal to 1, a single-thread version of the optimizer
executes. If this number is greater than 1, that number of parallel threads is launched, which run asynchronously in the
background. These threads allow the optimization to use the computational power available in machines with parallel
cores much more effectively.
Note that on the Project Options dialog box MWO Server Scheduler tab, the Max Parallel Jobs Per Node must be increased
from its default of "1" to take advantage of the parallel feature.
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You should keep this value at or below the number of cores in your computer for best performance.

2.7. Yield Analysis
You can use the yield analysis capabilities within the AWR Design Environment platform to study the effects of statistical
variations on circuit performance. The AWR Design Environment software can analyze the yield of a circuit for a given
description of the statistical properties of the component values. The software also performs yield optimization which
optimizes the yield of a circuit by modifying the nominal values of specified parameters.
There are two steps you must perform before analyzing the yield of a circuit. The first step is setting up the parameter
value statistical properties. The second step is the specification of the goals used to determine if a circuit has acceptable
(pass) or unacceptable (fail) performance.

2.7.1. Setting Statistical Properties
You can assign statistical properties to any independent variable or parameter. To set the statistical properties of independent
variables, right-click the variable in the schematic or equation window and choose Properties. The settings are similar
to those described as follows; you can click the Help button for more information. To set the statistical properties for an
element, double-click the element to display the Element Options dialog box, and on the Parameters tab, click the Yield
button on the toolbar to display the applicable columns.
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Click the Use Statistics column to vary the parameter randomly, based on the other settings, during yield analysis or yield
optimization. If Use Statistics is not selected, the statistical properties are ignored, and the parameter is not varied for
yield.
Click the Yield Optimize column to allow modification of the nominal value of the parameter during a yield optimization.
If the parameter value is also constrained, the yield optimizer uses these constraints to ensure that the nominal value is
not changed to an unacceptable value. If a parameter is used for yield optimization, you must also select Use Statistics.
Distribution allows you to specify different statistical distributions. You can specify variation using the Tolerance and
Tolerance2 columns. Tolerance2 is only used for those distributions that need a second statistical parameter. You can

specify the variation as an absolute value, or as a percentage of the nominal value (add % as a suffix to the tolerance
value).
Variation depends on what distribution type is set. If Distribution is Uniform, the variation is represented by a uniform
distribution that is non-zero for the nominal value +/- the Tolerance.

- Tol
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If Distribution is Normal, the Tolerance parameter specifies the standard deviation of the distribution.

+ Tol
- Tol
Nominal
- 1 Std Dev Value + 1 Std Dev

If Distribution is Log Normal, the Tolerance parameter specifies the standard deviation of the distribution. The shape of
the curve is identical to the normal distribution when the x-axis is plotted on a log scale. If not on a log scale, the
distribution displays as follows.

If Distribution is Normal - Tol, Tolerance specifies the standard deviation of the distribution and Tolerance2 defines how
far from the nominal value to remove from the distribution. You can use this distribution to try to use lower quality parts
that would be removed from the tighter tolerance center of the distribution. The dotted line in the following figure shows
the full normal distribution for reference.
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- Tol2

Nominal
Value

+ Tol2

If Distribution is Discrete, the Tolerance (total amount of spread allowed) and the Tolerance2 (at what intervals) values
are allowed.

-Tol

-3Tol2

-2Tol2

-Tol2

Nominal
Value

+Tol2

+2Tol2

+3Tol2

+Tol

If Distribution is Normal Clipped,Tolerance specifies the standard deviation of the distribution and Tolerance2 defines how
far to keep from the nominal value in the distribution. The dotted line in the following figure shows the full normal
distribution for reference.
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- Tol2

Nominal
Value

+ Tol2

2.7.2. Setting Yield Analysis Goals
The Yield Goals node in the Project Browser contain subnodes for each yield goal that you create in the AWR Design
Environment platform for that project.

The statistical analysis requires the specification of the goals used to determine if a circuit has acceptable (pass) or
unacceptable (fail) performance. You can add a yield goal by choosing Project > Add Yield Goal or by right-clicking Yield
Goals in the Project Browser and choosing Add Yield Goal. Yield goals are set and edited very similarly to optimization
goals (see “Setting Optimization Goals”).
To add a yield goal there must first be items in the project that can be measured (for example, schematics or EM structures).
Choose Project > Add Yield Goal or right-click Yield Goals in the Project Browser and choose Add Yield Goal. You can also
right-click a measurement on a rectangular graph legend and choose Add Yield Goal, then click and drag the mouse on
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the graph to define start and end points for the goal. The points snap to a grid that is defined along the horizontal axis
by the sweep points and along the vertical axis as one tenth of the division step size. Holding down the Shift key while
dragging disables this snap-to-grid feature. The end points also snap to this grid when editing goals by dragging them
on a graph, with the Shift key disabling the point snap.
NOTE: Yield goals are computed at simulated points inside the goal range only. If the goal starts or stops at a point
which is not simulated, then only the simulation points inside the goal range are considered for pass/fail analysis.
In comparison to optimization goals, there are fewer options associated with the yield goals. For example, there is not
an equality yield goal and there is no weighting associated with a yield goal. The Meas > Goal type indicates that the
measured value must be greater than the goal for passing performance.

You can add as many yield goals to the project as desired. During a yield analysis, if any of the yield goals indicate a
violation, that trial is considered to have failed.
You do not need to add goals if you do not want to get a yield value (number of trials passed). With no goals, you see
the variation of the response on graphs when the analysis runs.

2.7.3. Performing Yield Analysis
In general, yield analysis runs many simulations of the circuit and collects statistical data. For each trial, all enabled
parameters for statistics are set to some value other than the nominal value (details are covered in each analysis type that
follows). A simulation is then performed and the yield goals are computed to determine if the trial failed or passed.
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The AWR Design Environment platform has several types of yield analysis:
• Yield Analysis: variables are randomly varied.
• Yield Optimization: variables are randomly varied and nominal values are adjusted to optimize the yield percentage.
• Corners Analysis: all combinations of variables are at their extreme values.
• User Defined Corners: variables are run at user-specified values.
• Parallel Analysis: simulations are run locally in parallel, on machines in a remote simulation queue, or in parallel on
machines in a remote simulation queue. See “Performing Parallel Analysis” for details.
The number of iterations and the percentage of circuits that are passing yield displays in the Yield Analysis dialog box
during the analysis. The percentage passing also includes a "+/-" error component displayed after the number. You can
also plot these numbers on graphs using the Yield and YldError measurements. If no yield goals are defined, the yield
percentage is always 100% and the error is 0%. The following equation shows how the error is calculated.

N=

( Cε ) Y (1 − Y )
σ 2

where N is the number of trials, Y is the estimated yield, ε is the percent error and Cσ is the confidence level expressed
as a number of standard deviations. In all calculations, Cσ is set to 2, which corresponds to a 95.4% confidence level and
means that the error estimate is within a 2 standard deviation bound. You cannot change this parameter.
Solving the previous equation for ε and using 2 for Cσ you get the following equation:

ɛ = 2*

( Y ( 1N− Y ) )

This equations shows exactly how the yield error is calculated at each yield iteration.
The following table solves the first equation for various values of yield and error to help you estimate how many yield
iterations must be run to achieve a certain yield error value.
Yield (%)

10% Error

5% Error

2% Error

1% Error

10

36

144

900

3600

20

64

256

1600

6400

30

84

336

2100

8400

40

96

384

2400

9600

50

100

400

2500

10000

60

96

384

2400

9600

70

84

336

2100

8400

80

64

256

1600

6400

90

36

144

900

3600

Yield Analysis
Yield Analysis is typically called "Monte Carlo analysis" of the circuit. In this mode, the parameter values set to have
statistical distributions are set to random values based on the parameter's statistical distribution at each iteration.
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To perform yield analysis, choose Simulate > Yield Analysis to display the Yield Analysis dialog box. In Yield Methods,
select Yield Analysis as shown in the following figure.

The Maximum Iterations value determines how many iterations are run if you do not manually stop the analysis.
Yield Optimization
A peak of the component sensitivity histogram distribution that is not centered about the nominal value indicates that
the yield can be improved by changing the nominal value. The yield optimization capability automatically adjusts selected
nominal parameter values to improve the yield.
To perform yield optimization, choose Simulate > Yield Analysis to display the Yield Analysis dialog box. In Yield Methods,
select Yield Optimization as shown in the following figure.
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To run yield optimization, you must have at least one model parameter or variable set to use statistics, and its Yield
Optimize column must be selected. Yield optimization uses the Ysens data (the component sensitivity histogram) for each
variable to center the distribution. Therefore, you cannot run statistics on one set of parameters or variables and adjust
a different set of parameters or variables to optimize the yield.
Yield optimization requires a Monte Carlo analysis for each iteration of the yield optimization process. The number of
yield iterations needed for each optimization iteration depends on the desired error in the yield estimate, and on the yield
value. See “Performing Yield Analysis” for details on the relationships between these values, and a table to help estimate
the number of trials needed to achieve a specified error. The error used during the yield optimization is specified by
Maximum error entered as a number, not a percent. The number of trials that are needed for the error are computed
automatically as the yield analysis continues using the current computed yield value. Each iteration of the yield optimization
finishes when there are a sufficient number of trials to drop below the given error level. The lower error number specified
requires more yield iterations for each optimization iteration. The number of yield optimization iterations has a maximum
as set in Maximum Iterations, and stops with fewer iterations if no yield improvements are found. Typically only a few
optimization iterations are required.
The yield analysis also allows you to specify a Dampening factor that determines the size of the corrections that are used
for each iteration of the yield optimization algorithm. If the dampening factor is close to 1, then large corrections are
made (that may overshoot the optimum yield values). If the dampening factor is small, the yield optimization makes
small corrections in the nominal parameter values as the yield is optimized. Usually the default dampening is sufficient.
If the yield tends to "bounce around" during yield optimization, you can try a smaller Dampening value. A larger Dampening
value may be helpful for speeding the search for an optimum solution.
Corners Analysis
In Corners Analysis mode the parameter values that are set to have statistical distributions are set to either their maximum
or minimum values at each iteration.
To perform Corners Analysis, choose Simulate > Yield Analysis to display the Yield Analysis dialog box, then choose
Corners Analysis in Yield Methods as shown in the following figure.
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When performing Corners Analysis, the maximum and minimum values for each parameter must be calculated. For
uniform distributions, the maximum value is the nominal value plus the variation, and the minimum value is the normal
value minus the variation. For normal distribution, there are no absolute minimum and maximum values since a normal
distribution is a continuous curve. You must therefore specify how many standard deviations to use to calculate the
minimum and maximum values using the Scale Relative to Sigma value. The extremes are the nominal ± this value of
sigma away from nominal. Corners Analysis is not supported for distribution types other than uniform and normal.
The number of trials required to cover all of the corners combinations is 2N, where N is the number of varying parameters
or variables. You are only guaranteed an accurate range of performance if you run the full 2N trials, therefore the Maximum
Iterations value is determined for you. For large numbers of N, you should consider using yield analysis to get a better
sampling of performance. This analysis stops when it has reached 2N iterations.
User Defined Corners (Design of Experiments)
In User Defined corners mode (also called "design of experiments"), you first define all of the values to use for each
parameter or equation in a text file.
To perform User Defined analysis, choose Simulate > Yield Analysis to display the Yield Analysis dialog box, then choose
User Defined in Yield Methods as shown in the following figure.
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Maximum Iterations

is not editable because the text file you specify in Data file name specifies the number of parameter

sets to run.
The text file that defines the parameters used in User Defined corners is stored in the AWR Design Environment platform
project. You can create a new data file by right-clicking Data Files in the Project Browser, choosing New Data File, and
specifying Text Data Files as the type. The data file has the following syntax:
!Optional comments
!First, you must specify all the names of the variables to be used. These define the
columns in the data section
V1 = "Schematic_A\R1\R"
V2 = "Schematic_A\R2\R"
!Optional statement that allows the values to be relative if set to greater than zero
RELATIVE_VALUE=0
!Each row below is a sample for the Corners Analysis. Each column corresponds to a variable
defined previously
1 1
3 4
4 5

The variable name (on the left side of = ) must be Vn, where n is sequential from 1..N and represents the column in the
data part of the table. For Vn, V must be uppercase. Sample values are interpreted as relative to the nominal value of the
variable if RELATIVE_VALUE is defined and set to a value greater than zero (otherwise, the sample values are the
actual component values). In general, the syntax is "Document Name"\"Element ID"\"Parameter Name". For equations,
the "Document Name" and "Element ID" are the same, and are the name of the variable (left half of the equation). The
"@" symbol also indicates an equation when in a schematic or system diagram. The following shows some variable
name example formats:
!Parameter R on Resistor R1 in a schematic named Schematic_A
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V1 = "Schematic_A\R1\R"
!Variable X on a schematic named Schematic_A
V2 ="@Schematic_A\\X"
!Variable Y in Global Definitions
V3 ="Global Definitions\\Y"

Parameter values are entered in base units (for example, Farads, Meters, or Henries) so that the values used in simulation
do not change if you change any of the project units.
When setting up this analysis, every parameter or variable enabled for yield analysis must have an entry in the control
file. If not, the analysis does not run and a warning that the values for a yield variable were not configured is issued, as
shown in the following example.

In this example, the T parameter on the SUB1 model in Schematic 1 does not have an entry in the control file. Additionally,
the W parameter on the TL1 model in Schematic 1 does not have an entry in the control file.

2.7.4. Displaying Performance Variation
The measurements that display on the graphs plot traces for each statistical trial simulated during a Monte Carlo analysis.
The following graph shows a plot of the input reflection coefficient for a simple circuit.
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There are several options for displaying the performance variations of measurements plotted during a yield analysis. You
can set these options on the Graph Options dialog box Yield Data tab. See “Graph Options Dialog Box: Yield Data Tab”
for details. The options control how the traces for each trial display on the graph. You can display the traces for passed
trials, failed trials, or all trials. You can also display the mean value of the traces. Other available options include the
display of the range of values as a standard deviation, two standard deviations, or as the lowest and highest values
computed so far. These ranges can display as a trace of min/max values, as range bars that are centered about the trace,
or as a filled envelope that shows the computed range.
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The colors used to display each yield iteration are controlled on the Graph Options dialog box Format tab in the Trace
Color Styles section. Yield sets the style for each individual yield run and Yield Range sets the style for any traces that
aggregate the yield data (for example, range, median, or standard deviation). See “Graph Options Dialog Box: Format
Tab” for setting details.
Yield measurements are available for the aggregate yield data (for example, range, median, and standard deviation).
These measurements provide more flexibility for plotting this data than options such as trace color, thickness, and API
access. The following is a list of these measurements:
• “Minimum and Maximum for Measurements in a Yield Analysis: MeasRange”
• “Statistical Median for Measurements in a Yield Analysis: MeasMedian”
• “Statistical Average for Measurements in a Yield Analysis: MeasMean”
• “Statistics Variation for Measurements in a Yield Analysis: MeasSigma”
To clear the traces that accumulate on a graph as a result of a yield analysis, you can click the Clear button in the Yield
Analysis dialog box or choose Graph > Clear Frozen.
When running yield analysis, the yield data is available for the current AWR Design Environment software instance. If
you want the yield data to be available after the project is closed and reopened, you need to use yield data sets. Selecting
the Create data set for yield analysis option saves the yield data for later use. See “Yield Data Sets” for details on using
yield data sets.

2.7.5. Analyzing the Results
Component Sensitivity
Each parameter with a statistical variation can take on a range of values. This range of values is divided into a set of
discrete ranges called bins. The bins are used to keep track of the number of passes and fails as a function of the parameter
value. As the yield analysis proceeds, the statistical parameter space is sampled at random. The value of each parameter
falls into one of these bins for each trial. A parameter value that falls within the range of one of the bins for a single
passing or failing trial adds to the number of passing or failing trials for that bin. The percentage of trials that pass are
computed from the number of passing trials and the number of failing trials.
You can plot the binned results for each statistical parameter as a histogram. The histogram displays the percentage yield
as a function of the parameter value. Each bar in the histogram represents one bin. The numbers on the top of the bars
display the total number of trials that fell into that bin. The height of each bar represents the percentage of values that
passed the yield. To create a component sensitivity histogram, you can create a histogram graph and then add a YSens
measurement to the graph (select Yield as the Measurement Type in the Add/Modify Measurement dialog box). An example
histogram is shown in the following figure.
You can use the component sensitivity histogram to determine how sensitive the yield is to the parameter variations. The
histogram can also indicate if the yield can be improved by changing the nominal value of the parameter. If the peak of
the component sensitivity histogram distribution is centered around the nominal value of the component, then the parameter
is said to be "centered". A peak of the distribution that is not centered about the nominal value indicates that the yield
could be improved by changing the nominal value. If the distribution of the component sensitivity histogram is flat, then
the yield is not sensitive to the value of the component. A narrow distribution indicates that the yield is sensitive to the
component value.
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The previous distribution indicates a variable that is perfectly centered. The following histogram shows an uncentered
variable.
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The following histogram shows a parameter to which yield is not sensitive.
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Often it is too time consuming to view the Ysens measurement for each variable in a design. Several measurements can
help analyze the component sensitivity and provide a rank-ordered list of the variables that contribute the most to yield
degradation. See the “Ranked Yield Improvement Estimate (by Component Variation Elimination): YRank ” and “Ranked
Yield Improvement Estimate (by Component Variation Elimination and Centering): YRankCenter ” measurements for
details on setting up these measurements.
Additionally, a Pareto measurement is available that can determine which variables most strongly influence a specified
measurement. The results are rank ordered from largest to smallest making it very easy to identify which variables have
the biggest influence on a given measurement. See the “Pareto Measurement for Yield: YPareto” measurement for details.
Performance Histograms
Statistical variation produces ranges of responses for simulation results. As previously discussed, you can see all of the
yield results on current measurements for your project. You can also plot specific statistics from those results (for example,
range and median). You can plot the binned simulation results as well as a histogram. The histogram displays the
percentage of trials in a bin as a function of the measurement y-axis values. Each bar in the histogram represents one
bin, and the numbers on top of the bars display the total number of trials that fell into that bin. The height of each bar
represents the percentage of the values that fell into that bin. To create these performance histograms, create a histogram
graph and then add a Ymeas measurement to the graph (select Yield as the Measurement Type in the Add/Modify
Measurement dialog box).
The following graph shows S(1,1) of a filter after running 500 yield iterations.
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At approximately 370 MHz, there is a null where it is unclear how many of the trials are at specific values; it just looks
like a solid area. The area gives you an idea of what is possible. The performance histogram helps you understand how
many trials are at binned values. The following graph shows the performance histogram for the null at this frequency.
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See the “Performance Histogram: YMeas” measurement to better understand the results from these measurements.
By default, the performance histogram "bins up" the data at all x-axis points. However, on the measurement, you can
specify that it only bin the data between a range of x-axis values. In the previous example, the data was only collected
for 370 MHz.
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In the setup represented here, the frequencies of simulation are done every 10 MHz. The setting of 368.0e6 (368 MHz)
is the lower frequency in Hz and the setting of 370.0e6 (370 MHz) is the upper frequency in Hz. Only the 370 MHz
frequency falls into this range, so only data for that frequency is used for the performance histogram.
Identifying Values for a Given Yield Result
When running yield iterations, you can use the following steps to find the exact parameter and equation values that
produce a given yield trace.
1. Run a yield analysis to look for interesting results.
2. Click and hold on a yield trace for which you want to find the parameter values.
3. View the Status bar in the lower left of the AWR Design Environment platform interface for a list of yield iterations
that produced the chosen result.

4. On a tabular graph, add the YSample measurement (the only measurement parameter is the yield index read from the
Status bar in the previous step).
5. Simulate again to view the values used to produce the chosen yield result on the tabular graph.
The following figure is an example of this data.
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In general, the syntax is "Document Name"\"Element ID"\"Parameter Name". For equations, the "Document Name" and
"Element ID" are the same and are the name of the variable (left half of the equation). The "@" symbol also indicates
an equation when in a schematic or system diagram.

2.7.6. Saving and Restoring Yield Results
You can store the results from yield analysis in a data set, and then use the data set to view the yield data at a later time.
See “Yield Data Sets” for more information on using data sets.

2.7.7. Saving Yield Data to a File
All data generated in yield analysis can also be written to a file in XML format using the YldToXML measurement (see
“Yield Data to XML File: YldToXML ” for details). This data includes the measurement data as well as the
parameter/variable values used. XML format is used since it can be easily transformed into other formatting if you need
to use this data in other programs.
The file generated has three general sections and there are comments above each to help you understand what the file
contains.
1. Measurement data for each graph with the x and y data separated.
2. Identifiers for the variables or parameters used in the yield analysis. The syntax is the same as that used in the User
Defined corners. See “User Defined Corners (Design of Experiments)” for more information.
3. The values used for each variable or parameter in the yield analysis. There is one vector of values for each component
identified in the previous section.
The following is a simple two resistor example with one simple measurement to show an example of this file.
<YieldData>
<!-- The 'trial' attribute indicates the yield trial index -->
<Measurements>
<measure name="Schematic 1:R_SRC(1)">
<data trial="0">
<x_data>1e+009 2e+009</x_data>
<y_data>310.36 310.36</y_data>
</data>
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<data trial="1">
<x_data>1e+009 2e+009</x_data>
<y_data>301.567 301.567</y_data>
</data>
<data trial="2">
<x_data>1e+009 2e+009</x_data>
<y_data>298.4 298.4</y_data>
</data>
<data trial="3">
<x_data>1e+009 2e+009</x_data>
<y_data>316.759 316.759</y_data>
</data>
</measure>
</Measurements>
<Samples>
<SampleCompNames numb_comp="3">
<!-- The index is just the index into the vector of component values (matches the order
in SampleValues) -->
<Component index="0">Schematic 1\IN1\R</Component>
<Component index="1">Schematic 1\IN2\R</Component>
<Component index="2">Schematic 1\IN3\R</Component>
</SampleCompNames>
<SampleCompValues numb_comp="3">
<!-- The Sample Values are ordered the same as the SampleCompNames above -->
<!-- The pass property is used to indicate if the particular sample passed or failed
yield -->
<SampleValues trial="0" pass="1">97.9955 107.939 104.426</SampleValues>
<SampleValues trial="1" pass="1">100.476 108.618 92.4725</SampleValues>
<SampleValues trial="2" pass="1">98.1768 99.8825 100.341</SampleValues>
<SampleValues trial="3" pass="1">115.092 97.0817 104.585</SampleValues>
</SampleCompValues>
</Samples>
</YieldData>

2.7.8. Controlling Memory Requirements
When running yield analysis, your computer needs to keep various information in memory. If your computer runs out
of memory during operations, you need to change settings by choosing Options > Project Options to display the Project
Options dialog box. Click the Yield Options tab and adjust your options according to the descriptions of what yield
information is lost if you turn off an option.

2.7.9. Debugging Simulation Errors
When running yield analysis, parameter values can produce simulation errors. For example, the width of a line might
exceed the allowed limits. At the default settings, yield analysis stops when it first encounters a simulation error. You
can try the following settings to determine the cause of simulation errors:
• In the Yield Analysis dialog box (choose Simulate > Yield Analysis), select the Stop on simulation error check box and
clear the Simulate nominal when finished check box. With these settings, when a simulation error occurs the errors in
the Status Window provide clues as to what model is problematic.
• In the Yield Analysis dialog box, clear the Stop on simulation error check box. Add the YPassFail measurement to a
tabular graph (see “Iteration Status: YPassFail ” for measurement details). With this setup, when you run yield analysis
you can see which trials produced a simulation error when you see a value of -1 for the YPassFail measurement. You
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can then use the YSample measurement (see “Vector of Sample Values Used in the Yield Analysis: YSample” for
measurement details) to see the model parameters that produced the simulation error.

2.8. Working with Hierarchy
The AWR Design Environment platform has very powerful hierarchical design capabilities. This section includes
hierarchical design topics.
• Subcircuits are easily added to an existing schematic or system diagram. See “Adding Subcircuits to a Schematic or
System Diagram ” for details. Cadence recommends adopting a "test bench" design approach where one schematic
contains your design components (for example, transistors, microstrip lines, and capacitors) and then a higher level
"test bench" is created to use the design as a subcircuit. All of the sources, sweeps, etc. are set up at the top level. This
approach makes it very easy to set up new test benches for different types of simulation or to share a design with a
co-worker.
• Connections through hierarchy are determined by the PORT element or the PORT_NAME element. See “Adding and
Editing Ports” for details on these elements. Ports can contain impedance information as well as signal information
(for example, powers and signal types). This information is ONLY used when measurements are made on that schematic.
If this schematic is used as a subcircuit, then the impedance and signal information are not used and a port is only used
for determining connectivity.
• Parameters can be instructed from a subcircuit to be available to pass to the subcircuit using passed parameters. See
“Using Parameterized Subcircuits” for details.
• Parameters can also be pushed from a top level to all levels of hierarchy. See “Using Inherited Parameters” for details.

2.9. Using Simulation Filters and Switch View Lists
Simulation filters and Switch Views are two advanced means of controlling what is simulated. Note that these approaches
apply to all simulations including EM and transient simulations.

2.9.1. Simulation Filters
Simulation filters are an alternate way to configure what is simulated during a project simulation. By default, the AWR
Design Environment platform is a measurement driven environment-- the simulators needed for measurements on graphs
are the simulators that are used. For large projects this can be difficult to track, and can result in lengthy simulations.
You can use simulation filters to control what is simulated by specifying filters for simulator type, document name, and
other criteria.
You can access the simulation filters by right-clicking the Simulation Filters node in the Project Browser and choosing
Manage Simulation Filters, or by choosing Simulate > Manage Simulator Filters. In the Simulation Filters dialog box, click
the New button to add a new filter. See “Simulation Filters Dialog Boxes ” for more information. You can add many
different filters and can also select All Documents or All Simulators to Check None, or Toggle Checks to multi-select filters.
Any selected filter is applied to the overall simulation filter.

2.9.2. Switch View Concepts
Switch Views are an alternate way to view the documents in your project. The view names are global to all documents
in the project. A common Switch View use is to have an LVS (layout versus schematic) view. For each document in
your system that requires a different representation for LVS, you can create an LVS Switch View. See “LVS (Layout
vs Schematic) ” for LVS details. Another example of Switch View use is when you want to have different schematics
for linear and nonlinear simulation.
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Switch Lists control the views used during a simulation, or during LVS netlisting. The simulation Configuration you
select in the Add/Modify Measurement dialog box controls which Switch List is used. You can create any number of
simulation configurations.
A Switch List can contain one or more view names that are ordered in the list by priority. When Switch Lists are used,
Switch Views with higher priority (those at the top) are used in preference to views with lower priority. This matching
based on priority is designed to allow different documents in the system to have different Switch View names, so you
can use a single global Switch List to choose which Switch Views are used for individual documents. If a document has
more than one Switch View that matches one of the views in the Switch List, the view with the higher priority is used.
Preparing to Use Switch Views and Switch Lists
NOTE: Switch Views are not necessary for an LVS representation of distributed elements (which are shorts in LVS
netlists). The distributed elements do this automatically.
When using Switch Views and Switch Lists, you may need to change the way you build schematics. Each design
component that uses a Switch View must be a subcircuit rather than a direct component in a schematic. The following
is an example of building a lumped element filter.
PORT
P=1
Z=50 Ohm

IND
ID=L1
L=.2 nH

PORT
P=2
Z=50 Ohm

CAP
ID=C1
C=1 pF

Without Switch Views and Switch Lists, you can build a schematic as shown. If you want to use Switch Views, however,
you have three different options for modeling the inductor:
1. Distributed model for a microstrip inductor
2. Lumped element inductor
3. EM simulation
In the filter schematic, the inductor component must be a subcircuit as shown in the following figure.
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SUBCKT
PORT
ID=S1
P=1
NET="inductor1"
Z=50 Ohm
1

PORT
P=2
Z=50 Ohm
2

CAP
ID=C1
C=1 pF

The name of each Switch View is important to consider early in your design. You should establish a naming convention
that makes sense for the entire design. Typically, a Switch View is named for its purpose, such as LVS or EM. In this
example, the LVS named "Switch Views" is used for the proper LVS representation of each component, and the EM
named "Switch Views" is used when there is an EM simulation available for the component.
Using Switch Views and EM extraction are not compatible. See “Extraction and Switch Views” for more information.
Adding Switch Views
Any schematic, data file, or EM structure can have a Switch View. To create a Switch View, you create a new document
(schematic, data file or EM structure) or rename an existing document using the naming convention
"default_name/switch_view_name" where "default_name" is the name of the existing document you are making the
Switch View. Switch View documents must have the same number of ports as the "default_name" schematic.
In the previous filter example you create Switch Views for the inductor in the circuit. The schematic setup for Switch
Views is shown. The model in the inductor1 schematic is shown in the following figure.

PORT
P=1
Z=50 Ohm

MLIN
ID=TL2
W=10 um
L=40 um

MRINDSB2
ID=MSP1
NS=5
L1=70 um
L2=45 um
L3=65 um
LN=35 um
AB=180
W=10 um
S=5 um
WB=10 um
HB=2 um
LB=0 um
EPSB=1
TDB=0
TB=1 um
RhoB=1

MLIN
ID=TL1
W=10 um
L=40 um

PORT
P=2
Z=50 Ohm

You need to add a Switch View for the lumped element inductor used for the LVS netlist. Here you add a new schematic
named "inductor1/LVS".
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When you add this schematic, it displays differently in the Project Browser, showing you that it is a Switch List of the
"inductor1" schematic.

Inside this schematic is a lumped element inductor with two ports, as show in the following figure.
PORT
P=1
Z=50 Ohm

IND
ID=L1
L=0.2 nH

PORT
P=2
Z=50 Ohm

The same steps are repeated for the EM Switch View with the schematic named "inductor1/EM". The Project Browser
now displays two Switch Views for the "inductor1" schematic.

The EM Switch View should look like the following figure.

PORT
P=1
Z=50 Ohm
1

PORT
P=2
Z=50 Ohm
2

SUBCKT
ID=S1
NET="EM_Inductor"

When you push into a subcircuit using the Edit Subcircuit command, if there are switch views of the referenced document
an “Edit Subcircuit Dialog Box ” displays to allow you to choose which document to push into.
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Adding Switch Lists
A Switch List is the mechanism through which you pick a different Switch View for each measurement. A Switch List
tells the simulator which model to substitute for the default model when performing a simulation.
To create a Switch List:
1. Right-click the Switch Lists node in the Project Browser and choose Manage Switch Lists, or choose Simulate > Manage
Switch Lists to display the Switch Lists dialog box.
2. Under Switch Lists, click the New button. In the New Switch List dialog box, enter a name for the new switch list,
then click Create. The name you enter is the name chosen when adding measurements to the project.
3. Select the new switch list name under Switch Lists, and then under Design Views click the New button.
4. In the Edit Switch List dialog box, ensure that Select top level design for the Switch List specifies a schematic that is
using a Switch View, as this populates the Available list. You can also click the New View button to add additional
Switch View names.
5. From the Available list, select any view name and click the Add button to add the view to the current View List. Note
that you can add several Switch View names to a view list. When you do, the first Switch View found in this list is
used in simulation. Use the Move Up and Move Down buttons to re-order the Switch List.
6. Click OK to add the View List to your project.
7. Repeat these steps to create Switch Lists for the other Switch Views in your project.
When you add or edit a measurement in the Add/Modify Measurement dialog box, in Configuration you select the Switch
List name you want for the measurement. The options available are Default or any Switch List names you configured.
For example, to create a Switch List to use the LVS Switch Views:
1. Create a Switch List named "For LVS".
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2. Under Design Views, click the New button to display the Edit Switch List dialog box. Select Filter from Select top level
design for the Switch List since this schematic uses a subcircuit that has Switch Views.

3. Click LVS in the Available list and then click the Add button to add it to the View List, then click OK.
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4. When complete, the new Switch List displays under Design Views in the Switch Lists dialog box and you can use it
in simulation. You can select this Switch List and edit or delete it using the buttons at the bottom of the dialog box.

5. For example, to look at the magnitude of S21 of the filter using the lumped element inductor Switch View, select For
LVS as the Configuration when adding the measurement from the Add/Modify Measurement dialog box.
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In this example, a second Switch List is set up to use any EM models. The following graph shows results with the "For
LVS" and "Electromagnetic" Switch Lists.

s21
0
-0.5
-1

DB(|S(2,1)|)
Filter.*For LVS

-1.5

DB(|S(2,1)|)
Filter

-2

DB(|S(2,1)|)
Filter.*Electromagnetic

-2.5
-3
0.1

1.1

2.1
3.1
Frequency (GHz)

4.1

5

2.10. Using Scripted APLAC
2.10.1. Using the Scripted APLAC Simulator
The Scripted APLAC simulator is created by placing a SCRIPT block in the schematic and setting its SIM parameter to
“Yes” (the default). If a schematic contains one or more SCRIPT blocks with its SIM parameter set to “Yes”, a Scripted
APLAC simulation is created with that schematic as a data source. Subcircuit hierarchy is maintained in the netlist;
subcircuits are netlisted out as APLAC subcircuits (DefModels) and there may be several instances of the same subcircuit
with different parameter values.

Simulation and Analysis Guide 2–71

Using Scripted APLAC
You need to write a Prepare statement if necessary. The Prepare statement is always required when running harmonic
balance or noise simulations. Only one Prepare statement is allowed per netlist. You also need to define the analysis
setup and the plotting commands. Analysis type and frequency or other parameters, as well as any loops, are typically
defined using the Sweep statement. The APLAC simulator plot command is Show, which must be used within the Sweep
… EndSweep block. When plotting nodal voltages, you need to refer to the node names. You can use a named connector
(NCONN) in the schematic to specify a unique node name that can be referenced in the APLAC simulator scripts. Any
curves requested by Show are automatically exported into the AWR Design Environment platform and the graphical
result windows are added to the project.

2.10.2. Using SCRIPT Blocks
You can add SCRIPT blocks in the schematic to utilize APLAC simulator scripting capabilities. Here, APLAC simulator
scripting refers to all APLAC input language statements such as defining variables, performing numerical computations,
defining simulation and optimization tasks, displaying simulation results graphically, file I/O, and others. The SCRIPT
block is in the Simulation Control category of the Elements Browser.

The APLAC netlist written by the AWR Design Environment software has the following structure:
1. Prepare statement (if present, Prepare must always be the first item in the netlist)
2. “Before circuit description” SCRIPT blocks
3. Circuit description (all the elements in the schematic except SCRIPT blocks)
4. Sweep statement(s) defining the analysis and the measurements
5. “After circuit description” SCRIPT blocks
The SCRIPT block POSITION parameter defines whether the SCRIPT block belongs in the “Before circuit description”
or the “After circuit description” group. The ORDER parameter defines the netlisting order of the SCRIPT blocks within
each group, such that the SCRIPT block with the greatest order is netlisted last. The SIM parameter defines whether the
SCRIPT block is allowed to spawn a Scripted APLAC simulation or not.
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DC Analysis calculates the DC operating points of circuits. You can use DC simulation to generate data on plots, for
example, the IV curves of a transistor and annotating DC values on a schematic. It is also the first simulation step when
performing other simulations such as linear, harmonic balance, or transient. Any circuit with a nonlinear model or a
source with a DC component automatically requires DC simulation. For example, you might have a nonlinear transistor
model that is biased up and you are doing a linear measurement such as (S(2,1)). The DC simulation must occur first to
get the linear characteristics of the nonlinear transistor model.
The following are the most common measurements used for the DC simulator alone:
• IDC and VDC are available under the Nonlinear > Current and Nonlinear > Voltage categories when adding or editing
measurements. These are DC current with all AC sources turned off. If you are sweeping power, these values are flat
versus power.
• IVCurve and IVCurve2 are available under the Nonlinear > Current category when adding or editing measurements.
These are DC measurements used specifically with IVCurve sources to easily plot IV curves of transistors.
• Any schematic annotations beginning with "DC" are DC simulator only.
One of the most common mistakes users make is to use the IDC measurement in a power amplifier and not understand
why the value is constant versus input power. Due to self-biasing effects, the DC current should vary as input power is
increased, however when performing the IDC measurement, none of the AC sources are on, so self-biasing effects are
not included. The proper way to look at the DC value of a circuit under AC drive conditions is to use the Icomp
measurement with a harmonic index of 0. For example, see the following graph that shows the IDC and Icomp
measurements and the DC value of a power amplifier power sweep.
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The measurements agree at low power and then diverge quickly and the amplifier goes into saturation.
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Chapter 4. Linear Analysis
Cadence® Microwave Office® software supports linear analysis using the nodal admittance matrix method.
The type of simulator used to analyze a circuit depends on the types of elements and sources present in the circuit along
with the type of measurements requested. If all of the elements in a circuit are linear, only the linear simulator runs when
you choose Simulate > Analyze. If the circuit contains any nonlinear elements or sources but only linear measurements
are requested, then the harmonic balance simulator solves for the DC operating point. The circuit is linearized about this
operating point and analyzed by the linear simulator.

4.1. Using the Linear Simulator
The Microwave Office linear simulator is built using object-oriented techniques that enable fast and efficient simulations
of linear circuits. One of its trademarks is a real-time tuner that allows you to see resulting simulations as you tune. It
also allows you to perform optimization and yield analysis.
The linear simulator is used to analyze circuits that are a function of frequency, but are independent of drive level, such
as low noise amplifiers, filters, couplers, and dividers. Examples of linear elements are capacitors, inductors, resistors,
microstrip, stripline and coaxial transmission lines. Some of the measurements associated with linear circuit analysis are
gain, stability, noise figure, reflection coefficient, noise circles, and gain circles.

4.1.1. Linear Solver
The Microwave Office linear simulator uses the nodal admittance matrix method. This method computes the response
of the linear network from an admittance matrix equivalent of the N port network. The N port network can include
element models like microstrip, S-parameter files, or imported netlists that represent text-based versions of a schematic.

4.1.2. Linear Circuit Design
Linear circuit design in the Microwave Office program is easy and intuitive. The process to create a linear design begins
with placing linear elements in a schematic, then adding ports and sources to define the network. The elements can be
data files, models, or netlists. The network then registers as a subcircuit in the Elements Browser and can be used in
other schematics. Circuit hierarchy can be used for very complex designs by placing subcircuits within a top level
schematic. After the schematic is complete, graphs and measurements are defined to view the simulated data. All of the
popular measurements like scattering parameters, stability factor, and maximum available gain are included with the
program. If necessary, you can activate element parameters for tuning, and use a real time tuner to view changes in the
response instantaneously. Optimization and yield analysis are also available to further refine the design.

4.1.3. Linear Noise Analysis
Microwave Office software simulates linear noise using noise correlation matrices. Noise contributions from the following
are accounted for in the simulation:
• Thermal, shot, and flicker as defined by nonlinear device models. Noise from NL models is generally bias and
temperature-dependent. For linear noise analysis, these noise sources are linearized about the operating point.
• Thermal noise from lossy, passive elements. This noise is scaled by T/T0 where T0 is defined by convention to be
290K. T is controlled by the variable _TEMPK and defaults to 290K. _TEMPK can be overridden by placing an
equation that redefines _TEMPK to another value. Note that this value must always be in degrees Kelvin.
• Noise from active two-port devices as defined by the noise parameters Fmin, Gamma Opt., and Rn in an S-parameter
data file.
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• Any noise source elements, both linear and nonlinear, present on the schematic.

4.1.4. APLAC Linear Subcircuit Caching
Subcircuit caching can reduce the simulation time in designs that contain linear portions that do not change very often,
but are expensive to compute. The Cadence AWR Design Environment® platform uses subcircuit hierarchy when
searching for cache candidates. When a linear portion of a circuit is accepted for caching, AWR Design Environment
software stores its Y-parameters and noise parameters on disc. When the same subcircuit is next simulated, the Y-parameter
data is read from the disc cache.
Subcircuit caching can speed up the simulation when:
• there are multiple instances of the same subcircuit in the same top level simulation
• there are multiple top-level simulations in the same project using the same schematic as a subcircuit
• re-opening a project that has previously stored subcircuit cache data
Subcircuit caching is used for the Cadence APLAC® Linear simulator only. To enable this option, on the Circuit Options
dialog box APLAC Sim tab, display the secondary options, and under APLAC Simulator Options/AC Options, select Subcircuit
caching. When enabled, all subcircuits are examined for caching candidates. The automatic detection tries to identify
subcircuits with large potential speed-up, typically subcircuits with a large number of internal nodes compared to the
number of ports. Nonlinear subcircuits are also candidates, but only the linear portion of the subcircuit can be cached.
You can override this automatic selection by placing SUBCKT_CACHE control blocks in the subcircuit schematics that
are not often modified. If there are any SUBCKT_CACHE blocks in the circuit, the automatic selection is disabled and
only the subcircuits containing the control blocks are considered for reading or writing the cache. Note that a subcircuit
containing a SUBCKT_CACHE block may still be discarded from caching.
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AC analysis calculates the linear (i.e. small signal) response of the circuit to stimuli or noise generating elements. As
with port-based linear analysis, an initial DC analysis calculates the operating point of all nonlinear elements, which
determines their linear equivalent for the AC analysis. Unlike the port-based linear analysis, however, AC is a nodal
analysis that calculates complex voltages and currents, at all nodes and through all branches.
AC analysis can include one or more stimuli with arbitrary magnitude(s) and phase(s), but it only simulates one frequency
at a time. It uses the Tone 1 frequency sweep for all sinusoidal voltage and current sources in the circuit, as well as any
other sources with an ACMag parameter that is set to a non-zero value. All of these stimuli are “on” for the simulation.
Non-sinusoidal signal sources are assumed to be of zero value (voltage sources are shorted, and current sources are open
circuit). Regardless of type, all ports act as terminations only, not stimuli.
To perform AC analysis, add AC measurements in the Add/Modify Measurements dialog box by selecting Linear > AC
as the Measurement Type. AC analysis is supported by the Cadence® APLAC® simulator, so select APLAC AC from
Simulators. For AC voltage and current measurements, selecting the dB check box calculates 20*log10( |measurement|
). For example, if the magnitude of the input voltage is 1V, then a voltage magnitude measurement in “dB” is the voltage
gain of the circuit from the input source to wherever the measurement is made. Because AC is a linear analysis, the
magnitude of the input has no effect on the gain; for example, if the voltage gain is 10, then 1mV input yields 10mV out,
and 1kV input yields 10kV out, the DC supply is ignored after the initial DC analysis.

5.1. AC Noise Analysis
AC noise analysis requires at least one sinusoidal input source and one V_NSMTR noise meter with its InpSrc parameter
set to the ID of the input source. It then calculates the noise contribution of each noise generating element in the circuit
to the voltage measured by the V_NSMTR. AC noise measurements and annotations include the total output noise,
input-referred output noise (total output noise divided by gain from input source to output voltage), and the contributions
of individual noise generators to the output node.
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Chapter 6. Harmonic Balance Analysis
This chapter provides an overview of several Harmonic Balance (HB) analysis methods. The HB method is a powerful
technique for the analysis of high-frequency nonlinear circuits such as mixers, power amplifiers, and oscillators. The
method matured in the early 1990s and quickly became recognized as the simulator of choice for relatively small,
high-frequency building blocks. With the adoption of new developments in the field of numerical mathematics, the range
of applicability of HB has expanded to very large nonlinear circuits, and to circuits that process complicated signals
composed of hundreds of spectral components. Cadence® Microwave Office® software incorporates the modern Cadence
APLAC® HB simulator, which is built on the latest developments in numerical mathematics and circuit simulation. This
APLAC simulator is the default HB simulator in the Microwave Office program, and should be used for all new designs.
However, for assured backward compatibility with older design project simulations, the Microwave Office program still
includes its older, "legacy" HB simulator. The principle of operation, the most important features, and some common
applications of HB simulation are summarized in the following section after a brief comparison of HB and transient
simulators.
Transient simulations allow the simulation of switching behavior, while HB simulations yield steady state solutions.
Transient simulations can handle circuits that are not ordinarily responsive to HB simulations such as frequency dividers,
elements or circuits with hysteresis, highly nonlinear circuits, and digital circuits with memory. Both HB and transient
simulators are available in the Microwave Office program.
In cases where both HB and transient analysis are applicable, the better choice is dependent on the stimuli, circuit type,
available element models, and the desired measurements. Harmonic balance is a frequency domain solver and transient
analysis is in the time domain. For example, transient analysis is the better choice if the stimuli are not periodic and have
short rising or falling edges, the circuit shapes pulses using a large number of transistors, and the measurement is rise or
fall time. If the stimulus has a finite and discrete spectrum, the models are S-parameter files, and the desired measurement
is power at a specific frequency, then HB is the better choice.
In most cases, you can use both simulators to solve the same problem and verify the results. The choice of which simulator
to use is primarily a matter of efficiency. For example, during the design phase, microwave amplifier designers often
use large capacitors and inductors (ideal bias tees) to block DC from the input and output, and to choke off the RF signal
from the DC supplies. These capacitors and inductors have time constants that are significantly larger than the period of
the input signal. To simulate the steady-state response of such an amplifier using transient analysis, you may need to
simulate hundreds or thousands of periods for the transient effects to die out. Otherwise, to see the start up of an amplifier
from when the input signal is first switched on, HB analysis requires two tones to represent the switched RF signal, one
of which is a pulse with a very low frequency and hundreds of harmonics.

6.1. Harmonic Balance Background
Unlike time domain simulators, HB simulators analyze circuits in the frequency domain. The development of frequency
domain simulation technology was motivated by the following deficiencies of time domain methods in applications to
high-frequency circuits:
• Distributed circuit elements are almost exclusively modeled, measured and analyzed in the frequency domain, and
their incorporation in SPICE-like simulators is notoriously unreliable and inefficient.
• Multi-tone simulations (those that involve an application of two or more sinusoids that are harmonically unrelated)
are very common in RF and microwave applications but, again, very difficult to handle in time domain simulators.
Consider, for example, an amplifier that is to be tested by an application of two equal-amplitude sinusoids located at
9.999 GHz and 10.001 GHz. Such a test is frequently applied to determine the third-order intercept, a popular figure
of merit of an amplifier's linearity.
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• The two-tone input may be viewed as a high-frequency carrier modulated by a comparatively very slow sinusoid
where, in this case, fcarrier = 10 GHz and fmodulation = 1 MHz. So, there are 10,000 carrier cycles per one cycle of the
modulation (envelope) signal and, in addition, the simulator must follow the slow envelope over several periods to
determine the steady-state. More importantly, a time domain simulator takes many steps per carrier cycle in order to
maintain accuracy. In all, each unknown circuit waveform (in a time domain simulator, "unknown circuit waveforms"
are usually the node voltages and certain branch currents) is sampled at hundreds of thousands of instants to find the
solution, and worse, the number of samples increases with the ratio of carrier/envelope bandwidth. The solution process
is therefore slow, memory consuming, and often simply impractical.
• Many high-frequency circuits are high-Q, implying that they exhibit transients that last over hundreds and even
thousands of carrier cycles. RF and microwave designers are primarily interested in steady-state responses, and time
is wasted in the process of simulating through the transients.
HB simulators overcome these problems in a rather elegant and efficient manner, by resorting to a frequency domain
formulation of circuit equations (equations that arise from an application of Kirchoff's laws and the circuit elements'
constitutive relations.) The frequency domain formulation is obtained by substituting the unknown waveforms with their
phasor equivalents, and then matching the phasor coefficients that correspond to distinct frequencies.
The following figure illustrates the principle behind HB simulation.

As shown in this figure, the circuit is partitioned in two subnetworks -- one that contains all the linear elements and
another that encompasses the nonlinear devices. The voltages at the interconnecting ports are considered as the unknowns,
so the goal of HB analysis is to find the set of voltage phasors in such a way that Kirchoff's laws are satisfied to desired
accuracy. One way to state this goal in formal terms is:
Find
V1(ωk),V2(ωk),...,VN(ωk)

(6.1)

|IL(ωk)-INL(ωk)|<ε

(6.2)

for all ωk such that relation

holds at each interconnecting port.
Here, ωk is the set of significant frequencies in the port voltage spectra and ε specifies the desired accuracy.
The solution search, in most general terms, consists of the following steps:
1. Specify the set of significant frequencies, specify the desired accuracy, and determine an initial guess at the solution.
2. Calculate the currents that enter the linear subnetwork.
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3. Calculate the currents through the nonlinear devices.
4. Calculate the difference between the two sets of currents.
5. Determine a new guess at the solution in a way that reduces the difference.
6. Repeat the process starting at Step 2 until Kirchoff's laws are satisfied.
The elegance of the HB approach, in reference to the problems seen by time domain simulators, lies in the following
observations:
• At each step of the iterative solution search, the currents entering the linear subnetwork are related to the interconnecting
port voltages by the linear subnetwork's Y-parameters. Distributed components, therefore, are simulated in the most
natural way, by means of frequency domain linear circuit techniques.
• The frequency domain representation of two-tone signals, as will soon be apparent, usually consists of less than 100
terms. This is in contrast to the time domain representation that requires hundreds of thousands of samples.
• HB simulators impose the steady-state conditions by virtue of phasor expansion of the unknown signals. Simulation
times are, therefore, independent on the length of circuit transients.
Knowing the basic steps of HB analysis, a number of practical questions need to be answered. Some of these questions
have a significant impact on the accuracy, speed and ultimate success of the simulation, as discussed in the following
sections.

6.2. Accuracy, Speed, and Convergence
6.2.1. Choice of Significant Frequencies
In general, phasor equivalents of nonlinear circuit waveforms consist of an infinite number of terms. If a circuit is driven
by a sinusoidal waveform at a frequency ω0, for example, these terms correspond to frequencies in the set nω0,n = 0,1,...,∞
as shown in the following figure.

For the purposes of simulation, you truncate this representation to a finite set of terms by discarding components beyond
some point n=N. The act of spectrum truncation is a natural one, however, as high-frequency terms become less significant
due to the band-limited nature of physical circuits.
Generally, the choice of N depends on the degree of nonlinearity. Power amplifiers operating deep in compression, for
example, require more terms than low-noise amplifiers or amplifiers that behave almost linearly. The former may require
N=8, for example, while the latter may need as little as N=3.
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The idea of spectrum truncation is slightly more complicated in the case of "multi-tone" excitations. A multi-tone excitation
involves two or more tones that are not integer-related, as in the previous example that involved ω1=9.999 GHz and
ω2=10.001 GHz. In that case, it may be shown that circuit phasors correspond to frequencies in the set

nω1 + mω2, n = 0, 1, ..., ∞ m = 0, 1, ..., ∞
Again, you truncate this set as shown in the following figure.

In general, the spectral components that are retained in the simulation are given by
|mω1+nω2|

(6.3)

, where

m = − M, ..., M
n = − N, ..., N
In the previous figure, the truncation was performed using M=N=2. The terms nω1 are often referred to as tone-1 harmonics
and, similarly, mω2 are called tone-2 harmonics. The multipliers m and n are referred to as harmonic indices. The quantity
|m|+|n| is known as the order of an intermodulation (also, mixing or distortion) product.
The two-tone spectrum shown in the figure may be simplified further by discarding intermodulation products that are
higher than some K=|m|+|n|. In a near-linear low-noise amplifier tested under two-tone excitation, for example, experience
shows that the terms at 2ω2-2ω1 and 2ω2+2ω1 are negligibly small. These terms being of order 4, it may be reasonable
to exclude them from consideration by setting K=3. Modern HB simulators, like the ones featured in the Microwave
Office program, are very efficient and, in terms of speed, far less sensitive to the number of frequencies than early HB
simulators; the speed improvement gained by limiting K is therefore small, and setting it to a small number should be
avoided.
The case of three-tone analysis is analogous to the two-tone situation described previously. Three-tone simulations are
very useful for (but not limited to) linearity testing of mixers, where the circuit is subject to an LO excitation and
two-closely spaced sinusoids as an IF (or RF) input. In this case, every waveform in the circuit has an equivalent phasor
representation at frequencies in the set

nω1 + mω2 + pωLO, n = 0, 1, ..., ∞ m = 0, 1, ..., ∞ p = 0, 1, ..., ∞
and this set is truncated subject to
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m = − M, ..., M
n = − N, ..., N
p = − P, ..., P
Typically, the circuit behavior with respect to the LO signal is highly nonlinear, while the input signal suffers relatively
mild distortion. In applications, therefore, P should be set larger than M and N; typically, P is at least 5 (and often two
to three times as high), versus 2 or 3 for the remaining limits.
Regardless of the type of simulation, you should verify that the frequency set used in the analysis provides accurate
results by increasing the number of frequencies slightly, repeating the simulation, and verifying that the simulation results
changed by a negligible amount.
For most users, it is intuitive that a pure sinusoidal input requires single-tone analysis, and that two closely spaced
sinusoids require a two-tone analysis. Confusion arises in simulations that involve sources such as square-wave pulses,
which consist of a large number of harmonics that are not closely-spaced.
To prevent confusion, you should keep in mind that a simulation is considered n-tone if n is the smallest number of
frequencies whose integer linear combinations describe all the other frequencies in the source. A square wave signal, or
any periodic signal, has frequency components that are integer multiples of one frequency -- namely, the fundamental;
therefore, such a simulation is considered single-tone.

6.2.2. Calculation of Nonlinear Device Currents
As previously presented, the calculation of currents entering the linear ports is rather straightforward as it involves the
familiar theory of linear multi-ports in the frequency domain. It is, however, less obvious how an HB simulator calculates
the nonlinear device currents.
Nonlinear devices are almost exclusively specified as time domain functions of the controlling voltage waveforms. In
an HB simulator, however, the controlling voltages are represented in the frequency domain. To evaluate the nonlinear
device functions, the simulator resorts to the following procedure: 1) it converts the voltage phasors to the time domain
by application of Fourier transformations 2) it evaluates the nonlinear devices in the time domain, and 3) it applies another
set of Fourier transformations to obtain the current phasors.
Because of this brief excursion to the time domain, HB simulators are sometimes referred to as mixed (frequency-time)
domain techniques. This is mostly a matter of nomenclature, but the frequency domain label is preferred because of the
phasor representation of the unknown signals.
Domain transformations introduce, to a varying degree, inaccuracies in the evaluation of nonlinear devices. These
inaccuracies are caused primarily by the aliasing phenomenon, the degree of which depends on the level of nonlinearity
and the number of frequency components taken into account in the simulation. In principle, aliasing effects may be
reduced to negligible levels simply by performing the analysis with a very large number of frequencies. This, however,
is undesirable since it leads to slow simulations. A simpler method for reducing the effects of aliasing is based on what
is known in HB terminology as "oversampling".
The lower limit on the number of time domain samples used in the evaluation of nonlinear devices is 2H (the Nyquist
limit,) where H is the number of significant frequencies. To reduce aliasing, you are given the option of increasing the
number of time domain samples beyond the Nyquist limit; the resulting number of samples is some multiple of 2H, for
example, 2rH. Once the nonlinear device currents are evaluated at the 2rH time samples, a Fourier transformation yields
rH frequency components of the currents. Finally, the rH components are truncated back to the original H components
that were selected for the simulation.
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Oversampling is an effective means of reducing the effects of aliasing without paying a significant penalty in simulation
time. The question arises as to when to use it and what the right oversampling sampling factor should be.
In the Microwave Office program, the default oversampling factor is 1. This should be sufficient in a majority of
simulations with the possible exception of intermodulation analysis of mixers. In mixer intermodulation analysis, the
simulator must be able to capture intermodulation products that can be as much as 100 dB smaller than the largest signal
in the circuit (normally, the LO). Since the LO is very large, otherwise minor aliasing effects could effectively "mask
out" the crucial intermodulation products or, at least, cause errors in their calculation. You can prevent this by properly
selecting the set of significant frequencies, and by selecting a larger oversampling factor. You should check the results
by repeating the simulation with a larger set of significant frequencies and a larger oversampling factor.

6.2.3. Specifying Simulation Accuracy
HB simulation is an iterative process that terminates when Kirchoff's laws for the circuit are satisfied. Two criteria are
used to determine whether these laws are satisfied: the maximum absolute tolerance and the maximum relative tolerance
between the linear and nonlinear currents at each frequency and at each interconnecting port. The simulation ends when
either of these two criteria are met:

| I L(ωk ) − I N L(ωk ) | < εabs
| I L(ωk ) − I N L(ωk ) |
| I L(ωk ) + I N L(ωk ) | < εrel
The default values used in the Microwave Office simulator are sufficient in a majority of situations, but you should be
cautious when simulating circuits that feature very small, but nevertheless significant, signals.

6.2.4. Convergence
The simulator makes a finite number of attempts at satisfying Kirchoff's laws, after which it either reports convergence
failure or it resorts to source stepping.
Convergence failures, though rare, are usually a consequence of very strongly nonlinear circuit behavior. In such cases,
one difficulty encountered by the simulator is a lack of a "good guess" at the solution. Normally, the DC solution or the
linear approximation of the circuit constitute a good guess, but that may not be the case for strongly nonlinear circuits.
To find a better initial guess, the simulator reduces the specified excitation level (thereby lowering the level of circuit
nonlinearity) and attempts to find the "reduced" solution. Upon success, it uses that solution as the initial guess when
solving the original problem.
Sophisticated convergence control algorithms in the APLAC HB simulator, coupled with source stepping, result in
successful convergence in most situations. Occasionally, however, the simulator fails to converge. The following are
some of the common causes and solutions:
• Circuit instabilities. If the circuit being analyzed is not conditionally stable (or, in the case of oscillator analysis,
unconditionally unstable), harmonic balance is likely to have a difficult time converging. Often an instability is caused
by S-parameter data that has been extrapolated to DC or the higher harmonics of the simulation frequency. With the
default (linear) interpolation, this extrapolation often results in devices that generate power.
• Too few frequency components. If the circuit being analyzed is strongly nonlinear, it is important, both for accuracy
and convergence, to specify a sufficient number of frequencies in the simulation. Ensuring this is the first step in
troubleshooting convergence problems.
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• Nonlinear device modeling. Discontinuities in nonlinear model equations and their derivatives are a common source
of convergence difficulties. When utilizing user-defined models, it is imperative to model nonlinear functions and
their derivatives smoothly. General-purpose models have been devised with continuity in mind, but problems can still
occur if their parameters are entered or extracted incorrectly.
For additional information on addressing convergence failures, see “APLAC HB Simulator Convergence” and “HB
Simulator Convergence”. Further options for speeding up or improving convergence are available on the Circuit Options
dialog box APLAC Sim tab under Error and Convergence Settings and Harmonic Balance Analysis Options. See “Harmonic
Balance Options” for more information.

6.3. Harmonic Balance Options
There are global and local Harmonic Balance options in the Microwave Office. These two options differ in scope but
are otherwise identical.
Global options are, by default, applicable to all schematics in the circuit. Sometimes, individual schematics contain
circuits for which a set of options other than the global options yield faster or more accurate results. In this case, you can
use local options to override global defaults.
Choose Options > Default Circuit Options to display the Circuit Options dialog box for setting global defaults. You can
set local options for a schematic by right-clicking the schematic in the Project Browser and choosing Options to display
the Options dialog box.

The following sections describe the available options.
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6.3.1. Tone Harmonics
Tone 1, Tone 2, and Tone 3 Harmonics values correspond to the quantities M, N and P in “Choice of Significant
Frequencies”. Tone 1, Tone 2, and Tone 3 Over Sample specify the oversampling factor "r" discussed in “Calculation
of Nonlinear Device Currents”. The default value r=1 is typically adequate; a possible exception is intermodulation
analysis of mixers.

6.3.2. Harmonic Limiting
enables spectral truncation of harmonic components an order higher than Max Order, which is
analogous to the quantity K in “Choice of Significant Frequencies”. Apply 'Max Order' to Intermods Only truncates only
the intermodulation products with orders higher than Max Order, while including all the harmonics specified for each
tone under Tone X Harmonics.
Limit Harmonic Order

For example: in a two-tone simulation, Tone 1 and Tone 2 are set to seven harmonics each, Max Order is set to five, and
both Limit Harmonic Order and Apply 'Max Order' to Intermods Only are selected. The following table shows the harmonics
included in the simulation:

6.4. Setting Up HB Simulations
6.4.1. Specification of Analysis Frequency
Microwave Office software allows you to specify a project-level frequency sweep, as defined on the Project Options
dialog box Frequencies tab. You can also define frequency sweeps for individual schematics on the Frequencies tab of
the Options dialog box. In addition, you can define multiple frequency sweeps inside a schematic using the SWPFRQ
control available in the Simulation Control category of the Elements Browser.
When setting up a nonlinear measurement, you can use any of these frequency sweeps for the fundamental frequency of
the first tone. In the Add/Modify Measurement dialog box, simply choose the appropriate sweep in Sweep Freq by clicking
the arrow button next to the option. The menu title changes from Sweep Freq (FDOC) when you choose Document (using
the frequencies in the schematic's Options dialog box) to Sweep Freq (FPRJ) when you choose Project (using the frequencies
in the Project Options dialog box) to Sweep Freq (FSWP1) (using the frequencies from the first SWPFRQ control) and so
on.
The fundamental frequency for tones 2, 3, ...8 are set directly on the source element in the schematic.
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6.4.2. Single-Tone Analysis
Single-tone simulations are performed on the set of frequencies defined by

(6.4)

nω0,n=0,1,...,N
The fundamental frequency, ω0, is defined by the Nonlinear Frequencies or Project Frequency controls.

You can specify a variety of excitations for single-tone analysis, including sinusoidal, square wave and arbitrary file-based.

6.4.3. Two-tone Analysis
Two-tone simulations are performed on the set of frequencies defined by
|mω1+nω2|

(6.5)

The tone-1 fundamental, ω1, is controlled (as always) by the Nonlinear Frequencies or Project Frequency controls. There
are several methods to specify the tone-2 fundamental. Some sources allow direct specification of ω2, and others allow
a specification of ω2 as an offset Δω from the tone-1 fundamental. The fundamental frequency of the second tone may,
in addition, be specified as a function of the fundamental frequency of the first tone. To specify tone-2 as a function of
tone-1, you use the _FREQH1 reserved variable, which takes on the value of the tone-1 fundamental frequency in global
project units. For example, if Δω=0.1 GHz, you can define ω2 by entering _FREQH1 + 0.1 for the tone-2 source frequency,
assuming the project frequency units are in GHz.
The frequency of tone 2 and higher can be swept independently using a SWPVAR block, so that all combinations of
tone 1 and tone 2 frequencies are simulated. For example, to independently sweep the Fdelt parameter of a PORT2
element, or the Freq parameter of a PORTFN or PORT_SRC element, right-click the parameter in the schematic and
choose Setup Sweep..

6.4.4. Three-tone Analysis
Three-tone simulations use the set
|mω1+nω2+pω3|

(6.6)

The fundamentals may be specified directly in the source (using the PORTFN element) or by a combination of single
and two-tone elements. For example, tone-1 and tone-2 may be specified by the PORT2 element while PORTFN may
be used to specify the third.

6.4.5. Multi-tone Analysis
Microwave Office software supports simulations with up to eight tones. Tone X Harmonics and Tone X Over Sample options
for tones 4 through 8 are set directly on the port (or voltage or current source.) Double-click the element symbol in the
schematic to display the Element Options dialog box, then click the Show Secondary button. The NHarm and NSamp
parameters set the number harmonics and oversampling factor, respectively.

6.4.6. Sources
There are two types of sources in Microwave Office software: port sources and discrete sources. Discrete sources, which
are found under Sources in the Elements Browser, are ideal voltage or current sources. Port sources, which are found
under Ports in the Elements Browser, are defined by their available power and termination impedance.
Port sources serve two purposes. First, they provide a convenient and intuitive definition of power sources; second, they
define the inputs and outputs of a circuit, allowing its use as a subcircuit within another schematic.
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There are several types of ports used to specify excitations. A port is added to a schematic by dragging it from the
Elements Browser and dropping it on the schematic. You can also double-click an arbitrary Port element and change the
Port Type on the Element Options dialog box Port tab. For example, consider the simple termination (passive port) element
located on the main toolbar:

6.5. Nonlinear Measurements
Nonlinear measurements allow you to measure voltage, current, power, and more. Although categorized as nonlinear
measurements, you can use them in conjunction with linear circuits, as long as a large signal port or source is present.
To select a nonlinear measurement in the Add/Modify Measurement dialog box, under Measurement Type, expand the
Nonlinear node and select a type from the list. Each measurement type offers multiple measurements; for example, large
signal S-parameters, power at a specific harmonic (Pcomp), voltage spectrum (Vharm), or current waveform (Itime) and
others.

A brief description of the selected measurement is provided below the lists. For detailed information about the measurement,
click the Meas Help button. Nonlinear measurements generally require knowledge of specific currents or voltages (or
both), which are selected in Measurement Component. If the measurement is to be made at one of the ports in the top level
schematic, you can select that port in Measurement Component.
When measurements need to be made internal to the circuit, there are ways of identifying the relevant currents and
voltages, without the insertion of invasive elements that break the physical connections in the circuit.
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6.5.1. Measuring Voltages and Currents
A good way to identify internal circuit voltages and currents for measurements is the measurement probe (M_PROBE).
When placed on an element pin, you can select this probe as a measurement component to identify the voltage on that
pin, the current into that pin, or the power calculated from the voltage and current. If an M_PROBE is placed inside a
subcircuit, then the list includes one entry for the M_PROBE per instance of the subcircuit. Note that M_PROBE must
be placed on a pin; it does not identify a voltage if placed in the middle of a wire. After simulation you can move the
M_PROBE to check its associated measurements at different pins, without simulating again.
R=15 um
AB=0
WB=10 um
HB=2 um
LB=20 um
EPSB=1
TDB=0
TB=1 um
RhoB=1
MSUB=SubMMIC

2

2

M_PROBE
ID=VP1

AWR_MESFET_FET
ID=FET1
W=100 um
NG=50

1

3
W=100 um
L=100 um
W1=40 um
W2=40 um
CA=0.0003
MSUB=SubMMIC

Pins can also be identified for voltage and current measurements without an M_PROBE. When setting up the measurement,
click the ellipsis button next to Measurement Component to display a view of the schematic that you can navigate.
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Double-click any element pin, or select the element, and identify its pin from the list on the left. You can also select a
2-port element: voltage is measured at pin 1 (numbered or marked with a slash on the symbol) with pin 2 as the reference.
Current is measured as flowing from pin 1 to pin 2 on all elements except sources, where the measurement direction is
reversed.

6.5.2. Measuring Power
You can measure power by selecting a Measurement Type of Nonlinear > Power in the Add/Modify Measurement dialog
box. Measurements of this type also require a Measurement Component. If the selected measurement component is an
M_PROBE or an element pin, the power is calculated as the product of the voltage at that pin, and the current into it. If
an element is selected, then the power is measured as the sum of the powers at all pins of that element. This is equivalent
to the power dissipated in that pin.
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Whenever possible, power measurements have complex values; for example, power at a specific harmonic (Pcomp). In
some cases power measurements must include the real part only, if they are to be useful and logical; for example, total
power (PT).

6.5.3. Nonlinear Measurement Notes
Commonly, you want to measure power supplied by a source and power dissipated in a load (or voltages and currents
associated with the source and the load.) You can do so by selecting the corresponding port or source as the Measurement
Component. Currents, voltages, and powers are computed for ports, as shown in the following figure.

Note that only the ports in the top level schematic are available as measurement components. When measurements are
made on a top level schematic, ports in the lower level only indicate connectivity, and do not present a load to those
subcircuits.

6.6. Multi-rate (Nonlinear) Harmonic Balance Analysis
Multi-Rate Harmonic Balance (MRHB) is available for the APLAC harmonic balance simulator only. MRHB is a
technique of controlling what frequencies are simulated for each model in the circuit. For circuits with frequency
conversion, this can significantly decrease the simulation time without losing accuracy. The main reasons to consider
MRHB are:
• Enable HB simulation for a circuit that wouldn't be possible otherwise due to time or memory limitations.
• Turn a slow HB simulation to a quicker one.
MRHB should not be used if:
• The circuit simulates in a few seconds already.
• The circuit is a single-tone simulation.
• Every element in the circuit truly shares the same frequencies.
The following example uses a simple up-converter circuit to demonstrate the basic concept of MRHB.
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f1
RF IN

IF OUT

LO

f2

where f1 is the tone set at the input port and f2 is the tone set at the LO of the mixer. With HB analysis, there are many
mixing products from f1 and f2 at the output of the mixer. See the following spectrum plot for a sample spectrum at the
output of the mixer.
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For this example the amplifier at the output of the mixer is narrow band. See the amplifier response trace on the graph
that shows the amplifier is matched at the f1+f2 signal and quickly attenuates the other frequencies.
For traditional HB simulation, the amplifier at the output is solved for all the possible frequencies. For MRHB, the
amplifier at the output is configured to only simulate at the dominate frequency. The following figure shows the spectrum
at the output for the traditional HB analysis.
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The following figure shows the spectrum with MRHB.
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Finally, the following figure shows the voltage waveforms at the output of the circuit.
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In this simple example, there may not be a lot of time and memory savings from having the last amplifier use a limited
set of frequencies. On circuits with several frequency translations, however, the item and memory savings is significant.
See examples in the Cadence AWR Design Environment® platform to see circuits that are significantly faster without
a loss of accuracy when using MRHB.

6.6.1. Using MRHB
MRHB is configured by using MRHB blocks in a schematic, available from the Simulation Control category of the
Elements Browser. Each model must be assigned to an MRHB block for the simulation to function, including ports and
sources. You assign the block from the Model Options tab of the Element Options dialog box. See “Element Options Dialog
Box: Model Options Tab” for details on this dialog box. Use the MRHB ID parameter name in the Multi-rate Harmonic
Balance section of this dialog box.
You can visually inspect which models are in a specific group using the group highlighting feature. For more information
about this feature see “Viewing Items for Extraction”.
Note that you can simplify the setup process by assigning blocks to subcircuits instead of all the individual models in
the circuit.
MRHB Block Setup
Traditional harmonic balance configures the number of tones by the number of independent sources used in the design
and the number of harmonics specified for each harmonic. In MRHB, the MRHB block configures these settings and
applies them per model.
1. Determine the number of tones for the block you are configuring based on whether or not there is frequency conversion,
and the type of input. For example, if your block is equivalent to a single-tone amplifier, then tones would be 1. If
your block is equivalent to a two-tone amplifier, then tones would be 2. If your block is equivalent to a single-tone
mixer, then tones would be 2. If your block is equivalent to a two-tone mixer, then tones would be 3.

6–16 AWR Design Environment

Multi-rate (Nonlinear) Harmonic Balance Analysis
2. Determine the new fundamental frequencies for each tone. These are set on the TONESPEC parameters and are set
to the proper combinations of the unique tones in the original circuit. This might be as simple as typing "f1" which
means tone 1. You can also type in combinations of tones, such as "2f2-f1" or "f1+f2"
3. Set up the tone truncation type and order. This is similar to setting the number of tones for each harmonic and the
maximum order for intermodulation products.
For the tone truncation, the following figures help explain the meaning of the settings. For discussion purposes, this
example uses a mixer with a 50 MHz IF frequency (tone 1) and a 1 GHz LO frequency (tone 2). For the Box TRUNC
type you specify the maximum number for each tone, so the order of the tones is not limited. The order of the tones is
the sum of the integers in front of the frequencies. For example "f1" is order 1, "f1 + f2" is order 2, "2f2-f1" is order 3.
The following settings
MRHB
ID=HB1
NTONES=2
TRUNC=Box
TONESPEC1="f1"
MAXHARM1=3
TONESPEC2="f2"
MAXHARM2=2
Fo

. . . Fn

will include the following harmonics. Note that there are two signals from the LO frequency (1 and 2 GHz) and then
there are three sidebands for each of these frequencies.
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For the Diamond TRUNC type you specify the maximum order for all the tones. The settings are as follows
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ID=HB1
NTONES=2
TRUNC=Diamond
MAXHARMDIA=3
TONESPEC1="f1"
TONESPEC2="f2"
Fo

. . . Fn

will include the following harmonics. Note that there are two signals from the LO frequency (1 and 2 GHz) and then the
number of sidebands for each LO frequencies decreases for each higher tone 1 signal.
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For the Box and Diamond TRUNC type you specify the maximum number for each tone and the maximum order for all
the tones.

6.7. Nonlinear Noise Analysis
Microwave Office software is capable of analyzing noise in nonlinear circuits. Typical applications include:
• Mixer noise figure simulation
• Simulation of noise spectrum in amplifiers
Phase noise simulation is similar to noise analysis as described in “Phase Noise”. This section focuses on the background
behind nonlinear noise analysis and its applications to mixer noise figure simulations.

6.7.1. Noise in Nonlinear Circuits
Noise in electronic circuits exists in various forms, such as thermal, flicker, and shot noise. The following figure displays
how a noise spectral density at an arbitrary node in a nonlinear circuit resting at DC may appear:
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The low frequency portion represents low frequency noise, such as flicker noise, whereas the flat portion denotes the
contribution of thermal and shot noise sources.
For the purpose of simulation, the noise spectrum is divided in a finite number of intervals over the frequency range of
interest, as the following figure illustrates:

where each noise "sample" represents the noise power contained in a 1 Hz bandwidth.
If the circuit behaves linearly, a noise sample at some frequency ωn contributes to output noise power at ωn only, as
follows:

Noise-related performance measures, such as noise figure and noise temperature, are computed by established correlation
matrix techniques [1].
This is more complicated in the presence of a large signal drive, such as the LO pump in a mixer. If noise is assumed to
be small by comparison to large-signal waveforms, the action of the LO is frequency translation of noise samples by the
multiples of the LO frequency, as shown in the following figure.

6.7.2. Noise Analysis
Noise samples in a nonlinear circuit driven by a large-signal waveform are commonly referred to as noise sidebands. As
the previous figure shows, the behavior of noise sidebands is analogous to the behavior of RF and IF signals in a mixer.
In fact, the mathematical formulation that forms the basis for nonlinear noise simulation is very similar to the classical
large-signal-small-signal [3], also known as conversion matrix, mixer analysis.
The circuit is first simulated with noise sources excluded, subject to large-signal excitation alone. Following large-signal
analysis, noise sources are introduced at the ports connecting the nonlinear elements to the rest of the network, as shown
in the following figure.
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NL and NNL are random phasors of noise currents evaluated at each of the noise sidebands. NL represents the Norton
equivalents of all bias-independent noise sources, such as thermal noise sources, scattered within the linear subcircuit;
NNL represents bias-dependent noise sources contributed by the nonlinear components. Mean-square values of random
noise phasors are their spectral densities. In the case of shot noise, for example,

< N N LN *N L>shot = 2qI DC
q being electron charge, and IDC being the bias current of the device contributing shot noise.
Conversion matrices relate the sideband phasors of small current excitations, such as NL and NNL, to the corresponding
port voltage phasors. Formally, this relation may be expressed as V=T-1N, 1
where T is the conversion matrix and V, N are vectors of noise voltage (current) sidebands at interconnecting ports. A
mean-square operation on the above relation yields the samples of noise voltage spectral densities in terms of samples
of the known current spectral densities.

6.7.3. Performing Noise Simulations
The Noise Control Element
Noise analysis is best illustrated using a simple example.

1

This expression is valid at DC only and is not used as such in the simulator. The large signal current through the device "modulates" the noise source. Reference
[2] describes appropriate modifications to DC spectral densities in the presence of modulating large-signal waveforms.
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The mixer shown in the schematic operates as an upper-sideband downconverter, with IF frequency in the range 0.5-0.6
GHz. The LO frequency is 3.5 GHz.
A noise analysis is executed if the noise control element NLNOISE (located in MeasDevice > Controls in the Elements
Browser), is placed on the schematic. The following figure shows the schematic symbol of the NLNOISE element.

The following are NLNOISE parameters:
• PortTo is the index of the output port. In the example, the output is the IF port and its index is 3.
• PortFrom is the index of the input port. In the example, the input is port 1 (RF).
• NFstart, NFend, and NFsteps define the range of noise frequencies to sweep over.
• SwpType defines the type of noise frequency sweep (linear or log).
Noise Frequency Notes:
The following are comments on noise frequencies defined by NFstart, NFend, and NFsteps.
Recall that noise is analyzed about all the multiples of the LO, as shown in the following figure.
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If you are interested in the noise figure of a downconverting mixer, for example, the most natural way to define noise
frequencies is to specify the bounds of the upper-sideband noise range (N1,upper), which is 4.0 - 4.1 GHz in the example.
However, any other frequency range is acceptable as well, as the simulator automatically sets up the remaining sidebands.
Therefore, the "noise frequency range" should be interpreted as the width of any one of the sidebands shown in the figure.
Nonlinear Noise Analysis
Noise analysis can be carried out with one-tone or two-tone large signal excitation. The noise analysis with one large
signal tone is much faster, as it has been optimized using an iterative solution of the linear systems and FFT-speed matrix
vector multiplications with conversion matrix. The noise analysis with two large signal tones is significantly slower,
therefore nonlinear noise analysis with one large signal tone is the default setting.
You can enable the nonlinear noise analysis with two-tone large signal tones using the secondary parameters of NLNOISE,
LSTone, and SSTone, as shown in the following figure.

Measurements
You can compute the noise figure, the noise temperature, and the output spectral density of a noisy circuit. The large-signal
excitation may be swept in power and/or frequency, in addition to the noise frequency sweep.
Suppose that in the previous mixer example you want to compute the noise figure and the output spectral density. With
the RF port terminated and the noise control element properly defined, the mixer example schematic displays as shown
in the following schematic.
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Noise analysis can be carried out with one-tone or two-tone large signal excitation. The noise analysis with one large
signal tone is much faster, as it has been optimized using the iterative solution of the linear systems and fast and exact
matrix-vector multiplications using special properties of the conversion matrix.
To compute the noise figure, you need to specify the appropriate noise frequencies at the output and the input. In a
down-converting mixer, the appropriate sidebands are the IF for the output, and the upper-sideband RF for the input.
Microwave Office software can perform the nonlinear noise analysis with one-tone or two-tone large signal analysis.
The first type of nonlinear noise analysis is more common as it is significantly faster, and sufficiently accurate in most
practical situations when the power of RF signal is much smaller than that of the LO.
One-tone noise analysis means that the large signal solution is obtained with one tone only, that of the local oscillator
(LO) whose frequency is denoted f0. All other tones, including RF are treated as perturbations to the large signal solution
driven by the LO. All noise sideband frequencies f are then expressed as:
h1f0+h2Δf

(6.7)

where h1=-N.....N
with N being the number of tone 1 harmonics. The index h2 can only take two values, +1 for Upper sideband and -1 for
Lower sideband. Δf is the offset frequency of the frequency sweep specified in the NLNOISE element.
This example addresses noise conversion from RF to IF.
For fIF, h1=0 h2=1 (h2=1 means Upper in the dialog box)
For fRF, h1=1 h2=1 (h2=1 means Upper in the dialog box)
The harmonic indices fIF and fIF are specified in the following dialog box.
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The settings in this figure correspond to the index pairs for IF frequency (output) and for RF frequency (input).
The following figures show the noise figure and power spectral density (Nonlinear Noise NPo_NL measurement) at the
output port.
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You can calculate conversion gain in the standard manner, using two-tone large-signal S-parameter measurements.
Alternatively, the conversion gain may be calculated with the Nonlinear Noise Conv_G_SP measurement. This measurement
displays the conversion gain that is computed as a by-product of noise simulation. This is a "small-signal" version of
conversion gain, accurate when the input power level is appreciably smaller (for example, 15 dB or more) than the LO
power.
Simulation Controls
Conversion matrix analysis, which forms a basis for nonlinear noise simulation, requires an equal number of LO harmonics
and noise sidebands. To perform an analysis that takes into account the noise sidebands shown in the noise analysis range
figure, for example, the large-signal response needs to be computed at 7 LO harmonics (including DC).
For noise simulation, the number of tone-1 harmonics in Harmonic Balance options is essentially the number of tone-1
harmonics with noisy sidebands. The large-signal solution is transparently computed at a larger number of harmonics,
as required by conversion noise analysis.
All other HB controls apply to the large-signal solution in the usual manner.
References
[1] J. Dobrowolski, Introduction to Computer Methods for Microwave Circuit Analysis and Design, Artech House, 1991.
[2] V. Rizzoli, E. Mastri, D. Massoti, "General noise analysis of nonlinear circuits by the piecewise harmonic-balance
technique," IEEE Trans. MTT, May 1994, pp 807-819.
[3] S. Maas, Microwave Mixers, Artech House, 1993.

6.8. Nonlinear Oscillator Analysis
Microwave Office software incorporates extensions of existing harmonic balance capabilities to oscillator analysis.
Highlights of these features are:
• Precise determination of the oscillation frequency under large-signal conditions
• Rigorous computation of the large-signal spectrum, including spurious harmonic products
• Phase noise analysis
This section provides an introduction to oscillator analysis in the Microwave Office program, and includes several
simulation examples.
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6.8.1. Oscillator Analysis in the Frequency Domain
In general, oscillators can be analyzed in the frequency domain (using the harmonic balance technique), or in the time
domain using transient simulators such as SPICE, its derivatives, or Spectre™. If you are only interested in the steady
state and not in the transient process (startup of the oscillator), the harmonic balance approach has the following advantages:
• The steady-state is computed directly, avoiding costly and potentially inaccurate time-integration through transients.
• Frequency domain analysis accommodates multi-port parameter descriptions of distributed elements in the most natural
way, resulting in highly accurate simulations that are compatible with measured or EM-simulated S-parameter data.
While frequency domain analysis is the preferred method for the analysis of oscillators (those that operate at high
frequencies in particular), oscillators have traditionally presented a serious challenge in the field of simulation technology.
The difficulties stem from the mathematical implications, in high-Q circuits especially, of the lack of prior knowledge
of the fundamental oscillation frequency.
To address these challenges, Microwave Office software resorts to a special device called the "oscillator probe" [1],
which eases these difficulties and allows for fast and robust oscillator simulations, even in cases of extremely high
resonator Q.

6.8.2. The Oscillator Probe
Consider an oscillator in steady state operation as shown in the following highly simplified schematic.

Now, suppose that a sinusoidal voltage source of amplitude V and frequency ωp is applied to the oscillator at the node
denoted by X as shown in the following schematic.
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The source impedance is given by:

Z(ω) =

{

0 ω = ωp
∞ ω ≠ ωp

that is, it presents a short circuit at the source frequency and an open circuit elsewhere. The combination of the source
and the ideal impedance element is referred to as the oscillator probe.
Next, suppose that the probe voltage is equal to the steady state operating voltage at node X. Under those circumstances,
no current flows through the probe at frequency ωp. In addition, by the definition of the probe impedance, no current
flows through the probe at any other harmonic of ωp. The probe no longer disturbs the circuit, its frequency equals the
oscillation frequency, and its amplitude equals the amplitude, at the node to which the oscillator is connected, of the
original, probe-free oscillator.
This argument leads to the conclusion that the problem of solving for an oscillator's steady-state operation can be
approached by:
• Connecting the oscillator probe to a suitable node in the circuit
• Finding the amplitude and frequency of the probe that results in zero current flow through the probe
In this manner, in effect, oscillator analysis is reduced to standard HB analysis running in the inner loop of a routine that
attempts to locate probe parameters (amplitude and frequency) that result in zero current flow through its terminals. The
outlined procedure is the basis for oscillator simulation in the Microwave Office program.

6.8.3. Analysis Flow
APLAC oscillator analysis is based on using an oscillator probe element (OSCAPROBE) in harmonic balance analysis.
The oscillation frequency is found using optimization. The search for the solution, the amplitude and frequency at the
probe, is based on the frequency range specified by the Fstart and Fend parameters of the OSCAPROBE element. The
voltage across OSCAPROBE should be between zero and the maximum voltage, VpMax, which should not be set
unnecessarily large, because it may slow down the analysis.
If advanced harmonic balance options are available, you can use Transient Assisted Harmonic Balance simulation (TAHB)
to aid convergence when simulating oscillators. Enabling TAHB for oscillators is the same as for normal TAHB on the
Circuit Options dialog box APLAC Sim tab. For oscillator analysis TAHB performs additional steps beyond those for
aiding normal HB analysis. Those steps aim to find good initial guesses for probe voltage and oscillation frequency.
Note that OSCAPROBE has a TranKick parameter which helps the oscillator start up in transient analysis. TranKick is
set to "Yes" by default. To perform transient simulation of oscillator start-up from noise, set TranKick to "No".

6.8.4. Performing Oscillator Simulations
Two conditions must be satisfied for an oscillator simulation to occur:
• Recall that the Microwave Office program invokes those simulators that are appropriate for the required measurements.
Oscillator analysis is appropriate when any nonlinear or oscillator measurement is requested. Those measurements
are located in the Nonlinear > Power, Nonlinear > Voltage, Nonlinear > Current and Oscillator categories.
• The oscillator probe must be connected to the oscillator. The OSCAPROBE is located in the Elements Browser in the
MeasDevice > Probes category.
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For example, suppose that the power spectrum measurement (Nonlinear > Power Pharm measurement) is defined for the
following schematic.
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The OSCAPROBE element is next introduced between the resonator and the active device, which is the probe's
recommended location. When the simulation is executed, Microwave Office software automatically performs an oscillator
analysis, carrying out the steps shown in the analysis flowchart.
Probe Parameters
To a varying degree, probe parameters influence the speed, and ultimately, the convergence of an oscillator analysis.
Although most users find the oscillator analysis fast and simple to use, it is helpful to become familiar with probe
parameters in the event that the analysis fails, either internally or due to user error.
The following shows the schematic symbol of the oscillator probe.
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The most significant probe parameters are Fstart and Fend. These two parameters indicate the range to search for start-up
frequency. Choosing roughly +- 25% of the resonator's center frequency is sufficient in most cases. Fsteps is the number
of steps used in the search for start-up frequency, and it rarely needs to be changed from default. Exceptions may occur
in extremely high-Q cases, where you may need to increase Fsteps or narrow the frequency range.
The probe has a number of secondary parameters that are used to aid convergence or to increase simulation speed, but
are otherwise best left at default values. VpMax and Vsteps for example, control the probe voltage stepping as discussed
in “Analysis Flow”. The simulator steps the probe voltage, from a small value to VpMax in steps of Vsteps, in an attempt
to locate a suitable starting point for rigorous oscillator analysis. If the simulator occasionally returns a "Could not find
a starting point for oscillator analysis" message, you are prompted to increase Vsteps and/or VpMax.
The value of ΔV=VpMax/Vsteps is used to limit the maximum Newton step in oscillator analysis, so specifying a very
large Vsteps value could slow the simulation.
Parameters of lesser significance are Iter and Damp.
Iter is the total number of analysis iterations and Damp is a parameter for the so-called damped Newton iteration.
Decreasing Damp or increasing Iter from default values may improve convergence in rare circumstances.
NOTE: In addition to the mentioned parameters, several of the probe's secondary parameters are designated as "not
used". These parameters are manipulated internally by the simulator, and are likely to be removed in a future release.
Harmonic Balance Parameters
Harmonic balance simulation runs in the inner loop of oscillator analysis, so harmonic balance parameters apply as usual,
controlling the number of harmonics and simulation accuracy.
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Probe Connection
The location of the probe plays an important role in oscillator simulation. The recommended location is at a node
connecting the resonator and the active device. In many cases an alternate probe location results in successful and even
slightly faster simulations; however, you are encouraged to follow the recommended placement of the probe. Not doing
so opens the possibility of failure to detect start-up in an otherwise well-built oscillator.
Post-processing Capabilities
All nonlinear measurements apply to oscillator analysis in the usual way. You can view voltages, currents and power at
any port or meter, in the time or the frequency domain. You can examine dynamic load lines and power efficiency in
the same way as amplifiers.
One additional measurement is the Oscillator OSC_FREQ measurement, which you can use to display the oscillation
frequency. In the event that a bias is swept, as in the case of a VCO, the x-axis automatically displays the value of the
tuning voltage. If no swept voltage source is present in the circuit, the OSC_FREQ measurement displays the oscillation
frequency on both axes.
Limitations and Peculiarities of Oscillator Analysis
• Microwave Office software is capable of single-tone analyses of free running (but possibly voltage-controlled) oscillators
only; support for self-oscillating mixers and injection-locked oscillators is not included in the present version.
• You must place the probe in a top-level schematic.
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• If a frequency component measurement, such as Vcomp or Pcomp, is defined prior to the execution of an oscillator
simulation, the oscillation frequency is not known at the time of creation. For this reason, Harmonic Index in the
Add/Modify Measurement dialog box displays a multiple of an arbitrarily chosen fundamental equal to 1 GHz. After
the simulation is complete, the indices are reset to the correct oscillation frequency. Note that the arbitrarily chosen
frequency affects the appearance of the Add/Modify Measurement dialog box, not the validity of displayed results.
Increasing the Speed of Convergence
A typical oscillator simulates between less than a second and five seconds on a modern computer, depending on the
number of harmonics, the output power, the oscillator Q, the number of active devices in the circuit, and the level of
complexity of linear models.
To improve the speed of the simulation, you should attempt to decrease the value of the VMax and Vsteps parameters.
The number of harmonics has a significant impact on simulation speed, but reducing it below 5 is not recommended.
The accuracy settings have a relatively small impact on analysis times, and should not be altered in an attempt to speed
up simulations.

6.8.5. Phase Noise
Oscillator noise analysis is closely related to the nonlinear noise analysis of the previous section. Noise in the form of
noise currents perturbs the steady state of the oscillator, resulting in noisy voltages at the output. The relation between
the sidebands of noise sources and the noise sidebands of the output signal is described by the circuit's conversion matrix,
as previously discussed. In turn, the noisy voltage sidebands are related to phase noise [2].
Performing Phase Noise Analysis
Phase noise analysis is enabled by the presence of an OSCNOISE element (located in the Elements Browser MeasDevice
> Controls category) in the schematic of the oscillator circuit. The following shows the OSCNOISE element.

OFstart, OFend and OFsteps define the noise sweep range, as an offset from the carrier. SwpType selects between linear
and log sweep.
With the noise control in place, a phase noise analysis is performed automatically, following a large-signal oscillator
simulation.
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6.9. Linear Harmonic Balance Analysis
In nearly all cases, improvements in HB simulators render this analysis type obsolete. Please try the regular HB simulator
first, and severely reduce all input signal amplitudes by the same factor to see the small signal response.
Linear harmonic balance (AC-HB) analysis is similar to AC analysis, except it allows non-sinusoidal inputs with arbitrary
frequencies, and spectral and time-domain measurements. It is small signal analysis with arbitrary waveforms.
Again, an initial DC analysis calculates the operating point of all nonlinear elements, which determines their linear
equivalent, and the circuit is treated as completely linear. Unlike AC analysis, however, AC-HB handles multiple input
sources with arbitrary waveforms (for example, pulse, triangle, and sawtooth), at arbitrary frequencies. By superposition,
the output is the sum of the linear responses to each frequency component in the input signal(s). The circuit is treated as
linear, so the output only has spectral components at the same frequencies as the input(s). No new frequency components
are created; there is no intermodulation. The default number of harmonics for each input tone are the same as for regular
HB analysis. Choose Options > Default Circuit Options to display the Circuit Options dialog box for setting global defaults,
or set local options for a schematic by right-clicking the schematic in the Project Browser and choosing Options to display
the Options dialog box, then click theAWR Sim tab.
You can view AC-HB results using standard harmonic balance power, voltage, and current measurements (Pcomp, Vtime,
Iharm, etc.) under the Nonlinear measurement type. To use AC-HB analysis, set up the desired harmonic balance
measurement, but select AC-HB or Aplac AC-HB as the Simulator.
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The Cadence® Microwave Office® software makes transient analysis with Cadence APLAC® and Spectre™ simulators
available within the Cadence AWR Design Environment® platform. Transient analysis offers an alternative method of
nonlinear analysis that complements harmonic balance. You can simply choose a transient simulator for the nonlinear
measurement you need. The program performs any translations necessary for running the transient analysis with the
selected simulator, reads in the results after the analysis is complete, and calculates the measurement from the results.

7.1. Transient Analysis Basics
This section provides a general description of transient analysis that typically applies to all transient simulators. For
detailed information about the operation of the transient simulator that you use, see its documentation.
Transient analysis always begins at time=0, and assumes that only the DC sources were connected to the circuit prior to
that time. With the entire circuit properly biased by the DC supplies, the time-varying stimuli are switched on at time=0,
and the response of the circuit to them is calculated, time point by time point. The simulation continues for the specified
length of time, using step sizes that are determined by the simulator. Transient simulators start with the largest possible
time steps, and reduce the size of the steps if they have difficulty converging. For example, if voltages, currents, or
charges change too drastically between time-points t and t+delta, a smaller delta is attempted for the new time point.

7.1.1. Measurements Using Transient Analysis Simulators
Transient analysis saves node voltages and branch currents (and capacitor charges, if specified) at each time point in the
analysis, so measurements like Vtime and Itime are extracted directly from the raw analysis results. Smaller time steps
in transient analysis improve measurement accuracy. Transient simulators automatically take smaller steps when transient
events occur. When measuring time domain and transient effects such as rise and fall time, or overshoot, the time domain
resolution of the results is clearly indicated in the graph by the waveform of the time domain measurement. Tightening
the accuracy requirements specified in the transient simulator options forces the simulator to be more conservative (take
smaller time steps) during transient events. There are also simulator options that set maximum limits on step size.
Frequency domain measurements such as Pcomp and Vharm (and others that are dependent on them, like PAE and IPn)
are calculated from Fourier transforms of the transient analysis results. Accurate frequency domain measurements from
transient simulations require at least one period of well-resolved, steady-state time domain results. These terms are further
described:
• Period
The full set of frequency domain measurements are available for transient simulation of circuits that do not oscillate;
for these, the period is a function of the input stimulus frequency(ies). The period T is the smallest value that is an
integer multiple of every stimulus period. Another way to describe the period is T=1/F0 where F0 is the largest
frequency such that every stimulus frequency is an integer multiple of it; i.e. FSi=Ni*F0, where FSi are stimulus
frequencies and Ni are integers. For transient simulation of oscillating circuits, there is a set of FFT-based frequency
domain measurements (for example, Vfft and Pspec), and the period is determined from the results. For more
information, see the Help associated with these measurements.
• Steady State
Steady state is reached when the behavior of the circuit is identical from one period to the next. Note that circuits can
contain elements with very large time constants, relative to the frequency of operation, so it may be difficult to notice
the difference between periods. See the Basic_Transient.emp project in the Microwave Office /Examples directory
for an example.
• Resolution
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For frequency domain measurements, the maximum step size is typically 1/(25*FH), where FH is the highest significant
harmonic frequency. Note that harmonic balance analysis is much better suited for measuring harmonic components,
because it has a greater dynamic range (lower noise floor) than transient analysis.

7.1.2. Data File Size
Transient simulators save every voltage and current at every time point and every node (by default), so if a large circuit
is analyzed for a very long time with a very small time step, it can generate a great deal of data. This is common in
oscillator simulation where you don't know how long the oscillator will take to start up. Every node is saved by default,
so you can probe around a circuit after simulation is complete to see data at each node with no new simulation required.
In such cases, you should restrict the amount of data saved, because large data files take longer to process when calculating
and displaying the measurements. In extreme cases, the data file size can use up all of the available memory.
There are three ways to reduce the amount of data saved: reduce the length of the simulated time over which data is
saved, save fewer time points to reduce the "length" of the data, and/or reduce the number of variables that are saved
(the "width" of the data).
The Circuit Options dialog box APLAC Sim tab provides an option that offers two ways of controlling the length of the
data. The simulated time and maximum step size can be set, either by specifying the number of periods and using the
harmonic balance settings, or by specifying the start and stop times, and the step size. As previously stated, all transient
simulations start at time=0, so the start time is the time at which data begins to be saved. Data from previous time points
is not recorded. This can reduce the data file size considerably, by excluding undesired transient effects in the early part
of the analysis. Each transient simulator may treat the step value slightly differently; for example, one may use the
specified step size as the maximum and another may save simulation results only at those steps. Generally, however,
increasing the step size reduces resolution, and reduces the data saved. The individual options for each simulator allow
greater control over the resolution of the saved data.
You can use the Save currents and Save voltages options on the Circuit Options dialog box APLAC Sim tab to reduce the
width of the data (such as saving results at only ports or probes).

7.1.3. Restrictions on the Circuit Topology
Nonlinear simulations are difficult for circuits containing loops consisting of inductors and voltage sources (inductor
loops), or cutsets of capacitors and/or current sources only (capacitor cutsets). An inductor loop that is not obvious can
result when short lossless transmission lines are modeled using LC Pi lumped subcircuits.
Each node in the circuit should have a DC path to ground. Many model translations add a 1 GOhm resistor to ground to
avoid violating this rule, but there are other means. For example, if a set of elements is separated from the rest of the
circuit (and ground) but not disabled, it creates a set of nodes with "No DC path to ground".
Some transient simulators issue errors in a Microwave Office message window if any of these requirements are not
satisfied. You can double-click an error message to identify one of the schematic elements in the offending loop or cutset.

7.2. Sources in Transient Simulators
AC sources (ports, voltage and current sources) are set up by default to run with both harmonic balance and transient
simulators. Many of the sources will have a tone parameter (it may be a secondary parameter) that is only used by
harmonic balance. When harmonic balance runs, it must determine all the frequencies that must be simulated. With
combinations of several sources, determining these frequencies can take a significant amount of time and memory. Many
sources can be set up to only run with transient simulators by setting the tone number to 0. The AC_V, AC_I, and
PORT_SRC elements have specific modes for transient only. See “Dynamic AC Current Source: AC_I”, “Dynamic AC
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Voltage Source: AC_V”, and “Dynamic Source Port: PORT_SRC” for more details. If you are always running transient
simulations, you can set all tone settings to 0 to simplify setting up your sources.
For historical reasons, not all sources will have a tone parameter. For example, the simplest AC source is the ACCS
element which is hard-coded to be a tone 1 source. The ACCS2 is identical except hard-coded to be tone 2. However,
there is an ACCSN source where you can specify the tone required. The most generic sources are the AC_V, AC_I, and
PORT_SRC elements since they can be configured for any signal type and any tone number. However, if you want to
use other sources, the following is a list of all sources with a settable tone number.
• ACCSN
• ACCSNS
• ACVSN
• ACVSNS
• AC_I
• AC_V
• PORTFN
• PORTFNS
• PORT_SRC
• PORTSIGF
• PORTSIGF_F
• PORT_ARBS(secondary parameter)
• PORT_PRFB(secondary parameter)
Note that the convergence to a steady state is fastest if the zero time value of the periodic stimulus is equal to its average
value. Most transient simulators use a standard formula for sinusoidal sources, V(t)=Asin(ωt+φ), which means sources
with φ≠0 include an offset at t=0 that may take a long time to dissipate. By default, Microwave Office software translates
this phase into a delay, so that the phase relationships between sources are maintained, but the initial value for all sinusoidal
sources is their average value. To change this default behavior, choose Options > Default Circuit Options to display the
Circuit Options dialog box. Click the tab corresponding to your transient simulator, and in the Transient Options section
under Result Collection, clear the Use delay for angle check box.

7.3. Models in Transient Simulators
At RF and microwave frequencies, accurate models are needed for both active devices (FETs, BJTs, diodes) and distributed
devices such as transmission lines with discontinuities, couplers, baluns, and vias. These distributed elements must be
modeled properly; simplified lumped element network models are not adequate for realistic simulation results.
For purely linear, frequency domain models, harmonic balance simulation is equivalent to Fourier analysis, and provides
the most accurate reference solution. It is traditionally used to establish accuracy of the transient simulations with
non-trivial models, such as frequency-dependent distributed models. At the same time, transient simulations are the
reference, as harmonic balance simulations become difficult with complex input waveforms and large numbers of
nonlinear models (FETs, bipolar transistors, diodes). Due to the attributes of each simulation type, comparison of transient
and harmonic balance simulation results may help establish model accuracy, and gain confidence in model quality.
While harmonic balance simulations calculate the steady state of the circuit being simulated, and transient simulations
follow the transient process, there are two conditions under which the results of these simulations can be expected to
agree:
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• Transient simulations run to steady state
• Pseudo-transient simulations performed in harmonic balance with a large time period (small fundamental frequency).
In the first condition, transient simulations are run long enough for the transients to die out so that the steady state is
reached. Since the stimuli are periodic, the simulation length should be equal to an integer number of periods (nT). The
convergence to steady state is monitored by comparing the results for period number n-1 and period n. If the results are
sufficiently close (within the specified tolerance), the simulation is deemed to converge to the steady state, otherwise n
must be increased.
In the second condition, simulations with pulse voltage sources (more generally, functions with finite support) are
performed. The period for harmonic balance simulations is chosen sufficiently large enough to allow the transient process
to complete within that period. To accurately model fast rise/fall time with such a large artificial period, a large number
of harmonics must be chosen.
A typical test circuit involves a pulse voltage source with Tr=Tf=0.1ns (or 0.05 ns), a pulse width of 2 ns, and a period
of 10 ns (fundamental frequency of f=0.1 Ghz). For the first tone, 4096 harmonics are used, and a 0 setting is used for
all other tones. This large number of harmonics ensures that the Fourier series for the expansion of the voltage source
converged within six decimal places of accuracy to the exact function. You can use a smaller number of harmonics
(resulting in lower accuracy) but it should be several hundred at minimum. The transient process has to finish in the 8
ns between the end of the falling edge of the pulse and the beginning of the rising edge of the following pulse.
Note that with the first method the transient simulations take a long time, while with the second method the harmonic
balance simulations take a long time.

7.3.1. Causality of the Models
All models intended for use in transient simulations must be causal (having a response that does not appear before the
stimulus).
For models specified as the frequency-dependent admittance matrix Y(ω), the causality requirement can be expressed
as:
∞

I M[Y (ω)] = P ⋅ V ⋅ π1 ⋅

(x)]
( ∫ Re[Y
X − ω )dx
−∞

In this expression, P.V. represents the Cauchy principal value of the integral. It is well known that the imaginary part of
Y(w) should be an odd function and equal to zero at zero frequency, and that the real part Re[Y(w)] should be an even
function. If the real part is constant as a function of frequency, the imaginary part is required to be exactly zero.
Non-causal models are not translated into transient simulators unless a causality correction is possible. If a circuit contains
such a model, an error message displays and the transient simulation is not performed.
Lumped Models
Although harmonic balance simulations are possible with negative resistances, capacitances, and inductances, transient
simulations of such circuits almost certainly diverge. This is not a fault of the transient simulator or the model translation,
but a reflection of the fact that the solution of circuit equations with negative R, L, C is quite often a function that tends
to infinity. Of course, negative R, L, and C are unphysical ("do not exist"). The negative slope of dV/dI of a V-I curve
of a device is not the same as negative R.
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Non-causal lumped models (for example, frequency-independent complex admittance ADMIT, frequency-independent
complex impedance IMPED, and QHYB) are not translated into transient simulators. You should replace these models
with causal models for transient simulations. For example, a frequency-dependent complex impedance model (ZFREQ)
is causal if the real and imaginary parts are specified correctly, and you can use it for transient simulations.
Some software that matches circuit parameters of fixed topology subcircuits to the frequency-dependent S- or Y-parameters
as a function of frequency may end up with subcircuits containing negative R, L, and C. This match is of no use in
transient simulations. Microwave Office software contains code that takes the S- or Y- parameters of a device and
produces subcircuits suitable for transient simulations.
Several lumped models in the Microwave Office program are causal for particular values of parameters. For example,
the controlled sources (VCVS, VCCS, CCVS, CCCS) with frequency roll-off of the coefficient

M = Mo ⋅

exp ( − jωT − A)
1+ j⋅

f
F

are causal, provided A=0 or π. In this case, you can use them in transient simulations for these parameter values, and an
error message displays for the parameter values that violate the causality condition (A≠0 or π, in this example). The code
also rejects the case of A=π and you must set A=0 and change the sign of M if A=π is desired.
Transmission Line Models
Microwave Office software can perform accurate transient simulations with transmission line models that have
frequency-dependent parameters.
There are several controls for transient simulations with transmission lines. You can choose an option to perform an
accurate simulation of transmission lines (all or individually), or use various approximations. Choose Options > Default
Circuit Options and click the APLAC Sim tab on the Circuit Options dialog box to access the SPICE Model Extraction
options.
For the most accurate simulation results, select Level 3 - Distributed or Level 4 - Most accurate available.
All of the other transmission line modeling options are approximations that may be adequate in some cases but are
generally less accurate and inadequate in other cases. These options are useful for preliminary work such as layout
verification or determining the correct bias condition for transistors.
If you select Level 3 - Distributed or Level 4 - Most accurate available, the R,L,C,G, Table Generation options become
relevant.
You can easily verify the accuracy of transient simulations with transmission line models by setting up a small linear
circuit and comparing transient results to harmonic balance results according to the second condition discussed in
“Multi-rate (Nonlinear) Harmonic Balance Analysis”. If you plan to use approximate transmission line models, you
should study the effect of these approximations by setting up a small test circuit and comparing the result of the
approximations to the accurate result.
NOTE: Transient simulations with transmission lines of negative length (or with negative delay) are impossible, as such
models are non-causal. Some transmission line models issue an error message to this effect if transient simulations are
attempted.
There is one more causality requirement for transient simulation of transmission line models. The characteristic admittance
Yo and the characteristic impedance Zo=Yo-1 need to be causal functions of frequency such that the Hilbert transform or
the real part is equal to the imaginary part. This condition is violated for several Microwave Office models such as
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MCLIN (coupled microstrip line). In this case, transient simulations are performed not for the original model but for the
model corrected for causality. In these cases you see disagreement between harmonic balance and transient simulations.
Furthermore, in some rare cases a divergence of transient simulations with non-causal transmission line models may
occur.
Short transmission lines have the effect of restricting the time step of transient simulations such that the time step cannot
exceed the propagation delay of the fastest mode of the transmission line. Recognizing this, the translation uses a lumped
approximation (RLC-Pi circuit) for transmission lines with electrical length less than MaxDelayFraction of the period
of the MaxFrequency (maximum frequency of interest).
Behavioral Filter Models
The Microwave Office program supports accurate transient simulations with behavioral lumped filter models (located
in General > Filters group in the Elements Browser). Lowpass, highpass, bandpass, and bandstop filters of Butterworth,
Elliptic, Chebyshev, and Bessel type are supported. In addition, an accurate translation is available for the Distributed
Lowpass Butterworth Filter.
Transient simulations with realistic Q-factor of the filter are easier (for example, converge faster) than those with nearly
infinite Q (such as Q=1012).
Translation of the filter models uses the exact 2 x 2 admittance matrix Y(s) that is represented by four VCCSs with
frequency-dependent transconductance. No fitting of any kind takes place in obtaining equivalent models for the lumped
filters. No additional circuit nodes are created for behavioral filter models, thus resulting in efficient transient simulations.
Models for Piecewise Voltage and Current Sources
HB simulations are possible with sources specified as discontinuous (zero rise or fall time), such as a rectangular pulse
or a saw-tooth signal. Nevertheless, transient simulations with discontinuities in the stimuli are not advised. They may
work for lumped circuits, but not for distributed circuits. If you specify zero rise or fall time of a source, it is replaced
with 1/Maximum Frequency, where Maximum Frequency is the maximum frequency used for extraction of transmission
line models, and a related warning message displays. Any other positive value you specify is accepted as is. You can set
Maximum frequency in the R,L,C,G Table Generation section of the Circuit Options dialog box APLAC Sim tab.
You may want to obtain the unit step response of a circuit. In this case it is necessary to choose a non-zero rise time that
is sufficiently small so the result is close enough to the unit step response, yet large enough to avoid convergence problems.
The exact value depends on the specific circuit, and is usually established by trial and error. An initial value of "Tr=1/
Maximum Frequency" is recommended for this trial and error procedure.
Simplifying Assumptions for Several Lumped Models
The following models with frequency-dependent Q factor in the form of

( )

f
Q( f ) = Q ⋅ f
Q

α

are translated for transient analysis with the simplifying assumption a=1: CAPQ, INDQ, PLCQ, SLCQ, CHIPCAP,
CHIPCAP2.
The capacitor models from Dielectric Laboratories, Inc., (BOARDCAP, CHIPCAP, DICAP, GAPCAP, and MULTCAP)
are modeled as a linear capacitor unless you select Level 4 - Most accurate available as the SPICE model extraction option,
in which case a rational approximation is used.
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Transient Simulation with Models Specified by Frequency-dependent N-port Parameters
The Microwave Office program supports transient simulation of models specified by their S-, Y-, or Z-parameters as a
function of frequency (for example, Touchstone format .sNp files). You can choose two fundamental methods to perform
transient simulations with these models:
• rational approximation with subsequent equivalent circuit generation (default)
• numerical convolution (with four different settings which may work best in a particular case).
For successful simulation, the following requirements must be satisfied:
1. The device model must be causal. Solutions of Maxwell equations are causal, so if the model is obtained using a field
solver with sufficiently accurate settings, it should be causal. Multiple publications deal with the subject of testing
causality of experimental data (also referred to a Kramers-Kronig relation).
2. The number of frequency samples must be sufficient to resolve the resonances in the frequency range of interest. This
is easily judged by plotting the frequency dependence in X-Y plot. You should plot the frequency dependence of the
matrix elements of the short-circuit admittance matrix Y, as this is the matrix that forms the stamp for modified nodal
analysis.
3. The number of frequency samples should be sufficient for the linear system of equations to be over-determined.
Generally, this means no less than 50 frequency points, however it can be less for very simple frequency-dependence.
If the numerical convolution is used, the required number of frequency samples is even greater. In this case, the
simulator code interpolates linearly between the frequency samples, and the results should still be sufficiently accurate.
4. The value at DC is very desirable. It is usually easy to calculate-- no field solver is needed.
Transient simulation of these devices is controlled in the Element Options dialog box on the Model Options tab. Right-click
the subcircuit in the schematic and choose Properties to display the Element Options dialog box, then click the Model
Options tab. See “Element Options Dialog Box: (Subcircuit) Model Options Tab” for more information.
Three groups of options are available: use of rational approximation of the Y matrix, rational approximation of the S
matrix directly, or use of numerical convolution implemented in the transient simulator itself. In case of rational
approximation to either the Y or S matrix, the passivity of the generated approximation is enforced, and an equivalent
circuit for the simulator is generated using Voltage Controlled Current Sources with the s-dependence in a form that is
supported by the simulator. The aim of the models is accurate but efficient transient simulation; adding the fewest sources
and internal nodes. The availability of advanced frequency domain controlled sources in some simulators makes the
usage of VCCS far superior to generating the equivalent circuit with R, L, C, K elements.
Testing has demonstrated that in the majority of cases the rational approximation yields a more accurate transient
simulation, and a far superior simulation performance for long transient simulations than the convolution.
If rational approximation is selected, the code first checks the passivity of the model specified by the Touchstone file or
an EM structure. Passivity in this context refers to the N-port absorbing active power delivered to it at all the frequencies
given in the Touchstone file or EM structure. The lack of passivity means that the N-port has an internal power source
and is capable of delivering active power to the rest of the circuit. Formally the passivity test is equivalent to establishing
the positive-definiteness of the matrix G=Re Y at all frequencies of interest. The same passivity criterion can be expressed
in terms of the scattering matrix S, and states that eigenvalues of the matrix A=U-SHS should be non-negative. In this
expression, U is the identity (unit) matrix, and the superscript "H" denotes Hermitian-conjugate of the matrix. A
Linear/PASSIVE measurement is available to help you determine at which frequencies the model is non-passive, and
the magnitude of passivity violation.
If the passivity check is enabled and finds the model to be non-passive, the code switches to use of direct numerical
convolution. There are three possible reasons for the lack of passivity in the model:
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• A systematic error in the measurements or EM simulation if the N-port represents a linear passive device, such as a
portion of interconnect, or a coupler
• Numerical errors in EM simulations and unavoidable random measurement errors
• The model represents an N-port device that has an internal power source (for example an amplifier described by its
S-parameters). In this case, S-parameter description is a rough approximation that may or may not be adequate for a
particular transient simulation. In the amplifier example, the model amplifier is linear regardless of the magnitude of
the input signal, while in practice the linearity can be reasonably assumed only for a particular range of the amplitudes.
A small passivity violation can still occur for the model that is intended to be passive (such as interconnect), due to the
numerical errors of EM simulations or experimental errors. You can override (skip) passivity checks by selecting a Make
passiveoption. If the results were obtained from EM simulations, you should check the results by using PASSIVE
measurements. If the passivity violation is found to be small, Cadence recommends overriding the passivity check by
using the corresponding setting. If the passivity violation is found to be large, you should review the EM simulation
settings or experimental setup for systematic errors.
Guidelines for Use of Rational Approximation
Using the rational approximation approach (the code developed by Cadence) is recommended for transient simulations
of passive devices specified by frequency-dependent S-parameters. The following are the advantages of the rational
approximation approach:
• Results of transient simulations are often much more accurate than those of numerical convolution.
• Fewer data samples are needed (still resonances need to be resolved). The non-uniform grid of frequency points is
handled well, and is recommended (more points near the resonances to resolve them, and fewer points where the Y
or S matrix varies slowly).
• After an initial cost of obtaining the rational approximations, the simulations are much faster. The CPU time-scales
linearly with the length of transient simulations (not quadratically as is the case for numerical convolution).
To use the rational approximation approach, select an option under Fitting to Y Parameters or Fitting to S Parameters. You
cannot use this approach for active devices. If the lack of passivity is detected, the code automatically switches to the
usage of numerical convolution, but you can override passivity checks by selecting Make passiveoptions that skip them.
Typically, for models that correspond to interconnect, it is beneficial to fit directly to S parameters using one of the Fitting
to S parameters options. If the EM simulations were performed with ideal conductors (zero resistivity), fitting to S
parameters is strongly recommended. Fitting to Y parameters does not work well. Fitting to S parameters is also
recommended for large N-ports (number of ports N>4), and N-ports with large electrical length (delay between ports).
When fitting to S parameters, passivity of the resulting rational approximation can be enforced either from f=0 (DC) to
the maximum frequency given for the model (for the Use Convolution if not passive options and Make passive in band
option, or for the entire frequency axes Make passive everywhere option). Normally, it is sufficient to enforce passivity
for the frequency range of interest, as the power content outside that frequency range is negligible. However, on rare
occasions you might encounter transient simulations diverging with the diagnostic "Internal time step too small in transient
simulations". If this occurs, you should select Make passive everywhere under Fit to S Parameters to fix the problem. Note
that using Make passive everywhere increases the time necessary to construct the rational approximation, and may cause
a slight decrease in the accuracy of approximation.
Fitting to Y parameters may provide more accurate results of transient simulations for small N-ports with significant
coupling, such as spiral inductors. This setting works well if the f=0 (DC) result is available, and may also require a
number of low frequency data points to be provided, as Y matrix exhibits fast variation as a function of frequency near
DC. Most available EM solvers cannot perform simulation at f=0 (DC), and there is a practical limit on the minimum
frequency fmin at which the EM simulations can be performed (fmin=1 MHz for EMSight). Extrapolation to DC from
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the lowest available frequency works better for S parameters than for Y parameters due to more smooth frequency
variation. Fitting to Y parameters is the method of choice for the optimal distribution of frequency samples; however,
in less than ideal situations, fitting to S parameters is often preferable. For historic reasons, fitting to Y parameters remains
the default.
The passivity criterion used are very strict, and it is common to override a passivity check that is intended to prevent
using rational approximation with devices that are active by intent, and to alert a user if there are large passivity violations
for the devices that are passive by intent (such as interconnect). Unlike small passivity violations (see the Help for the
Linear > PASSIVE measurement for guidelines on which passivity violations are considered "small" and "large"),
significant passivity violations indicate a serious problem with EM simulations or measurements and disqualify the
results from being used.
The rational approximation approach involves obtaining the rational approximation for the given frequency-dependence
of Y matrix in the form of
N0

Y (s) = Y 0 + Y 1s +

∑(
i=1

)

Ai
A′i
s − pi + s − p′ ⋅ (1)
i

with the same set of poles for all matrix elements where A'i is complex conjugate of Ai. The fitting proceeds in two
stages. First the common set of poles is determined, and then the residues Ai for each matrix element are found. 1
This form assures causality and stability (as all poles are selected such that Re pi<0). Furthermore, the passivity condition
expressed as positive-definiteness of G=Re Y is enforced for all frequencies in the file.
When fitting to Y matrix, the code starts with NP=20 pairs of complex conjugate poles, and may reduce the number of
poles for simple frequency dependencies. Fitting of the rational approximation in the form (1) requires that the system
of equations be overdetermined. If the number of frequency samples is insufficient, a warning message displays and the
number of pole pairs is reduced. The success of fitting in this case is not guaranteed and you are encouraged to provide
more frequency samples. Obtaining more frequency samples by interpolation between the available samples is not advised
as it does not provide any new useful information. A rational approximation in form (1), even with the reduced number
of poles, is a far superior way to interpolate frequency dependencies than linear or even spline interpolation.
For the S matrix approximation, the approximation is obtained for each matrix element individually, with each having
its own set of poles. The number of poles to use is determined dynamically, based on the complexity of the dependence
to be approximated, and the quality of the obtained approximation. The code can automatically increase the order of
approximation if needed, or decrease it to avoid "overfitting". As a result, rational approximation of S matrix requires
fewer frequency samples, and takes less time. Since this approach involves fitting each matrix element individually,
fitting to S matrix works well for large N-ports.
Rational Approximation and the Time Step Control
When simulating the propagation of digital signals through distributed devices ("pulses propagating through interconnect"),
you may need to override the default Use HB settings on the APLAC Sim tab of the Circuit Options dialog box, and specify
the transient time step explicitly. Transient simulators usually use variable time steps with sophisticated time step control,
but an unreasonable starting value in Step time can still yield poor results, or even divergence.

1

For information on the optimal approach for determining the common set of poles, see B. Gustavsen: "Computer code for rational approximation of
frequency-dependent admittance matrices", IEEE Trans. on Power Delivery, vol. 17. no. 3, pp. 1093-1098, October 2002.
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The optimal setting for the transient time step Step time varies depending on the circuit, but general guidelines can be
provided. If Tr is the rise time, and Tf is the fall time of the pulse, a reasonable setting for Step time ranges from 0.1
min(Tr, Tf) to 0.01 min (Tr, Tf). You can often get good results with a relatively large time step of about 0.1 min(Tr, Tf).
If Use HB settings is selected in this example, the initial step is determined as 1/(4 f0 Nh), where f0 is the fundamental
frequency, and Nh is the number of harmonics specified on the APLAC Sim tab. For a reasonable case, for the period T=
4 ns, Nh=5 (default setting in a new project), the result is f0=0.25 GHz. The time step would be 0.2 ns, which is
unsatisfactory.
Since Tr=0.1 ns, you can reasonably assume that providing the frequency response from f=0 (DC, or as close to DC as
possible, for example, 1 MHz) up to fM=1/Tr=10 GHz is sufficient with high accuracy. Nevertheless, it is wise to provide
results for the N-port parameters (S or Y parameters) from 0 to 2 fM. Note that some out-of-band frequency samples are
needed to ensure passivity of the generated rational approximation. Generally, if the range of interest is from 0 to fM,
provide the samples from 0 to approximately 2fM, with more coarse grid for f > fM.
Third-Party Circuit Simulators
For Spectre, the AWR Design Environment software uses a consistent circuit description, regardless of the analysis type:
linear, AC, or transient. Models are always translated (if necessary) so they can be simulated with Spectre transient
simulator. This provides an excellent opportunity to compare the behavior of a distributed Cadence AWR model in the
simulator of choice, to its original implementation in the AWR simulators. For example, you can plot the port parameters
(or other linear measurement) using the default and Spectre linear simulators, on the same graph, and compare the two
to see the impact of the rational approximation on the model.

7.4. Netlist Management for APLAC
When an analysis is run that includes an APLAC simulator measurement, an APLAC netlist is created in the application
data folder in the default location: C:\Users\"username"\AppData\Local\AWR\Design
Environment\15.0\temp\"Project_Name"\"Schematic_Name"\. You can access these netlists by clicking the respective
link in the Status Window upon simulation completion. When the analysis is complete, results files are also written to
the same directory. Note that these files are overwritten with each analysis, so you must move them to a different location
if you want to save files from a specific analysis.

7–10 AWR Design Environment

Chapter 8. Circuit Envelope Simulation
The Cadence® Microwave Office® program makes circuit envelope simulation available with the Cadence APLAC®
envelope simulator within the Cadence AWR Design Environment® platform. As a part of this capability you can
simulate modulated signals using IQ data and measure the time domain waveforms around a carrier, or look at the
corresponding spectrums.

8.1. Circuit Envelope Basics
Circuit envelope simulation can be used to simulate circuits sourced with modulated signals. The Envelope analysis is
based on Harmonic Balance, but it also includes additional time integration parts from dynamic models. The result of
each simulated time point is similar to Harmonic Balance analysis, as the simulation returns both voltage and current
spectrums. However, the time integration means that, for example, the ideal capacitor current spectrum at DC may be
nonzero.
The excitation for Envelope analysis can be any source valid in HB analysis, plus special Envelope ports such as
PORTIQ_ENV that refer to a file containing I/Q data.
To access Envelope simulator options, choose Options > Default Circuit Options or right-click a schematic and choose
Options to display the Circuit Options (project level) or Options (schematic level) dialog box. On the APLAC Sim tab
under APLAC Simulator Options are Envelope Options. It is important to set the Time step such that, in the 1-tone case, the
bands around the carrier do not overlap.
Convergence, algorithm, and accuracy related settings and Harmonic Balance Analysis Options are controlled in the same
dialog box.
It is also important to verify any model to be simulated with Circuit Envelope analysis in the time domain. If a model is
defined in the frequency domain, the extraction to the time domain is performed by the APLAC Envelope simulator
which is similar to extracting to the time domain for transient analysis.
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Chapter 9. Remote and Parallel Simulation
Remote and Parallel circuit simulations allow you to run schematic simulations in a variety of ways to minimize simulation
time. These modes are most useful for longer circuit simulations such as complicated Harmonic Balance simulations,
complex/larger linear simulations such as simulating extremely large S-parameters, parameter sweeps, load pull simulations,
optimization, or yield analysis. Extremely fast simulations (sub 1 second) are likely to see no benefit due to the overhead
of remote/parallel simulation. You can run simulations locally in parallel, on machines in a remote simulation queue, or
in parallel on machines in a remote simulation queue. This flexibility allows you to optimize your simulation setup to
the type of problem being simulated and the computer hardware available for simulation.
You can run the following simulations remotely, in parallel, or both:
• Top level circuit schematics - Any schematic that has a measurement.
• Sweeps - Any non-frequency sweep using a special sweep block.
• Optimization - An optimization run on a schematic with two parallel optimizers.
• Yield - A yield run on a schematic with parallel yield engines.
To use remote or parallel simulation you must have a floating license server; node-locked licenses do not work. For
remote simulation, each remote computer requires the same licenses that are checked out on the client machine at the
time of simulation. For parallel simulation, TOK-200 license features are required.

9.1. Setting Up Remote or Parallel Simulations
Before performing remote simulations, you need to ensure that your remote simulation queue is operational (see “Utilizing
Remote Computing” for details) and make the simulation portable by enabling Simulate as AWRDE Server Job on the
“Options Dialog Box: Job Scheduler Tab”. Once enabled, any measurement-based simulation performed on that schematic
is asynchronous and portable.
After a simulation is portable, you can run it remotely or run multiple simulations simultaneously on the same machine,
or a combination of the two.
To run top level simulations remotely, you need to change the project option Remote Execution to Remote Only on the
“Project Options Dialog Box: MWO Server Scheduler Tab ”. This allows you to run any schematic that has Simulate as
AWRDE Server Job selected to run on the remote simulation queue. If there is more than one remote simulation machine
on the queue, the jobs distribute to each remote machine and run.
To run top level simulations in parallel, on the “Options Dialog Box: Job Scheduler Tab”, change Max Threads to greater
than 1. This causes any schematics that have Simulate as AWRDE Server Job selected to run in parallel on the local machine.
The simulation runs Max Threads jobs at the same time. A Max Threads setting of 0 allows use of all available threads.
To run top level simulations remotely and in parallel on the remote machine, you need to change the project option
Remote Execution to Remote Only and Max Threads to greater than 1. This allows any schematics that have Simulate as
AWRDE Server Job enabled to run on the remote simulation queue with up to Max Threads simulations running on each
remote simulation machine. A Max Threads setting of 0 allows use of all available threads.
NOTE: Queue settings must support parallel jobs. See “Supporting Parallel Simulation on a Remote Queue” for details.

9.2. Running Remote or Parallel Sweeps
Distributed sweeping allows simulation of parameterized sweeps to be distributed across multiple parallel Cadence®
AWR Design Environment® platform server mode processes. Distributed sweeping is enabled by sweeping with a
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SWPVAR_DIST sweep block instead of the normal SWPVAR block. Use of the SWPVAR_DIST sweep block is identical
to SWPVAR, except the sweep is now distributed across one or more distributed AWR Design Environment platform
server processes (though note that there is little value in only distributing it across one server).

The number of processes to distribute across is controlled by the project level Job Scheduler options (see “Project Options
Dialog Box: MWO Server Scheduler Tab ”). You can have multiple SWPVAR_DIST blocks in a single schematic, and
each point in the multi-dimensional parameter space is distributed across the available AWR Design Environment platform
server processes.

9.3. Performing Remote and Parallel Optimization
To perform remote/parallel optimization, set up the parameters of interest for optimization as you would for local
optimization, then select a parallel optimization method.

Set the Num of Parallel Jobs to control the number of independent optimization threads on which the optimization is
performed. Note that this setting is treated only as a request, as the number of parallel AWR jobs may be limited to a
smaller number due to the Max Threads/Processes per Job/Node setting and, if using remote simulation, the number of
computers available in the remote queue as well as their Max Nodes for Multiple Jobs setting (see “Circuit Options Dialog
Box: Job Scheduler Tab”).
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If running locally, ensure that the Project Options dialog box MWO Server Scheduler tab setting for Max Parallel Jobs per
Node is set appropriately.

To run remotely, ensure that the Project Options dialog box MWO Server Scheduler tab setting for Remote Execution is
set to Remote Only.
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To run remotely and in parallel, Remote Execution must be set to Remote Only and Max Parallel Jobs per Node must be set
appropriately.
NOTES:
• Queue settings must support parallel jobs. See “Supporting Parallel Simulation on a Remote Queue” for details.
• When you choose a parallel optimization method, the Optimizer dialog box Show all iterations option changes to
Periodically show improved iterations. When performing parallel optimization, all updates to graphs and measurements
in the AWR Design Environment platform client process require a local simulation in the client process. Selecting
this option controls whether or not these updates are performed during optimization. The frequency of the updates is
controlled by the project level Job Scheduler Percent Improvement for Async Update option (see “Project Options Dialog
Box: MWO Server Scheduler Tab ”).

9.4. Performing Parallel Analysis
Yield analysis is supported in parallel mode to minimize simulation time for Yield Analysis, Corners Analysis, and User
Defined Analysis.
To perform Parallel analysis, choose Simulate > Yield Analysis to display the Yield Analysis dialog box, then choose one
of the three Parallel analysis options in Yield Methods as shown in the following figure.
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Parallel yield engines can run a yield analysis on a schematic locally, or remotely, on machines in a remote simulation
queue. This flexibility allows optimization of the yield analysis setup to the type of job and the computer hardware that
is available.
When setting up a parallel analysis, set up the parameters of interest as you would for a local yield analysis, then select
one of the three parallel analysis modes: Parallel Yield Analysis, Parallel Corners Analysis, or Parallel User Defined. Set
Number of Parallel Jobs to specify how many parallel AWR Design Environment platform server processes are used to
run the yield analysis.

9.5. Utilizing Remote Computing
Remote computing allows you to set up a simulation on a local computer, but simulate the structure or schematic on a
different computer. By setting up dedicated, remote computers for resource intensive simulations, you can use local
computers for other work or smaller simulations.
Licensing: No additional licenses are required for remote computing. You must have a front-end license (XXX-001) to
submit remote simulation jobs, and the remote computers must have TOK licenses to simulate. Remote scheduler nodes
that function solely as queue managers (not enabled for simulations) do not need a license.
Feature Blocklist: Each remote machine checks out the same features you start with. If these features are not available,
the remote simulation fails with a licensing error. There are situations where startup features are not required by remote
machines to perform simulations (for example, VER_100 or WIZ_100), so it never makes sense to check them out on
the remote machine. You can add these types of features to the feature blocklist so they are not checked out by the remote
machines. The first time a remote/parallel simulation is run the feature blocklist is populated with a default set of features
that you can view in the user.ini file.
You can amend the blocklist in the user.ini file (choose Help > Show Files and Directories to locate it ) [License] section
by adding/editing the entry: NoRemoteFeat=FEATURE-XXX, with multiple entries added as a comma-separated list.
Note that adding features to the blocklist which are required for a simulation (for example, MWO_XXX), causes the
simulation to fail because it cannot obtain a license.
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OEM Products: Non-AWR products/simulators are never checked out for parallel/remote simulations, so they cannot
run remotely or in parallel.
Version Compatibility: Multiple versions of AWR Design Environment software can be installed on either the user or
remote computers. However, in order to simulate, an exact version match must be found between the AWR Design
Environment software version used to submit a simulation job on the user computer, and the simulator version on the
remote computer.
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The Job Scheduler is a separate program that configures and schedules simulations in the Cadence® AWR Design
Environment® platform. When you run a local or remote simulation, the Job Scheduler determines when to start it based
on licenses available and the number of processors to use for the simulation.

10.1. Running Asynchronous Simulations
The Job Scheduler, along with data sets (see “Data Sets” for more information), allows simulations it controls to run
asynchronously. Asynchronous simulation allows you to do the following during a simulation:
• Continue to work on other areas of your design, including the EM structure or schematic that is simulating.
• Edit the same EM structure or schematic, and when you simulate, the new version also simulates.
• Open and work in a different project. The simulations from the previous project continue to simulate. Data is written
to data sets and the data is available after the simulation is complete.
The status of jobs controlled by the Job Scheduler displays in the Simulation dialog box. For example, in a project with
one Cadence AXIEM® 3D planar EM stand-alone structure, when it is first simulated, the Simulation dialog box displays
as shown in the following figure.
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While this simulation is running, you can edit the same EM document and run the simulation again. The Simulation
dialog box now displays as shown in the following figure.

The first simulation is shown as running and the second simulation is shown as scheduled. When the first job finishes,
the second job starts simulating, as shown in the following figure.
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Note the following in the Status dialog box:
• For each job, the name of the EM document or schematic, the simulator type, and the name of the data set being written
to are listed next to the job number. For example, "Rat Race:Axiem:EM_Sim_DS1" indicates that the document name
is Rat Race, the simulator is AXIEM, and the data set being written to is EM_Sim_DS1.
• You can select individual jobs. The selected job displays its simulation status in the Output log section of the dialog
box.
• You can select multiple jobs by pressing the Shift or Ctrl key while selecting the individual jobs.
• You can pause one or more simulation jobs by clicking the Pause button. Click the Resume button to continue the
simulation.
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• You can cancel one or more simulation jobs by clicking the Cancel button.

10.1.1. Extraction Issues
Using extraction is a special case that currently does not run asynchronously because another simulation (a measurement
pointing at the schematic that uses the EXTRACT block) needs to occur after the current EM simulation is complete.
The following figure shows an example of the Simulation dialog box when simulating with extraction.
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In this case, the "Wilkinson" schematic contains the EXTRACT block and is the top level simulation listed. The second
job in the list shows that the schematic simulation is dependent on this simulation finishing. Also notice that the Type is
set to "Sync", so the environment is locked until this simulation completes.
To make extraction simulations behave asynchronously:
1. Right-click the EXTRACT block in the schematic, or the schematic in the Project Browser, and choose Add Extraction
to prepare the EM structure for simulation.
2. Right-click the EM document created in the previous step and choose Simulate to run the EM simulation asynchronously.
3. Simulate the project to make the schematic simulate using the extracted EM results.

10.2. Setting Job Scheduler Options
The Job Scheduler has its own set of options. To set project level options, choose Options > Default EM Options or Options
> Default Circuit Optionsand click the Job Scheduler tab on the EM Options or Circuit Options dialog box. To set Job
Scheduler options for an individual EM structure or schematic, right-click its node in the Project Browser and choose
Options, then click the Job Scheduler tab on the Options dialog box.
See “EM Options Dialog Box: Job Scheduler Tab” or “Circuit Options Dialog Box: Job Scheduler Tab” for information
on Job Scheduler settings.
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10.3. Using the Job Monitor
The Job Scheduler can display job status in the Simulation dialog box while the AWR Design Environment program is
running. While the program is closed you can use the Job Monitor to view the job status.
To launch the Job Monitor, choose Tools > Job Monitor or open it from the Start menu AWRDE program folder.
The Job Monitor displays as shown in the following figure.

The Job Monitor normally displays all jobs running from all users on remote computers, but can also display only local
jobs by changing the selection in the drop-down box. Select any job in the list and use the dialog box buttons to cancel,
pause, or resume jobs. Click the Fetch Datasets button to manually retrieve data sets for the selected job(s) from the
remote simulation queue. You may need to reopen the project utilizing the retrieved data sets in order to load the new
data sets. Click the Details button to display additional job information that can help diagnose any problems. To remove
completed jobs from the list, clear the Show Ended Jobs check box.
When you submit a job to the scheduler node, the Job Status is "Pending". Once all input files are transferred from the
user computer to the scheduler node, the status becomes "Scheduled". The status updates to "Running" when the simulation
starts, and to "Ended" once the simulation is complete. After the status changes to "Ended" on the remote machine, there
may be a delay before it changes from "Running" to "Finished" in the user computer Simulation window, due to data
transfer delays.
If the scheduler node on a user computer changes while the Job Monitor is open, you must restart the Job Monitor to
display jobs on the new scheduler node.

10.4. Utilizing Remote Computing
Remote computing allows you to set up a simulation on a local computer, but simulate the structure or schematic on a
different computer. By setting up dedicated, remote computers for resource intensive simulations, you can use local
computers for other work or smaller simulations. See “Utilizing Remote Computing” for information about remote
computer licensing and version compatibility.
On remote computers, the AWR_JobScheduler service manages the simulation queue. You must install this service from
the latest version of AWR Design Environment software installed on the computer. The service supports jobs submitted
from lower versions of AWR Design Environment software, but not from higher versions. For example, a remote computer
running a v22.1 Job Scheduler service can simulate jobs submitted from user computers running v16. But a v16 Job
Scheduler service cannot run jobs submitted from a v22.1 user computer.
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10.4.1. Remote Server Configurations
Each remote simulation is referred to as a job. The following are the various computers in a remote simulation set up:
• User computer - This is the designer's local (client) computer that is used to set up the job.
• Scheduler node - This is the remote (server) computer that the designer submits jobs to. The scheduler node maintains
the job queue and distributes jobs to available compute nodes.
• Compute node - This is the remote (server) computer that runs the simulation. Compute nodes do not maintain a queue,
and can only accept one job at a time. Note that the scheduler node can also function as a compute node.
The following sections describe the supported server configurations. You can set up multiple scheduler nodes (with
connected compute nodes) on a network.
One Remote Computer
In this configuration, only one remote computer is available. It is set up as both a scheduler node and a compute node.
It maintains a job queue, and also run the jobs in order of submission.

Multiple Remote Computers
In this configuration, several remote queues are available. One computer is set up as the scheduler node for the queue,
and the remaining computers are set up as compute nodes. User computers submit jobs to the scheduler nodes. The
scheduler node maintains a job queue and then distributes the jobs in the order of submission to available compute nodes.
The scheduler node can be set up to also function as a compute node and run jobs, or you can disable simulations on it
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and designate it as strictly a queue manager. You can also connect to a Linux resource manager. See “Remote Linux
Simulations” for details.

Job Distribution
Each simulation counts as one job. For swept documents, each sweep counts as one job. If multiple compute nodes are
available (when using multiple remote computers), jobs from one project might be distributed among several computers
and simulated in parallel. A single job is simulated on one computer, and not spread among several computers.

10.4.2. Installing and Setting Up Remote Computing
The following steps provide an overview of the installation and set up required for remote computing on Windows. The
sections that follow provide the details for these steps.
1. On each remote computer, run a command line installation of the AWR Design Environment platform to set up the
service.
2. On each remote computer, configure the Job Server settings.
3. For a configuration with multiple remote machines, add compute nodes to the scheduler node's Remote Hosts table.
4. After remote computer setup, add the scheduler node to the user computer's remote host table.
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Remote Computer Installation and Set Up
The following sections apply to scheduler and compute node computers only, not to user computers. For scheduler and
compute nodes, you must install the AWR Design Environment software from a command shell with Administrator
privileges.
New Installations

The following command line syntax installs the AWR Design Environment software with the Job Scheduler service to
default location and writes the installation log to recrystallisations. See the Installation Guide for additional command
line arguments.
awrde_<version>.exe /ComponentArgs "AWRDE":"JOBSERVICE=YES" /Log /LogFile
.\recrystallisations

After running the installers, you need to specify the license file location by either running the AWR Design Environment
program, or by running LicLocSetup.exe from the AWR Design Environment platform installation directory. See “Using
the AWR_JobScheduler Service” for details on managing the service.
After installation, open the Windows Task Manager and click the Services tab to verify that the AWR_JobScheduler
service is listed with its Status as "Running". For further details and service options, click the Services button at the
bottom of the window to display the Services window. After the Job Scheduler is registered as a service, it launches
whenever Windows starts and serves jobs on that computer until the computer shuts down or you stop the service. See
“Using the AWR_JobScheduler Service” for information on stopping and removing the Job Scheduler service.
NOTE: Running the AWR Design Environment platform installer again switches the version of the Job Scheduler service
to that of the most recent installation. When installing multiple versions of AWR Design Environment software on a
remote computer, you should install from the lowest to the highest version number to ensure that the highest version of
the Job Scheduler service is installed. See “Manually Setting the Service Version” for information on manually changing
the service version.
Manual Upgrade

Before upgrading to a newer version of the AWR Design Environment platform you need to stop the AWR_JobScheduler
service. See “Using the AWR_JobScheduler Service” for details. After stopping the service, the upgrade procedure is
the same as for new installations. The Job Scheduler service automatically migrates to the newer version of AWR Design
Environment software when you run the installer.
Remote Install and Uninstall

Compute nodes can be remotely updated from the scheduler node if all nodes are running Job Scheduler service version
13.02 or higher. Additional scripts are required for remote upgrades, and are available from the Knowledge Base. See
Compute Node Remote Update for details.
Major Version Upgrades

Job Scheduler service settings migrate when upgrading to a new major version, such as upgrading from v16 to v22.1.
Licensing or .ini File Changes

Whenever there are changes to the mwoffice.ini or redirect.ini files, you must restart the AWR_JobScheduler service on
all remote scheduler and compute nodes. See “Using the AWR_JobScheduler Service” for details.
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Compute Node Setup

After the AWR_JobScheduler service is installed, follow these steps:
1. Choose Tools > Job Scheduler Admin to open the Job Scheduler Admin dialog box, or open it from the Start menu
AWRDE program folder.
2. Set Editing to "All User (Service) Settings".
3. Under Job Server Settings, change QueueTypeOverride to Compute.
4. Click Save and Close to complete Compute node setup.
No other steps are necessary on these computers unless you want advanced options. See “Advanced Remote Computer
Settings” for information on advanced options.
Scheduler Node Set Up

After the AWR_JobScheduler service is installed, follow these steps:
1. Choose Tools > Job Scheduler Admin to open the Job Scheduler Admin dialog box or open it from the Start menu
AWRDE program folder.
2. Set Editing to "All User (Service) Settings".
3. Under Job Server Settings, change QueueTypeOverride to Scheduler.
4. If the scheduler node is the only remote computer and is also functioning as the compute node, then click Save and
Close to complete scheduler node setup.
5. If there are additional compute nodes, you must add them to the Remote Hosts table of the scheduler node. The process
is the same as adding a new scheduler node for a user computer.
a. Click the Create a new host entry button to add the compute nodes. The host (compute nodes) must be a different
computer. You cannot add the same computer as a host to itself.
b. In the Host Details window, type the compute node name for the Host name. Specify the Transport type using the
drop-down list, or leave it as "auto-detect" if the transport type is unknown.
c. Click the Verify Hosts button to check connectivity between the scheduler node and compute nodes.
d. After adding all the compute nodes, click the Save and then Close buttons to complete scheduler node setup for
multiple remote computers.
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Supporting Parallel Simulation on a Remote Queue

To enable more than one job to simulate simultaneously on a single remote machine, the MaxRunningJobs setting in the
Job Scheduler Admin dialog box must be set higher than 1 for each remote queue machine. It should not be set higher
than the number of cores a machine has. Choosing "Unlimited" for this option effectively sets the limit to the number of
logical processors on the node.
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Even though you typically do not have access to queue settings that are set once and do not require changing, you still
need to be able to control how jobs are run. Some jobs might require more compute resources, and so should not be run
in parallel on compute resources. Some jobs may not require as much resource, and so increased simulation speed can
be obtained by running jobs in parallel.
The maximum number of jobs that run at any given time is defined as follows:
•

MaxJobsPerNode:

The maximum number of parallel jobs per compute node

•

MaxRunningJobs:

Queue setting (set on each queue machine) for the maximum number of parallel jobs allowed

•

NumComputeNodes:

•

Max Number of Jobs

•

Max Number of Jobs = min(MaxJobsPerNode,MaxRunningJobs_Q1) + min(MaxJobsPerNode,MaxRunningJobs_Q2)
... min(MaxJobsPerNode,MaxRunningJobs_QN) when MaxRunningJobs is not identical on each remote computer

The number of compute nodes on the queue

= NumComputeNodes x min(MaxJobsPerNode,MaxRunningJobs) when MaxRunningJobs is
identical on each remote computer

Advanced Remote Computer Settings

The scheduler node by default also functions as an additional compute node, and runs jobs. You can change this
functionality in the Job Scheduler Admin dialog box in the Job Server Settings table:
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•

LocalPriority

= RemoteFirst makes the scheduler node less desirable in terms of job assignment. Jobs are assigned to
other compute nodes first, and run on the scheduler node only if no other compute node is available to run a job.

•

NoLocalJobs = True disables simulation on the scheduler node. The scheduler node only functions as the queue manager,

and assigns all jobs to compute nodes.
See “Job Scheduler Admin Dialog Box: General Settings Tab ” for more information on Job Server settings.
In the Job Server Settings table you can use the LocalComputePerformance and LocalMemoryCapacity options to differentiate
between remote computer capabilities. These settings, along with corresponding job preferences, are used to control job
assignment. The scheduler node only assigns jobs to compute nodes that satisfy these performance and memory preferences
of the job. If no computer can satisfy the requirements, the job is rejected by the scheduler node and the job cannot run
remotely. See “Job Scheduler Admin Dialog Box: General Settings Tab ” for Job Server Setting details, and “Setting Job
Scheduler Options” for details on setting job remote preferences on a user computer.
User Computer Installation and Set Up
For user computers, follow the standard AWR Design Environment software installation procedure. No additional
installation procedure is required to enable remote computing functionality.
To simulate remotely, you must specify a scheduler node on the user computer. To add a new scheduler node by name:
1. Choose Tools > Job Scheduler Admin to display the Job Scheduler Admin dialog box, or open it from the Start menu
AWRDE program folder.
2. Click the Create a new host entry button above the Remote Hosts table.

3. In the Host Details window, type the scheduler node name (“sched1” in the following figure) for the Host name.
Specify the Transport type using the drop-down list, or leave it as "auto-detect" if the transport type is unknown. Click
the Verify button to check the connection between the user computer and the scheduler node.
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4. The Host Verify window should indicate that verification was successful. If verification was unsuccessful, click the
Help button for troubleshooting information. Click OK to close the Host Verify window. The Transport type should
now be specified if it was previously left as "auto-detect". Click OK to close the Host Details window.

The Job Scheduler Admin dialog box now shows the scheduler node as "Verified". The Version column lists the
version of the AWR_JobScheduler service running on the scheduler node, and the Queue Type column switches from
auto-detect to "Scheduler".
NOTE: Do not add a compute node to a user computer remote host table because a user computer should not connect
to a compute node. The Queue Type for a user computer remote host entry should always be "Scheduler" and not
"Compute".
5. Click the Save button to save the current host list and then click Close to close the Job Scheduler Admin dialog box.
The user computer can now submit the job to the scheduler node. See “Using Remote Simulation” for details.
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Connecting to Remote Servers

The Remote Hosts table can list multiple scheduler nodes. To disconnect from a scheduler node, clear the check box next
to its name in the Entry Name column of the Remote Hosts table, then click the Save button. You do not need to delete
the entry. To reconnect to a scheduler node, select the check box next to its name in the Entry Name column and click
the Save button.

10.4.3. Using the AWR_JobScheduler Service
You may occasionally need to stop the AWR_JobScheduler Service for upgrades, scheduled maintenance, or other. You
should stop and restart all remote computers together. Do not restart a compute node without restarting the scheduler
node. It is important to stop, and then restart in the following order, using the shutdown command:
1. Issue the shutdown command on the scheduler node first to prevent any new jobs from starting. The scheduler node
waits for any current jobs in the queue to finish before stopping.
2. Issue the shutdown command on each compute node. Each compute node completes the current job before stopping.
3. Restart the service on compute nodes.
4. Restart the service on scheduler node.
Stopping the Service
To prevent data loss, you must stop the AWR_JobScheduler service before uninstalling the AWR Design Environment
program or installing a newer version of the AWR Design Environment software. To stop the service, run the following
command from the AWR Design Environment platform installation directory with Administrator privileges:
awr_jobschedulercontrol –controller "local service" –command shutdown

With this command, the Job Scheduler service waits for the currently running job(s) to complete, saves the job queue,
and then shuts down. A restart of the service reloads the queue and starts running the next job(s) in the queue (if any).
Alternatively, you can immediately stop the AWR_JobScheduler service from the Services window or command shell,
although this results in loss of data for any currently running job(s). To access this window, open the Windows Task
Manager and click the Services tab, then click the Services button at the bottom of the window. The command to
immediately stop the service is:
net stop AWR_JobScheduler

Starting the Service
After installation, the AWR_JobScheduler service automatically restarts when Windows starts, or anytime an AWR
Design Environment platform installer is run. You can also restart the service from the Services window or command
shell. To access this window, open the Windows® Task Manager and click the Services tab, then click the Services button
at the bottom of the window. The command to start the service is:
net start AWR_JobScheduler

Manually Setting the Service Version
After the AWR_JobScheduler service is installed, any subsequent AWR Design Environment platform installations
change the version of the service to the version of the installation. The service version also changes when using the
installer to repair an installation, and when uninstalling the AWR Design Environment platform without the command
line option to remove the service. Problems can arise if the version of the service is unintentionally switched to a lower
version. Re-running the installer in the highest version of the AWR Design Environment software resets the version, or
you can manually reset the version.
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Before switching the version of the AWR_JobScheduler service, first stop the service. From a command shell with
Administrator privileges, change directories to the desired AWR Design Environment platform installation directory and
execute the following two commands separately:
AWR_JobSchedulerService /UnregServer
AWR_JobSchedulerService /Service

You can now restart the service.
Uninstalling the Service
Before removing the AWR_JobScheduler service, stop the service to prevent loss of data. The following commands
remove the AWR_JobScheduler service, converting the computer from a remote simulation computer to a user computer.
For scheduler and compute nodes, you must uninstall the AWR Design Environment software from a command shell
with Administrator privileges. For AWR Design Environment platform installation removal, use the following command
line syntax:
awrde_<version>.exe /ComponentArgs "AWRDE":"JOBSERVICEOFF=YES" /LOG /LogFile
.\awrde_uninstall.log

10.4.4. Using Remote Simulation
For remote circuit simulation, see “Remote and Parallel Simulation ”. Remote EM simulation is specified via the Remote
Execution option. This option is only available when there are enabled entries in the remote hosts table in the Job Scheduler
Admin dialog box. You can set this option for each EM structure, or set it globally on the Options dialog box Job Scheduler
tab by selecting the Use project defaults check box. By default, Remote Execution is set to Local Only, so the EM structure
or schematic simulates on the user computer. To change this option to use remote computers:
1. On the user computer, right-click the EM structure or schematic in the Project Browser, and choose Options.
2. In the Options dialog box, click the Job Scheduler tab.
3. Set Remote Execution to Remote Only.
4. Optionally, change other job options from default settings in the tab.
5. Choose Simulate > Analyze to simulate. The job simulates locally on the user computer or simulates remotely, depending
on Remote Execution settings and computer availability. The scheduler node maintains a queue, so if all computers
are busy the job is queued until a computer that satisfies the job requirements is available.

10.4.5. Shutting Down Computers
For the proper procedure to stop Job Scheduler service before shutting down or restarting remote computers, see “Using
the AWR_JobScheduler Service”. Shutting down without stopping the service may result in a loss of data.
After a job is submitted to the scheduler node, you can shut down the user computer, including sleep and hibernate modes.
The job continues to run on the remote computers, and the results are returned to the user computer when it is back
online. You should transfer from user computer to the scheduler node all necessary files to run the job before shut down,
or the simulation cannot proceed until the user computer is back online to complete file transfer. You can use the Job
Monitor to verify file transfer status. After the job status changes from "Pending" to "Scheduled", all files have completed
transfer and shut down may proceed.

10.4.6. Troubleshooting Remote Computing
This section provides solutions for potential problems that may occur.
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Firewall Ports
The following ports are associated with file sharing and server message block (SMB) communications, and need to be
open for remote simulation:
• Microsoft file sharing SMB: User Datagram Protocol (UDP) ports from 135 through 139 and Transmission Control
Protocol (TCP) ports from 135 through 139.
• Direct-hosted SMB traffic without a network basic input/output system (NetBIOS): port 445 (TCP and UPD)
Verification Failure
Socket Transport Verification Failure

If a remote host using "awr_socket_ipc" transport type fails to verify, check the following:
• Ensure that the local socket connection is enabled on the remote host. Open the Job Scheduler Admin dialog box on
the remote host and select the Show incoming connecting settings check box to expose the "local socket service" entry.
Ensure that the check box is selected for the "local socket service" entry.

• Check that the port is open. If necessary, change the port number to an open port. To change port numbers:
1. On the remote host, open the Job Scheduler Admin dialog box and select the Show incoming connecting settings
check box to expose the "local socket service" entry. Double-click on the entry to open the Host Details dialog box
and change the port number to an open port.
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2. On the local computer (either the user computer if the scheduler node fails to verify, or the scheduler node if the
compute node fails to verify), open the Job Scheduler Admin dialog box, and double-click on the remote host entry
to open the Host Details dialog box. Change the port number to match the setting on the remote host.
Named Pipe Transport Verification Failure

If a remote host using "awr_pipe_ipc" transport type fails to verify, most likely there is a Windows credential issue. This
situation can arise when the user computer and scheduler node are on different network domains, or the network is set
up without a domain controller. Because the AWR Design Environment platform does not store usernames and passwords,
the remote host might refuse a connection it does not recognize. Without the domain, there is no concept of network user
accounts/passwords and the AWR_JobScheduler service running under SYSTEM on the scheduler node may not be
recognized by SYSTEM on the compute node. The optimal solution is to switch transport type from named pipes to
sockets, which does not use Windows credentials. Note that a remote machine can (and does by default) support both
sockets and pipes at once. To switch transport type to sockets:
1. On the local computer (user machine if the scheduler node fails to verify, or scheduler node if the compute node fails
to verify), open the Job Scheduler Admin dialog box.
2. In the Remote Hosts table, double-click on the remote host entry that fails to verify.
3. Change the Transport from awr_pipe_ipc to awr_socket_ipc.
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If it is not possible to switch to the socket transport type, try the following:
• If a user computer cannot verify a scheduler node, create a shared folder on the scheduler node and then mount the
shared folder on the user computer:
1. On the user computer, open Windows Explorer. If the menu toolbar is not displayed, press the Alt key.
2. Choose Tools > Map network drive. Map a folder on the scheduler node to a drive on the user computer using the
username/password required for the scheduler node. Once mapped, verify that you can access the mapped folder.
• If a scheduler node cannot verify a compute node, move the service from SYSTEM to a user account on all remote
machines. On a Windows 10 machine, the steps are as follows:
1. Stop the AWR_JobScheduler service if it is currently running.
2. Open the Services Window by starting the Task Manager and clicking the Services tab, then click the Services
button at the bottom of the window. You can also locate this window by searching for "Services" from the Start
menu.
3. In the list of services, right-click on AWR_JobScheduler and choose Properties.
4. In the AWR_JobScheduler Properties window, click the Log On tab.
5. Select This account and enter the account name and password.
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6. Click OK to exit all windows.
7. Restart the service.
8. From the scheduler node, try to verify the compute node. If verification still fails, mount a shared folder from the
compute node to the scheduler computer using the account and password of the user under which the service is
running. The procedure is the same as listed previously for when a user computer cannot verify a scheduler node.
9. NOTE: When the AWR_JobScheduler service is running under a user account instead of SYSTEM, all Job Scheduler
configuration files and log files are located in the Appdatauser folder of the user account instead of in the
\Appdatacommon folder.
Log Files
It may be helpful to review the Job Scheduler log files on user and remote computers when there are problems. There is
a script that automatically archives the log files and emails them to Cadence AWR® Support. To run this script, choose
Scripts > Configuration > Send Logs. Click the Get Logs button in the Job Scheduler Admin tool before running the "Send
Logs" script to include logs from the remote computers in the archive.
On the user computer, logs are stored in the Appdatauser\Logs directory. To find the log files on the user computer:
1. Choose Help > Show Files/Directories.
2. In the Directories window, select the Logs folder.
3. Save the logs by copying AWR_JobScheduler_x64_log.txt and MWOffice_ipclog.xml, or archiving the entire Logs
folder into a .zip file. Note that restarting the AWR Design Environment program clears out MWOffice_ipclog.xml,
so you should save these logs before restarting.
On remote computers, logs are stored in the \Appdatacommon\logs directory. To find the log files on the server computer:
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1. Choose Help > Show Files/Directories.
2. In the Directories window, select the Appdatacommon folder and then the Logs subfolder.
3. Save the log by copying AWR_JobScheduler_x64_log.txt or archiving the entire Logs folder to a .zip file.

10.5. Remote Linux Simulations
The AWR Design Environment platform allows you to run AXIEM, Cadence Analyst™ 3D FEM, and other solvers on
a remote Linux cluster.

The following sections describe remote Linux simulation using of AXIEM and Analyst software.
• “Architecture”
• “Cluster Requirements”
• “Cluster Installation”
• “Creating the Linux Job Scheduler Remote Host”
• “Running a Remote Linux Simulation”
• “Job Parameters and LSF/Torque Submission”

10.5.1. Architecture

There are several computer components involved in the system, including:
1. User's Desktop - This is a Windows computer with the AWR Design Environment platform software installed. No
additional components need to be installed here to support remote Linux simulations.
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2. Submit Host - This is a Linux computer that can accept LSF or Torque jobs. This node needs to meet the “Cluster
Requirements”.
3. Compute Nodes - These are the Linux-based computers where the simulation is run. These nodes need to meet the
“Cluster Requirements”.
There are several processes involved in a remote Linux simulation:
1. AWR_JobScheduler – This Windows-only process runs on the user’s desktop, and in this context is responsible for
submitting the job to LSF or Torque on the cluster submit host by issuing SSH commands. This process maintains a
shared memory connection to the client user interface.
2. awr_jobproxy – This Linux-only process runs on the cluster submit host. One such process is started by the
AWR_JobScheduler process for every remote Linux job that is submitted. This process is responsible for managing
communication between the AXIEM and Analyst software simulators and the AWR_JobScheduler process through
a series of sockets.
3. axiem and grsim – These processes represent the AXIEM and Analyst software simulators. In this context, multiple
instances of these Linux-only processes are run on the compute nodes. For Analyst software, LSF or Torque launches
MPI (mpiexec), which is responsible for starting the grsim processes. For AXIEM, LSF or Torque launches the axiem
process directly.
The following sequence occurs when a Linux job is submitted:
1. The AWR_JobScheduler establishes an SSH connection to the cluster submit host.
2. The AWR_JobScheduler launches the awr_jobproxy process on the cluster submit host given the port number and
network address of the user's desktop.
3. The awr_jobproxy establishes a peer-to-peer socket connection to the AWR_JobScheduler.
4. The AWR_JobScheduler develops the submission script for LSF or Torque.
5. The AWR_JobScheduler moves the input files to the cluster submit host over the SSH channel.
6. The AWR_JobScheduler issues a cluster-specific command to submit the job to LSF or Torque.
7. The AWR_JobScheduler monitors the cluster submit host for an indication that the job has started. The job consists
of mpiexec, which is responsible for starting the axiem or grsim processes on the compute nodes.
8. Each of the grsim processes establishes a client-server socket connection to the awr_jobproxy that is used for sending
status messages and other content. These messages are subsequently sent from the awr_jobproxy back to the
AWR_JobScheduler and eventually to the AWR Design Environment platform on the user's desktop.
9. As intermediate dataset files are written by axiem or grsim, it notifies the awr_jobproxy, which in turn notifies the
AWR_JobScheduler. The AWR_JobScheduler then copies these files back to the user's desktop for use in the AWR
Design Environment software.
10. When the simulation completes, the mpiexec and axiem or grsim processes exit and notify the awr_jobproxy accordingly.
11. After the awr_jobproxy has completed all communication with the user's desktop, it too exits.
12. The AWR_JobScheduler transfers all remaining output files back to the user's desktop for use in the AWR Design
Environment platform over the SSH channel.

10.5.2. Cluster Requirements
The following are the Linux-based computer requirements:
1. Redhat 7.x (or derivative such as CentOS) or compatible.
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2. LSF 10.1 or Torque 4.2.6 or compatible.
3. For Analyst software only: OpenMPI 2.1.3 or compatible built with MPI_THREAD_MULTIPLE support. The AWR
Design Environment platform looks for this support, and fails accordingly if not found.
4. SSH access. Cadence AWR uses single-factor public key authentication (SSH-RSA and SSH-DSA).
5. Non-interactive SSH sessions cannot echo anything to standard out. The AWR Design Environment platform checks
for this and fails accordingly if not found.

10.5.3. Cluster Installation
The following steps are performed on the submission host of your Linux cluster, typically by the system administrator:
1. Verification of all “Cluster Requirements”.
2. Users can choose any shell, but must set the following environment variables appropriate for that shell (for example:
.bashrc for BASH shell or .cshrc for C shell).
• AWR_PATH - This is where AWR software is installed. Version-specific subdirectories are located here, for
example: /opt/AWR/16_0_13450_1
• For Analyst software only: AWR_MPI_PATH_VXX (where XX is the major version number, for example:
AWR_MPI_PATH_V16) - This is where the OpenMPI binary files (such as mpiexec) are found on the cluster. For
example: /opt/openmpi213/bin.
• AWR_SIM_FOLDER - This is where temporary files are located during simulations. Each simulation creates a
subdirectory for its temporary files. This folder must be accessible by all nodes and must have sufficient free space.
An NFS directory is recommended.
3. Unzip and un-tar all of the AWR Design Environment platform solver files in a common location so all nodes can
access the files. An NFS directory is recommended. The version number should be maintained (for example, the
resulting files live in /opt/AWR/16_0_13450_1) as this facilitates simultaneous installation of multiple versions. The
environment variable AWR_PATH should point here as mentioned previously.
4. “Configure SSH”.
Configure SSH
The AWR Design Environment platform uses SSH to communicate with your cluster. To maintain communication
security, it uses single-factor public key authentication (SSH-RSA and SSH-DSA).
NOTE: PuTTY generates SSH2 public-private keys which are not compatible with SSH.
Every user needs a public-private key pair. One or more individuals may access the cluster as a particular user by using
the private part of the user's key pair.
The best resource for creating and installing a key pair is your cluster administrator. The following is offered for reference
if no overriding policy is in place:
1. As the user (not as root) enter the command ssh-keygen -t rsa at a terminal on the submission host.
2. Assuming your local user is named "localuser" your output displays as follows:
Generating public/private rsa key pair. Enter file in which to save the key
(/home/localuser/.ssh/id_rsa):

Press Return to accept this file name and path (or enter a new name).
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3. You are prompted for a passphrase with which to secure the key. You may either enter a passphrase or leave the
passphrase blank. If you leave the passphrase blank, you can use the private key for authentication without entering
a passphrase. If you enter a passphrase, you need both the private key and the passphrase to log in. Your organization
may have a policy governing this decision.
4. A private key, id_rsa, and a public key, id_rsa.pub, are generated in the .ssh directory of the localuser's home directory.
5. Add the public key to the file of known authorized users on the cluster. As the user (not as root), enter the command
cat ~/.ssh/id_rsa.pub >> ~/.ssh/authorized_keys at a terminal on the submission host of your
cluster.
6. Restrict the permissions of the local user's .ssh directory with the command: chmod 700 ~/.ssh.
7. Restrict the permissions of the files in that directory with the command: chmod 600 ~/.ssh/*.
8. Copy the private key (~/.ssh/id_rsa) to the Windows computer from the AWR Design Environment platform is run.
You will need to know the location of this file on the Windows system when you configure the Linux job scheduler
remote host later.
9. Remember that the private key should not be shared with anyone who should not have access to your cluster! It can
be provided to any person who wants to access the cluster as "localuser". See “Creating the Linux Job Scheduler
Remote Host” for details on setting up user access.
If the Linux cluster must be accessed through a remotehost/gateway, you have to install the same public-private key pair
between your Linux cluster and the remote host. The public key should be installed on the remote host.

10.5.4. Creating the Linux Job Scheduler Remote Host
To configure a link to your Linux cluster, you create a host in the AWR software:
1. Choose Tools > Job Scheduler Admin to display the Job Scheduler Admin dialog box, or open it from the Start menu
AWRDE program folder.
2. Click the Create a new host entry button above the Remote Hosts table.

3. For Entry Name, enter a user-friendly name for the host. This name does not need to match the remote computer name
or any other name. For Queue Type select Compute, and for Initialization > Transport, select awr_ssh_ipc. This tells the
job scheduler that you want to use a secure shell connection (SSH) to communicate with the remote cluster.

10–24 AWR Design Environment

Remote Linux Simulations

4. For Initialization > Host Name enter the IP address or hostname of the submit host. Specify the Submission Arguments
Location and enter the default job submission script or command line arguments for the resource manager. See “Job
Parameters and LSF/Torque Submission” for job parameter details. These options can be overwritten on the EM
Options dialog box Job Scheduler tab Submission Options Override option.

5. For Initialization > SSH Authentication > User Name enter your user account name on your cluster. For Private Key, click
the ellipses button at the right margin of the dialog box. Navigate to the location where the private key matching the
public key on your cluster is stored, and click Open in the Browse dialog box to choose the key. This should be the
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Linux private key you created (see “Configure SSH”); do not use a private key created by a third-party tool. Enter
the passphrase if you created one when creating the keys.

6. For Initialization > Cluster Resource Manager > Type, set your cluster resource manager type. For tools such as EMX
Planar 3D Solver that use the AWR Job Scheduler as the resource manager, set Type to Local.

7. If the Linux cluster must be accessed through a remotehost or gateway, enter that IP address or host name in Initialization
> Optional SSH Forwarding (Tunneling) > Destination Host. Otherwise, leave this empty. Change the Destination Port and
Source Port if different from the defaults.
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8. Click the Verify button on the Host Details dialog box. The system tries to verify that a communication link can be
established with your cluster. On success, a message box displays with a "Host Verification Succeeded!" message.

On failure, a message box displays with a "Host Verification FAILED!" message, and describes the error causing the
failure.

For a discussion of troubleshooting steps to take upon a verification failure, see “Troubleshooting Host Verification”.
9. Click OK to close the message box, and then the Host Details dialog box. If the verification succeeds, a green check
mark and the word "Verified" displays in the Job Scheduler Admin dialog box Verified column for the new host entry.
The verification process for this host is now complete and you do not need to perform verification again when you
run a simulation on this host.
10. If you have additional hosts on which you want to run remote simulations, repeat this process. You can add multiple
entries for the same host with different submission options. When you finish adding all of your hosts, make sure the
box next to each host name in the Entry Name column is checked to enable the host. If you prefer to disable the host
and make it unavailable for use while storing its values in the system, clear the check box.
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11. Click the Save button on the Job Scheduler Admin dialog box to save the settings for your host entries, and then click
the Close button to close the dialog box.
Troubleshooting Host Verification
If verification of your host fails, the most likely reasons are:
1. The host is unreachable. Attempt to "ping" the host.
2. The public and private keys are not matched correctly. The public key should be on the cluster. The private key should
be on your computer (see “Configure SSH”), and the path correctly entered via the job scheduler Host Details dialog
box (see “Creating the Linux Job Scheduler Remote Host”).

10.5.5. Running a Remote Linux Simulation
After you set up the link between the AWR Design Environment platform and your cluster, you can configure a simulation
to run on your cluster. The procedure is identical to running a remote Windows simulation as detailed in “Using Remote
Simulation”.

10.5.6. Job Parameters and LSF/Torque Submission
This table maps the parameters in the user interface with the submission scripts or command line arguments for LSF and
Torque.
Parameter Name

Description

Maximum Number of
Processes Per Node

Number of processes per compute node that will #PBS -l
be run. For Linux simulations, this value must be ppn=[Value]
> 0, otherwise it is interpreted as 1.

#BSUB -R
"span[ptile=[Value]]"

Cluster/Number of Nodes

Number of compute nodes per job.

#BSUB -n [Value]

Cluster/Simulation Options
Override

This input is used to override the value defined in #PBS [Value]
the job scheduler Host Details dialog box. These
values are passed directly to your Linux resource
manager (for example, LSF) as trailing lines in
the submission script, and can be used to specify
memory reservations, wall time limits, and other
options.
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#PBS -l
nodes=[Value]

LSF Usage

#BSUB [Value]
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Parameter Name

Description

Torque Usage

LSF Usage

Examples include:
"-m grid001 -q testqueue"
"-l walltime=01:00:00grid001 -q
testqueue"

The following is an example LSF submission script (named _AWR.sub) for a 2 node, 8 process per node simulation that
would be submitted using "bsub < _AWR.sub", assuming that Cluster > Submission Arguments Location is set to Submission
Script in the job scheduler Host Details dialog box.
#BSUB -L /bin/bash
#BSUB -J "{021D6E34-656C-40EC-B2DD-85547C0404FF}"
#BSUB -e /home/centos/analyst_sim_folder/BPC/158808871538808/_AWR_error
#BSUB -o /home/centos/analyst_sim_folder/BPC/158808871538808/_AWR_output
#BSUB -Jd "Job_7: None"
#BSUB -n 16
#BSUB -R "span[ptile=8]"
LD_LIBRARY_PATH=/opt/grsim_install/16:/opt/openmpi213/lib:$LD_LIBRARY_PATH
/opt/openmpi213/bin/mpiexec /opt/grsim_install/16/grsim
'/home/centos/analyst_sim_folder/BPC/158808871538808/simulation.xml' /license_remote
/host=10.22.64.56,192.168.122.1, /port=33824 /nt=1
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Chapter 11. EM: Creating EM Structures with Extraction
The term extraction is often used when discussing Electronic Design Automation (EDA) software. In this chapter,
extraction is the general process of providing physical data input (in the form of shapes with conductor properties on
dielectric layers) to a physical simulator that produces output to be used with circuit simulation. The output depends on
the physical simulator. In silicon design, extraction is used for traditional parasitic extraction. In microwave design,
extraction is used to ease the process of setting up for EM simulation, or to use Automated Circuit Extraction (ACE).
This chapter presents general concepts regarding the Cadence® AWR Design Environment® platform extraction flow
and includes sections that discuss issues specific to each type of physical simulator.
While extraction is a significant advancement in the automation of including an EM simulation in another electrical
analysis, the quality of the simulation results is a direct result of the configuration of the extraction. Extraction does not
guarantee accurate results just because it is relatively simple to set up and use, but it effectively removes a large portion
of the tedious and error prone tasks required to perform this task manually. You should consider extraction set up as if
performing manual set up of the EM analysis, overriding the default behavior of the extraction where appropriate.

11.1. Extraction Overview
You can select element(s) in a schematic that you want to associate with an extraction. A separate model parameter
allows you to define this association. When you select this mode of simulation, an EM structure is automatically generated
using the schematic layout for all elements associated with the extraction. The physical simulation runs, and the EM
results automatically replace that element's built-in model(s) in any simulations using the schematic. The extraction
process is generic in operation, the major difference being the type of simulator you use. The following figure shows a
diagram of the extraction flow.
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The geometry to be simulated in the extraction comes directly from the Layout View of the commanding schematic.
This concept is essential to the methodology of the extraction process; the contents of the Layout View are modeled
using a physical simulator.

11.1.1. Physical Simulators
Physical simulator is a generic term for a simulator that uses layout geometry and a physical stackup to produce a network
that electrically represents the physical structure that can be used with a circuit simulator. Cadence uses this generic term
because the AWR Design Environment platform has several types of physical solvers:
• EMSight - an AWR electromagnetic solver; the results are in the form of network parameters.
• Cadence AXIEM® 3D planar EM solver - an AWR electromagnetic solver; the results are in the form of network
parameters.
• Cadence Analyst™ 3D FEM EM solver - an AWR 3D electromagnetic solver; the results are in the form of network
parameters.
• ACE - an AWR transmission line extractor; the results are in the form of a netlist of transmission line elements.
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• Other EM solvers - Other Cadence solvers using the EM Socket for full EM analysis; the results are in the form of
network parameters.

11.1.2. Why Use Extraction?
• An iNet can only be simulated using the extraction process.
• Allows for an easy way to account for coupling that is not included in models (for example, coupling of two transmission
lines due to proximity in layout, coupled spiral inductors, etc.).
• The physical simulation is used for simulation results only, not as a layout cell in your design.
• Significantly reduces the sources of error for performing physical simulation versus the manual process of doing the
same, such as: copying layout or drawing EM structures layout by hand, adding ports and wiring up into a schematic
as a subcircuit. For simple structures the advantage is significant, for large structures (over a few ports) the manual
process is not manageable.

11.1.3. When Not to Use Extraction
• If the physical geometry does not come from a schematic element's layout. This includes geometry from artwork files
(GDSII or DXF files) or non-standard geometry (for example, an ellipses).
• You want to use a physical simulation as a design element and get the layout from the physical simulation layout.

11.2. Extraction Setup Basics
There are four basic requirements for using the extraction process in the AWR Design Environment platform. Each is
explained in further detail:
1. A schematic with a layout that is properly snapped together. DO NOT attempt extraction unless you have ensured
your layout is correct. See “State of Layout” for more details.
2. An EXTRACT block placed in a schematic to control the physical simulator used and the settings for the physical
simulator. See “EXTRACT Block” for details.
3. Each schematic element and/or schematic layout shape must be configured to use extraction. See “Selecting Models
and Shapes for Extraction” for details.
4. A STACKUP element used to define the physical environment for your process including dielectric layers and
conducting materials with a vertical position and thickness for each. See “STACKUP Block” for details.

11.3. Extraction Flow
After setup is complete, all you must do is simulate; the AWR Design Environment software performs the rest. New
documents are created under the EM Structures node in the Project Browser. Don't be misled by the EM name, these
documents contain the input for ANY of the physical solvers you use. The name "EM Structures" is only used for historical
reasons. When the EM simulation is complete, these results are automatically used in any simulations of your schematic
using extraction.
NOTE: The design can create the EM documents before simulating to allow you to visually confirm they contain what
you expect, to view the mesh, etc. See “Viewing EM Structures Before Simulation” for details.
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11.4. Schematic Layout
11.4.1. State of Layout
You should use caution with your layout when using extraction. Depending on the physical simulator type you use, if
your layout is not properly connected you can get open circuit responses or short elements together. For example, if your
layout has rat lines, you can get open circuits. If you have elements with overlapping layouts, those elements can be
shorted. The AWR Design Rule Check engine (see “Design Rule Checking (DRC) ”) can search for rat lines and shorts
(for iNets only). You must decide how to ensure the layout is correct before running extraction.
The physical solvers available are in two generic classes: shape based and path based extractors. For shape based extractors
(such as AXIEM) a meshing operation must occur to determine the connectivity of the entire structure. In this case, any
rat line or touching shapes affect the results, as if the circuit was fabricated this way. For path based extractors (such as
ACE) the layout objects simulated are paths. Since a path is a connection from point A to point B with some width, the
path contains the connectivity information and so no meshing operation is needed. In this case, any rat lines or touching
shapes do not create open circuits or shorts.
If you are unsure of what your physical solver will do in either of these situations, Cadence recommends that you create
some simple test structures to test these issues, or always ensure your layout has no shorts or rats lines.

11.4.2. Issues with Hierarchy
See “Extraction Through Hierarchy” for details on hierarchy issues.

11.4.3. EM Extracting Elements with Grounds
Some elements with layout in the AWR Design Environment platform have a built-in ground connect, for example the
MLSC (short-circuited microstrip line). If these elements are used for EM extraction, the extraction process doesn't
understand how to ground one end of this line and so won't be extracted properly. For example, see the following schematic
and the resulting EM structure for EMSight that is generated.
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EXTRACT
ID=EX1
EM_Doc="MLSC_EX"
Name="EM_Extract"
Simulator=EMSight
X_Cell_Size=1 um
Y_Cell_Size=1 um
PortType=Default
STACKUP=""
Extension=100 um
Override_Options=Yes
Hierarchy=Off

PORT
P=1
Z=50 Ohm

STACKUP
Name=SUB2

MLSC
ID=TL1
W=20 um
L=100 um

MSUB
Er=12.9
H=100 um
T=2 um
Rho=1
Tand=0
ErNom=12.9
Name=SUB1

Notice in the EM structure that the right end of the structure is not touching the enclosure outline nor has any sort of via
to the top or bottom of the structure. In this case this line simulates as an open rather than a short.

The correct approach is to use an MLIN element in the schematic and then use a separate ground element on one end of
the line as follows.
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EXTRACT
ID=EX1
EM_Doc="MLSC_EX"
Name="EM_Extract"
Simulator=EMSight
X_Cell_Size=1 um
Y_Cell_Size=1 um
PortType=Default
STACKUP=""
Extension=100 um
Override_Options=Yes
Hierarchy=Off

PORT
P=1
Z=50 Ohm

STACKUP
Name=SUB2

MLIN
ID=TL1
W=40 um
L=100 um

MSUB
Er=12.9
H=100 um
T=2 um
Rho=1
Tand=0
ErNom=12.9
Name=SUB1

Notice that the EM structure created has two edge ports, one on each side. With the extraction flow, this EM result
replaces the MLIN in the schematic, and since one end of the MLIN is grounded, one end the EM structure gets grounded
in the schematic simulation.

11–6 AWR Design Environment

Schematic Layout

Vias to ground are another case where extraction can be difficult. The following figure shows a via to ground in a
schematic.

EXTRACT
ID=EX1
EM_Doc="EM_Extract_Doc" PORT
Name="EM_Extract"
P=1
Simulator=EMSight
Z=50 Ohm
X_Cell_Size=5 um
Y_Cell_Size=5 um
PortType=Default
STACKUP=""
Extension=100 um
Override_Options=Yes
Hierarchy=Off

MLIN
ID=TL1
W=40 um
L=100 um

VIA
ID=V1
D=40 um
H=100 um
T=2 um
RHO=1

STACKUP
Name=SUB1

Since the via is a two-node model, the extraction flow needs to add a second port at the bottom of the via. There should
not be a port here, however, because the via is connected to the bottom of the enclosure.
There are two solutions to this problem. The simplest is to use the VIA_1P model which is a one-port model with ground
included in the model. The second work-around is to place the via in a schematic where the via is grounded and one port
is added.
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PORT
P=1
Z=50 Ohm

VIA
ID=V1
D=40 um
H=100 um
T=2 um
RHO=1

You can then use this schematic as a subcircuit where you want your vias, as shown in the following figure.

STACKUP
Name=SUB1
EXTRACT
ID=EX1
EM_Doc="new"
Name="EM_Extract"
Simulator=EMSight
X_Cell_Size=5 um
Y_Cell_Size=5 um
PortType=Default
STACKUP=""
Extension=100 um
Override_Options=Yes
Hierarchy=Off

PORT
P=1
Z=50 Ohm

MLIN
ID=TL1
W=40 um
L=100 um
1

SUBCKT
ID=S1
NET="via"

The final step is to set up the subcircuit to extract, instead of the via model itself.

11.4.4. Extraction Ports
By default, auto ports are used for AXIEM and Analyst software extraction. For AXIEM software, auto ports automatically
determine port settings based on geometry and stackup. See “Auto Ports” for more information on this port type. For
Analyst software simulation, auto ports map to edge ports with Connect to lower as the Type. In some cases it is best to
manually specify port settings or numbering. You can disable auto ports on a per port basis by adding extraction ports
to the schematic layout and specifying port settings on the extraction port.
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To add an extraction port, select the item in your schematic layout to which you want to add the port, choose Draw >
Extraction Port and then place the port on an edge of the selected shape. This is the same as adding ports in an EM structure.
In the following figure an extraction port is added to the schematic layout.

You can now set port properties that are transferred to the EM document created during extraction. For example, you
can change the ground type, the mutual group type, or de-embedding. You can also change the reference plane distance.
Double-click the extraction port to display the Properties dialog box. On the Port Attributes tab, enter the value you want
to de-embed in Ref. Plane Distance. When you do this, the reference plane draws outside of the shape to which it is
connected. For example, the previous structure has a reference plane extension of 100um.

Note that the EM structure created from extraction adds this length to the shapes extracted.
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The extraction ports are only suggestions. They are only used if the EM structure created with extraction needs a port
where the extraction port is located in the layout; for example, when you have two MLINs in a schematic connected
together and you are extracting both. If you place an extraction port between the two MLINs, the settings from the
extraction port are not used since there is not a port in this location in the EM structure.

You can place extraction ports at any level of your hierarchical design. If there are ports at the same location but at
different levels of hierarchy, the extraction port at the higher level of hierarchy is used. The extraction ports created at
one level of hierarchy are unique in the extracted document, there are not any settings that are shared (such as port number
or mutual groups). For example, see the following figure where two of the schematics created above are used through
hierarchy, so the layout looks as follows,
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and the extracted EM structure looks as follows.

Notice that there is a port 1 and 2 and not two ports with number 1. It is valid in AXIEM software to have two ports with
the same number, but you could only achieve that with extraction ports when using them at the same level of hierarchy.
Hiding Extraction Ports
To turn off display of extraction ports in the schematic layout view:
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1. From the menu, select Options > Drawing Layers
2. In the General section, click on Drawing Layer 2d.
3. For the drawing layer EMSymbols, clear the Visible check box.

11.4.5. Area Pins
Area pins are layout objects where an area is used to define the allowed connection location. There are several cases
where you will want area pins included in the EM structures generated from extraction. There are two classes of area
pins for extraction. Ports that have layouts that are area pins are the first case, and any other area is the second case. The
main reason to have a port with layout is when using iNets. Often you need your port to have layout to define where to
connect to a layout through hierarchy. Also, you often need a port to have a layout so you can get a rat line (between the
port and whatever it is connected to) so you can route an iNet.
By default, if an extracted element is connected in the schematic to a port with an area pin, that area pin's layout is
extracted. Area pins that are not connected to extracted elements are not extracted. On the EXTRACT block, you can
change the Extract_PinShapes parameter to "Yes" and then area pins (on p-cells) that are touching other extracted elements
are included in the EM structure generated from extraction. You can override this behavior per area pin. Select the shape
that has the area pin in layout, right-click and choose Shape Properties to display the Cell Options dialog box, then select
the Faces tab. In Face, select the face number of interest. In the Area Pins section, change Extract pins connected to extracted
objects to either Default, Yes, or No. See “Cell Options Dialog Box: Faces Tab ” for more information about this dialog
box. Default is the behavior previously described regarding the different types of area pins. Yes and No override any other
settings that control how area pins are extracted.

11.5. EXTRACT Block
The EXTRACT block controls the physical simulator and options for that simulator. You should place this block at the
top level of your design hierarchy if not using hierarchical extraction, or at any level lower down if using hierarchical
extraction. See “Extraction Through Hierarchy” for details about working with hierarchy. The element Help for the
EXTRACT block has details for each of the parameters on this block; see “Extraction Control Block: EXTRACT”.
The EM_Doc parameter is the exact name of the EM structure that is automatically generated in the project. This name
should be different from all other names on extract blocks or other EM structures.
The Name parameter connects individual models and shapes from the schematic layout to the specific EM structure
specified. You enter the name by typing it between quotes. For models or shapes using this name, it is available in the
drop-down menu. You can also include more than one group with an EXTRACT block by typing all of the names
separated by a comma and between the {} characters. For example, if groups a, b, and c are used for various models or
shapes in the design, you can type "{a,b,c}" to include all of those groups in the one EM structure.

11.5.1. EXTRACT Block Enable
You can enable or disable the EXTRACT simulation control in the controlling schematic by selecting the EXTRACT
control, right-clicking and choosing Toggle Enable.
When the EXTRACT control is enabled, the simulation proceeds as documented in the previous sections. When the
EXTRACT control is disabled, each of the elements associated with the extraction group reverts to the behavior they
would have if the extraction group did not exist. This provides a convenient way to see the electrical effect of an extraction
on your simulated results.
Note that disabling the EXTRACT simulation control does not disable the associated EM document. If the simulation
results of the EM document are not valid, this document is resimulated. You must disable the EM document if it is not
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used. This is not done automatically, because it is possible to configure the measurements directly upon the EM document
or to have another EXTRACT simulation control with the same EM document name specified.

11.5.2. Simulator Defaults
The EXTRACT block has tabs to control simulator options so you can make changes here rather than directly on the
EM structure. You can set options directly on the EM structure. This is not recommended since the EM structure is
generated from a schematic with an EXTRACT block that can override the options on the EM structure. If you must set
options directly on the EM structure, make sure to set the EXTRACT Override_Options parameter to "No".

11.5.3. Extraction EM Frequencies
When an extraction is first performed (or the EM structure is first created) the set of frequencies from the Frequencies
tab are used. Once the EM structure is set up with these frequencies, no further automatic update of the frequencies is
done, unless the structure is deleted and recreated. From this point, you can modify the EM structure simulation frequencies
and they remain unchanged. When a schematic is simulated the EM results may have to be interpolated or extrapolated
if the frequencies for the schematic are different than those of the extracted EM structure.
Often, to speed the electromagnetic simulation process, you may want to reduce the frequency set if the port parameters
do not vary quickly over frequency. Depending on the simulator associated with the EM structure, this may or may not
reduce the simulation time.
Because the simulation frequencies are not altered after creation of the EM structure some common errors can occur. If
the simulation frequencies of the controlling schematic are altered after the extraction EM structure is created, these
changes are not forwarded to the EM structure. This is to allow the customization of the frequencies as previously
mentioned.
Another common error in the EM structure simulation frequencies occurs when you perform a nonlinear simulation on
the schematic using a harmonic balance or time domain simulator. In either case, the EM structure is asked to supply
port parameter information from DC to some higher multiple of the simulation frequency. For harmonic balance simulations
this is at DC, harmonics of the fundamental and possibly mixing products of a multi-tone analysis. You must configure
the EM structure frequencies in a manner appropriate to the analysis being performed.
For a time domain simulation, a rational function expansion is performed on the EM structure to create a time domain
model. To create this function, the EM structure is asked to supply additional frequency domain data.
You must ensure that the set of simulation frequencies applied to the EM structure is appropriate for the simulation
performed on a parent schematic.

11.5.4. Multiple Extractions in a Single Schematic With Different Group Names
You can apply multiple extractions within the same schematic to different EM structures and different group names.
You should use this technique if two sections of the schematic are physically separated such that you expect minimal
coupling between the extraction groupings. All that is required to enable multiple extractions is to have multiple EXTRACT
blocks to the schematic. In this case, each EM_Doc and Name should be unique. This is the main reason that when setting
up for extraction you must specify a name for the extract group.

11.5.5. Multiple Extractions in a Single Schematic With the Same Group Names
You can apply multiple extractions within the same schematic to different EM structures and the same group names. In
this case, each EM_Doc should be unique and the Name should be same. The frequencies for all the EXTRACT blocks
must be unique. The application of this feature is to allow different simulator settings or even different simulators for
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different frequency ranges, yet allowing the extraction flow to manage creating all of the EM structures and merging all
of the data together after all the simulations are complete. For example, you might want AXIEM simulation with thin
metal for your DC point, AXIEM simulation with thick metal for your in-band frequencies (and meshed at your highest
in-band frequency), and then AXIEM simulation with thin metal for your harmonic frequencies (and mesh at your highest
harmonic frequency), or you might want to use ACE for DC and then EMSight for the rest of your frequencies, etc.

11.6. STACKUP Block
You must add a STACKUP substrate element to the top level schematic or to the global definitions. This element is used
to set up the EM structure's dielectric stack-up and conductor properties. If you use PDKs, these blocks are typically
configured for you and are in the global definitions. Cadence suggest only placing STACKUP blocks in the global
definitions for several reasons:
1. There is only one in the project, so you know all your extractions use the same STACKUP.
2. If you create EM structures without extraction, the new structures can use the STACKUPs in the global definitions
as the default settings.
STACKUPS added to a schematic automatically use the schematic's LPF.
See “Configuring Stackup” for details on the STACKUP settings.

11.6.1. Multiple STACKUPs
For some processes, you may want several STACKUPs for your simulation needs. This is common when using full-wave
EM simulations since you can make simulations more efficient by collapsing dielectric layers. The correct approach is
to create as many STACKUP elements as necessary. For each, you should define a unique Layer Mapping, then for the
EXTRACT block, you can use any of the defined STACKUP elements.

11.7. Selecting Models and Shapes for Extraction
To associate schematic circuit elements for extraction, in the Schematic View, double-click the element or right-click it
and choose Properties to display the Element Options dialog box. Click the Model Options tab. In the EM Extraction Options
area, click the Enable check box and in Group name, you can either type in a new name or use the drop-down menu to
choose any name already set up on an EXTRACT block. See “Element Options Dialog Box: Model Options Tab” for
more information. You can select multiple elements in the schematic and turn on extraction for all selected elements at
once. For iNets, you select the wire in the schematic for that iNet.
You can also associate elements with an EXTRACT control from the Layout View. This is often more convenient, as
this view allows you to identify elements that are in close physical proximity. With iNets, layout is much simpler than
the schematic for setting up extraction. Select the shape you want to extract, right-click and choose Element Propertiesto
display the Element Options dialog box. Click the Model Options tab. In the EM Extraction Options area, click the Enable
check box and in Group name, you can either type in a new name or use the drop-down menu to choose any name already
set up on an EXTRACT block. You can select multiple elements in the schematic layout and turn on extraction for all
selected elements at once.
When working in schematic layouts, you can also have "dumb" shapes, which are shapes that don't have a schematic
element. These are drawn by hand in the schematic layout and they can also be used in extraction. Select the shape you
want to extract, right-click, and choose Shape Properties. In the EM Extraction Options area, click the Enable check box
and in Group name type in the group name.
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11.8. Viewing Items for Extraction
After making associations, you can visually see the associations in both the layout and schematic. If you select the
extraction simulation control within the schematic, all elements associated with that extraction are marked as shown in
the following figure.

STACKUP
Name=SUB2

EXTRACT
ID=EX1
EM_Doc="EM_Extract_Doc"
Name="EM_Extract"
Simulator=EMSight
X_Cell_Size=1 um
Y_Cell_Size=1 um
PortType=Default
STACKUP=""
Extension=100 um
Override_Options=Yes
Hierarchy=Off

PORT
P=2
Z=50 Ohm

MTRACE2
ID=X1
W=20 um
L=200 um
BType=1
M=1
PORT
P=1
Z=50 Ohm

MLIN
ID=TL1
W=20 um
L=100 um

MLIN
ID=TL3
W=20 um
L=100 um

1
MTEE$
ID=TL2

3
2
MSUB
Er=12.9
H=100 um
T=2 um
Rho=1
Tand=0
ErNom=12.9
Name=SUB1

MTRACE2
ID=X2
W=20 um
L=200 um
BType=1
M=1

MLIN
ID=TL4
W=20 um
L=100 um

PORT
P=3
Z=50 Ohm

Similarly, in the layout, the layout cells associated with that extraction are marked as shown in the following figure.

In this mode, the highlight color is always red. The highlight turns off when you click elsewhere.
Alternatively, right-click the EXTRACT block and choose Highlight. A Color dialog box displays to allow you to specify
a color for the extraction group highlight. After highlighting, right-click the EXTRACT block again and choose Highlight
Off. This mode takes a few more mouse clicks to turn on but has several advantages:
• You can use the color you want.
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• The highlight stays on until turned off. This allows you to select subcircuits, right-click and choose Edit Subcircuit to
push into the subcircuit while the highlight remains on. This allows you to find items through hierarchy.
• If you have more than one EXTRACT block, this mode can highlight items in different extract groups at the same
time.
For example, the following circuit has two different extraction groups, one is highlighted in green and the other is
highlighted in orange.

EXTRACT
ID=V4
EM_Doc="Extract_Signal"
Name="Signal"
Simulator=OEA
X_Cell_Size=0.1 um
Y_Cell_Size=0.1 um
PortType=Default
STACKUP=""
Extension=10 um
Override_Options=No
Hierarchy=Off

GND

DCVS
ID=V2
V=3.3 V

EXTRACT
ID=V3
EM_Doc="Extract_DC"
Name="DC"
Simulator=OEA
X_Cell_Size=0.1 um
Y_Cell_Size=0.1 um
PortType=Default
STACKUP=""
Extension=10 um
Override_Options=No
Hierarchy=Off

VDD
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11.9. Viewing EM Structures Before Simulation
When performing extraction, you can view the EM structure before the physical simulation is run. With your extraction
properly configured, right-click the EXTRACT block in your schematic and choose Add Extraction. Alternatively, you
can select the schematic name in the Project Browser and choose Add Extraction. Either command creates the EM structure
generated with the name set on the EXTRACT block. If nothing is created, there are no EXTRACT blocks in that
schematic, the EXTRACT block is disabled, or there are no elements added to the group controlled by the EXTRACT
block.
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You should do this every time you start a new group of extraction problems. Once you are sure the layout is extracting
reasonably for your layout, you can expect that it will continue to work for small changes of layout. You should always
check the connectivity in the layout and ensure it still functions correctly.

11.10. Extraction Through Hierarchy
The Extraction flow supports extraction through hierarchy. When a schematic has an EXTRACT block, the extraction
process looks for models or shapes to extract through all levels of hierarchy. There are several ways to change this
behavior.

11.10.1. EXTRACT Blocks Through Hierarchy
The default behavior is for the top level EXTRACT block to override all lower level EXTRACT blocks, causing all
extraction to be performed as one flat simulation. You may want an EXTRACT block at lower levels of hierarchy for
when you simulate that level. See “3D EM Extraction” for exceptions related to 3D EM simulations.
The Hierarchy parameter on the EXTRACT block controls how extraction is executed throughout the design hierarchy

EXTRACT
ID=EX1
EM_Doc="EM_Extract_Doc"
Name="EM_Extract"
Simulator=EMSight
X_Cell_Size=5 mil
Y_Cell_Size=5 mil
PortType=Default
STACKUP=""
Extension=100 mil
Override_Options=Yes
Hierarchy=Off

When Hierarchy is set to "Off" for any EXTRACT block at a lower level other than the top level being simulated, any
shapes associated with the lower level EXTRACT block are only extracted by the top level EXTRACT block. Hierarchy
is being flattened, and any lower level shapes are included as part of the top level extraction. If there is no top level
EXTRACT block, then nothing is extracted.
When Hierarchy is set to "On" for any EXTRACT block at a lower level than the top level being simulated, any shapes
associated with the lower level EXTRACT block are extracted in the lower level document and the top EXTRACT block
extracts any shapes not associated with the lower level block. Hierarchy is being preserved, and any lower level shapes
are extracted at the lower level, and are included in top level simulations as a separately extracted subcircuit. If there is
no top level EXTRACT block, the lower level is extracted.
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11.10.2. Extracting Subcircuits
Hierarchy is created in a design by using a SUBCKT model and specifying the name of the subcircuit. By default, the
extraction process pushes into each subcircuit looking for items to extract. However, if you set the SUBCKT block itself
to extract, the process will not push any lower into hierarchy. There are several situations where you would want to
extract the SUBCKT model. The first situation is when you assign an artwork cell to your subcircuit. For example, you
could create a transmission line model from lumped RLC elements. Since this model has no layout, you could use this
model as a subcircuit and then assign an artwork cell to the layout cell for the subcircuit.
The second situation is when you are using an EM structure as a subcircuit in your design (not created with extraction)
and you want to extract the layout from this EM structure into a larger EM simulation. For example, if you need to use
EMSight to simulate several discontinuity models and you are using these EMSight results in your overall design, then
you wanted to simulate the complete design using AXIEM software. In this case, you would set up your EM subcircuits
to use extraction, just like any other model.
When extracting EM subcircuits, you might end up with the metal used for any de-embedding distance undefined. This
occurs when an EM subcircuit is connected directly to a port, because the extraction process doesn't know what is
connected to the EM subcircuit. You can fix this problem by setting the connect type for the ports in the EM document.
To do this, select the port in the EM layout, right-click, choose Shape Properties, and click the Cell Port tab. See “Properties
Dialog Box: Cell Port Tab ” for more information about this dialog box. You then select the connection type for this
port.

11.11. EM Optimization, Tuning, and Yield Analysis
You can tune, optimize, and perform yield analysis using EM simulators, extractors, or ACE. To do so, the shapes being
extracted by an EXTRACT block must be controlled by variables that are being tuned or optimized. The following figure
shows a schematic with an MLIN element with W and L parameters set up for EM tuning.
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For EM optimization, tuning, and yield analysis to operate correctly, you must set the layouts to automatically snap
together so that each time a parameter changes the layout is automatically updated, and correctly represents what needs
to be simulated. (Choose Options > Layout Options and on the Layout tab under Layout Cell Snap Options set Snap together
to Auto snap on parameter changes.) See “Layout Options Dialog Box: Layout Tab ” for more information.
Tuning and optimizing on parameters that affect the layout results in resimulation as the layout changes. Tuning and
optimizing swept variables (SWPVAR blocks) is NOT supported, however, since swept values do not affect layout (their
value for layout is derived from the default swept parameter equation value). Currently, only variation on model geometry
is allowed; you cannot vary dielectric height or dielectric constants using the extraction flow.

11.12. Extraction and Switch Views
EM extraction and Switch Views are two different ways the simulator uses an electrical model different than the default
model. EM extraction simulates the model's shapes in an EM simulator and uses the EM result for the model. Switch
Views can switch between different ways of modeling a specific component of the design (for example, linear model or
S-parameters). For more information about switch views, see “Switch View Concepts ”. You cannot use both switch
views and EM extraction at the same time because the software has no way of knowing which model you want. Currently,
if you set up simulations with both configured an error message displays.
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11.13. Extraction and Swept Variables
Swept variable analysis does not change layouts during the swept analysis. If you want to do an extraction with swept
variables where the swept variables affect the layout of the items being extracted, special consideration is required. To
update layouts with extraction and swept variables for AXIEM and Analyst software simulations only, you must add the
name of the swept variable to the EXTRACT block SweepVar_Names parameter.
These concepts are demonstrated with an example. The following schematic shows a simple setup of a swept length of
transmission line.
L=305

Xo

PORT
P=1
Z=50 Ohm

. . . Xn

SWPVAR
ID=Tline_L1
VarName="L"
Values={ 100,200,300 }
UnitType=None

MLIN
ID=TL2
W=25 mil
L=L mil

MSUB
Er=10
H=25 mil
T=1.4 mil
Rho=1
Tand=0
ErNom=9.8
Name=SUB1
PORT
P=2
Z=50 Ohm

When simulated without extraction and looking at the phase of the line, the phase should increase as the length is increased,
as shown in the following figure.
phase_no_extraction
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line_no_extraction
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p1: L = 100
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5

p2: L = 200
p3: L = 300

If the same schematic is set up for extraction by adding a STACKUP, adding an EXTRACT block, and assigning the
MLIN to the proper extract group, the schematic would display as shown in the following figure.
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STACKUP
Name=SUB2

L=305

Xo

MSUB
Er=10
H=25 mil
T=1.4 mil
Rho=1
Tand=0
ErNom=9.8
Name=SUB1

PORT
P=1
Z=50 Ohm

. . . Xn

MLIN
ID=TL2
W=25 mil
L=L mil

PORT
P=2
Z=50 Ohm

SWPVAR
ID=Tline_L1
VarName="L"
Values={ 100,200,300 }
UnitType=None

EXTRACT
ID=EX1
EM_Doc="EM_Extract_Doc"
Name="EM_Extract"
Simulator=AXIEM
X_Cell_Size=25 mil
Y_Cell_Size=25 mil
STACKUP=""
Override_Options=Yes
Hierarchy=Off
SweepVar_ Names=""

When you run the simulation the Simulation dialog box displays only one EM simulation.

The simulation results are shown in the following figure.
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As shown in these simple results, it is obvious that the extraction did not properly handle the swept variable.
The proper setup is to add "L" to the EXTRACT block SweepVar_Names parameter. After this change, the schematic
displays as shown in the following figure.
STACKUP
Name=SUB2

L=305

Xo

MSUB
Er=10
H=25 mil
T=1.4 mil
Rho=1
Tand=0
ErNom=9.8
Name=SUB1

PORT
P=1
Z=50 Ohm

MLIN
ID=TL2
W=25 mil
L=L mil

PORT
P=2
Z=50 Ohm

. . . Xn

SWPVAR
ID=Tline_L1
VarName="L"
Values={ 100,200,300 }
UnitType=None

EXTRACT
ID=EX1
EM_Doc="EM_Extract_Doc"
Name="EM_Extract"
Simulator=AXIEM
X_Cell_Size=25 mil
Y_Cell_Size=25 mil
STACKUP=""
Override_Options=Yes
Hierarchy=Off
SweepVar_ Names="L"

When you run the simulation, the Simulation dialog box displays only three EM simulations.
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The simulation results in the following figure now show the expected behavior.
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11.14. Extraction and Shape/Layer Modifiers
Shape and layer modifiers allow additional manipulation of layout shapes outside of layouts snapping together from
schematic elements. See “Shape/Layer Modifiers” for details on using shape modifiers. When using either the Stretch
Area shape modifier or any of the layout modifiers, changes to the modifier do not change the schematic layout. When
you generate the EM document from extraction, however, the shapes are changed.
The following layout shows a simple transmission line 20um wide and 100um long. A Layer Resize modifier is set to
oversize the shape by 20um.
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When the EM document is created, the line is oversized in each direction by 20um, so the total size is 60um wide and
140um long. The following figure shows the extracted AXIEM document.
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11.15. EMSight Layout Issues
When using EM extraction, the extraction process attempts to add edge ports when the EXTRACT block's PortType
setting is "Default" when it can, and use via ports when it cannot.
The following cases are situations where edge ports are not possible:
Case 1. In the AWR Design Environment platform, any edge ports on the same edge of the structure must have the same
de-embedding length. For extraction, this means that for more than one edge port to be on the same side, the connection
locations must be lined up exactly. For example, see the following figure for the schematic layout.
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The following figure shows the extracted EMSight extraction document.

Notice that port 2 is not an edge port but rather a via port.
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If the two edges are lined up exactly, then both will have edge ports.

Case 2. Using extraction where connections cannot be made on the outside of the structure. For example, two lines with
a chip capacitor between them with only the lines set for extraction. Two of the connections are external to the structure;
these can use edge ports. Two connections, however, are internal and must use via ports.
Case 3. Using extraction where an EM port is required on a non-orthogonal edge. For example, if the only extracted
element is a line that is rotated even slightly, so that its edges are not at exact multiples of 90-degrees, edge ports cannot
be placed on it. Via ports are used instead. In the schematic layout, right-click on any shape, choose Shape Properties to
display the Cell Options dialog box, then click the Layout tab to see if it has been rotated.
A via port in EMSight is a port that extends vertically from the layer it is on down one layer, and then a source is attached
at the bottom of the via. Via ports and EMSight must be considered very carefully before deciding if using them is
acceptable.
• Via ports have some inductance due to the vertical metal simulation that is not de-embedding from your simulation.
You need to determine if this inductance is significant or not at your simulation frequencies.
• Via ports only go through one level of dielectric. If the via port does not go to the bottom of the structure, the excitation
of this port is not correct.
NOTE: AXIEM software has different types of ports that are more suitable for connections that cannot use edge ports.
If EMSight's port issues are significant, you might consider using AXIEM software.
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11.16. 3D EM Extraction
In addition to other schematic elements, 3D EM Extraction supports extraction of BWIRES elements and hierarchical
designs using different technology LPFs. Therefore, structures such as MMIC-bond wire-Board transitions can be
extracted and simulated using a 3D EM solver such as the Analyst 3D Electromagnetic simulator.
The following are limitations of 3D EM Extraction:
• The BWIRES pCell is the only 3D EM pCell recommended for use with Analyst Extraction. All other 3D pCells do
not have schematic layout representations appropriate for 3D EM Extraction.
• Artwork cells cannot be extracted.
• EM structures used as subcircuits in schematics cannot be extracted.
• When extracting through hierarchy:
• A SUBCKT block cannot be added to an extraction group, in order to be extracted as one flat structure. The elements
to be extracted in each subcircuit schematic must be added to the desired extraction group.
• The extracted EM structures can preserve the hierarchy of the schematics-- each schematic with an EXTRACT
block has its own EM structure. The EXTRACT block is required if the stackup of the subcircuit is not the same
as the higher level schematic.
• If a lower level schematic does not have an EXTRACT block, the extracted elements in it will use the EXTRACT
block in the higher level schematic, and will be part of that EM structure.

11.16.1. 3D EM Extraction Setup
This material assumes familiarity with the general Extraction procedure. See “Extraction Setup Basics” for details on
the general procedure. For 3D EM Extraction, there are three additional steps described in more detail in the following
sections.
1. Synchronize the schematic 3D view with the EM 3D view.
2. Define the z-position of elements.
3. Define the boundary in the schematic layout

11.16.2. Synchronizing the 3D Layout
In the AWR Design Environment platform, there are two independent 3D layout views: the schematic 3D layout view
and the EM 3D layout view. Each schematic has an associated LPF that defines the drawing layers for that schematic.
For schematic 3D layout, the Drawing Layer 3d Properties settings determine how shapes draw in the schematic 3D view
with respect to z-position and thickness. See “Options - Drawing Layer 3D Dialog Box ” for details. The schematic 3D
view is a visual aid only and has no effect on simulation results, or extracted EM structures. How shapes draw in the EM
3D view, however, is determined by the STACKUP element used to generate the EM structure. The material thicknesses
and the EM Layer mappings in the STACKUP directly control how the 3D geometry is constructed for simulation.
In order to use the schematic 3D layout as a visual aide for setting up the 3D EM Extraction, the z-position and thickness
settings for schematic drawing layers must match the material thickness and EM Layer mapping in the STACKUP used
for extraction. Otherwise, the two 3D views are different. When the extracted EM structure is generated, a warning is
issued in the Status Window if there are any differences between LPF and STACKUP settings. You can resolve these
differences by running the Sync LPF with Stackup command.
1. In the Layout Manager, under Layer Setup, right-click the LPF and choose Sync LPF with Stackup.
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2. In the Update LPF from Stackup dialog box that displays, select the STACKUP element that you want to use for
Extraction.
3. Select the Update 3D attributes of mapped drawing layers check box, and then click OK.
These steps modify the 3D properties of thickness and z-offsets for all drawing layers that have EM mappings in the
STACKUP. In addition, the z-offset for the Bond Wires drawing layer (used to display the BWIRE element) is reset to
z=0, so the z-position of BWIRE elements can be set directly in the schematic, on a per instance basis. Unmapped drawing
layers are not modified; you may need to manually modify them in the Drawing Layer 3d Properties settings. The Update
LPF from Stackup dialog box also includes an Update 2D attributes of mapped drawing layers check box. Select this check
box to update the fill color and pattern for mapped drawing layers in the LPF to match the settings defined in the STACKUP
Material Definitions.

11.16.3. Z-Position
The z-position of all extracted elements must be correctly set to ensure connectivity in the Extracted EM structure.
• For a schematic pCell element (MLIN, for example) and dumb shapes, the z-position in the Extracted EM structure
is determined in the EM Layer Mapping table in the STACKUP used for extraction. See “Configuring Stackup” for
details on the STACKUP settings.
• For a 3D EM pCell (BWIRES, for example), z-position is set per instance.
• For schematic subcircuits, z-position is set per instance.
For 3D EM pCells and schematic subcircuits, you can set the z-offset as an absolute distance, or relative to the EM layer.
The position z=0 refers to the bottom boundary of the EM structure. In order to set z-offsets relative to an EM layer, the
schematic must contain an EXTRACT block that references a STACKUP. To set z-offset, in the schematic layout view:
1. Select an element in the layout.
2. Right-click the element and choose Shape Properties. The Cell Options dialog box displays.
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3. Click the Layout tab.
• If the EM layer drop-down list is grayed, there is not yet an EXTRACT block associated with the schematic, and
the z-position must be set as an absolute value in Offset. An Offset of "0" references the bottom boundary of the
EM structure.
• If the EM layer drop-down list is enabled, select an EM layer to set the z-position. The Offset is now relative to the
selected EM layer.

11.16.4. Boundary Shape
The default boundary conditions for extracted 3D EM structures is Perfect Conductor for the bottom boundary, and Approx
Open for all other boundaries. To add a boundary shape to the schematic layout to control exact boundary size and
conditions:
1. On any drawing layer, draw the Boundary shape. This shape must be a closed polygon.
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2. Select the shape, then right-click and choose Draw > Create Simulation Boundary. The shape transforms into a Boundary
shape.
3. Select the Boundary shape, then right-click and choose Shape Properties.
4. In the Properties dialog box, click the Boundary Conditions tab and set the boundaries. See “Specifying Simulation
Boundaries” for details.
5. Click the Layout tab. In the Em Extraction Options section, select the Enable check box and enter a Group name. This
step includes the shape as part of the extraction group.

11.16.5. EM Hierarchy
3D EM Extraction supports EM hierarchy, in which schematic subcircuits are extracted as EM subcircuits. Using EM
hierarchy allows subcircuits to be defined with a different LPF and STACKUP from the parent schematic. You can place
each instance of the subcircuit at a different z-position in the parent schematic.
To set up EM hierarchy:
1. Place an EXTRACT Block in the subcircuit schematic. The EXTRACT block should reference the STACKUP
representing the subcircuit.
2. In the schematic layout of the parent schematic, set the z-position for each instance in the Cell Options dialog box.
The following example illustrates the concept of EM Hierarchy. It consists of a chip connected to a board using bond
wires. The chip is defined as a subcircuit with its own LPF and STACKUP. It is selected for extraction along with bond
wires and board elements. In the schematic layout, the chip subcircuit is positioned to sit on top of the board.
EXTRACT
ID=EX1
EM_Doc="EM_chip_bondwire_board"
Name="EM_Extract"
Simulator=Analyst
X_Cell_Size=0.025 mm
Y_Cell_Size=0.025 mm
PortType=Default
STACKUP="Thick_Metal_module"
Override_Options=Yes
Hierarchy=Off
SweepVar_Names=""

PORT
P=1
Z=50 Ohm

BWIRES
ID=IC1
N=1
Dia=0.0254 mm
Rho=1

MLIN
ID=TL1
W=0.3 mm
L=.5 mm
2

BWIRES
ID=IC2
N=1
Dia=0.0254 mm
Rho=1

SUBCKT
ID=S1
NET="chip"
1 1

MLIN
ID=TL2
W=0.3 mm
L=.5 mm

2
1

2

PORT
P=2
Z=50 Ohm

In order to extract the chip subcircuit as an EM subcircuit, place an EXTRACT block in the chip schematic and reference
the STACKUP representing the chip. In the following figure, only the GSG pads are selected for Extraction.
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EXTRACT
ID=EX1
EM_Doc="EM_Chip"
Name="EM_Extract"
Simulator=Analyst
X_Cell_Size=0.025mm
Y_Cell_Size=0.025mm
PortType=Default
STACKUP="Thick_Metal_mesfet"
Override_Options=Yes
Hierarchy=Off
SweepVar_Names=""
AWR_MESFET_GSG_PAD
ID=GSG1
MSUB=GaAs

PORT
P=1
Z=50 Ohm
1

2

MLIN
ID=TL1
W=0.01 mm
L=0.2 mm
MSUB=GaAs

MLIN
ID=TL4
W=0.042 mm
L=0.1 mm
MSUB=GaAs

SUBCKT
ID=S1
NET="ckt"
1

PORT
P=2
Z=50 Ohm

2

2

1

AWR_MESFET_GSG_PAD
ID=GSG2
MSUB=GaAs

When the Extracted EM structure is created, the chip subcircuit is extracted as an EM subcircuit.

It is critical to preview the extracted EM structure before simulation to ensure that the geometry is correct. See “Viewing
Items for Extraction” for steps to generate the Extracted EM structure before simulation. The following is the Preview
Geometry view of this example, with the chip sitting on top of the board. The chip is defined with a different STACKUP
than the board.
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This concept of EM hierarchy is not the same concept as Extraction hierarchy. Extraction hierarchy is also supported for
3D EM Extraction. See “Extraction Through Hierarchy” for details.
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Chapter 12. EM: EM Editor
This chapter describes how to use EM structures in the Cadence® AWR Design Environment® platform when you create
the EM structures by themselves. Structures are generated by drawing shapes in an EM structure, importing DXF or
GDSII files, or copying layout from schematic layouts or artwork cell layouts. Note that this approach is covered in an
example in the "Using the Electromagnetic Simulator" chapter of the Microwave Office Getting Started Guide.

12.1. Creating EM Structures without Extraction
This section is organized in the order of the steps you take when creating a new EM structure.

12.1.1. Creating a New EM Structure
To create a new EM document:
1. Right-click EM Structures in the Project Browser and choose New EM Structure, or choose Project > Add EM Structure
> New EM Structure. The New EM Structure dialog box displays.

2. Enter a name for the EM structure, select an available simulator from the list, choose from the Initialization Options,
then click Create. An EM structure window opens in the workspace, and the Project Browser displays the new EM
structure and its subnodes under EM Structures.
You can generate new EM structures directly from DXF or GDSII files, see “Creating Shapes by Importing GDSII/DXF
Files” for more information.

Simulation and Analysis Guide 12–1

Creating EM Structures without Extraction

12.1.2. Initialization Options
When creating an EM structure, the initialization offers several options for the physical Stackup used (for example,
dielectric layers and conductors). This allows you to set up a structure's physical stackup once for a process rather than
for each new EM structure. You can always change Stackup properties after the EM structure is created. The initialization
can be the complete Stackup or a starting point.
There are three initialization options:
•

From Stackup: Cadence recommends this method because it allows the most flexibility. The other methods are supported
only for legacy designs. One or more STACKUP blocks (located under the Substrates category in the Elements

Browser) placed in the AWR Design Environment platform Global Definitions window are required to use this option.
You can place multiple STACKUP blocks with different configurations for different Stackup properties. When you
select this option, a Use Stackup drop-down list displays for selection of any of the enabled STACKUP blocks in
Global Definitions. For more information on configuring STACKUP blocks, see “Configuring Stackup”
•

From LPF:

You can define the global Stackup properties in LPF files. This information is entered between the
$EM_SETUP_BEGIN and $EM_SETUP_END statement sections. See “The Layout Process File (LPF)” for more
information. Since you can have multiple LPFs and multiple EM layer mapping settings in each LPF, when you select
this option there are options for choosing the LPF and EM mapping to use.

•

Default:

Uses the EM Stackup information in the default (first in the list) LPF in the project, and the first EM layer
mapping in the default LPF. This is the default setting since there is always an LPF and EM mapping in a project, but
not always STACKUP blocks in the project. This is a common option if the EM structure Stackup properties are
configured after the EM structure is created.

12.1.3. Simulator, Mesh, and Simulation Frequency Options
Each project has default frequencies (choose Options > Project Options and click the Frequencies tab) and simulator
specific options (choose Options > Default EM Options and click the Mesh tab, or the appropriate simulator tab). When
you create a new EM document it uses these default settings. If you change the defaults later, each EM document uses
the new settings. You can link the frequencies, mesh, and simulator options to the project default settings by right-clicking
the EM document in the Project Browser and choosing Options. On the Frequencies, Mesh, and specific simulator tabs
(for example, the AXIEM tab), select the Use project defaults check box in the upper left corner of each dialog box. Note
that making any changes to the defaults causes linked EM structures to resimulate.

12.1.4. Enclosure Size and Grid
After the EM structure is created, the next step is to set up the Enclosure size and grid. The definition of an Enclosure
differs in each EM simulator.
In the Project Browser, double-click the Enclosure node below the name of the EM structure. The Element Options ENCLOSURE Properties dialog box displays. The settings on the Enclosure tab are used differently for different simulators.
The ENCLOSURE properties describe the dimensions and resolution of the rectangular Enclosure. The Enclosure X-Y
dimension is defined on the Enclosure tab, and the height of the Enclosure is determined from the thickness of the dielectric
layers, which are defined on the Dielectric Layers tab. The resolution also defines the drawing grid for the structure. For
more information about the Enclosure tab, see “Element Options-(EM) ENCLOSURE Properties: Enclosure Tab”.
If using a third-party simulator for analysis, see the vendor documentation for details on selecting the x and y cell size
dimensions. For many simulators the grid size may have no effect on simulation accuracy or time.
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12.1.5. Stackup Properties
The additional tabs when double-clicking the Enclosure node below the name of the EM structure are for configuring
the properties of the EM Structure in the z-direction, such as dielectric layers or conductors. This setup is common for
several flows; see “Configuring Stackup” for more information on set up. If a STACKUP from the Global Definitions
is used to initialize the EM structure, additional setup may not be necessary.

12.1.6. Drawing Shapes in EM Structures
This section describes drawing and editing EM structures within the AWR Design Environment platform. Two methods
are available for editing the EM structure depending on the simulator (AWR simulators versus third-party simulators
integrated into the AWR Design Environment platform). If using AWR simulators, continue to the next section. The
first method of editing available with all the simulators that have been integrated via the EM Socket interface is the EM
structure Layout Editor (the AWR Design Environment platform Layout Editor). For third-party electromagnetic
simulators, the EM Socket integration may allow drawing and editing the EM structure in the third-party solver Native
Editor. Note that implementation of a Native Editor is optional for the third-party integration, and some vendors may
choose not to do so. In this case, only the AWR Design Environment platform editor is available.
The representations in the two editors are ensured identical. However, due to potential inconsistencies between the editors,
one of the two editors is defined as the default editor. This default editor holds the master definition of the geometry,
and the other (child) editor attempts to represent the geometry as closely as possible. For selection of the default editor
see “Options Dialog Box: General Tab”.
All changes to the geometry should be made through the default editor once selected. The child editor should only
represent a structure view. If the AWR Design Environment platform editor is the default, you can make the changes in
the Native Editor. On exiting the Native Editor you are prompted whether or not to change the default editor to the Native
Editor, make a best effort translation of the geometry, or cancel all changes. If you select the Native Editor as the default
editor, all the edit functionality of the AWR EM Layout editor is turned off, and it essentially becomes a geometry viewer.
You can change the default editor any time on the EM Options Dialog Box General tab and a best effort translation is
performed.
To open the Native Editor from the AWR Design Environment platform, right-click the EM document under EM Structures
in the Project Browser and choose Open in Native Editor. A new window opens with the solver's Native Editor. Note that
the AWR Design Environment program blocks all input until the Native Editor is closed. Documentation for using the
Native Editor should be available from the third-party solver vendor.
Locking EM Layouts
EM structures can be very long simulations, and any change to the layout prompts the simulation to restart. To prevent
accidental edits resulting in lost data, you can lock EM structures for editing. To lock an EM structure, right-click it in
the Project Browser, choose Options to display the Options dialog box, and then click the Locking tab. Several locking
options are available; the most common is Do not allow editing.
NOTE: This option only locks editing of the EM structure layout. It does not lock other settings that can prompt simulations
to restart such as frequency, mesh settings, boundary settings, and simulator options. Because these settings require you
to change and save them in an Options dialog box, there is little chance of making accidental changes with them.
AWR EM Layout Environment
This section describes the use of the AWR EM structure Layout Editor. Note that this editor is used for planar circuit
geometries and does not support editing or viewing generalized 3D objects.
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After specifying the Enclosure, you can create the structures with the appropriate Draw menu options or by using the
toolbar buttons. Before drawing shapes, you should understand the following sections.
EM structures use the same layout editor as the Schematic Layout Editor and the Artwork Cell Editor in the AWR Design
Environment platform. Each shape must have physical properties (dielectric layer number, conductor or via, and material
type) defined for simulation purposes. When editing an EM structure, you click on the Layout tab on the main window
to view the Layout Manager, as shown in the following figure.

These controls select the active layer for the EM structure for
viewing and adding new shapes to an EM structure.

Stackup Display pane.
Displays the location of metals and vias in the dielectric stackup

LPF Manager and Artwork Cell Manager. All the LPFs for the project and the
artwork cells are stored here.
Sets the active layer for drawing and editing shapes

Sets drawing to line type-based shapes instead of drawing
layer-based shapes in the layout
Controls the visibility by material and boundary selection in 3D view only.
Allows the scaling of EM Layers in 3D view
Controls the visibility of the shapes on an EM layer in layout and 3D view.
Status Display bar.
Displays the status of selected shapes in the EM document.

LPF Manager: All the LPFs (layer processing files) loaded in the program display here. A Default LPF is always loaded
into the program.
Artwork Cell Manager: Artwork cells (DXF or GDSII) imported or created in the AWR Design Environment platform
are listed here; see “Creating Artwork Cell Libraries” for details.
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EM Layers and Via Selection Pane: This selection pane sets the active layer for creating or editing shapes by the EM
layer properties (layer number, material type and conductor or via).
Stackup Display Pane: This is a cross-sectional view of the dielectric stackup. It also displays the location of conductors
and vias based on their EM layer.
Drawing Layer Pane: This selection pane sets the active layer for creating or editing shapes. Drawing layers are the
named layers used for creating shapes. Only those drawing layers that are assigned or mapped to EM layers are available
for creating shapes in an EM document. Drawing layers are assigned to EM layers through the EM layer mapping (see
“EM Layer Mappings” for details). The Drawing Layers pane has most of the same controls as the schematic layout
Drawing Layer pane (see “Drawing Layer Pane” and “Displaying Layers by Mapping Status” for more information.
Line Types Pane: This selection pane displays the line types defined in the LPF. You can select a line type to draw line
type-based shapes instead of drawing layer-based shapes in the layout. Line type shapes draw with all the layers and
layer offsets set in the Line Type definition in the LPF (see “Line Type Definitions” for information).

NOTE: If these panes are not initially visible, move the mouse to the bottom of the Stackup Display pane until the cursor
changes to a double-sided arrow, then click and drag upwards to expose the panes.
EM Layer Scale Pane: This pane allows the scaling of EM Layers for 3D viewing. You can scale the layers by entering
the scaling factor or by adjusting the slider by scrolling the mouse wheel. Selecting Scale All Layers applies the scaling
factors to all the layers. Selecting Scale Via Only applies the scaling factors to vias only. The Reset button resets the scaling
factor to the values at which the project was last saved. Note that the change is reflected in the Draw Scale column on the
Dielectric Layers tab of the Element Options-(EM) ENCLOSURE Properties dialog box.

Visibility By EM Layer: Turn on and off the visibility of the shapes on an EM layer in both the EM layout and 3D view.
Clear the check box in the Visible column to hide the shapes on an EM layer. Right-click in this pane for a menu with
options to show/hide the shapes on all the EM layers at once. Mapped Drawing Layers gives you more information on
which drawing layers are currently mapped to that numbered EM layer.
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Visibility By Material/Boundary: This pane turns on and off the visibility of shapes by their material properties in 3D
view only. Right-click in this pane for a menu with options to set the visibility by conductor or via or the boundary.

Status Display Bar: The Status Display Bar displays information such as dimension, area, drawing layer name, EM
layer, and the material type for a selected shape.
Drawing Shapes by Stackup Parameters
Once you completely define your Stackup properties, you can draw a conductor or via by selecting a Material and EM
Layer. You do not need to set up the EM mapping and you can choose any material to draw either as a conductor or via
with any extension. A shape is drawn on an EM layer and since it does not have a corresponding Drawing layer or material
in the mapping table, a new Drawing layer is automatically created in the form of +Lay_<layer number>_<material
type>_<shape type> where:
<layer number> = physical layer of the shape
<material type> = material type of shape, using only valid materials defined for that structure
<shape type> = COND for conductor and VIA for a via.
For these auto-generated layers, the EM mapping is automatically set in local EM mapping (the EM Layer Mapping tab
in the Element Options - ENCLOSURE Properties dialog box). The EM mapping for auto-generated layers cannot be
altered from the local EM mapping.
Drawing a Conductor: Conductors are created by selecting the EM Layer and Material. Depending on the EM layer and
material selected, the conductor displays in the Stackup Display pane as shown in the following figure.
NOTE: You must select an EM layer and material to draw a shape. The following figure indicates that there is no prior
EM mapping table set, as there is no drawing layer displayed in the Drawing Layers display pane.
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Select EM Layer
Select Material
Select Conductor

Conductor displayed on EM Layer 3

After selecting the conductor, you can add a new conductor shape by choosing Draw and a menu option for a shape such
as Rectangle, Polygon, Path, or Ellipse. These drawing options are also available on the Draw Tools toolbar using the
following buttons.

After the conductor shape is created, a drawing layer (as explained in a previous section) is automatically created as
shown in the following figure.
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Conductor drawing layer
is automatically created

Drawing a Via:Vias are used for connecting shapes on different layers. To draw a via, select an EM Layer, select Via,
and select an Extent number as its extension into layers, as shown in the following figure. Select a different Extent number
and notice how the via extension changes in the Stackup Display pane.
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Select EM Layer

Select Via and Extent number

Via through EM layers 3 and 4 displayed
as a result of selecting 2 as Extent

Automatically created via drawing layer

After the via is selected, to add a new via shape, choose Draw > Rectangle or any desired shape option. These drawing
options are also available on the Draw Tools toolbar.
Drawing Shapes by Drawing Layers
If EM mapping (see “EM Layer Mappings”) is already set for drawing layers, simply select the drawing layer in the
Drawing Layers display pane and draw the shapes. The shapes are drawn in their corresponding EM layers; you do not
need to select the EM Layer and Material
Drawing a Conductor: Select a drawing layer defined for conductor. The location of the layer in the stackup displays
in the Stackup Display pane as shown in the following figure, where the selected layer shows an arrow next to the layer
name.
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Drawing a Via: When an EM mapping is set up for Via, you can draw the via by simply selecting the drawing layers
displayed in the Drawing Layers display pane, or as previously explained. A via must be at least one cell wide. The length
of a via is the same as the dielectric layer thickness. The top and bottom of the via are meshed as normal planar conductors,
so it is not necessary to overlap a connecting planar conductor with the via. The current carried in the via is modeled as
uniform z-directed volume current. The Via model assumes that the length of the via is relatively short compared to the
wavelength. If the structure requires the via to be relatively long compared to the wavelength, the substrate should be
split into several "thin" dielectric layers so that the via is modeled by several shorter vias stacked on top of each other.
The following figure shows the via position and extension based on the EM Layer and Extent.
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Drawing Shapes by Line Types
In the Line Types pane, select a line type and then draw the line type-based shape. Line type shapes draw with all the
layers and layer offsets set in the Line Type definition in the LPF (see “Line Type Definitions” for information). For
information about line type mapping, see “Line Type Mapping”.
Displaying Layers by Mapping Status
The Drawing Layer pane shows the status of a drawing layer. Depending on the EM layer mapping settings, the display
warns of conditions such as when the material name used is missing for the EM document, or when the EM layer
corresponding to a drawing layer is missing in the EM document, or when no EM mapping is set up for the drawing
layer. To display a tooltip with layer details, hover the cursor over the color for the layer.

The missing material and missing layers are seen as errors, since the attempted EM mapping is not valid. These drawing
layers display in the Drawing Layer pane with a red X over the fill pattern. The absence of an EM mapping setup for the
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drawing layer is not considered an error, but simply as a decision not to set up mapping for that layer. These drawing
layers display in the Drawing Layer pane with a blue X over the fill pattern. The following figure shows these cases.

When you click on a drawing layer, the area above displays messages about the layers.
The EM Drawing Layer pane toolbar includes an additional button named Show unmapped layers:

With you click this button, the unmapped layers display in the pane with a blue X on the layer name.
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Additionally, sorting by the Actv column sorts by the EM mapping status. For more information, see “Displaying Layers
by Mapping Status”.
To only display shapes on drawing layers with errors, sort by the first column and then turn off the visibility for the
layers you do not want to see.
Creating Shapes by Importing GDSII/DXF Files
You can generate new EM structures from DXF or GDSII files (see “Importing GDSII/DXF as an EM Structure” for
more information).
Defining Shapes by Copying Artwork
There are cases where the shapes for EM structures come from a DXF or GDSII Artwork Cell Library:
• You are drawing geometry directly in a DXF or GDSII library in the AWR Design Environment platform.
• The DXF or GDSII library you are using has multiple top level cells. You cannot directly import such file structures
into an EM structure, so you must first import them into the Artwork Cell Editor and then copy and paste them into
an EM structure layout.
To copy DXF or GDSII Artwork Cell Library shapes to an EM structure:
1. Open the cell from the library.
2. Select the shapes you want to copy to the EM document (or use Ctrl-A to select all).
3. Copy the shapes (Ctrl+C or choose Edit > Copy).
4. Create a new EM structure and size the Enclosure based on the dimensions of the artwork cell.
5. Paste the shapes into the EM document (Ctrl-V or choose Edit > Paste).
The shapes in DXF and GDSII files do not have the physical properties (for example, dielectric layer, material type, and
whether or not it is a via) defined for them so you must define these properties. See “Cleaning Up EM Layer Mapping”
for more information.
Selecting Shapes
To select a shape, simply click it. To select multiple shapes, Shift-click the shapes. Alternatively, you can select multiple
shapes by clicking outside of the shapes and dragging a selection box. To select a shape from amongst overlapping
shapes, hold down the Ctrl + Shift keys and click the overlapping shapes multiple times until the correct shape is selected.
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Editing Shape Properties
Select a shape in the EM structure, right-click and choose Shape Properties or choose Edit > Shape Properties. Click the
Layout tab to edit shape properties such as the EM Layer and Material, and to switch between Conductor or Via. Change
the mesh property on the Mesh tab. For more information about this dialog box, see “Properties Dialog Box: Layout
Tab”.
Editing Shapes
Because the EM Layout Editor is the same as the Schematic Layout Editor, all of the schematic layout editing functionality
is also available for EM layouts. For information on all of the edit commands available in layout Draw tools, see
“Schematic/EM Layout Draw Tools ”.
Trimming with EM Clip Region
See “Trimming with EM Clip Region” for more information.
Clipping Shapes in Schematic Layout and Creating an EM Structure
See “Clipping Shapes in Schematic Layout and Creating an EM Structure” for more information.
Moving Shapes to Different Layers
You can move selected shapes to different layers by clicking the Move Up or Move Down buttons on the toolbar. The
material does not change.

12.1.7. Using Ports
Ports are required to define the external connections to the EM structure. See “Adding EM Ports” for details on adding
and editing EM ports. Each simulator handles ports differently. (See “EMSight Ports ” for port specifics for EMSight,
“AXIEM Ports ” for specifics for Cadence AXIEM® 3D planar EM analysis ports, and “Analyst Ports” for information
about Cadence Analyst™ 3D FEM EM analysis ports.)

12.1.8. Using a 3D Layout
The 3D layout of an EM structure is used for many things including:
• Visually verifying what shapes will be simulated.
• Visually verifying that the structure is correct in terms of shapes being conductors or vias.
• Displaying many of the annotations for EM structures (such as mesh, current, and E-fields).
To open a 3D layout of an EM structure, first open the 2D layout of the structure by double-clicking it in the Project
Browser. Next, with the 2D layout window active, choose View > View 3D EM Layout or click the View EM 3D Layout button
on the EM Layout toolbar. You can open several 3D layouts of the same EM structure to view different annotations on
different 3D layout views (for example, the mesh on one view and the current on a second view). To open additional 3D
layouts, with the 3D layout window active, choose Window > New Window or click the New Window button on the Standard
toolbar.
You can rotate the 3D view by clicking in it and dragging it. To change the viewing orientation, choose View > View From
and choose an orientation such as bottom, back, left, or right, or use the corresponding toolbar buttons.
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You can also change the view angle by pressing the Ctrl key while double-clicking in the layout window. The view you
use is determined by where in the 3D layout window you click. The 3D layout window is first divided into two regions,
as shown in the following figure.

The inner region outlined in red is the bounding box of the shapes for the 3D layout. The outer region is between the red
bounding box and the window edge defined by the blue box.
The following figure shows the approximate areas within the inner region that define the view when you click in them.
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The following figure shows the approximate areas within the outer region that define the view when you click within
them.

The following figures show several different 3D EM Layout (AXIEM - Async) views for the same EM structure.
Ortho Top Left
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Ortho Top Right

Top
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12.1.9. Setting Frequencies
Each EM structure in the project has its own frequency range. In addition, the project also has a specifiable frequency
range. You can use the project frequency range for an individual structure by selecting the Use Project Defaults check
box on the Options dialog box Frequencies tab.
You can specify the project frequency range by double-clicking Project Options in the Project Browser and clicking the
Frequencies tab. See “Project Options Dialog Box: Frequencies Tab ” for more information.
If the project frequencies are overridden, the EM structure is only simulated at the specified frequencies.
You can specify the EM structure's frequency range by selecting the EM structure in the Project Browser, right-clicking
and choosing Options. The Options dialog box displays with a Frequencies tab. See “Options Dialog Box: Frequencies
Tab” for more information.
If an EM structure is used in a schematic that has a different frequency range, or a measurement on the EM document
requires another set of frequencies, these frequencies are interpolated or extrapolated from the specified frequencies
using the options specified on the Interpolation/Passivity tab of the Project Options dialog box. See “Project Options
Dialog Box: Interpolation/Passivity Tab ”for more information.
In the Options dialog box you can also set the meshing frequency for the simulation. You can select the Use Maximum
Frequencycheck box to set the meshing frequency equal to the highest frequency in its set of simulation frequencies.
Alternatively, you can specify the meshing frequency explicitly, although the meshing frequency entered must be greater
than the highest simulation frequency. Not all simulators integrated via the EM Socket use the meshing frequency to
determine the mesh. EMSight always uses the highest simulation frequency when determining the mesh and thus does
not use the meshing frequency option. When using an alternative third-party EM simulator, you should consult the
documentation provided by that vendor to determine if this option is used.
Advanced Frequency Sweeps
Some EM simulators have advanced frequency sweep capabilities, also called fast frequency sweeps and other names.
The basic capability is a simulation mode where you specify the start and stop frequencies and the simulator determines
the frequencies needed to obtain an accurate response. Each simulator has different capabilities. See the associated
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documentation for each solver for these capabilities. (See “Advanced Frequency Sweep (AFS) ” for AFS specifics for
EMSight and “Advanced Frequency Sweep (AFS) ” for AFS specifics for AXIEM software).
Exporting EM Structures
If exporting an EM structure for use in another project, Cadence recommends that you set your frequencies on the EM
structure rather than using the project defaults. If using the project defaults, the structure usually needs to be simulated
again to get the proper response for the project frequencies.

12.1.10. Meshing
EM simulators must mesh the shapes in the structure for simulation. The mesh is critical for getting accurate answers
and also for solving the problem in a reasonable amount of time. You can control EM structure mesh at the following
three levels:
1. Project level options that apply to all EM structures in the project .
2. EM structure options that apply to only the current EM structure .
3. Shape options that apply to only the current shape in an EM structure .
Each simulator has different controls and considerations for meshing. See the simulator-specific pages on meshing for
more detail. (See “Conductor Meshing” for specifics for EMSight and “AXIEM Meshing” for specifics for AXIEM
software.)

12.1.11. Importing and Linking to EM Structures
The following sections discuss importing and linking to EM structures that have previously been exported, and importing
GDSII/DXF as an EM structure.
While importing an EM structure, the simulator is automatically set to EMSight, however, you can change this after the
import is complete.
Importing EM Structures
To import an existing EM structure (that was previously exported):
1. Right-click EM Structures in the Project Browser, and choose Import EM Structure.
2. In the dialog box that displays, locate the desired EM structure. EM structures have an .eml extension.
If the simulation of the structure was complete when the structure was exported, the simulation results are stored in the
project. Cadence recommends setting the frequency list local to the EM structure when exporting EM structures. If using
the global frequency list, the imported project might have a different frequency list than the exported project, thus causing
the EM structure to simulate again.
Linking To EM Structures
To link to an existing EM structure (that was previously exported):
1. Right-click EM Structures in the Project Browser, and choose Link To EM Structure.
2. In the dialog box that displays, locate the desired EM structure. EM structures have a .eml extension.
NOTE: When an EM structure is linked, the linked file must always be available for the project to read.
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Importing GDSII/DXF as an EM Structure
You can directly import into an EM document GDSII/DXF that contains only one cell. If the GDSII or DXF file contains
multiple cells, you should import the file as a library in the Layout Manager under the Cell Libraries node and then copy
the shapes into the EM document as explained in “Defining Shapes by Copying Artwork”.
To import GDSII or DXF into an EM document:
1. Right-click EM Structures in the Project Browser and choose Import GDSII or
browse to the location of the GDSII or DXF file and click Open.

Import DXF. In the dialog box that displays,

2. Enter a name for the EM structure, select an available simulator from the list, choose an appropriate Initialization Option
(see “New EM Structure Dialog Box”), and then click Create.
3. If the project does not have corresponding drawing layer names for the layer names in the file, the AWR Design
Environment software automatically creates these drawing layers. Click OK to accept this auto-generation.

4. An EM structure window opens in the workspace, and the Project Browser displays the new EM structure and its
subnodes under EM Structures.
5. If you have proper EM mapping set up (see “EM Layer Mappings” ) the shapes are automatically mapped to correct
EM layers. If you do not have EM mapping set up then you need to assign the material properties and EM layer for
all of the shapes. See “Cleaning Up EM Layer Mapping” for more information.

12.1.12. Exporting EM Structures
NOTE: Importing an EM structure into another project using the Import Project command is generally more efficient
than using the following export process. See “Importing a Project ” for more information.
To export an EM structure along with its Enclosure, dielectric stackup, and the material properties information so it can
be simulated in other projects without any set up, right-click the EM structure in the Project Browser and choose Export
EM Structure. The Save As dialog box displays. Specify where you want to export the EM structure and enter the file
name under which you want to save it. This file can only be imported into the AWR Design Environment platform.
You can also export the shapes in an EM structure to any of the supported artwork file types. There are two ways to
export, depending on how the EM structure is set up.
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Exporting from Schematic Layout
If your EM structure is configured to use the drawing layers for your process, the simplest way to export the layout is to
use the EM structure as a subcircuit in a schematic layout, and then export the layout for the schematic. You can determine
if this approach works by placing an EM structure in a schematic and verifying that the layout shapes all draw on the
proper layers. See “Exporting the Layout ” for more information about exporting a schematic layout.
Exporting from EM Layout
If your EM structure is not configured to use the drawing layers for your process you should export from the EM layout.
This typically occurs if shapes are simulated using the EM properties (for example, EM layer and material) without
worrying about the layer name. Another clue is that the drawing layer names for shapes in the EM structure begin with
the "+" symbol. In this case, you should perform these steps to export the layout for the EM structure:
1. Choose Options > Environment Options, click the Layout tab and ensure that Show EM Document's LPF is selected, then
close this dialog box.
2. Click on the Layout tab to display the Layout Manager, then double-click the LPF name for the EM structure you
want to export. The LPF is listed under the Layer Setup node and has the same name as the EM structure with a "+"
symbol preceding the name.
3. Configure the proper export mapping (GDSII, DXF, Gerber, etc). See “Exporting the Layout ” for more information
on setting up this mapping.
4. Right-click the EM structure in the Project Browser, choose Export Layout, and select the file format.
A common problem is that the layer names can contain "+" symbols, which is not allowed in some other programs that
read DXF files. To avoid this problem:
1. When setting up the export mapping, provide layer names that do not use these characters.
2. Choose Options > Layout Options, click the Export/LPF tab and select the Remove illegal chars in layer names check box.

12.1.13. Cleaning Up EM Layer Mapping
When generating EM structures by importing DXF or GDSII files or copying shapes from an artwork cell layout, typically
the EM mapping needs to be corrected before simulation can occur. You should view the 3D layout of any EM structure
to see all the shapes that currently have EM layer mapping. There are several ways to correct EM layer mapping after
shapes are added to an EM structure so the shapes simulate with the proper physical properties.
Changing Shape Properties
Select the shape inside the EM document, right-click and choose Shape Properties. In the Properties dialog box, choose
an appropriate EM layer and Material and specify whether it is a conductor or a via.
For many shapes:
1. Right-click in the Drawing Layers pane and choose Show Shapes on Unmapped Layers to display all layers in your
process. If a layer name displays a blue X in the first column, it does not have a mapping set up.
2. Right-click in the Drawing Layers pane and choose Hide All Shapes to turn off the visibility for all of the drawing layers.
3. Go through the drawing layers list and turn on each unmapped layer. For layers with shapes, select all the shapes in
the layout (Ctrl+A), right-click and choose Properties to change the electrical properties for all the selected shapes.
The advantage of this procedure:
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• It is a simple use of the user interface to change the properties for a shape, especially when there are few shapes.
The disadvantages of this procedure:
• Must be done per shape, so is difficult when there are many shapes.
• Not guaranteed to map the shapes to a drawing layer in the current list. It uses a derived layer (beginning with a "+"
character) if EM layer mapping does not exist for the properties set. This is acceptable if you do not use your EM
structure as a subcircuit in a larger design and want the layout to be correct for your process.
• Fixes the EM layer mapping for this structure only. If there are others you need to perform the same process again.
Changing EM Structures EM Layer Mapping
You can change the EM layer mapping for the EM structure as explained in “EM Layer Mappings”.
The advantage of this procedure:
• It is very simple to change the EM layer mapping for each drawing layer.
The disadvantages of this procedure:
• Fixes the EM layer mapping for this structure only. If there are others you need to perform the same process again.
Changing the Parent LPF EM Mapping
To change the Parent LPF EM mapping after creating the EM structure:
1. Open the EM layer mapping from the LPF used to create the EM structure.
2. Configure the EM layer mapping in this LPF. When complete, close the dialog box.
3. Right-click the edited LPF and choose Update Dependent LPFs.
4. In the dialog box that displays, select the EM structures to update and then click OK.
The advantage of this procedure:
• Changes the EM layer mapping for the entire project, so other EM structures can use this same mapping.
The disadvantages of this procedure:
• Can be difficult to perform, since editing the EM layer mapping in the LPF is more difficult because the dielectric
layers and materials are not defined. You must type in the dielectric layer and materials exactly for this to function.
• If you have multiple LPFs in your project or multiple EM layer mappings in an LPF, it can be difficult to know which
one to update.

12.1.14. Disabling EM Structures for Simulation
To stop an EM structure from being computed, right-click the structure in the Project Browser and choose Toggle Enable
EM Structure.

12.1.15. Forcing Resimulation
When an EM structure completes simulation, the results are stored in the structure until a change in the structure prompts
it to simulate again. Under some circumstances, you may want to force the structure to simulate as if it were a newly
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created structure. To force resimulation, right-click the structure in the Project Browser and choose Force Resimulation
or press the Shift key while clicking the Analyze button on the toolbar.

12.1.16. Using EM Structures in a Schematic
EM structures are added to schematics as subcircuits in the same way other subcircuits are added. The port numbers in
the EM structure correspond to the port numbers of the subcircuit. When used as a subcircuit, the S-parameters of an
EM structure are used in the schematic simulation. The layout for the EM subcircuit is generated from the EM structure
layout by setting up EM mapping as explained in the “AWR EM Layout Environment”.

12.2. Configuring Stackup
An essential step in performing an EM simulation is definition of the physical Stackup of the structure. There are two
places you can specify Stackup information:
• Double-click the Enclosure node in the Project Browser under any EM structure.
• Place a STACKUP block in a schematic or in the Global Definitions window and double-click the model. The
STACKUP model is located in the Elements Browser in the Substrates category.
The dialog box that displays has several different tabs. The common tabs are described in the following sections.

12.2.1. Material Definitions
The bulk material properties define dielectric, conductor, and impedance material properties. To specify the bulk materials
properties, click the Material Defs tab on the ENCLOSURE Properties dialog box.
Dielectric Properties
Dielectrics define properties such as relative permittivity and loss tangent. The following table lists common dielectric
substrate material properties.
Material

Dielectric Constant

Loss Tangent

Air

1.0

0

Alumina

9.8

<0.0015

Quartz

3.78

<0.0001

Silicon

11.9

~0.003

Gallium Arsenide

12.9

0.001

RT Duroid(R) 5880

2.20

<0.0009

RT Duroid(R) 5870

2.33

0.0012

RT Duroid(R) 6006

6.15

0.0019

Conductor Definitions
Conductors define the conductivity of a material. The following table lists common conductor material properties.
Material

Conductivity

Silver

6.14x107

Copper

5.88 x 107
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Material

Conductivity

Gold

4.10 x 107

Aluminum

3.53 x 107

Nickel

1.47 x 107

Impedance Definitions
Impedances define the resistive (low and high frequency) properties of a material. The Low frequency parameter specifies
the DC resistance (ohms/square) of the planar conductor. The DC resistance is used, assuming there is a uniform current
distribution in the cross-section of the conductor. The DC resistance is typically set to the following value where σ is
the conductivity of the conductor and t is the thickness.

1
RDC = σt
The high-frequency loss coefficient specifies the loss associated with the conductor at frequencies where the thickness
of the conductor is significantly thicker than the skin depth. Since the loss associated with the skin depth effects are
proportional to the square root of frequency, the skin depth loss coefficient is multiplied by the square root of frequency
to provide an ohms/square value that is used for loss computations. The high-frequency loss coefficient is multiplied by
a (1+j) factor to represent the equal real and imaginary components of the surface impedance that is associated with the
skin depth phenomena. The high-frequency loss coefficient is given by:

RH F =

μ
πσ

At low frequencies, the DC resistance is used in the computation of conductor loss, while at high frequencies the
high-frequency loss coefficient is used to compute conductor loss. In the transition region (frequencies where the skin
depth is close to the thickness of the conductor) both factors are used.
The Excess surface reactance is used to model the reactance associated with superconductors. You should not use it for
normal conductors.
For more information about the Material Defs tab on this dialog box, see “Element Options-(EM) ENCLOSURE Properties
Dialog Box: Material Defs. Tab”.

12.2.2. Frequency-dependent Material Definitions
You can define several parameters in the STACKUP as equations to specify frequency-dependent parameters. The
following parameters can be defined as a function of frequency:
• Er
• TanD
• Ur
• TanM
• ResSq
• React
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Frequency-dependent Equations
You can define both frequency-independent and frequency-dependent equations in the STACKUP. Frequency-independent
equations use the same syntax as equations defined elsewhere in the AWR Design Environment platform. See “Equation
Syntax” for equation details. Note that frequency-dependent equations defined in the STACKUP have the following
limitations:
• _FREQ is the only variable that can be used in the equation.
• Only global constants _PI and other constants defined using the built-in function constants() are supported.
• Built-in math functions are supported, but other functions such as vector(), complex(), and swept() are not recognized.
• Equations must be real. Complex equations are not supported, and the imaginary numbers "i" and "j" are not recognized.
• Yield, tuning, and optimization are not supported since variables are not supported.
In order to simplify complex equations, the following functions are defined for the STACKUP element only:
STACKUP Function

Description

rePole(reA,imA,reB,imB) Real part of (1/(A+B)) where A and B are complex numbers and reA and reB are the
real parts of A and B respectively, and imA and imB are the imaginary parts of A and B
respectively.
imPole(reA,imA,reB,imB) Imaginary part of (1/(A+B)) where A and B are complex numbers and reA and reB
are the real parts of A and B respectively, and imA and imB are the imaginary parts of A
and B respectively.
reLog(reA,imA)

Real part of the natural logarithm of A where A is a complex number and reA is the real
part of A and imA is the imaginary part of A.

imLog(reA,imA)

Imaginary part of the natural logarithm of A where A is a complex number and reA is the
real part of A and imA is the imaginary part of A.

Specifying Frequency-dependent STACKUP Parameters
To specify a frequency-dependent material parameter, enter the frequency-dependent equation in the parameter field in
the STACKUP. For example, you can enter the equation 3.8 + 0.05*(reLog(1.6e11,_FREQ)-reLog(1.6,_FREQ)) for
Er.
Frequency-dependent parameters can only be defined as a real equation that is a function of _FREQ. If a parameter is
specified as a table of values versus frequency, the table of values must be curve-fitted to an equation.
Verifying Stackup Values
Cadence recommends that the frequency-dependent equation also be implemented as an output equation that is plotted
to a graph to verify the frequency response of the equation. Furthermore, after AXIEM simulation, the Status Window
includes a link to open a text file with the naming convention ProjectName_DocumentName_FreqMatlParams.txt. This
file contains a table of parameter values versus frequency used in simulation. You can copy and paste the contents of
the file directly into a new text data file, and plot it to a graph using the PlotCol measurement. The column headers in
this file are already set up appropriately for plotting. A similar text file is also provide for Analyst software simulations.

12.2.3. Dielectric Layers
The stackup must contains a minimum of two dielectric substrate layers. The following figure shows a 3D view of a
multi-layer structure.
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Often the top dielectric layer is set with the properties of air (or a vacuum), although this is not necessary. There is no
practical limit on the number of dielectric layers that can be included in the Enclosure. The height of the Enclosure is
the sum of all the dielectric layer thicknesses.
To enter the substrate layers, click the Dielectric Layers tab on the ENCLOSURE Properties dialog box. To insert a
dielectric layer click Insert to add new layers below the selected layer, or Delete to delete the selected layer.
The boundary conditions for the top and bottom of the Enclosure are user-defined.

You can also edit the top and bottom boundary settings on this tab.
For more information see “Element Options-(EM) ENCLOSURE Properties Dialog Box: Dielectric Layers Tab”.

12.2.4. Conductor Materials
The materials properties defined on the Material Defs tab are assigned to conductors on the Materials tab. Click the Materials
tab to specify a conductor name. Each conductor is assigned one of the named materials from this dialog box. You can
always use the default conductor "Perfect Conductor" (a perfect conductor material) for a material property.
For a conductor, the thickness only affects the loss characteristics if the material is defined as a conductor on the Material
Defs tab. Impedances already define their loss characteristics.
You can set a conductor thickness as negative so that the corresponding shape is formed by extruding toward the bottom
boundary. The structure is still physical and the real conductor has a positive thickness.
For more information see “Element Options-(EM) ENCLOSURE Properties Dialog Box: Materials Tab”.
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12.2.5. EM Layer Mappings
EM layer mapping determines how the shapes in an EM layout are used in EM simulation. It also determines the visibility
of the EM structures when used in a schematic layout. There are three common use models:
• EM simulation, but not using the EM structure in a schematic layout. In this case, EM layer mapping does not apply.
When drawing shapes in EM layout, you set the EM layer and material for each shape and the software manages the
EM layer mapping.
• EM simulation, and also using the EM structure in layout. The EM layer mapping is necessary to create the connection
between the drawing layer name in the schematic layout and the physical EM properties for shapes on that layer. In
this model you can use the EM structure as a subcircuit in schematic layout, and make it display properly.
• Extraction flow requires EM layer mapping since the shapes in schematic layout use drawing layers. EM layer mapping
determines how the shapes in a schematic layout are sent to the EM structure and simulated during the extraction
process.
Note that in a 3D view of the EM structure you only see shapes that have EM layer mapping configured.
There is a slight difference between editing these properties from the Enclosure node of an EM structure and editing the
Active EM Mapping and LPF Name on the EM Layer Mapping tab of the Element Option: STACKUP dialog box. The EM
structure Enclosure does not need to set either of these properties because the mapping is stored in the EM structure. The
STACKUP block sets up EM structures based on the EM Layer Mapping tab settings. Since a project can have more than
one LPF (although not commonly) and each LPF can have more than one EM layer mapping setup, the STACKUP block
allows you to select which mapping you want to set up. It is the same whether you set up the EM layer mapping in the
STACKUP block or in the LPF. Cadence recommends using the STACKUP for several reasons:
• The values for the Material are included in a drop-down box because they are already defined. When editing in the
LPF directly, you must type in these names exactly.
• You can visualize in the cross-sectional view where the mapping places the conductor or via in the physical stackup.
The LPF editor does not define a stackup, so you don't have this visual.
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For more information on the EM layer mapping of an EM structure, see “Element Options-(EM) ENCLOSURE Properties
Dialog Box: EM Layer Mapping Tab”. For more information on the EM layer mapping of a STACKUP block, see
“Element Options-(Schematic) STACKUP Properties Dialog Box: EM Layer Mapping Tab”.

12.2.6. Line Type Mapping
Line type mapping is used for the shapes defined by line types, and is typically only used for extraction. Line Type
mapping addresses common situations such as when an object in layout needs to be drawn with many layers for processing
purposes, but only needs to simulate as one shape in EM structures. For example, a plated line in a Monolithic Microwave
Integrated Circuit (MMIC) process, where the line typically consists of a bottom metal, a dielectric etch layer, and a top
metal layer. In EM structures, this line is more efficient to simulate as only one shape.
When drawing shapes in an EM structure, you can tell shapes to use Line Types (this is not very common). See “Drawing
Shapes by Line Types”. Line type mapping defines how this line type is simulated.
During the extraction flow, some items in schematic layout use line types that include line models such as microstrip
lines and stripline, and any shapes drawn in layout with the Use Process Layer option selected. Extraction only uses Line
Type mapping if Extract_LineTypes on the EXTRACT block is set to "Yes". If set to "No", all of the different shapes
for any objects using line types are flattened in the EM layout and only EM layer mapping is necessary.
For more information see “Element Options-(EM) ENCLOSURE Properties Dialog Box: Line Type Tab”.
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12.2.7. EM Layer Mapping vs. Line Types
Each STACKUP element has an Element Options: STACKUP dialog box with EM Layer Mapping and Line Type tabs,
both of which you use to define the physical properties (conductor properties, conductor location in STACKUP) used
for EM simulation. Each simulator type and situation differs. Only EM simulators use EM Layer mapping. The ACE
simulator only uses Line Type mapping. EM simulators use Line Type mapping if the EXTRACT block Extract Line
Type parameter is set to "Yes". If Line Type mapping is set, but EM Layer mapping is empty, EM simulators use Line
Type mapping when the EXTRACT block Extract Line Type parameter is set to "No". This is because in this case it
flattens the shapes using Line Types into dumb polygons for the EM structure, and these polygons are mapped to existing
drawing layers.

12.3. Adding EM Ports
Ports are used to model the input and output terminals of EM structures. The physical representation of the port, and the
method by which the port is excited is dependent on the EM solver. See “AXIEM Ports ” and “Analyst Ports” for details
on how each solver models the following EM ports.
The Draw menu includes commands for adding ports, and the EM Layout toolbar contains buttons for adding EM ports.
Not all simulators support all port types; the command or button is grayed out when the port type is not supported.

You can quickly add ports in succession by first enabling command repeat mode before using an Add Port command.
When in command repeat mode, a new port is added with each mouse click until you exit the mode.
Port numbering is automatic; the port numbers increase as you add ports. To change a port number, double-click the port
to open the Properties dialog box and edit the Port Number. See “Editing EM Ports” for more information about editing
port properties.

12.3.1. Adding Edge Ports
Edge ports are added to any edge of a conductor.

To add an edge port, choose Draw > Add Edge Port or click the Edge Port button on the EM Layout toolbar. Move the
cursor over any side of any shape and an outline of the port displays. Click to place the port.
To move an edge port, select it and drag it to another edge on the same shape. The outline of the port displays. Release
the mouse to place it on that edge.
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12.3.2. Adding Point Ports
Point ports are small ports added to the centroid of any conductor.

To add a point port, choose Draw > Add Point Port. Move the cursor over any shape and an outline of the port displays.
Click to place the port in the center of the shape. You can also add point ports to multiple shapes at once by selecting
more than one shape and choosing Draw > Add Point Port.

12.3.3. Adding Internal Ports
To add an internal port, select the polygon that you want to be the negative terminal for the internal port, then choose
Draw > Add Internal Port. Move the cursor onto the edge of the polygon where you want the port (an outline of the port
displays) and click to place the port. The positive terminal of the internal port displays a "+" sign as shown in “Internal
Port Example”. This example also shows how to properly wire schematics that use an EM structure with an internal port.
Note that you cannot add reference plane extensions to internal ports.

12.3.4. Creating Ports from Subcircuits
You can auto-add ports to EM subcircuits by selecting the subcircuits and choosing Draw > Create Ports from Subckt. EM
ports are automatically added at all possible locations. If the subcircuit already has some ports attached, this command
adds ports at all remaining locations. If the original EM structure contains differential ports, this command also adds
differential ports to subcircuit instances of the EM structure. All other port attributes or groupings in the original EM
structure are not included with the ports added to the subcircuit instance. This command only adds ports to locations
defined one level down in hierarchy; it cannot add ports to locations defined down multiple levels of hierarchy.

12.3.5. Setting Reference Planes
To set the reference plane of a port, select the port, click the reference plane highlighted at the flush end, and drag it with
the mouse. The arrow shown in the following figure displays, the end of which defines the new reference plane. If the
reference plane coincides with the port edge, the arrow is not visible. You can also type in the exact physical distance
you want for your reference plane. Double-click the port to open the Properties dialog box and change the Ref. Plane
Distance.
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12.3.6. Setting the Port Excitation or Termination
The computation of the port parameters does not depend on the excitations or terminations at the ports, however, the
current annotations depend on these settings. To set the port excitation or termination, double-click the port to display
the Properties dialog box.
You can specify the port as an excitation or termination port. For an excitation port, you can set a relative magnitude
and angle for the port excitation along with the source impedance. Note that the magnitude of the excitation is described
by an available power, meaning that if the port is conjugate-matched to the specified impedance, the specified amount
of power enters the structure.
For a termination port, you can specify the resistance and reactance of the termination. The ability to solve for the currents
in the structure with terminations on the ports allows the current animation to show the waves traveling through the
structure (the usual short-circuit solution only shows a standing wave of the currents in the structure). Specifying the
excitation or termination at a port only affects the current animation. Electrical port parameters (for example,
S-parameters) assume a port impedance of 50 ohms. To change the reference impedance of the network parameters,
place the EM structure as a subcircuit in a circuit schematic and edit the port impedance.

12.3.7. Editing EM Ports
You can edit various port properties after placing the port in the layout. To edit the properties of a single port, double-click
the port in the EM layout to open the Properties dialog box. See “Port Attributes Dialog Box” for more information.
A common mistake is that the Excitation and Impedance settings on this dialog box only apply to viewing currents. The
S-parameters generated from the simulation are not affected by these settings, they always use a 50 ohm reference
impedance.
You can select multiple ports to edit all of the selected port's properties at the same time. You can also restrict selection
to just ports by right-clicking and choosing Restrict Selection from within an EM layout.
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Click the Check All button and then clear the EM ports option to filter the selection.
You can also display all of the properties for the ports in your EM layout. With an EM layout window active, choose
Edit > Port Properties to display the EM Ports Properties dialog box. (If there is only one port in the layout, the Properties
dialog box displays for just that port.)

You can change all of the port properties in this dialog box. With the dialog box open, position it so you can see the EM
layout. When you select a property for any of the ports, the EM layout automatically highlights the port in blue and
magnifies it for easy identification.
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When you add a port, it is assigned the next highest number available for that document. When you simulate, the ports
must be sequential. You can make ports differential by setting negative port numbers. See “Differential Ports” for
examples. When you edit port numbers, they may no longer be sequential. The same thing can occur if you need to delete
certain ports. You can choose Edit > Re-number Ports to renumber the ports so they are sequential. This operation only
changes the port numbers that are not sequential; it does not change all of the port numbers in the EM layout. If you have
defined multi-terminal ports or differential ports, this command renumbers any ports with the same number to have the
same new number.

12.4. Parameterizing EM Structures
The AWR Design Environment software has powerful techniques to parameterize EM structures that enable the following
capabilities:
1. Generating an EM-based model by sweeping many geometries of an EM structure.
2. Generating an EM-based model by simulating only the geometries needed in your design.
3. Optimization of an EM structure without using the extraction flow.
4. Yield analysis of an EM structure without using the extraction flow.
There are three different techniques available to fully parameterize an EM document including:
1. Defining variables in a STACKUP and using equations to parameterize any of the dielectrics or materials used in the
EM structure.
2. Using shape modifiers to parameterize the layout geometry in the EM structure.
3. Using pCells to parameterize the layout geometry in the EM structure.
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Parameterization is only available for AXIEM and Analyst software EM structures. See “Shape/Layer Modifiers” for
details on parameterizing EM structures.

12.4.1. EM Schematic
With the advanced parameterization of EM structures, the concept of an EM schematic is important. Each EM document
also has an equivalent schematic view. Typically you do not need to access this schematic. However, for parametrization,
the EM schematic can greatly simplify the process of parameterizing a geometry.
To access the EM schematic, make your EM layout active and then click the View EM Schematic button on the EM Layout
toolbar.

An unedited EM schematic has the following basic components:
ENCLOSURE
ID=ENCL
X_Dim=500 mil
Y_Dim=500 mil
Grid_X=2 mil
Grid_Y=2 mil
STACKUP
Name=Duroid
PORT
P=2
Z=50 Ohm

PORT
P=4
Z=50 Ohm

PORT
P=1
Z=50 Ohm

PORT
P=3
Z=50 Ohm

There is one ENCLOSURE block, one STACKUP block and one port for each port in the layout. If the document was
created from extraction, there is also an EXTRACT block in the schematic.
You can edit the ENCLOSURE and STACKUP blocks in the same way that you edit the Enclosure block, by
double-clicking it under the EM document name in the Project Browser. Only one ENCLOSURE and STACKUP model
must exist or an error is issued.
Ports are automatically added to the schematic when you add ports in the EM layout. You should not add, remove, or
edit ports from the EM schematic. You should always add ports to your EM document in the layout. When you add
pCells on an EM schematic, you do not need to wire-up the ports to any location. The port locations are known by their
placement in the Layout View and the numbers of the ports in the Layout and Schematic Views.
You can add and wire together models on an EM schematic, just like a circuit schematic. Before an EM document is
simulated, it snaps together all the layout objects that are wired together in the EM schematic. Subcircuits can also be
added, even if the subcircuit is another EM structure (in which case only the layout is used). In this mode, you can disable
the EM structure that is the subcircuit so it does not simulate as a stand-alone EM document.
You can add equations to the EM schematic or the EM layout. Equations are processed in the following order, where
each level can look below in the order listed, but cannot look above:
1. layout
2. schematic
3. global
The entire set of equations is resolved (global, schematic and then layout) to get the final values for each variable, and
then those values are used when assigning values to elements in the EM schematic.
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For example, if you have an equation "x=2" in the layout and "x=3" in the schematic, the value "2" is used anywhere
that variable is assigned to an element in the EM schematic. Another example is to define "a=2" in the layout and "b=3"
in the schematic. The layout could use the equation "c = b + a" and both a and b would have values. You could not use
this equation in the schematic since "a" was defined in the layout.

12.4.2. Parameterizing EM Documents
In order to parameterize any of the dielectric or conductor properties, you assign variables to fields that you would
normally use numbers in when setting up the STACKUP for your EM structure. For example, see the following figure
where the Er value for the dielectric layer "Alumina" is set to a variable named "Er".

The variable names used must exist either in the EM layout (choose Draw > Equation) or in the EM schematic (see “EM
Schematic” for details on using the EM schematic). After you define the variable, you can use the variable properties to
specify yield or optimization settings for that variable.
In order to parameterize the geometry of the EM document, you can use shape modifiers, pCells, or a combination of
both. Using pCells is typically much simpler if a pCell already exists to draw the proper geometry. For example,
parameterizing a spiral inductor could require many shape modifiers to fully parameterize the layout. A fully parameterized
pCell already exists in the AWR Design Environment software, however, to do all this work for you.
To use pCells to parameterize the geometry of the EM document, you add models with layout to the EM structure and
let the layout system build up the layout. There are two basic use models to consider:
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• You can add pCells directly to the EM layout. With the EM layout window active, click and drag any element from
the Elements Browser. Only items with layout display. Alternatively, you can click the Element button on the toolbar
to display the Add Circuit Element to Layout dialog box and filter elements to show only those with layouts.
After adding a pCell, you can right-click and select element properties to change the parameters of the pCell.
Each element added is not connected to the others; if you want the layout system to connect elements and snap layouts
together, the elements must be wired in the EM schematic.
• You can build up the EM schematic the same way you build a schematic (see “EM Schematic” for details). Only the
model layout is used to generate the geometry for the EM simulation. The electrical model is not used for anything in
this mode. The schematic is used so models can be wired together and snapped together when parameters change, as
well as being able to use the model parameters to parameterize the geometry.
For AXIEM software to work with pCells, the Model as linetype option on the Options dialog box Layout tab must be
cleared (off) for individual EM documents.
Instead of using pCells, you can use shape modifiers to perform the parameterization for you. See “Shape/Layer Modifiers”
for details on using the shape modifiers.
When using both pCells and shape modifiers, the shape modifiers move shapes first and then the layout snapping occurs.
You may need to anchor certain pCells to get snapping to work correctly.
A good example of using both pCells and shape modifiers is building a parameterized coupled bend model where you
can fully parameterize the width, angle, and spacing of the coupled bends. One approach to doing this is to use pCells
to generate the bends and lines feeding up to the bend, and a shape modifier to control the spacing between the individual
lines. The following figure shows an EM schematic that has pCells wired up correctly, and equations to do the proper
model parameter adjustments.
MLIN
ID=TL3
W=wum
L=25um

MBEND
ID=TL2
W=wum
ANG=angDeg
M=0.5

MLIN
ID=TL4
W=wum
L=25+w+sum

ang=90
w=20
s=10
r=50
r2 = r+s+w

MBEND
ID=TL1
W=wum
ANG=angDeg
M=0.5

MLIN
ID=TL6
W=wum
L=25+w+sum
MLIN
ID=TL5
W=wum
L=25um
ENCLOSURE
ID=ENCL
X_Dim=800um
Y_Dim=800um
Grid_X=10um
Grid_Y=10um

STACKUP
Name=SUB
PORT
P=1
Z=50Ohm

PORT
P=2
Z=50Ohm

PORT
P=3
Z=50Ohm

PORT
P=4
Z=50Ohm

The layout has the objects in the right locations, and a spacing modifier to properly add the right spacing.
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12.4.3. Using Parameterized EM Documents
After an EM document is parameterized, there are various ways you can use the document:
• EM optimization: Directly optimizing an EM structure's geometry.
• EM yield: Varying an EM structure's parameters to see performance variation.
• User-defined EM models: Sweeping the geometry of an EM structure to generate a parameterized circuit model.
• On-demand simulation: Simulating a specific EM geometry when needed from a circuit schematic.
EM Optimization
After an EM structure is parameterized, EM optimization is identical to any other optimization in the AWR Design
Environment platform. See “Optimization” for details on using optimization.
When EM optimization is performed for any EM type that supports parameterization, all of the results are written into
data sets, one data set per iteration. See “Data Sets” for details. Data sets operate slightly different during EM optimization.
In the following figure the top result in green is from the best iteration. Each of the data sets shown are from an iteration
of the optimization.

EM Yield
After an EM structure is parameterized, EM yield is identical to any other yield analysis in the AWR Design Environment
platform. See “Yield Analysis” for details on using optimization.
When EM yield is performed for any EM type that supports parameterization, all of the results are written into data sets,
one data set per iteration. See “Data Sets” for details. Data sets operate slightly different during EM optimization. In the
following figure the top result in green is from the simulation at the nominal values. Each of the data sets shown are from
an iteration of the yield analysis.
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User-defined EM Models
In user-defined EM models the geometry of an EM structure is swept to generate a parameterized circuit model. In this
mode, each sweep value is EM-simulated and the data is stored. You can then use the EM structure as a model in a circuit
schematic. The EM subcircuit has the parameter values of the parameters swept in the EM document. You can either
use the discrete points simulated in the sweep, or interpolate between the swept points.
To set up a user-defined EM model, you must first have a parameterized EM structure. From the EM schematic (see
“EM Schematic” for details), you add SWPVAR blocks the same way you would set up swept variables for other
simulations. See “Creating a Sweep with Variable Sweep Control (SWPVAR)” for information on setting up the swept
variable. Part of setting up swept variable analysis is defining a variable. The variable should use the "=" operator and
not the "<<" operator. Any variable that is swept is automatically available as a parameter when the EM structure is used
as a subcircuit in a schematic. The following figure shows an example of the EM schematic of a simple stub network set
up to parameterize the length of the stub, where pCells are used to create the parameterized geometry and the geometry
is swept.
SWPVAR
ID=SWP1
VarName="L"
Values=stepped(180,300,10)
UnitType=None

L=240
ENCLOSURE
ID=ENCL
X_Dim=650 mil
Y_Dim=600 mil
Grid_X=25 mil
Grid_Y=25 mil

Xo

MLIN
ID=TL1
W=50 mil
L=200 mil

MLIN
ID=TL3
W=50 mil
L=200 mil

MTEE$
ID=TL4
1

. . . Xn

2
3

STACKUP
Name=SUB2
MLIN
ID=TL2
W=50 mil
L=L mil

PORT
P=1
Z=50 Ohm

PORT
P=2
Z=50 Ohm

Before you simulate the swept EM document, right-click the document in the Project Browser and choose Preview
Geometry. The Preview Swept Geometry dialog box displays as follows to allow you to preview the geometry at each
sweep point and ensure the parameterization is as expected.
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When this dialog box is open, the EM structure 2D and 3D layouts display the sweep values selected. Click the Show
Next button to move through all of the geometries listed. You can also zoom, pan, measure distances, and perform other
operations in the EM layout. After you are satisfied with the geometry, you can simulate this structure to get one data
set for the EM structure that contains all of the results. To see all sweep points for the structure, right-click the data set
and choose View the Data Set Geometry to display the Show Geometry in dialog box.
When the simulation is complete, you can use the EM structure in a schematic by adding it as a subcircuit. When this
subcircuit is added, any of the variables that were swept now display as parameters of the subcircuit. By default, the
available values are the discrete list of swept values simulated.

You can enter any value and interpolate between the simulated points by choosing Options > Default Project Options to
display the Project Options dialog box, clicking the Interpolation/Passivity tab, and selecting Enable parameter interpolation.
You can set this option globally, or just set it locally for individual EM structures by selecting the same option for the
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EM structure. Once parameter interpolation is enabled, the subcircuit parameters allow you to specify any number for
the parameter, as shown in the following figure.

SUBCKT
ID=S1
NET="my_em_doc"
L=209

1

2

Note the following when using user-defined EM models in a schematic:
• Ensure the frequencies simulated for the EM structure cover the entire frequency range needed for the circuit simulation,
including DC and harmonics if performing nonlinear simulation.
• When interpolating, the schematic layout for this subcircuit also uses the interpolated value.
• You cannot extrapolate beyond the extremes of the swept parameters.
• When interpolating, you can check the accuracy of an interpolated part by using extraction to EM-simulate the exact
value you are using by setting up the EM subcircuit to extract.
After you create a user-defined EM model, you can use the model in other projects. The best way to do so is to use the
project import feature (see “Importing a Project ” for details) to import the EM document and its corresponding data set
into the new project. When using project import, some settings need to match between the two projects, including project
units and several layout options. Project import does not work if the layout units are different between the projects (for
example, mils versus mm or um). There are other layout settings that a project import may report as not matching,
however they are not critical. Ideally the settings match, but if not, you can inspect your user-defined EM model in the
project into which it is imported.
The following procedure is the suggested flow for sharing user-defined EM models between projects.
1. In the original project, lock the EM structure by right-clicking the EM document and choosing Options, and then
clicking the Locking tab on the Options dialog box. Select Do not allow editing to prevent accidental edits that force
the entire resimulation of the EM.
2. In the new project, choose File > Import Project. In the Import Project dialog box, select the AWR Design Environment
platform project that contains the user-defined EM model and then click Open.
3. In the Import Project dialog box you MUST select the EM document and the matching data set as shown in the
following figure.
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After your selections click OK to import the user-defined EM model into your current project.
On Demand Simulation
In On Demand simulation the geometry of an EM structure is parameterized, and then the variables used to parameterize
are passed up from the EM document to the schematic. When you use this EM subcircuit in a schematic, the EM simulation
occurs when the schematic is simulated at the parameter values the designer sets. Only new geometries not previously
simulated are simulated. This mode is different from the user-defined EM models in that the EM simulation only occurs
when the schematic requests it; whereas user-defined EM models do allow simulation before being used in a schematic.
To set up an On Demand simulation, you must first have a parameterized EM structure. From the EM schematic (see
“EM Schematic” for details) or layout, you need to assign to a variable any parameter that should passed to the schematic.
This variable then needs to be passed up through hierarchy by defining the variable with the << syntax. For example, if
you assign X to some parameter, you then bypass it by defining an equation of the form X<<10, where 10 is the default
value of the passed up parameter.
When you define an EM structure to pass up parameters, the EM structure itself does not simulate with the default values.
It only simulates when used in a schematic.
The following figure shows an example of the EM schematic of a simple stub network set up to parameterize the length
of the stub, where pCells are used to create the parameterized geometry and passing up the parameterization value.
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L<<240

ENCLOSURE
ID=ENCL
X_Dim=650 mil
Y_Dim=600 mil
Grid_X=25 mil
Grid_Y=25 mil
MLIN
ID=TL1
W=50 mil
L=200 mil

MLIN
ID=TL3
W=50 mil
L=200 mil

MTEE$
ID=TL4
1

2
3

STACKUP
Name=SUB2
MLIN
ID=TL2
W=50 mil
L=L mil

PORT
P=1
Z=50 Ohm

PORT
P=2
Z=50 Ohm

When you use this EM structure in a schematic as a subcircuit, the passed up parameters display as parameters, then
each unique parameter set in the schematic is simulated. For example, see the following schematic.

PORT
P=1
Z=50 Ohm
1

SUBCKT
ID=S1
NET="on_demand"
L=199

SUBCKT
ID=S2
NET="on_demand"
L=233
2 1

SUBCKT
ID=S3
NET="on_demand"
L=199
2 1

2

PORT
P=2
Z=50 Ohm
In this case, when this schematic is simulated, two versions of the EM document are simulated: one with L=199 and the
other with L=233. Notice that there are two subcircuits with L=199. Once the simulation is complete for L=199, any
other instances using the same geometry can use the previously simulated data. Each unique instance has its own data
set, as shown in the following figure.

Both data sets display with green, indicating that they are current. In this mode, an EM document can have many current
data sets.
When simulation occurs, the EM structure simulates at the frequencies specified by the EM structure, not the schematic.
You therefore need to ensure that the frequencies simulated for the EM structure cover the entire frequency range needed
for the circuit simulation, including DC and harmonics if performing nonlinear simulation.

12.5. EM Annotations and Cut Planes
Annotations are results that are viewed directly on the EM structure layout, 2D layout, or 3D layout, including:
• Mesh for both 2D and 3D layouts.
• Visualizing currents on the conductors.
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• Visualizing electric fields for the entire structure.
The following information applies specifically to EM structures that use EMSight, AXIEM or Analyst software as the
EM solver. If you specify a third-party solver, you should check the vendor documentation for details on the method(s)
used for EM simulation.
Cut planes are a way to "cut" the 3D layout of an EM structure to better see the structure internally.
To add an annotation to an EM structure, right-click the EM structure in the Project Browser and choose Add Annotation
or click the EM Annotation button on the toolbar to display the Add EM Structure Annotation dialog box.

Click the Meas Help button to view the Help for the selected annotation. NOTE: For simulators that extract equivalent
circuits (such as ACE), you can view the extracted values on the EM structure using the CKT_EXT3D annotation located
under the ERC measurement type.
The following are examples of a mesh, current, and e-field annotation from the EMSight simulator.
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12.5.1. Mesh Annotations
Viewing the structure mesh provides you with a good indication of the complexity of a problem, and whether or not you
might have accuracy issues. You should always view your mesh before simulating. There are two mesh annotations:
•

EM_MESH_2D:

A mesh viewed in the 2D layout of the structure.

•

EM_MESH: A mesh viewed in the 3D layout of the structure. Cut planes affect this mesh annotation. This 3D mesh has

some advanced features to help diagnose your circuit, as discussed in the following section. You should use this
annotation with thick metal to better see which shapes are using thick metal.
A common EMSight mistake is not selecting the Synchronize Mesh check box on each of these annotations. With this
option off, the mesh does not update when you edit your geometry. You can select this option for small structures when
the mesh time is very small, so you can make edits and the mesh updates quickly. For large structures where the mesh
time is long, you should not select this option. This allows for many edits and an update of the mesh only when you close
and reopen the view of the structure. This setting does not apply to AXIEM software.
EM_MESH Features
Unique features of the EM_MESH annotation are the Opacity and Color Key options. Opacity controls the transparency
of each layer. For example, see the following 3D figure of this via transition.
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With the Opacity set to 0, the shapes have no color; only the mesh displays.

With the Opacity set to 0.5, the shapes are partially transparent, so you can see the mesh and all the shapes through the
3D structure.
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With the Opacity set to 1, the shapes are filled solid so you can only see the top shapes from the angle from which you
are viewing the structure.

The Color Key controls how the shapes get their color in the 3D view. There are two options, Material and Net ID. For
Material, every shape using the same defined conductor types has the same color. In this example, all shapes use the same
conductor.
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For Net ID, every shape physically connected has the same color. In this example, the ground plane and the signal line
are not connected, so they display in different colors.

The Net ID is a good check to ensure that your structure is connected as desired. For example, in the following annotations,
the first structure has a via connecting the two rectangles, and therefore they are the same color. The second structure
has no via, thus no connection, and the shapes are shown on different nets (different colors).
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12.5.2. Cut Planes
Cut planes provide an easy way to look inside a structure to see the mesh or current flow. They work with any EM
document 3D view and cut the layout shapes, the EM_MESH annotation, and the current and E-field annotations.
To turn on a cut plane click the Use Cut Plane button on the EM 3D Layout toolbar.

The following figure shows the cut plane with just the EM structure geometry at one location.
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The following figure shows the cut plane moved closer to the center of the structure.

You can edit the cut plane location with the following operations:
• Change the cut plane axis with keys x,y,z.
• Flip the cut plane axis with keys Shift + x,y,z.
• Drag the cut plane to move its location.
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• Drag the cut plane arrow to rotate the plane.

The following is an example of the cut plane being used with the EM_MESH annotation.

The following is an example of the cut plane being used with the EM_CURRENT annotation.
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12.5.3. Current Animation & E-field Visualizations
EMSight and AXIEM software provide both qualitative and quantitative information for analyzing EM structures. While
measurements and graphs are great for quantifying performance, it is the current animation and E-field visualization
features that can provide the most insight into the behavior of structures.
Current Animation
In the 3D layout of a structure, you can view the current distribution found during the solution process. The graphical
display of the current distribution provides a visualization of the vector current distribution. Arrows indicate the direction
of the current flow, while the color and the arrow size indicates the magnitude. The lighter colors (yellow) represent the
higher magnitude and the darker colors (blue/black) represent the smaller magnitude. A toolbar also provides the current
density values.
Viewing the Current Distribution
To view the current distribution in 3D, right-click the EM structure name in the Project Browser and choose Add Annotation.
Choose the EM_CURRENT measurement located under the Planar EM measurement type.
Click the Meas Help button to view the Help for the selected annotation.
Animating the Current Distribution
To animate the current distribution in the 3D view, click the Animate Play button on the EM 3D Layout toolbar after the
solution is completed. When the animation first starts it creates a set of frames (this step appears as a slower animation).
After the frames are created, the animation automatically starts by cycling through the frames. On the Current View tab
in the Options dialog box you can set the number of frames used per cycle for the animation.
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Pausing the Animation
To pause the animation to view a single frame, click the Animate Pause button on the EM 3D Layout toolbar.
Stopping the Animation
To stop the animation click the Animate Stop button on the EM 3D Layout toolbar.
Selecting the Animation Frequency
When more than one frequency point is specified when solving an EM problem, the frequency used for the animation is
controlled in the Edit EM Structure Annotation dialog box by selecting the animation frequency from the Sweep Freq
list of frequencies.
NOTE: If using the AFS feature for EM, this frequency selection is not accurate because the simulation frequencies are
unknown before simulation occurs. In this case, you should make a duplicate EM structure and only simulate a few
frequencies without AFS enabled, where you want to view the currents.
Viewing Animation Versus Phase
When you first view currents, if you open the tuner, you can tune over the source phase. The number of tune states is set
by the number of frames per cycle set on the Current View tab of the EM Options dialog box or the (local EM structure)
Options dialog box.
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Terminations and Excitations
EMSight and AXIEM software allow you to specify the magnitude and phase of the port excitation. You can visualize
the current distributions that arise from different modes of operation by specifying the relative phases of different ports.
Any port can be either a port excitation or a termination. For terminated ports, you can specify the termination impedance.
The specification of the terminations and excitation only affect the animation and not the S-parameter solution. The
solution that is used to compute the S-parameters uses short-circuited terminations. The current solution for short-circuited
terminations is a standing wave. To visualize how the currents flow through a structure, the solution of the structure with
loaded terminations must be computed. By default, EMSight and AXIEM software compute the current solution for the
loaded terminations in an extra step after the S-parameters are already determined. This extra step takes very little time,
however, you can disable it for EMSight by clearing the Compute loaded currents check box on the EMSight tab of the
EM Options dialog box or Options dialog box.
E-field Visualization
Currently, E-fields are only possible in EMSight, not AXIEM software.
The tangential electronic field (E-field) can also be computed in addition to current distributions. E-field animations are
viewable in 3D views of the structure. The graphical display of the E-field provides a visualization of the tangential
E-field in any XY plane. Arrows are used to indicate the direction of the field, while the color and the arrow size indicate
the magnitude of the voltage. The lighter colors (yellow/green) represent the higher magnitude and the darker colors
(blue/black) represent the smaller magnitude. A toolbar also provides the E-field density values.
Unlike the current animations, E-field simulations increase simulation time.
Viewing the E-field Distribution
To view the E-field distribution in the 3D view, right-click the EM structure name in the Project Browser and choose
Add Annotation. Choose the EM_E_FIELD measurement located under the Planar EM measurement type.
Click the Meas Help button to view the Help for the selected annotation.
The E-field is only calculated for the layer specified in Layer Number. You cannot view the E-field for the top or bottom
of the Enclosure if that boundary condition is using Perfect Conductor. Cadence recommends using the Approx Open
boundary condition for viewing the E-field on the top or bottom. See “Element Options-(EM) ENCLOSURE Properties
Dialog Box: Dielectric Layers Tab” for more information.
Viewing and Animating the E-field
All of the same options for viewing and animating currents are available for E-fields.
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12.6. In-situ Measurements and Annotations
In-situ measurements are performed on an EM structure where the excitation for the simulation is provided through
another mechanism other than the port settings in the EM structure. For example, if you view currents or antenna patterns
of EM structures you must set the port power, phase, and impedance of the ports and the results of the simulation
correspond to how the port is configured. With in-situ measurements you can run the EM simulation and then you can
plot the currents or antenna measurements/annotations where the source is provided through a schematic. This allows
you to view current and/or antenna information for different excitations without having to resimulate the EM structure.
Further functionality is enabled by parameterizing components in excitation circuits and allowing tuning or optimization
of these component values using the antenna patterns or currents as goals. This process all occurs with a single simulation
of the EM document.
For example, consider a 64-patch antenna array as shown in the following figure, zoomed in on a few of the elements.

AXIEM or Analyst software solvers are used to simulate the characteristics of the array. The excitation schematic consists
of a power dividing network, phase shifters, and attenuators which have been parameterized to steer the radiation pattern
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to a specified direction with a specified amplitude taper. The result is that you can view the antenna characteristics via
measurements/annotations given the current state of the excitation circuit. For example, the radiation pattern show in the
following figure is a result of an excitation circuit steered to bore-sight (Theta = 0 deg).

Modification of the parameters of the excitation circuit (the schematic) to steer the radiation direction to Theta = 45 deg,
Phi = 135 deg modifies the phase of each element resulting in the following radiation pattern.

Note that the resulting radiation pattern is calculated without resimulating the EM structure, so the tuning on the excitation
parameters occurs in near real time.
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12.6.1. In-Situ Current Animation
The EM_CKT_CURR annotation is an “in-situ” annotation, meaning that the EM document is simulated “in place” and
includes the interaction of the EM simulation with the circuit surrounding it. The EM documents are instanced as
subcircuits in a schematic. This annotation displays current contours and arrows to represent current flow on conductors
in the 3D view of the EM document due to sources in the schematic. Both the current contours and arrows can be animated
in time to show the current flow.
In addition to the restrictions in “Limitations/Restrictions of In-situ Measurements/Annotations”, in-situ current
measurements can only be used with the AXIEM EM simulator.
To access the EM_CKT_CURR annotation to display currents on EM structures:
1. Create an independent AXIEM EM structure and make sure it simulates as expected with the desired ports and grounds.
2. Instance the EM structure as a subcircuit in a schematic. The schematic must have at least one single-tone source (for
example PORT1, not shown) driving it.

3. Properly set up the EM_CKT_CURR measurement to identify the schematic, the EM structure, the subcircuit ID and
the desired view number (if more than one 3D layout window is open).
4. Choose the desired Sweep Freq. properly. It must be explicit in both the schematic and the EM structure frequency
lists.
5. Open the EM structure and view the 3D layout.
6. Simulate the structure. The current contours and arrows display in the 3D layout window.
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12.6.2. In-situ Antenna Measurements and Annotations
There are multiple in-situ measurements/annotations for antennas, including an annotation for the 3D antenna pattern
and all of the antenna measurements. These measurements include the iteration of the EM simulations with the circuit
surrounding it where the EM documents are instanced as subcircuits in a schematic.
The annotation displays the 3D antenna pattern in the 3D view of the EM document and operates much like the “3D
Antenna Pattern: ANTENNA_3D” measurement, but where the sources come from the excitations schematic rather than
the ports on the EM structure. See “3D Antenna Pattern from Circuit Excitation: ANTENNA_CKT_3D” for more
information about the annotation.
For each antenna measurement in the Electromagnetic > Antenna category, there is a corresponding in-situ measurement
under Electromagnetic > Antenna_CKT in the Add/Modify Measurement dialog box. As with all in-situ measurements,
the source comes from the excitation schematic rather than the EM structure. For additional help with individual
measurements, click the Meas Help button in the Add/Modify Measurement dialog box.

12.6.3. Limitations/Restrictions of In-situ Measurements/Annotations
The following are restrictions when using in-situ measurements/annotations:
• Only Harmonic balance and transient circuit simulators can be used.
• In-situ measurements/annotations do not work with Extraction.
• Only single-tone analysis is supported. You can have multiple sources if they are the same tone.
• DC and harmonic content are used to calculate circuit response and load impedance presented to the EM structure.
The current annotation only plots at the fundamental frequency, however.
• Only the results corresponding to frequencies for which there is an EM solution in the data sets can be plotted. Therefore,
if AFS (Advanced Frequency Sweep) is enabled in the AXIEM software options for the EM document, only those
frequency points that are simulated by AFS are available. If AFS is used the Sweep Freq options in the Add/Modify
EM Structure Annotation dialog box must be set to FSAMP to access them.
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• Schematic excitation frequency must also match the EM structure frequency. Although the frequency sweeps for the
EM structures and the schematic may be different, this annotation only works for common frequencies between them.
• Only frequency can be swept on the EM structure or excitation schematic. No other sweeps are supported.

12.7. Geometry Simplification
Geometry simplification is supported for all EM simulators except EMSight. The geometry simplification feature allows
you to write rules that simplify the geometry used to EM simulate a layout. Typically, there are layout requirements for
manufacturing a design which can often cause unnecessary complexity in EM simulations. A good example is a plated
line in a MMIC process, where there are often several metals connected by an etch layer where there are small offsets
of each layer. The offsets are required for manufacturing, however, they can cause the EM meshing process to add many
mesh elements that are unnecessary for accurately simulating the structure. Circular shapes are another example. Circles
are usually drawn with 36 or more sides, adding complexity to EM simulations because the mesher captures that level
of detail for the circle instead of the 6 to 8 sides that can accurately simulate a circle. For example, the following mesh
has no simplification for a via.

This via has a total of approximately 2650 unknowns. With rules to simplify the via, the mesh appears as follows.
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This via has a total of approximately 1100 unknowns, yet the answer is nearly the same.

12.7.1. Writing Rules
You can write the geometry simplification rules on the Element Options: STACKUP dialog box Rules tab if using
extraction or STACKUP elements to initialize new EM documents. You can also write the rules on the Rules tab of the
Enclosure settings of an EM document (double-click the Enclosure under an EM structure in the Project Browser to view
the Element Options - ENCLOSURE Properties dialog box). Rules are typed into this field, one rule per line. See “Element
Options-(EM) STACKUP Properties Dialog Box: Rules Tab” for more information. “Rule Syntax” describes the available
rules.
Rule Writing Guidelines
Because of the number of rules available, it can be difficult to know where to start. There are two ways to set up layer
names and EM mapping, depending on the process type:
• Rules for processes with conformal metals.
• Includes most MMIC processes, where the same metal type may be at different heights or may be stacked up with
other metals, depending on which drawing layers it overlaps.
• For these processes, you should create <EM_LayerName> drawing layers for all possible layer stacks and crossovers.
These new EM layers are mapped, while the original drawing layers are deleted in the SPP rules.
• Rules for processes with planarized metals.
• Includes most RFIC and PCB Stackups. Metal shapes on a given drawing layer are always at the same height and
thickness, and traces are not typically drawn with stacked metal layers.
• SPP operations can generally be run 'in place' on these layers.
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For MMIC processes, a drawing layer naming convention you can use is to name all new EM layers "EM_*", then add
them to the bottom of the drawing layer list. Set their color and fill close to the original layer(s) if possible, then set them
to be cloaked.
After determining your layer issues, you can use the following basic procedure for a general case.
1. Set units
• Use the LENGTH_UNITS rule to set the length units for this process and make entering numbers more intuitive.
2. Via array rules
• Merge via arrays or stripes. Reducing polygon counts early makes subsequent rules run faster.
3. Apply Boolean rules
• Resize any inset layers used in stacked linetypes.
• Find layer intersections (use AND) to determine possible regions for each combination of metals.
• Use SUBTRACT to determine final EM_* layers (for example, EM_Metal1 = Metal1 SUBTRACT <any stacked
linetypes which include Metal1>)
• Remove any temp layers
4. Via (thru hole) simplification
• Remove via pads (as part of the Boolean rules)
• Merge vias
5. Clean up rounded shapes
• Reshape circles (consider the Classify Circle rule to help identify circles that are not perfectly drawn).
• Use the DECIMATE_MIN_EDGE rule for curved traces with fewer points on the curve. A good place to start is
0.5*width of the desired trace.
• Use the RESHAPE_CIRCULAR_ARCS rule for everything else, where there are curves that are not traces, such
as a radial stub or a line with a circle on the end that is "Booleaned" together.
6. Clean up geometry where junk can be retained from operations
• Use the SMALL_CORRECTIONS_SNAP rule to remove small slivers and change shape vertices to make better
shapes.
• Use the FILTER rule to remove shapes that have a small area or small width (usually the result of Boolean operations
where shapes do not align). This removes shapes that match the criteria.
Generic Procedure for Fixing High Aspect Ratio Facets

See “AXIEM High Aspect Ratio Facet Detected” for a description of high aspect ratio facets. This section includes a
generic procedure for fixing high aspect ratio facets.
To fix high aspect ratio facets:
1. Set the rules length units to project units so you can easily measure distances on the layout and map them back to
rules; use "um" as units.
2. Look for some small features and measure their width (or edge) to give an approximate idea of the length scales. For
example, if there is a circle at 100 um diameter it indicates that typically the smallest good mesh edges are in the 2-5%
range of this feature diameter, about 5 um. The smallest bad mesh edges could be in the 0.5 (10%) um range or less
(these result in high-aspects). You can use the following two rules to address possible min-gaps:
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length_units um !set this to project units
set_min_gap 0.5 !10% of the smallest 'good' edge-lengths; at these lengths it
is permissible to short
small_corrections_snap 5.0 !snap if possible below this range, while shorting
below the 0.5 range as set above.

3. If you want to add additional rules (such as Boolean operations to simplify plated lines or via merging), you add them
after the units setting, but before the other two rules.

12.7.2. Using Rules for EM Simulation
Rules are applied before simulating an EM structure. You can comment out individual rules or you can select the Enable
rules check box to turn rules on or off. When you mesh a structure, you see the mesh of the simplified geometry. You
can also view the simplified geometry by right-clicking the EM document and choosing Preview Geometry to show the
geometry after the simplification (but without the mesh) in both 2D and 3D views. Menus such as those for using rules
and changing layer visibility are active when viewing the geometry. After the Preview Swept Geometry dialog box
closes, the geometry returns to its original state.
You can also apply the simplification permanently to the layout of an EM document by choosing Draw > Modify Shapes
> Simplify Shapes to alter the layout. You should only do so if you are not going to use the layout for the EM structure
when generating exported layout files (GDSII, DXF, or Gerber).
For example, the following figure on the left shows the 3D layout of a simple plated MMIC line without any simplification,
with the middle etch layer expanded significantly in the Z direction for effect. With the proper rules written and the
simplification enabled in the EM layout, the 3D layout displays as shown on the right.

AXIEM Considerations
Previous versions of AXIEM software had separate sets of mesh decimation settings for Shape PreProcessing (SPP).
Projects using these settings now automatically use the equivalent rules to provide the same simplification. AXIEM
software mesh settings are not the same as geometry simplification rules. The rules change the geometry that is sent to

12–62 AWR Design Environment

Geometry Simplification
AXIEM software, whereas the mesh options only change how AXIEM software meshes the geometry. Note that you
should always view your mesh before simulating to make sure it looks reasonable; this is what the simulator solves.

12.7.3. Rule Syntax
The following table of rules uses these guidelines:
• Rule labels are not case sensitive; they can be all uppercase, all lowercase, or mixed case.
• "layer" - when a layer is specified it must be enclosed in quotes only if it contains a space. In the table, it is always
enclosed in quotes.
• "layer_or_list" - indicates that you can specify a layer name or the name of a list.
• "results_layer" - this can be a temporary layer name specified only locally. You can put results on any layer. Only
layers that have proper EM mapping display at the results of the processing.
• "optional:layer_or_list" - indicates that you can specify a layer, although it is not necessary. If omitted, the command
applies to all layers.
• Scientific notation is NOT allowed for values: "11000.0", not "1.1e+4".
• If there are syntax errors in rules such as "bad rule name" or "bad layer name", an error message displays and simulation
does not occur.
The following table defines the available rules.
Label

Syntax

Description

C-Style comments

/* this is a c-style comment */

Can span multiple lines. Nested
comments are not allowed, for
example: (/* ... /* ... */ ... */).

Single line comments

! followed by comment

Any text following a "!" until end
of line is considered a comment.

VERBOSE_STATUS <0/1>

Set to 1 to print details of each SPP
rule to the Status Window,
including number of input/output
shapes, number of vertices, shapes
created from Boolean operations
and others. Setting this to 0 turns
off status output.

INCLUDE <pdk-name>
<relative-path-to-rules-file>

Inserts the text from the specified
file. The file path is relative to the
location of the .ini file for the
specified PDK. Example:
INCLUDE AWR_MESFET
"Library\spp_rules.txt". Included
rule files can include other files.
Using this command makes it easier
to edit rules (because you can use

Adding Comments

Debugging
VERBOSE_STATUS

Including External Rules Files
INCLUDE
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Label

Syntax

Description
an external text editor), and
provides for automatic update of
SPP rules when switching to an
updated version of the PDK.

Basic Rules
LENGTH_UNITS

LENGTH_UNITS < um | nm | mm | mil >

Set units for subsequent length
inputs. If not set, all sizes are in
nanometers. You can use this rule
multiple times; all rules after this
rule use the specified units.

ANGULAR_UNITS

ANGULAR_UNITS < deg >

Set angular units for all subsequent
angular values. Only degrees is
currently supported.

LIST

LIST list-name "layer 1" "layer 2" ...

Create a named list of layers for
subsequent use.

MAX_TRACE_WIDTH

MAX_TRACE_WIDTH <max-trace-width> Applies to all subsequent
operations. Differentiates ground
shapes from trace shapes. Typically
the computed trace width is slightly
larger than the measured trace width
because some traces have via-pads
at their ends. However, ground
width is typically orders of
magnitude larger than trace width.
While specifying a
<max-trace-width>, use a factor
such as 1.5x the measured trace
width in the syntax for best results.

SET_CLASSIFY_CIRCLE

SET_CLASSIFY_CIRCLE
<allow-concave(0/1)>
<max-percent-deviation=7>

Allows for changes to circle
detection settings. <allow-concave>
set to 1, allows concave notches in
the shape. <max-percent-deviation>
is a tolerance for the shape to
deviate from an exact circle. The
default is 7.

SET_MIN_GAP

SET_MIN_GAP <min-gap>

Gaps smaller than <min-gap> are
allowed to short when calling
SNAP_VERTICES or
SMALL_CORRECTIONS_SNAP.

Boolean and Resizing
BOOLEAN_OPS
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BOOLEAN_OPS "result_layer"
Performs specified Boolean
"layer_or_list A" <AND | SUBTRACT | OR operation on 'Layer_or_list A' with
| XOR > "layer_or_list B"
'Layer_or_list B' resulting in
'result_layer'. 'result_layer' cannot
be same as "layer_or_list A" or
"layer_or_list B".
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Label

RESIZE

Syntax

Description

'BOOLEAN_OPS "result_layer"
(boolean-expression)', where
boolean-expression = <"layer_or_list_A" |
(boolean-expression)> <AND | SUBTRACT
| OR | XOR | RESIZE> <"layer_or_list_B" |
(boolean-expression) | resize-value >

Performs multiple Boolean or resize
operations, resulting in
"result_layer". Each
boolean-expression must be in
parentheses, including the
outermost step. Each expression can
recursively call other expressions,
so you can perform as many
Boolean or resize operations as
necessary. For example:
BOOLEAN_OPS "newLay" (("B"
AND ("C" OR ("D" RESIZE 200)))
SUBTRACT "E") 'result_layer'
cannot be same as any of the input
layers.

RESIZE "result_layer" "target_layer_or_list" Resize 'target_layer_or_list' by
<resize_distance>
<resize_distance> to produce
'result_layer'. 'result_layer' cannot
be same as "target_layer_or_list".
RESIZE "target_layer_or_list"
<resize_distance>

Resize shapes in
'target_layer_or_list' by
<resize_distance> in place. No
result layer is required.

UNION_AFTER_BOOLEAN_OPS UNION_AFTER_BOOLEAN_OPS
<do-union(0/1)>

Turn on or off an extra merge step
to be performed after any Boolean
operation or resize. Default is 0.

SET_RESIZE_CORNER_STYLE

SET_RESIZE_CORNER_STYLE
<round/sharp>

Change how a resize operation acts
on acute angles with a positive
resize value. Default behavior is
'round'. Same behavior as the 'RCS'
parameter on the Layer Resize
Modifier.

SNAP_VERTICES <tolerance>
"optional:layername-or-list"
<optional:sssoverlap=0.1>

Performs snap operation using
<tolerance>. "layername-or-list" is
optional. When unspecified, snap
is applied on all layers. The
snapping of vertices occurs only
between shapes and not within the
same shape (to align shapes on
different layers, for example).
<sssoverlap> is an optional
argument that specifies the
minimum overlap area as a percent
(divided by 100.0), of at least one
of the two shapes involved. The
default is 10% (0.1). When the

Shape Snapping
SNAP_VERTICES
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Label

Syntax

Description
value is set to less than 0.0, it is
treated as no overlap, but connected
at the edges.

SNAP_VERTICES_VIA

SNAP_VERTICES_VIA <tolerance>
<optional:sssoverlap=0.1>

Performs snap operation using
<tolerance> on all via layers.
Equivalent to creating a list of via
layers and applying
SNAP_VERTICES on it.
>sssoverlap<: see
SNAP_VERTICES.

SMALL_CORRECTIONS_SNAP

SMALL_CORRECTIONS_SNAP
<tolerance> "optional:layername-or-list"

Attempts to remove small defects
and gaps between shapes. It is not
automatically applied.

CLEAN_DIRTY_GEOMETRY

CLEAN_DIRTY_GEOMETRY
<optional:min-angle=2.0>
<optional:remove-collinear(0/1)=1>

Can be used to remove vertices with
extreme angles. <min-angle> is the
smallest subtended angle allowed.
The default is 2.0 degrees.
<remove-collinear> is either 0/1.
The default is 1. It is applied on the
entire geometry and cannot be
applied per layer. It is automatically
applied at the end of the commands
using default settings.

LDELETE

LDELETE "layername-or-list"

Deletes a layer or a list of layers

FILTER_LAYER

FILTER_LAYER "result_layer"
Deletes shapes in 'target_layer'
"target_layer" <AREA | WIDTH | POINTS> based on filter condition; anything
<< | <= | == | >= | >> <value>
that fails the filter is deleted.
"result_layer" cannot be the same
as "target_layer".

Layer and Shape Filtering

FILTER_LAYER <AREA | WIDTH |
POINTS> << | <= | == | >= | >> <value>

Deletes shapes in all layers based
on filter condition; anything that
fails the filter is deleted.

REPLACE

REPLACE "layer A" "layer B"

Deletes 'layer A' and renames 'layer
B' to 'layer A'

REMOVE_VIA_PADS

REMOVE_VIA_PADS
<max_pad_to_via_ratio>
<allow-non-zero-thickness=0>

Deletes all shapes that are directly
connected to a via, with centroids
matching and pad-to-via area ratio
less than <max_pad_to_via_ratio>.
Set <allow-non-zero-thickness> to
1 if non-zero thickness via-pads
need to be removed. The default is
0.

Via Merging
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Label

Syntax

MERGE_VIAS

MERGE_VIAS "result_layer" "target_layer" Recursively merges all via in the
<max_merge_distance>
target layer based on connectivity
(the merged via should connect to
the same shapes and their merging
should not violate the original
connectivity) and merge distance.
"result_layer" cannot be the same
as "target_layer".

MERGE_VIA_RADIUS_MULT

Description

MERGE_VIAS "result_layer"
<max_merge_distance>

Searches for all via layers and
merges them. Replaces the original
via shapes with the merged via.

MERGE_VIA_RADIUS_MULT
<radius-multiple>

Merges all via (on all via layers)
using a <radius-multiple> of the via
to search for nearby via.

Shape Decimation
DECIMATE_MIN_EDGE (Details) DECIMATE_MIN_EDGE
Decimates shapes in the layer so as
"optional:layer_or_list" <min-edge-length> to have no edges smaller than
<optional:max_angle=value>
<min-edge-length>. <max_angle>
prevents decimation of vertices that
rotate at the vertex more than that
value.
DECIMATE_MIN_EDGE_TRACE See DECIMATE_MIN_EDGE

Only decimates trace nets (trace net
= at least one non-via shape in the
net connectivity should be less than
MAX_TRACE_WIDTH)

DECIMATE_MIN_EDGE_GROUND See DECIMATE_MIN_EDGE

Only decimates non-trace nets
(trace net = at least one non-via
shape in the net connectivity should
be less than
MAX_TRACE_WIDTH)

Circle and Circular Arc Reshaping

In all the RESHAPE rules below,
use radius_min=value and
radius_max=value to set radius
limits. If not specified,
radius_min=0.0 and
radius_max=infinity.

RESHAPE_CIRCLES_DIVS

RESHAPE_CIRCLES_DIVS
<number-of-edges>
"optional:layername-or-list"
radius_min=value radius_max=value

Reshapes all circles in the layer or
layer list to have number-of-edges.

RESHAPE_GROUND_VIA_CIRCLES_DIVS RESHAPE_GROUND_VIA_CIRCLES_DIVS Reshapes via connected to ground
<number-of-edges>
using number of edges.
"optional:layername-or-list"
radius_min=value radius_max=value
RESHAPE_TRACE_VIA_CIRCLES_DIVS RESHAPE_TRACE_VIA_CIRCLES_DIVS Reshapes via connected to trace
<number-of-edges>
using number of edges.
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Label

Syntax

Description

"optional:layername-or-list"
radius_min=value radius_max=value
RESHAPE_CIRCLES_MAX_EDGE RESHAPE_CIRCLES_MAX_EDGE
<max-edge-length>
"optional:layername-or-list"
radius_min=value radius_max=value

Reshapes all circles in the layer or
layer list to have edge no larger
than max-edge-length.

RESHAPE_GROUND_VIA_CIRCLES_MAX_EDGE RESHAPE_GROUND_VIA_CIRCLES_MAX_EDGE Reshapes via connected to ground
<max-edge-length>
using max edge length.
"optional:layername-or-list"
radius_min=value radius_max=value
RESHAPE_TRACE_VIA_CIRCLES_MAX_EDGE RESHAPE_TRACE_VIA_CIRCLES_MAX_EDGE Reshapes via connected to trace
<max-edge-length>
using max edge length.
"optional:layername-or-list"
radius_min=value radius_max=value
RESHAPE_CIRCULAR_ARCS

RESHAPE_CIRCULAR_ARCS
"layer-name-or-list" <max-edge-length>
radius_min=value radius_max=value
<min-points=7> <max-radius-deviation=0.2>
<min-arc-angle-degree=60.0>
<average-arc-length-subtend-max-degree=30.0>
<max-radius-deviation-as-percent-of-shape-width=0.2>

RESHAPE_CIRCULAR_ARCS_DIVS RESHAPE_CIRCULAR_ARCS_DIVS
"optional:layer-name-or-list"
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Reshapes all circular arcs in shapes
in the layer or layer list, with given
arguments. This does not work for
traces that have curves, since they
need to change in a similar manner;
use DECIMATE for these.
min-points=7 is the minimum
points the arc should have before
processing.
max-radius-deviation=0.02 (20%)
is the maximum percent by which
the radius can vary along the arc.
To account for integer snapping and
slight elliptical arcs,
min-arc-angle-degree=60.0 is the
minimum angle the arc needs to
subtend at the centroid to be
reshaped.
average-arc-length-subtend-max-degree=30.0
is the arc length that needs to be
subtended by each chord at the
centroid.
max-radius-deviation-as-percent-of-shape-width=0.1
is the maximum of the "(max-radius
min-radius)/computed-shape-width"
allowed. In shapes with numerous
logarithmic or elliptic arcs, reduce
max-radius-deviation-as-percent-of-shape-width
to 0.1 or less, and use DECIMATE
instead.
Same as 'reshape_circular_arcs',
except specify number of divisions
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Label

Syntax

Description

<num-divs-on-360> radius_min=value
for 360deg instead of
radius_max=value <min-points=7>
max-edge-length.
<max-radius-deviation=0.2>
<min-arc-angle-degree=60.0>
<average-arc-length-subtend-max-degree=30.0>
<max-radius-deviation-as-percent-of-shape-width=0.2>
Shape Fillet
FILLET_SHAPES

FILLET_SHAPES "optional:target_layer"
<radius=value-in-length-units
><min_radius_if_variable=1.0>
<max_internal_angle=100.0>
<min_internal_angle=45.0>
<num_points_on_360=int-value>
<masking_draw_layer="layer_name">
<radius_no_fit_option=none|resize_radius>
<use_negative_mask=true|false>
<skip_intersections=true|false>
<skip_ports=true|false>

Adds fillets to shapes based on the
following arguments. <radius=0.0>
is the radius of the fillets/chamfers
in length units; the default is 0.0.
<min_radius_if_variable=1.0> If
'radius' does not fit and
radius_no_fit_option is
'resize_radius', then this is the
minimum radius allowed.
<min_internal_angle=45.0> sets the
minimum internal angle at the
vertex to be filleted. If the internal
angle is lesser, it is not filleted.
<max_internal_angle=100.0> sets
the maximum internal angle at the
vertex to be filleted. If the internal
angle is greater, it is not filleted.
<num_points_on_360=16.0> sets
the resolution of the fillet as
resolution per 360.0 degrees. The
number of vertices on the fillet is
fillet-angle/360.0*num_points_on_360.
<masking_draw_layer="Draw layer
name"> If specified, the shapes in
this layer are used to mask the
vertices on the target layer, to either
exempt them or include them, based
on the 'use_negative_mask' setting.
<use_negative_mask=false> is only
active when 'masking_draw_layer'
is set to a valid draw layer.
<radius_no_fit_option=none/resize_radius>
Each vertex only 'owns' half the
edge on either side. If the fillet
radius is larger than 1/2 of the
smallest adjacent edge, then it
cannot fit in that space. In this case
if this option is set to 'none', the
vertex is skipped. If the option is
set to 'resize_radius', then 1/2 the
smallest adjacent edge is used as
the radius. <skip_ports=true/false>
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Syntax

Description
If set to true, vertices with ports
attached to them are skipped.

Via Fencing
DRAW_FENCE

DRAW_FENCE "optional:target_layer"
<linear_spacing=value
><proximity_spacing=value>
<spacingtype=center-to-center/edge-to-edge>
<oversize=value> <width=value>
<height=value>
<keep_paths_open_ended=true|false>
<path_min_rect_ratio=value>

Draws a via-fence around a shape,
based on the following arguments.
<linear_spacing=value> is the
linear spacing to maintain between
adjacent fence elements (FE). Each
FE has two neighbors, one to its left
and one to its right.
<proximity_spacing=value> is the
spacing to maintain between an FE
and any other FE that is not its
immediate two neighbors.
<spacingtype=center-to-center/edge-to-edge0>:
center-to-center is the spacing
computed between the centroids of
each fence element; edge-to-edge
is the spacing computed along the
boundary of the fence element. For
<oversize=value> oversize> 0, the
fence is drawn outside the
boundary. For oversize = 0, the
fence is drawn on the boundary. For
oversize < 0, the fence is drawn
inside the boundary. <width=value>
<height=value> is the dimension of
each of the fence elements
(bounding-box). For
<keep_paths_open_ended=true/false>,
if true, then SPP auto-detects if a
polygon is a path and keeps its ends
open. For
<path_min_rect_ratio=2.0>, for a
rectangle to be considered a path
the larger dimension to the smaller
dimension ratio must be greater
than this option (default is 2.0).

FILL_SHAPES "optional:target_layer"
<clearance=value ><width=value>
<height=value> <pitch_x=value>
<pitch_y=value> <stagger_row=0>
<stagger_col=0> <justify=false|true>

Fills a shape with via based on the
following arguments.
<clearance=value> is the closest a
via can get to the perimeter of the
shape from the inside.
<width=value> <height=value> are
the two dimensions of the
rectangular via. <pitch_x=value>
<pitch_y=value> are the minimum

Via Fill
FILL_SHAPES
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Syntax

Description
x and y axis displacements between
the nearest via centroids.
<stagger_row=0> <stagger_col=0>
can be used to stagger every
even-numbered row or column by
that amount. Use either row or
column and not both for
non-overlapping results. For
<justify=false|true>, when true, this
attempts to spread the via where
possible, to occupy the available
area in the shape more uniformly
(does not increase the number of
vias, it just spreads them and
maintains clearance and minimum
pitch).

Moving Ports Between Layers
MOVE_PORTS

MOVE_PORTS "from_layer" "to_layer"

Moves ports from draw layer
"from_layer" to draw layer
"to_layer". By default, there is a
sophisticated algorithm that moves
ports when the location where they
should be has moved. This rule
helps by specifying the layer to
search for the new port location.

MOVE_PORTS "from_layer" "to_layer"
<minimum_displacement>

Same as when no distance is
specified, but the port should move
at least <minimum_displacement>

MOVE_PORTS "from_layer" "to_layer"
<minimum_displacement>
<maximum_displacement>

Same as when no distance is
specified, but the port should move
in the range
(<minimum_displacement>,
<maximum_displacement>)

FIX_CAPS

FIX_CAPS

Heuristically detects the presence
of capacitors and prevents them
from snapping (but decimation is
allowed). Use this rule only when
other simplification approaches do
not properly simplify your
geometry.

FIX_RESISTORS

FIX_RESISTORS
<dc-resistance-limit(ohm/sq.)>

Resistor shapes with resistance
higher than <dc-resistance-limit>
are fixed and prevented from
snapping (but decimation is
allowed). Use this rule only when
other simplification approaches do

Capacitor and Resistor Processing
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Syntax

Description
not properly simplify your
geometry.

Region
REGIONS_BEGIN

REGIONS_BEGIN

First line of the REGIONS section.

REGION (Details)

REGION "new_layer"
"optional:sublayer1"="layer1" ...
"optional:subLayerN"="layerN"
(<Boolean_expressions>)

Create layer "new_layer" from the
result of the Boolean operations
(<Boolean_expressions>) on the
drawing layers
"optional:subLayerN"="layerN".

REGIONS_END

REGIONS_END

Last line of the REGIONS section.

BREAK_POLYGONS
"optional:target_layer"
<max_points_per_poly>

Breaks all specified polygons into
polygons containing a number of
vertices less than
<max_points_per_poly>.

SET_ARC_SNAP_MULT

SET_ARC_SNAP_MULT <value>

Gaps smaller than <min-gap> are
allowed to short when calling
SNAP_VERTICES or
SMALL_CORRECTIONS_SNAP.

SET_SHAPE_SNAP_MULT

SET_SHAPE_SNAP_MULT <value>

Set grid multiple for shape to shape
vertex snapping. For deprecated,
use SNAP_VERTICES instead.

SET_VIA_SNAP_MULT

SET_VIA_SNAP_MULT <value>

Set grid multiple for via to
via/shape vertex snapping. For
deprecated, use SNAP_VERTICES
instead.

DECIMATE

DECIMATE "optional:target_layer"
<level:1..6>

Decimates layer with the level set
from 1 (minimum) to 6 (maximum);
'target_layer' is optional. When
unspecified, is applied to all layers.

DECIMATE_TRACE

see DECIMATE

Decimates only trace nets (trace net
= at least one non-via shape in the
net connectivity should be less than
MAX_TRACE_WIDTH)

DECIMATE_GROUND

see DECIMATE

Decimates only non-trace nets
(trace net = at least one non-via
shape in the net connectivity,
should be less than
MAX_TRACE_WIDTH)

Miscellaneous
BREAK_POLYGONS

Legacy Rules Obsolete but provided
for backward compatibility with v9.x.
Use an active rule instead.

DECIMATE_PER_SHAPE_SETTINGS DECIMATE_PER_SHAPE_SETTINGS
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Label

Syntax

Description

CIRCLE_ARC_RESHAPE

no arguments

Uses value set in
SET_ARC_SNAP_MULT and
SET_SHAPE_SNAP_MULT to
reshape arcs/circles as stacks.
Deprecated, use the other rules
above.

12.7.4. Rule Details
The following sections provide details on select rules.
DECIMATE_MIN_EDGE
Syntax

DECIMATE_MIN_EDGE "optional:layer_or_list" <min-edge-length> <optional:max_angle=value>
<optional:skip_circles>
Example Usage

length_units um
decimate_min_edge "layer 1" 2.3 max_angle=70.0 skip_circles
Summary

Tries to decimate shapes, per shape, by removing vertices in such a way that there are no edges smaller than
<min-edge-length>. Setting <max_angle> prevents removal of vertices that rotate at the vertex more than that value.
Setting <skip_circles> skips decimation of circles.
Description

"layer_or_list"
"layer_or_list" is an optional argument that specifies the layer or a previously assigned 'list' for decimation. If this
argument is not present, all layers are decimated. Double quotes are required if the argument has spaces.
<min-edge-length>
This rule removes vertices that are attached to edges that are smaller in length than <min-edge-length>. In the following
figure, the 'Edge length 1' and 'Edge length 2' must be smaller than <min-edge-length>. Ideally, after you apply this rule
on a polygon shape, the shape should have no edges smaller than this value.
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Vertex to be decimated

Angle of rotation

The following conditions apply:
• If removing a vertex to eliminate a less than <min-edge-length> edge causes a short and/or an open circuit, it is not
done.

Vertex to be decimated
Shape 1
Angleof rotation

Shape 2

Overlap after decimating

• If the rotation angle (see the first figure) at the vertex is greater than the optional <max_angle> argument (default is
0 deg), it is skipped.
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• For vertices on a trace, if a vertex has a 'parallel' vertex (see the second figure), then either both the vertices must be
decimated together, or none at all. They must satisfy all of the previous conditions.

Trace shape

Vertex and ‘parallel’vertex in a trace are either decimated together,
Or not at all.

• If a vertex is shared between two shapes that are physically on the same vertical location, but are logically on two
different layers, then decimating only one layer does not allow that vertex to be decimated.
<max_angle=value>
Optional argument. Specifies the maximum allowed rotation angle at the vertex, that can be decimated, irrespective of
the edge lengths. Defaults to 0.0 degree.
<skip_circles>
Optional argument. If circles are reshaped using other rules, use this option to prevent them from being decimated further.
REGION
Syntax

REGION "new_layer" "optional:sublayer1"="layer1" "optional:subLayer2"="layer2" ...
(<Boolean_expressions>)
Example Usage

REGIONS_BEGIN
REGION EM_M1_M2
( Metal1 AND Metal1 )
REGION EM_M1_M2_M3 ( EM_M1_M2 AND Metal3 )
REGIONS_END
Summary

REGIONs are used to define each unique combination of drawing layers. Each REGION statement creates new layers
you can map to different EM layers and materials.
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Details:
• All ‘REGION’ statements must be grouped inside the REGIONS_BEGIN / REGIONS_END section.
• Only one REGIONS_BEGIN/_END block should appear in the SPP rules.
• Only lines starting with REGION can be in this section.
• At least one new layer will be created for each REGION statement. These are normal SPP layers that can be used after
the REGION_END statement.
• REGIONS_BEGIN and REGIONS_END have no parameters. They must appear on a line by themselves.
• The (<Boolean_expressions>) are the same as a normal BOOLEAN_OPS command. They should be enclosed in
parentheses, although if you just have a single layer, you can use that layer name by itself.
REGIONS can be defined in terms of other REGIONS. For example:
REGION EM_M1_M2
REGION EM_M1_M2_M3

( Metal1 AND Metal1 )
( EM_M1_M2 AND Metal3 )

The optional "sublayerN"="layerN" statements are for defining smaller regions inside the newly created region. One
common use is for defining ‘TOP’ and ‘BOT’ layer regions (for example, for MIM capacitors or crossovers). You can
add as many as you need. They are created by AND’ing the provided ‘layerN’ with the full region shapes.
For example, assume you have a process with two metal layers which can be used individually, or together as a 'plated'
line with a "Dielectric Via" layer connecting them. They can also be used as a capacitor (without the dielectric via layer).
For EM simulation, you want to create new shapes which are either M1 alone, M2 alone, or a single shape where the
metals are plated. Where the two metals overlap each other to form a capacitor, you want to create new layers for the
cap top and cap bottom shapes:
REGIONS_BEGIN
REGION EM_M1
REGION EM_M2
REGION EM_PLATED
REGION EM_CAP
REGIONS_END

Metal1
Metal2
(Metal1 AND (Metal2 AND ("Dielectric Via" RESIZE 2000)))
TOP=Metal2 BOT=Metal1 (Metal1 AND (Metal2 RESIZE 4000))

After these rules execute, you have new layers called EM_M1, EM_M2, EM_PLATED, EM_CAP_TOP, EM_CAP_BOT,
which you can map to different EM layers and materials in the EM mapping table.

12.7.5. Debugging Rules
There are several techniques available to debug the rules you are writing.
Previewing the Geometry
You preview the geometry to see what geometry will be sent to the simulator as was discussed at the beginning this
section. You can also view the simplified geometry by right-clicking the EM document and choosing Preview Geometry
to show the geometry after the simplification in a new EM structure. You can then measure distances, open a 3D view,
change layer visibility of this preview. You could open the 3D view of the original and processed geometry and view
the windows next to each other.
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Verbose Logging
Add the "VERBOSE_STATUS 1" command to your rules file to produce detailed output to the status window. With
this flag enabled you get lots of helpful information, like how many vertices and polygons in/out, how many vertices
snapped in a decimation step, and how many shapes in input and output of BOOLEAN_OPS commands (shape counts
in brackets). The picture below shows a sample output from this logging.

12.7.6. Rule Examples
The following are common rules examples.
Creating an Air Bridge Layer
In some IC processes, an airbridge is created by metal being deposited over a layer of some material that is then etched
away. The following figure shows a simple structure with this type of process where there is a line connecting to the top
plate of a capacitor. The airbridge is between the line and the capacitor.

To simulate this correctly, the overlap of the metal and airbridge should be on a different EM layer, since there is a
difference in height of the air bridge than just the metal. With only the shapes that are in this layout, there is no way to
properly set up the correct shapes and vias to move the airbridge up a layer. The 3D layout of this structure without any
processing is shown as follows.
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Notice that the top metal extends to the top of the cap and the airbridge shape is floating above these shapes. This is not
correct. By using rules, you can create the proper shapes for simulation, as shown in the following figure.

The rules used to create this layout are shown with comments above each to describe the purpose of each rule.
!Find the intersection of thick metal (metal on top of the cap) and air bridge, place
on temporary layer "temp1"
BOOLEAN_OPS "temp1" "Thick Metal" AND "Air Bridge"
!Subtract the resulting shape temp1 from thick metal, this will be the new thick
metal layer eventually
BOOLEAN_OPS "tmtemp" "Thick Metal" SUBTRACT "temp1"
!Resize the boolean and to make room for the vias
RESIZE "temp2" "temp1" 2000
!Intersection of oversized air bridge and original thick metal, this maintains the
width of the metal but keeps the oversize for the length
BOOLEAN_OPS "temp3" "temp2" AND "Thick Metal"
!Intersection of cut out thick metal and new via shape to create vias.
BOOLEAN_OPS "em_der_air_bridge_via" "temp3" AND "tmtemp"
!Put new resized air bridge back on air bridge layer
REPLACE "Air Bridge" "temp3"
!Put cut out shape for thick metal back on thick metal layer.
REPLACE "Thick Metal" "tmtemp"

Simplifying Plated Lines
For many MMIC processes, there is a concept of a plated line, which is just connecting two or more metallization steps
by opening up the insulator between them. Typically, the processing requirements are such that the sizes of each
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metallization step cannot be the same size, or the opening cannot be the same size, so small offsets result. See the following
figure for an example of what these layer offsets may look like.

The following figure shows a 3D view of the unsimplified shapes on the left and the simplified shapes on the right. The
spacing between the two metallization layers is not to scale, to more easily see this shape.

The rules used to create this layout are shown with comments above each to describe the purpose of each rule. In this
example, the resulting shape to simulate is placed on a new layer called "em_thick_metal" which must be added to the
drawing layer list. You must set up EM mapping for this approach to work.
!Set the units for any sizes to be microns.
UNIT um
!Find intersection of Cap Bottom and Nitride Etch, good enough to define a plated line
in this case
BOOLEAN_OPS "temp3" "Cap Bottom" AND "Nitride Etch"
!Resize this new layer to be the full width of the line, em_thick_metal is a new
drawing layer added and is mapped
!Now have all the new layer to simulate, just need to remove other shapes at the same
locations.
RESIZE "em_thick_metal" "temp3" 5
!Subtract new thick metal shape from cap bottom to new layer
BOOLEAN_OPS "cb_temp" "Cap Bottom" SUBTRACT "em_thick_metal"
!Replace new layer with original cap bottom, not needed just for the line, but would
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need for other structures, caps, etc.
REPLACE "Cap Bottom" "cb_temp"
!Repeat the subtract and replace for the next two lines for the original plated line.
BOOLEAN_OPS "ne_temp" "Nitride Etch" SUBTRACT "em_thick_metal"
REPLACE "Nitride Etch" "ne_temp"
BOOLEAN_OPS "tm_temp" "Thick Metal" SUBTRACT "em_thick_metal"
REPLACE "Thick Metal" "tm_temp"

Signal vs Ground Vias
For complex PCB processes, there are typically two types of vias: vias used for signals and vias used to tie ground planes
together. You can use the rules to distinguish between the different types of vias and simplify differently. The following
figures demonstrate by showing the 2D and 3D layout of a simple structure.

Notice that all the vias are on the same layers, but some connect ground planes and some connect signal paths. The
following shows the 3D view of the simplified shapes. The vias in the signal path are octagons and the vias on the ground
planes are squares.

The rules used to create this layout are shown with comments above each to describe the purpose of each rule.
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!all distances set will be in mils
UNIT mil
!maximum width of a signal path will be 30 mils.
MAX_TRACE_WIDTH 30.0
!resize the ground vias on the Via MS 2 Gnd to have 4 sides.
RESHAPE_GROUND_VIA_CIRCLES_DIVS 4 "Via MS 2 Gnd"
!resize the signal vias on the Via MS 2 Gnd to have 8 sides.
RESHAPE_TRACE_VIA_CIRCLES_DIVS 8 "Via MS 2 Gnd"
!resize the ground vias on the Via SL 2 Gnd T to have 4 sides.
RESHAPE_GROUND_VIA_CIRCLES_DIVS 4 "Via SL 2 Gnd T"
!resize the ground vias on the Via SL 2 Gnd T to have 8 sides.
RESHAPE_TRACE_VIA_CIRCLES_DIVS 8 "Via SL 2 Gnd T"
!resize the ground vias on the Via SL 2 Gnd Bto have 4 sides.
RESHAPE_GROUND_VIA_CIRCLES_DIVS 4 "Via SL 2 Gnd B"
!resize the ground vias on the Via SL 2 Gnd Bto have 8 sides.
RESHAPE_TRACE_VIA_CIRCLES_DIVS 8 "Via SL 2 Gnd B"
!any via pads that are not connected to and have a ratio of the area of the pad
!divided by the area of the via is less than 4, then remove the pad
REMOVE_VIA_PADS 4.0

12.8. Creating Arbitrary 3D EM Structures
This section describes how to create arbitrary 3D EM structures in the AWR Design Environment platform. Structures
are generated or modified using the AWR 3D Editor.

12.8.1. Creating a New Arbitrary 3D EM Structure
To create a new Arbitrary 3D EM Document:
1. Right-click EM Structures in the Project Browser and choose New Arbitrary 3D EM Structure, or choose Project > Add
Arbitrary 3D EM Structure > New Arbitrary 3D EM Structure. The New 3D EM Structure dialog box displays.
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2. Enter a name for the EM structure, choose from the Initialization Options, then click Create. An EM structure window
opens in the workspace, and the Project Browser displays the new EM structure and its subnodes under EM Structures.

12.8.2. Initialization Options
The initialization options for a 3D EM structure can define the initial material set available for use in the 3D EM structure
and are defined in the same way as 2.5D EM structures: “Initialization Options”.

12.8.3. Simulator, Mesh, and Simulation Frequency Options
All of the simulator, mesh, and frequency options also have a consistent use model as 2.5D EM structures. For details
on setting the default values for each new EM structure or how to navigate to each EM structure's individual set of
options, see “Simulator, Mesh, and Simulation Frequency Options”.

12.8.4. Creating Arbitrary 3D EM Geometries
You must use the AWR 3D Editor to add or modify shapes in an Analyst arbitrary 3D EM structure. To open the arbitrary
3D EM structure in the 3D editor, right-click on the arbitrary 3D EM structure and choose Open in 3D Editor. Once in the
3D editor you can add or modify shapes and their materials. See “Analyst 3D Editor Help” for details on accessing 3D
editor Help.

12.8.5. Creating Arbitrary 3D EM Structures from Existing 3D EM Structures
Sometimes the majority of an EM structure is planar, yet a portion of it can only be modeled in true 3D space. If the
planar 3D portion was designed in a 2.5D editor, you may need to re-create the geometry in a 3D editor. This is quite
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inefficient. In the AWR Design Environment platform you can convert a geometry from a 2.5D representation to a full
3D representation that you can then modify in a true 3D editor.
To convert a 2.5 representation of a 3D EM structure to a full 3D representation, from the 2D layout of the EM document
to be converted:
1. Choose Layout > Copy to Arbitrary 3D EM Structure.
2. Name the new EM structure and click Create.

A new arbitrary EM structure that is a 3D representation of the original 2.5 EM structure displays in the EM Structures
node. Note that you can only run this command from 3D EM documents, such as Analyst.
You can open the new arbitrary 3D EM structure in the 3D editor where you can modify the geometry to include shapes
that can only exist in a true 3D editor.
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Chapter 13. EM: Automated Circuit Extraction (ACE)
Automated Circuit Extraction (ACE) is a method of automatically modeling the electrical characteristics of a single
signal line or a group of signal lines using the built-in transmission line models, discontinuities, lumped elements, and
via models. The signal lines can be comprised of iNets and transmission line elements. Unlike EM extraction which uses
an EM simulator, ACE uses the circuit simulator which leads to a meaningful simulation of a circuit in a relatively short
time.
While ACE is an advanced method of electrical analysis of the signal lines and interconnects using the transmission line
models, the quality of the simulation results is directly related to the configuration of the extraction. The extraction does
not guarantee accurate results just because it uses the models to represent the circuit. Extraction effectively removes the
tedious tasks required to construct the circuit schematic using a number of elements. The set up of an extraction should
be considered the same as constructing the circuit using the schematic elements, (making sure that the circuit is represented
by proper models).
The Net(s) or distributed models to be associated in ACE can be selected either in a schematic or in a layout. A separate
model parameter is used to define this association. When this mode of simulation is selected, an extracted document is
automatically generated under EM Structures in the Project Browser using the schematic layout and the associated
STACKUP properties. The types of model used for the circuit need to be defined in the extraction options. The circuit
simulator then runs and uses the built-in models to construct a circuit as per extraction setup to represent the layout. The
simulation results then automatically represent the schematic for the layout.
The geometry to be simulated in the extraction comes directly from the Layout View of the commanding schematic.
This concept is essential to the methodology of the extraction process; the contents of the Layout View are electrically
modeled using the built-in models.
After a group of layout nets or circuit models are associated with an extraction, the electrical models of these shapes are
effectively added to the schematic, and ports are added at every connection to the shapes outside of the extraction group.
When simulation proceeds, the layout shapes of each of the associated nets are written into an extracted document,
modeled using the built-in models and simulated using the linear simulator. These simulation results are then automatically
incorporated back into the entire schematic as if including them as a schematic subcircuit with built-in models. Once set
up, the extraction reflects any changes in the layout as a new analysis.
Elements that can be selected for ACE extraction include iNets, MLIN, CLIN_SYM_2-10, CLIN_ASYM2-16, MCFIL,
MLEF, MCTRACE, and MTRACE2 elements. The advantage of including these elements in an ACE simulation is that
ACE can calculate the coupling between these models where the models themselves may not account for the coupling.
For example, MLIN models in a schematic have no way of accounting for coupling if they are close together. To account
for coupling, you can use a coupled microstrip model, or include the two MLIN models in an ACE extraction.

13.1. Overview of Extraction Setup
This section presents the basic steps required to set up a Circuit Based extraction.
Consider the schematic shown in Figure 13.1, “Circuit Schematic for Automated Circuit Extraction ”, with its corresponding
layout shown in Figure 13.2, “Original Schematic Layout”. The schematic consists of two sets of resistors connected by
wire. The resistors shown in the layout are not extracted. The goal is to connect the resistors in layout with iNet routing
and then model the interconnects using the ACE feature.
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Figure 13.1. Circuit Schematic for Automated Circuit Extraction
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Figure 13.2. Original Schematic Layout

13.1.1. Extraction Process
Before the extraction process, perform the following steps manually:
1. Set up Line Types in the LPF (Layout Processing File). See “The Layout Process File (LPF)” for information on how
to configure the LPF. This is essential, as the extraction process only recognizes the line types defined in STACKUP.
The same line types then must be used with iNet routing.
2. The extraction process is controlled by the STACKUP element, which needs to be set up carefully to best represent
the circuit and to ensure the accuracy of the results.
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3. Via modeling must be set up. A Via mapping text file and via model need to be defined to model the via during
extraction.

13.1.2. Configuring the STACKUP Element
The first step in setting up the extraction process is to set up the STACKUP element. If this element is already configured
for the Process Design Kit (PDK) you can use it from the kit.
The STACKUP element is used to set up the dielectric stackup for the circuit being extracted. It represents a generalized
multi-layered substrate stackup. Figure 13.3, “Addition of the STACKUP Element to the Original Schematic.” shows
the addition of this element.
Figure 13.3. Addition of the STACKUP Element to the Original Schematic.
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After you add the STACKUP element you need to set its properties to represent the desired dielectric stackup. In this
example, it duplicates the stackup of the MSUB elements. Double-click the STACKUP element to display its Element
Options dialog box. You must configure the Material Defs, Dielectric Layers, Materials, and Line Type tabs. See “Configuring
Stackup” for details on setting up the STACKUP.
Figure 13.4, “Nets routed with iNets” shows the layout nets routed with iNets. The upper set of resistors is routed on
line M1 and the lower one is routed with line M2.
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Figure 13.4. Nets routed with iNets

13.1.3. Adding the Extraction Control Element
The second step in setting up an automatic extraction is to add an EXTRACT control element to the schematic. The
EXTRACT element extracts the net(s) and assigns them to a group which is used by a linear circuit simulator. The X
and Y_Cell_Size and Extension parameters are not used and can be ignored. The EXTRACT element is located in the
Elements Browser in the Simulation Control category. Figure 13.5, “Addition of the EXTRACT Simulation Control”
shows the schematic with the EXTRACT simulation control added.
Figure 13.5. Addition of the EXTRACT Simulation Control
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The EXTRACT element parameters must be configured for automatic extraction. See the EXTRACT element in the
Microwave Office Element Catalog Help for details. The following briefly reviews these parameters in the context of
the extraction process:
• EM_Doc - the name of the extracted document to be created to collect the nets associated with the extraction.
• Name - the name for the extraction group. This name is also used for extraction through levels of hierarchy.
• Simulator - the name of the simulator used to simulate this extraction document. This should be set to ACE.
• X and Y Cell Size - the cell sizes used in the extracted document. This does not affect the circuit simulation.
• STACKUP - the name of the STACKUP element used to determine the dielectric stackup of the extracted document.
If let blank, it uses the first one found in the schematic or the Global Definitions.
• Create_Enclosure - turns on or off the automatic reconfiguration of stackup after the extracted document is created.
• Create_Shapes - determines whether or not to send the shapes to the extracted document every time a simulation is
required.
• Extension - not used in circuit extraction.
• Override_Options - simulator options can be set on the EXTRACT block as well as directly on the EM document.
With this option set to Yes, the options set on the EXTRACT block override the options set directly on the EM structure.
• Hierarchy - determines how to treat this extraction block if used at lower levels of hierarchy, see “Extraction Through
Hierarchy” for more information.
• Extract_LineTypes - set this to No.
If the extracted network will be simulated with a transient simulator, the EXTRACT block has a SPICE Model Generation
tab that controls how ACE extracted netlists are used in transient simulations.

13.1.4. Adding iNets and/or Line Models to the Extraction Group
Both iNets and certain distributed models are supported for ACE, including the MLIN, CLIN_SYM_2-10,
CLIN_ASYM2-16, MCFIL, MLEF, MCTRACE, and MTRACE2 elements.
The next step in setting up the circuit extraction is to associate iNets and/or line models with the extraction group. In this
example both of the iNets are associated with the extraction group. There are two ways to associate with the extraction
group. One is to select the wire or model in the schematic and the other is to select the layout objects. Selecting a wire
in the schematic selects the entire corresponding iNet in layout. In layout, selecting just a section of an iNet selects the
entire iNet for extraction. This is often more convenient, as in the Layout View it is easier to identify nets that are in
close physical proximity.
In this example, in the Schematic View select a wire, right-click it, and choose Edit Net Properties to display the Element
Options dialog box. Click the Model Options tab. In the EM Extraction Options area, select the Enable check box and in
Group name enter the extraction group name as "Circuit_Extract". Figure 13.6, “Model Options Tab Configured for
Extraction” shows the Model Options tab with these settings.
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Figure 13.6. Model Options Tab Configured for Extraction

If working in Layout View, select an iNet, right-click it, and choose Element Properties. Click the Model Options tab and
assign an extraction group.
Note that you can select multiple objects in Schematic or Layout Views and assign them for extraction.
After associating nets for extractions, select the EXTRACT element in the schematic and notice that all the elements
associated with the extraction are highlighted as shown in Figure 13.7, “Schematic Wires Association with EXTRACT
Element”. Similarly, in the Layout View, the iNets associated with the extraction are highlighted as shown in Figure 13.8,
“iNets Association with EXTRACT Element”.
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Figure 13.7. Schematic Wires Association with EXTRACT Element

MSUB
Er=4.47
H=10 mil
T=0.1 mil
Rho=1
Tand=0.015
ErNom=12.9
Name=SUB3

MSUB
Er=4.47
H=10 mil
T=0.1 mil
Rho=1
Tand=0.015
ErNom=12.9
Name=SUB2

EXTRACT
ID=EX1
EM_Doc="Circuit_Extract_Doc"
Name="Circuit_Extract"
Simulator=ACE
X_Cell_Size=1 mil
Y_Cell_Size=1 mil
STACKUP="SUB1"
Override_Options=Yes
Hierarchy=Off

STACKUP
Name=SUB1

PORT
P=1
Z=50 Ohm

TFR
ID=TL1
W=3 mil
L=5 mil
RS=50
F=10 GHz

TFR
ID=TL2
W=3 mil
L=5 mil
RS=50
F=10 GHz

PORT
P=3
Z=50 Ohm

TFR
ID=TL4
W=3 mil
L=5 mil
RS=50
F=10 GHz

TFR
ID=TL3
W=3 mil
L=5 mil
RS=50
F=10 GHz

PORT
P=2
Z=50 Ohm

PORT
P=4
Z=50 Ohm

Figure 13.8. iNets Association with EXTRACT Element

13.1.5. Configuring ACE Simulation Options
ACE options are set up on the EXTRACT block. The accuracy of the circuit simulation depends on this configuration.
Double-click the EXTRACT block. In the Element Options dialog box click the ACE tab in Figure 13.9, “ACE EXTRACT
Setup Dialog Box”.

Simulation and Analysis Guide 13–7

Overview of Extraction Setup
Figure 13.9. ACE EXTRACT Setup Dialog Box

The models used to construct a circuit for an extracted document depend on the ACE options. For more information on
these options, see “Options Dialog Box: ACE Tab”.
The circuit for this example is extracted using the settings shown in Figure 13.9, “ACE EXTRACT Setup Dialog Box”.
Add a graph to plot S21 for the schematic or the extracted document and simulate. When an extraction is first performed
(or the extracted document is first created) the set of frequencies from the schematic with the EXTRACT block are copied
to the extracted document frequencies. The extracted document frequencies are not set to use the project default frequencies.
Once the extracted document is set up with these frequencies, no further automatic update of the frequencies is done,
unless the extracted document is deleted and recreated. A new set of frequencies can then be assigned to the extracted
document and this remains unchanged. The circuit simulator constructs a circuit to represent the layout using the models
specified in the Circuit Extract options. The circuit that gets simulated is equivalent to the circuit that you would create
in a schematic using the element models. After the simulation is complete, click the Status Window button on the toolbar
to display the Simulation Information window. Click the "Extracted netlist information" line in the Status Window to
display the netlist for the circuit that was sent to the circuit simulator. The netlist displays as shown in Figure 13.10,
“Netlist of the Circuit Representing the Extracted Document”. Notice that the models the circuit simulator uses to construct
the circuit are the same as those in the Elements Browser.
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Figure 13.10. Netlist of the Circuit Representing the Extracted Document

You can view the circuit that represents the extracted document by adding an annotation to the 3D view of the extracted
document. In the Project Browser, right-click the extracted document "Circuit_Extract_Doc" and choose Add Annotation.
Expand Annotate > ERC under Measurement Type and choose EXT_CKT3D under Measurement and add the measurement
as shown in Figure 13.11, “Add Annotation to Display the Circuit Representing the Extracted Document”. For more
information on this measurement, see the Microwave Office Measurement Catalog Help.
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Figure 13.11. Add Annotation to Display the Circuit Representing the Extracted Document

The circuit is annotated as shown in Figure 13.12, “Extracted Circuit Annotated in the 3D View”
Figure 13.12. Extracted Circuit Annotated in the 3D View
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13.1.6. Viewing an EM Structure without Simulating
Now that the entire extraction is configured, the extracted document is first created and is further configured for built-in
model selection before simulation. If this step is not performed (simulated after setting up the extraction), the extracted
document is automatically created and is simulated with the default circuit setup. To extract the structure before simulation,
in the Project Browser under Circuit Schematics, select the schematic containing the EXTRACT simulation control,
right-click and choose Add Extraction.
Figure 13.13. Creating the EM Document without Simulation

The extracted document specified by the EXTRACT control is created. Figure 13.14, “Extracted Document” shows the
extracted document.
Figure 13.14. Extracted Document
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13.2. Advanced Extraction Topics
This section includes advanced extraction topic such as multiple extraction.

13.2.1. Multiple Extractions in a Single Schematic
You can apply a multiple extraction within the same schematic. You should use this technique if an interconnect or
interconnects in the layout need to be modeled differently than the others. To enable multiple extractions, simply add
another EXTRACT control to the schematic. Figure 13.15, “Schematic with Two Extraction Groups Highlighting the
Elements in the Second Extraction Group” and Figure 13.16, “Layout View of Isolated Nets Highlighting the Elements
in the Second Extraction Group” show a schematic and layout that have two isolated nets and two EXTRACT controls.
Note that the Name parameter of the second EXTRACT control is changed to "Circuit_Extract_Line2" and the EM_Doc
parameter is set to "Circuit_Extract_Doc_Line2". As in the previous section, the top line routed with M1 is added to the
extraction group named "Circuit_Extract". The bottom line routed with M2 is assigned to the extraction group named
"Circuit_Extract_Line2". Figure 13.17, “EM Document Produced by the "Circuit_Extract" Extraction Group” and
Figure 13.18, “EM Document Produced by the "Circuit_Extract_Line2" Extraction Group” show the two extracted
documents created by the two extractions.
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Figure 13.15. Schematic with Two Extraction Groups Highlighting the Elements in the Second Extraction Group
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Figure 13.16. Layout View of Isolated Nets Highlighting the Elements in the Second Extraction Group
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Figure 13.17. EM Document Produced by the "Circuit_Extract" Extraction Group

Figure 13.18. EM Document Produced by the "Circuit_Extract_Line2" Extraction Group

13–14 AWR Design Environment

Chapter 14. EM: EMSight
EMSight is a full-wave electromagnetic (EM) solver based on a modified spectral-domain method of moments. This
method is used to accurately determine the multi-port scattering parameters for predominantly planar structures.
This chapter applies mainly to the analysis methods of EMSight (EMSight is the simulator associated with the EM
structure). If you select a third-party simulator you should consult the documentation provided by that vendor for analysis
details.
EMSight can analyze circuits with an unlimited number of layers and an unlimited number of ports. The circuit is analyzed
inside of a multi-layered rectangular enclosure. A gridded, variable cell size mesh is automatically generated which
places smaller cells in areas that have high variations in current densities, and larger cells in areas with more uniform
current variations. You can control the mesh by changing the meshing density of specific polygons. You can view the
generated mesh while editing the geometry so the effect of changing the meshing density is seen instantly. The
discontinuities that arise from the excitations at the ports can be automatically removed by EMSight's de-embedding
algorithm. In addition, you can use arbitrary reference planes for the de-embedding. The reference plane lengths are set
by clicking and dragging the reference plane symbols.

14.1. EMSight Enclosure
The enclosure represents a box with grounded side walls that limit the region of analysis. The enclosure properties
describe the dimensions and resolution of the rectangular enclosure. The resolution also defines the drawing grid for the
structure. For more information about the Enclosure tab of the ENCLOSURE Properties dialog box, see “Element
Options-(EM) ENCLOSURE Properties: Enclosure Tab”.
When using EMSight, all shapes drawn in EM structures should coincide with the drawing grid because the mesh must
coincide with the grid. The cell size or grid spacing is specified by setting the Grid_X and Grid_Y Grid settings. The
dimension and the cell size do not need to be the same for the X and Y directions.

When using EMSight, the optimum cell size for a given problem is determined by several factors. While smaller cell
sizes should provide a more accurate simulation, the use of cells that are too small greatly increases the solve time. It is
generally advisable to initially use the largest cell size that can accurately approximate the geometry (assuming the cell
sizes are still small enough to give a good approximation to the current density in the conductor). If the cell size is too
large, the results of the simulation may not be accurate enough, in which case the cell size can be reduced until there is
no change in simulation results. If the cell size is larger than about a tenth of a wavelength, the mesh created from the
cells may not be able to provide an acceptable approximation of the current on the conductors.
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14.2. EMSight Ports
Ports are two terminal devices used to model the input and output terminals of the structure. Physically, a port represents
a gap voltage source that excites current in the structure. The solution for the current is found during the simulation
process. The linear port parameters (S-parameters, for example) are then calculated from the computed currents.
The Cadence® AWR Design Environment® platform EM structure supports three kinds of ports: edge ports, via ports,
and internal ports. The AWR Design Environment program allows an unrestricted number and combination of ports.

14.2.1. Adding Edge Ports
You can only add an edge port to a conductor side that is flush with the boundary of the enclosure.

To add an edge port, select a conductor and choose Draw > Add Edge Port. Move the cursor onto the flush side; an outline
of the port displays. Click to place the port.
Port numbering is automatic; the port numbers increase as you add ports. To change a port number, delete the ports and
add them back in the desired order.

14.2.2. Setting the Reference Planes

To set the reference plane of a port, select the port, click the reference plane highlighted at the flush end, and drag it with
the mouse. The arrow as shown in the previous figure displays, the end of which defines the new reference plane. If the
reference plane coincides with the port edge, the arrow is not visible. Note that if you add more than one port on the
same side of the enclosure, all reference planes are stretched simultaneously.

14.2.3. Setting the Port Excitation or Termination
The computation of the port parameters does not depend on the excitations or terminations at the ports, however, the
current density computation and antenna analysis depend on these settings. To set the port excitation or termination,
double-click the port to display the Port Attributes dialog box.
You can specify the port as an excitation or termination port. For an excitation port, you can set a relative magnitude
and angle for the port excitation along with the source impedance. Note that the magnitude of the excitation is described
by an available power, meaning that if the port is conjugate-matched to the specified impedance, the specified amount
of power enters the structure.
For a termination port, you can specify the resistance and reactance of the termination. The ability to solve for the currents
in the structure with terminations on the ports allows the current animation to show the waves traveling through the
structure (the usual short-circuit solution only shows a standing wave of the currents in the structure). Specifying the
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excitation or termination at a port only affects the current animation. Electrical port parameters (for example, S-parameters)
assume a port impedance of 50 ohms. To change the reference, place the EM structure as a subcircuit in a circuit schematic
and edit the port impedance.

14.2.4. Adding Via Ports
Via ports are similar to edge ports in that they are typically connected to the top or bottom boundary of the EM Enclosure.
Via ports are used to add terminals between the enclosure boundary and the EM structure. The boundary must be
conductive, because it serves as the ground reference for the port. You can use via ports to create probe feeds as shown
in the following figure for a patch antenna.

To add a via port, select Via in the EM Layer Selection pane and choose Draw > Add Via Port. Draw a rectangle to draw
a via port. Once created, you can modify the via port by double-clicking it.
Port numbering is automatic; the port numbers increase as you add ports. To change a port number, delete the ports and
add them back in the desired order.

14.2.5. Adding Internal Ports
Internal ports are the most complicated of the three ports, and should be used with caution. To use the internal ports
effectively requires a good understanding of both the implementation of the internal ports and the concept of a local
ground reference. The resulting S-parameters from a simulation that uses the internal ports is not a general S-parameter
and there is a relatively non-intuitive methodology that must be followed in order to get meaningful results.
To add an internal port, select the polygon that is to be the negative terminal for the internal port, then choose Draw >
Add Internal Port. Move the cursor onto the edge of the polygon where a port is desired; an outline of the port displays.
Click to place the port. The positive terminal of the internal port displays a "+" sign as shown in “Internal Port Example”.

14.2.6. Description of Internal Ports
The port parameters of the passive EM structure are determined at all ports, for example, both external and internal ports.
The internal ports allow connection of arbitrary two-terminal or three-terminal devices. A three-terminal internal port
can be connected to an active FET (Field-Effect-Transistor) while two-terminal internal ports can be used for passive
FET switch devices, lumped elements, diodes, or any other two-terminal device.
An internal port does not use the same ground reference as the external ports or any other internal ports. The lack of a
common ground between different internal ports leads to the restriction that devices connected to the internal ports
cannot be connected to other ports or ground. In addition, the electrical distance between the actual terminals of the
ports needs to be small compared to a wavelength. The internal ports are most useful when a connection of zero-dimensional
electrical components is required.
The internal port is implemented using the same technique that is used for the external ports. A gap voltage source is
applied at the terminals of the internal port, and the resulting current distribution is computed. The following shows a
configuration for a single internal port, where T1 and T2 are the terminal connections for the port. The admittance looking
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into the port is found from the magnitude of the current basis at the port (the center basis in the following figure). An
assumption in the implementation requires that the current flowing into T1 must equal the current flowing out of T2.
Also, the voltage at each terminal is unknown (floating reference), only the voltage across the terminals is known.

The terminal characteristics of a circuit that does not have any connection to the reference ground can be represented by
an indefinite Y-matrix. For a typical electromagnetic simulation, both internal and external ports are used. The results
from the simulation are in the form of a definite Y-matrix (the ground reference is part of the circuit). The key point is
that the port that represents the internal port does not use the same ground reference as the other ports. Effectively, the
ground reference for the internal port is the negative terminal of the port as shown in the previous figure. When a device
is to be connected across this internal port in the circuit simulator, the negative terminal of the device is connected to
ground in the circuit simulator (although in reality this is actually just a local ground for that port).
There are several restrictions regarding what can be connected to this internal port. The restrictions are that lumped
models' terminals are electrically "close" to each other, and the lumped description must also be in indefinite form (not
connected to ground). The latter restriction is not a problem as it is easy to convert definite admittance descriptions to
indefinite form (the conversion is built into the circuit simulator. It is this feature that allows the connection of a two-port
device as a three-port, as is commonly done when adding series feedback to a FET model). Also, internal ports that are
not electrically close to each other should not be connected together using the lumped circuit models.

14.2.7. Internal Port Example
The following example illustrates the use of internal ports. To use internal ports, there must be two polygons that are
adjacent to each other as shown in the example. The internal port is added between the two polygons which are touching
each other.

To add the internal port, select the polygon that is to be the negative terminal for the internal port, then choose Draw >
Add Internal Port. Move the cursor onto the edge of the polygon; an outline of the port displays. Click to create the port.
The positive terminal of the internal port displays with a "+" sign.
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>NOTE: There must be a polygon on each side of the internal port or the results are meaningless. The EM simulator
does not check for this condition and runs the analysis regardless. The following example would lead to meaningless
results:

Port numbering is automatic; the port numbers increase as you add ports. To change a port number, delete the ports and
add them back in the desired order.

14.2.8. Using the Results of the Internal Port Example
The following schematic illustrates how to connect a 100 ohm resistor across the internal port terminals. The end of the
resistor to be connected to the negative terminal of the internal port must be connected to ground in the schematic.
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If the previous example is simulated at a low enough frequency that the distributed sections of the EM structure are
electrically very short, the resulting S-parameters will be the same as for a 100 ohm resistor connected between Ports 1
and 2.

14.2.9. Example Using a Three-Terminal Device
With care, you can embed a three-terminal device such as a FET into an EM simulation by using the internal ports. This
application assumes that the FET model is for the intrinsic FET only, and no de-embedding is done at the internal ports.
The following is an example of a three-terminal device.

In this FET structure, there are four internal ports and two external ports. In the equivalent circuit model that follows,
the external ports are represented by the single G and D terminals. The voltage associated with these external terminals
is relative to the common ground (also shown). The internal ports are represented by two terminals each. The voltage
associated with an internal terminal is the voltage across the terminal pair. If the FET is assumed symmetric, then any
external excitation on ports G or D results in the voltages at terminals g1 and g2 being at the same potential, and the
voltages at terminals s1 and s2 being at the same potential. Since the terminals are at the same potential, the terminal
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points can be connected together to allow for the FET to be represented by the equivalent circuit (shown in the following
figure), where the gate terminal is represented as a floating (non-common) ground, since it is a common terminal to all
the terminal pairs shown in the previous figure. (The symmetry is not a requirement, but allows for a more compact
representation).

The following figure shows how the circuit would be connected in the circuit simulator.

In the previous figure, the positive terminals of the internal port are indicated as s1, s2, d1 and d1 to match the first figure.
The external terminals are marked as G and D. The grounding of the FET's gate is actually a connection to the virtual
ground of the gate terminal.

14.3. De-embedding
The process of de-embedding removes the effects of the port discontinuities and feedlines from the results of the simulation.
EMSight features automatic de-embedding; the de-embedding procedure is illustrated as follows. The details discussed
in this section apply specifically to EM structures which use EMSight as the EM solver. If you use a third-party solver
you should check the vendor documentation for details on de-embedding.

The result of the simulation yields the S-parameters for the entire structure previously including the port discontinuity
Z and the length of transmission line leading up to the reference plane. The result can be represented by the following
three cascaded circuits. The first circuit block is shown in greater detail in the box below it. The automatic de-embedding
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procedure is used to compute the S-parameters of the DUT using the solution of the de-embed standards and the original
result.

14.3.1. The Standard De-embedding Algorithm in EMSight
The de-embedding procedure requires the analysis of two separate "de-embedding standards" to perform the de-embedding.
The standard de-embedding method requires a completely separate analysis with a different sized enclosure. The enclosure
used for the separate simulation uses an enclosure that is twice the length of the reference plane length to be de-embedded.

The standard algorithm sometimes has difficulty de-embedding the structure when the length of the reference plane is a
multiple of a quarter wavelength. The standard algorithm can be used for any number of ports on a side. The de-embedding
of multiple ports on a side takes into account the coupling that occurs between the multiple conductors associated with
the feed lines.
When using the standard de-embedding algorithm, the reference planes need to be far enough from the edge of the
enclosure that the higher order modes caused by the port discontinuity do not effect the de-embed results. A guideline
is that the reference plane should be about two substrate heights away from the edge. An exception to this is that zero
length reference planes can be used (the de-embedding then removes just the port discontinuity).

14.3.2. The Fast De-embedding Algorithm in EMSight
The fast de-embedding algorithm determines the required "de-embedding standards" using the moment tables from the
main structure, which eliminates the need to compute a new set of moment tables for the de-embedding process.
The drawback of the fast de-embed algorithm is that it is currently only implemented for the de-embedding of sides that
have a single port. When there are multiple ports on a side, the standard de-embedding routine is automatically used
instead of the fast de-embed routine. The other drawback with the fast de-embedding algorithm is that it fails when the
length of the enclosure is close to a multiple of a half wavelength. The solver issues a warning when it detects this
problem.
With the fast de-embedding algorithm, the reference planes do not need to be kept far away from the edge of the enclosure.
Any length of reference plane should provide valid results (with the exceptions noted earlier), although if you have a
discontinuity close to the port, the results will have some error due to the interaction of the port and the discontinuity.

14.3.3. De-embedding Issues in EMSight
For zero length reference planes, the fast de-embed algorithm and the standard algorithm are the same, and they should
yield identical results. When a zero length reference plane is specified and the de-embedding is enabled, only the port
discontinuity is removed.
The solver computes the impedance and propagation constants of the feed lines for sides of the enclosure that have only
one port. If the de-embedding standard is a multiple of a half wavelength then the solver may not give an accurate answer
for the impedance or propagation constant.
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14.3.4. De-embedding of Via Ports in EMSight
Currently the de-embedding of via ports is not automatic in EMSight, and any discontinuity that results from the presence
of the via in the circuit becomes part of the solution. Although automatic de-embedding is not supported, manual
de-embedding can be done using the two port negation element (NEG2) that is part of the linear circuit simulator. The
following example illustrates:
In the following structure the effect of the port via is de-embedded.
EM Structure Named "Structure"

To use the negation element, you should create a second structure with the via port structure and a feedline as follows.
This structure should have the same line widths and height as the structure to be de-embedded, and the via should have
the same cross-section and position relative to the edges of the line. The x and y size of the enclosure can be smaller than
the main structure to reduce the simulation time.
EM Structure Named "Standard"

The de-embedding should be turned on for both the structures shown previously. Once the solution is obtained, create
a schematic with the main structure and the negation element as follows.
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The resulting S-parameters for this structure have the effect of the via removed back to the reference plane indicated in
the first structure shown previously. For more information on the negation element, see “(Obsolete) 2-Port Negation
Element (Closed Form): NEG2”.

14.4. Conductor Meshing
The current that is computed during the simulation is approximated by a mesh of non-uniform rectangular cells. The
meshing options for a structure are controlled on the Mesh tab of the EM Options dialog box. You can view the mesh
for a structure by right-clicking the structure name in the Project Browser and choosing Add Annotation. In the Add EM
Structure Annotation dialog box choose the EM_MESH measurement located under the Planar EM measurement type.
The mesh is only viewable in the 3D view of the structure.
The following figure shows the structure with the mesh on. See the applicable vendor documentation for details when
viewing the mesh using a third-party simulator.

In addition to controlling the mesh generation for the entire structure, you can set the meshing properties for individual
conductor shapes. The default settings for a conductor use the default properties set in the EM Options dialog box.
(Choose Options > Default EM Options.) The following dialog box displays the Mesh tab of the EM Options dialog box.
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Using EMSight as the selected simulator, the size of the cells is determined by the estimated wavelength for a transmission
line on the same layer. In addition, the meshing options allow the specification of a meshing density of Low, Normal, or
High. The meshing can also be set to create one mesh cell for every grid cell by selecting No variable mesh. A mesh that
uses a Low meshing density has larger mesh cell sizes with a corresponding lower level of accuracy. Normal mesh density
is the default, and you can use High or No variable mesh when you want higher accuracy. The min and max settings at
the bottom of the dialog box specify the minimum and maximum size of a mesh cell in cell units.

14.4.1. Specifying Individual Conductor Mesh Properties
In addition to controlling the mesh generation for the entire structure, the meshing properties can be set for individual
conductor shapes. By setting the meshing density to High where the current is known to be varying more rapidly, and to
Low in regions with low current densities, the mesh can be hand-tuned and optimized for a given problem. The default
settings for a conductor are the default properties set through the EM Options dialog box.

14.5. EM Solver Options
The default EM options set in the EM Options dialog box (choose Options > Default EM Options) determine the EM options
applied to all EM structures. In addition, each individual EM structure has its own set of options that are initially set to
use the project defaults. To access the EM options for an individual EM structure, select the individual EM structure
node in the Project Browser, right-click and choose Options.
The default EM options are discussed in “Project Level Defaults - EM Options Dialog Boxes”. The EM options applied
to the individual EM structures are discussed in “Document Level Defaults - Options Dialog Boxes ”. Note that the last
tab on the Options dialog box changes depending on the simulator associated with the EM structures. If EMSight is
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selected, an EMSight tab displays. See “EM Options Dialog Box: EMSight Tab” for more information. You should consult
the vendor documentation for information on this custom set of options if a third-party simulator is associated with the
EM structure.

14.6. The Moment Tables in EMSight
The details discussed in this section apply specifically to EM structures that use EMSight as the EM solver. If you specify
a third-party solver, you should check the vendor documentation for details on the method(s) used for EM simulation.
Contact Cadence AWR® Support for more information on moment table caching.

14.6.1. EMSight as Frequency Domain Solver
The EMSight solver computes a separate solution for each frequency specified in the frequency range. If new points are
added to the frequency range after a simulation, only the new frequency points require simulation. If frequency points
are removed, no simulation is performed (if a frequency point is deleted then added back later, a simulation at that
frequency is required).
To terminate an EM simulation in progress, click Terminate Simulation in the progress dialog box. This action interrupts
the simulation immediately after it completes the routine in effect at the time you click the button. The termination can
take anywhere from a few seconds to minutes, depending on the complexity of the problem and the computer speed.
The solution results are saved for all frequencies simulated before termination. Upon simulating the EM structure again,
the simulation should proceed from the last frequency previously simulated. If an alternate third-party simulator is
associated with the EM structure, you should reference the vendor documentation for similar details.

14.7. Using the EMSight Simulator Effectively
The details discussed in this section apply specifically to EM structures which use EMSight as the EM solver. If you
specify a third-party solver, you should check the vendor documentation for details on the method(s) used for EM
simulation.

14.7.1. The Solution Process
Although it is not necessary to understand all of the details of EMSight's solution process, a general understanding of
the process can provide insight to getting the best performance from EMSight. The method of solution for the
electromagnetic problems is based on the spectral-domain method applied to three-dimensional circuits in a rectangular
enclosure filled with a planar, piece-wise constant stratified media. The rectangular enclosure always has perfectly
conducting sides, while the top and bottom of the enclosure can be modeled as a perfectly conducting surface, as a lossy
surface, or as an infinite waveguide (in the z-directions).
The following is an example structure where three dielectric layers are shown.
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The planar conductors and x and y currents are confined to infinitely thin sheets between the dielectric layers. Z-directed
currents are included to allow the electrical connection of the planar currents in different layers. The z-directed currents
also allow the connection of the planar conductors to the ground plane as follows.

The z-directed currents represent metallic vias, and are modeled as columns of z-directed current with no x or y components.
The z-directed current representation is an approximation that is valid for layers that are thin relative to a wavelength.
The currents on the conductors are spatially approximated using rooftop basis functions for the x and y currents and
rectangular cross-section current vias are used the for z-directed currents as shown.
The discretization of the conductors is performed on a uniform rectangular grid. After discretization, the solution process
determines the amplitudes of the individual basis functions such that when all the basis functions are summed together
they provide an accurate approximation of the current on the conductors. The solution process is divided into several
steps described in the following sections.
Creating the Structure
The first step in solving a problem in EMSight is to define the structure geometry. The following describes some of the
considerations involved in creating the geometry. (For detailed information on defining the geometry see “Configuring
Stackup”).
Defining the Layers
At least two dielectric layers must be defined in EMSight although there is no practical restriction on the maximum
number of dielectric layers. The most basic case with two dielectric layers is often used to model microstrip circuits
where the top dielectric is assigned properties of air and the lower dielectric is assigned properties of the microstrip
substrate. The dielectric layers can be lossless or lossy. If all the dielectric layers that are defined for a structure are
lossless, the boundaries are lossless and the conductors are perfect conductors, then real mathematics can be used in the
computation of the moment matrix entries (see the following). A lossless dielectric layer is defined with a loss tangent
and bulk conductivity of zero. If any of the dielectric layers have a non-zero loss tangent or bulk conductivity, then
complex mathematics are required for the computation of the moment matrix entries. The advantage of using all lossless
dielectrics is that the computation of the moment matrix entries using real mathematics is significantly faster than the
same computation using complex mathematics. For some problems the time required for the computation of the moment
matrix entries is not significant compared to the entire solution time, while for other problems this step can take a
significant portion of the time. The information presented in this section is intended to provide the insight needed to
evaluate the impact of using lossy dielectric layers.
Adding the Conductors
After the dielectric layers are defined the conductors that are to be modeled must be defined. In a typical two dielectric
layer microstrip circuit the conductor is drawn on top of the lower substrate (layer 2). Conductors, like dielectrics, can
be modeled as lossless (perfectly conducting) or lossy. If all the conductors in the structure are lossless (their material
property is set to Perfect Electric Conductor) and all the dielectric layers are lossless, the moment matrix solution can
be found using real mathematics, which provides a very significant time savings for most problems (for very small
problems the time savings is not as noticeable). The use of real mathematics can decrease the moment matrix solution
time by a factor of 3 to 7, depending on the solver options, as follows.
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Defining Ports
Ports represent the terminals of the circuit. The ports and the associated reference planes define the inputs and outputs
of the circuit. There is no practical limit on the number of ports that you can define for an EMSight structure. If there is
only one port on a given side, then that port can be de-embedded using either the fast de-embed algorithm or the standard
de-embed. If there is more than one port on a side, then that side is de-embedded using the standard algorithm. For the
special case where the reference planes are of zero length (the reference plane is at the enclosure boundary) the fast
de-embed algorithm is always used, even when there is more than one port on a side. The Use fast deembed (1 port/side)
option is only effective when there are two possible ways to de-embed the port. For all other cases EMSight automatically
chooses the correct method.
Meshing the Geometry
The meshing process approximates the currents using rooftop basis functions as described previously. The solution
method used by EMSight requires that the geometry conforms to a uniform rectangular grid. The uniform grid is required
because the rooftops that are used to approximate the currents must coincide with the uniform grid. EMSight automatically
snaps any shapes to the grid during meshing, which can often lead to unexpected results. For example, very narrow
shapes that are less than one cell wide may be turned into zero width shapes by the mesher. For shapes that have edges
that do not coincide with the uniform grid you should view the mesh before solving to make sure that it is discretizing
the shapes properly.
EMSight uses a variable cell size meshing algorithm to approximate the currents as into a set of overlapping x and y
directed rooftop functions. Each rooftop function is at least one cell wide and two cells long. The one cell by two cell
basis function is the smallest planar basis and is the primitive building block for larger basis functions. The primitive
basis function covers two primitive cells. Basis functions that are larger than one cell by two cells are constructed from
a weighted sum of the primitive basis functions. The following example shows the x directed basis functions that would
be used to mesh the rectangle shown in the lower part of the figure. The dotted lines in the lower figure represent the
uniform grid coordinates, while the solid lines represent the variable sized mesh. As shown, the variable size mesh always
conforms to the uniform grid that is defined for the structure.

The previous figure shows the basis functions used to model the x directed current only. The y directed current is
represented by another set of basis functions that are perpendicular to the x directed functions. The effect of the size of
the basis functions is described in the following section.
Creating the Moment Matrix
To determine the unknown amplitudes of the basis functions used to approximate the current density on the conductors,
EMSight must solve a matrix equation. The matrix to be solved is called the moment matrix. The moment matrix is a
square matrix with one row and one column for every basis function created during the meshing process. Each entry in
the moment matrix represents the electromagnetic coupling between two basis functions. For example, the moment
matrix entry at row one and column two represents the coupling between the first and second basis functions.
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Typically the computation of the moment matrix entries (filling the matrix) is one of the more time-consuming tasks
when using the Method of Moments. In EMSight, a specialized Fast Fourier Transform (FFT) algorithm is used to provide
a fast and efficient method for computing the moment matrix entries. The FFT algorithm computes the moment matrix
entries in two steps. The first step, the generation of the moment tables, is independent of the actual conductors that were
discretized during the meshing process. The moment tables are dependent on the size of the enclosure, the number of
grid divisions defined for the enclosure, the dielectric layer properties and heights, the enclosure top and bottom boundary
conditions, and the frequency used for the analysis.
The second step is the computation of the moment matrix entries using the moment tables. The moment matrix entries
can be quickly computed from the moment tables after the moment tables are generated. For example, the moment matrix
entry that corresponds to the coupling between two primitive basis functions can be computed by summing four entries
from the moment matrix tables. For non-primitive basis functions (basis functions that are larger than one cell by two
cells) the moment matrix entries are computed by summing the coupling contributions from the primitive basis functions
that are used to construct the larger basis functions. Basis functions that cover a very large number of primitive cells can
require a very large number of summing operations to compute the moment matrix entry. This is most noticeable when
a very fine grid is used relative to the conductor dimensions. If the "Fill Moment Matrix" step is consuming a large
amount of time as indicated in EMSight's progress indicator, then this may be the cause.
The FFT algorithm is used in the generation of the moment tables. Typically, FFT-based electromagnetic solvers work
most efficiently when the number of grid divisions is a power of 2. In EMSight a mixed-radix FFT is used that is efficient
when the number of divisions is a power of 2 or a product of small prime numbers. For example, if 100 divisions are
used then the algorithm is still very fast because 100=2*2*5*5 where 2 and 5 are both small prime numbers.
Since the moment tables are only dependent on the enclosure and substrate configurations, you can save and use them
for other problems that use the same enclosure and substrate configuration (and also the same analysis frequencies).
EMSight uses an algorithm that automatically saves these tables in a cache for later use. For many problems (for example,
the analysis of a microstrip discontinuity) the generation of the moment tables is the most time-consuming step in the
solution process. For these types of problems, the reuse of previously saved moment tables can provide solution times
that are several factors faster.
In EMSight, the moment tables are transparently cached on your hard drive so the next time that you need to solve a
circuit that uses the same size enclosure and the same dielectric stackup, the moment table information is read from the
cached version, resulting in significant computational savings. The caching mechanism is completely transparent (similar
to the caching of web tabs by popular Internet browsers). A cache management algorithm automatically deletes cached
tables that are used infrequently, and you can specify the maximum amount of disk space that the cache can use.
Solving the Moment Matrix
Since the moment matrices can be very large, only one moment matrix is in memory at a time. The limiting factor for
the size of the problem that EMSight can solve is generally the amount of physical memory available for storing the
moment matrix. The EMSight solver becomes orders of magnitude slower if the moment matrix does not fit in physical
memory and requires virtual memory for storage. The amount of memory required for the storage of the moment matrix
is displayed in the Information dialog box (choose View > Information). Further, if an estimate of the memory requirements
determines that there is not enough memory to solve the current matrix, the Information dialog box displays before the
solution is attempted.
The moment matrix is both symmetric and dense. Symmetric in the sense that elements are mirror images of each other
across the diagonal of the matrix (Znm=Zmn), and dense in the sense that very few if any elements of the matrix are
zero. EMSight can store the moment matrix as a full matrix (storing all entries) or as a symmetric matrix (where only
half of the entries are stored). As the number of unknowns grows large, the required memory for dense matrix storage
is proportional to the number of unknowns squared (memory=Km·N2), where Km is a constant. The storage method only
affects the constant Km, not the N2 dependency. Symmetric matrix storage allows problem solving with approximately
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1.4 times more unknowns as compared to the use of full storage. Further, the matrix is complex if the modeled system
is not lossless. A complex number uses twice as much storage as a real number, so likewise, the number of unknowns
solved for can be increased by approximately 1.4 if the system is lossless.
The storage method is determined by the Matrix Solver options. The Full Direct solver stores the full matrix, while the
Symmetric Direct solvers and all of the Iterative solvers store only half of the matrix. Further, Iterative solvers have other
storage requirements that are dependent upon the solver chosen and the actual matrix entries. Details of these additional
storage requirements is addressed in the section on Iterative solvers.
Direct Matrix Solvers
The Direct solvers offered in EMSight include the default, Full and Symmetric storage methods. The default solver is a
Direct solver that attempts to pick the optimum Direct solver based upon the EMSight structure and the available RAM
on your computer. In doing this, either the Full or Direct (out-of core) solvers is chosen. As implied by their names, the
Full solver stores the entire matrix, while the Symmetric solver only stores half of the matrix. The difference between
the two methods is seen in the actual solution time required. With the Direct solvers you trade one benefit for degraded
performance in another area. The algorithm used to solve the matrix using full storage is significantly faster than the one
used to solve it using symmetric storage. Typically, for a complex matrix, you see an increase of four-fold.
A study of dense Direct Matrix solver algorithms shows that the required number of solution steps and thus the solution
time required is proportional to the number of unknowns cubed (time=Kt·N3), where Kt, is constant. By switching
algorithms, we only influence Kt, not the N3 behavior. Thus, you find that as the problem size increases, the time spent
solving the matrix equation dominates in a method of moments EM simulation.
Direct (Out-of-Core) Matrix Solver
Like the other Direct solvers, the Direct (Out-of-Core) Matrix solver inverts the moment matrix by a factorization
algorithm. The difference in this algorithm is that this solver is able to store the matrix on the disk drive and factor the
matrix in blocks as they are swapped to and from memory. This effectively removes the limitations of the maximum
problem size due to the amount of RAM on your computer. This swapping of portions of the matrix during the computation
does not rely on the standard Windows swapping mechanism, rather, a unique algorithm in the solver looks ahead in the
computational sequence and loads blocks needed for future operations. By the time the processing of a loaded block is
complete, the blocks required for the next operation are already loaded into memory. Like the Direct Full solver, the
Direct (Out-of-Core) solver solution time is dependent upon the number of unknowns cubed. The constant multiplier
(K) is nearly identical to the Direct Full solver, however, the Out-Of-Core solver does have some time penalties to start
it. You should select the Direct Full solver for small problems, and use the Out-of-Core solver for larger problems. The
default Matrix solver attempts to do this automatically.
The maximum problem size of the Out-Of-Core Matrix solver is currently limited to 50,000 unknowns, and the simulation
time per frequency is on the order of days. Practical problem size limitations is determined by your computer.
Iterative Matrix Solvers
As implied by the name, Iterative Matrix solvers attempt to find the solution vector to the matrix equation Ā·x=rhs via
iterative methods. While Iterative Matrix solvers can decrease simulation times by orders of magnitude, they are not as
user friendly as the Direct solvers. If the computer has enough memory, the Direct solvers require no user interaction at
all. It is very tempting to go after the dramatically decreased solution time possible using Iterative solvers, however it is
highly recommended that you master the other aspects of EMSight with the Direct solvers before attempting use of
Iterative solvers. The following is a list of problems with iterative matrix solution methods:
• Iterative methods are not guaranteed to converge to the correct answer.
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• Solution times for Iterative solvers increase linearly with the number of right-hand sides, or in EM terms, the number
of ports.
• Iterative methods converge to a given tolerance and then stop; this is typically not the machine tolerance.
• There is no accurate way to tell in advance the memory usage, solution time, or if the process will converge until you
attempt it. Estimates can be applied, however.
• Iterative solvers are only beneficial for a very large number of unknowns.
Given these problems, solution times can be on the order of minutes instead of hours for some problems.
The purpose of an Iterative solver is to find the values of the solution vector x that makes true the following matrix
equation given Ā and rhs.

(14.1)

Ā·x=rhs

The solver does this by first making an estimate of the solution vector x. An iterative method is then used to determine
an approximation for the solution based on the previous solution estimate and information gathered from the matrix.
This process continues until some convergence criteria is met, usually involving the error in the right hand side. These
iterative methods are very similar to optimization techniques for N variables, and the same types of problems apply.
Given this optimization analogy, it is not surprising that these iterative methods do not perform well except for extremely
benign cases. Common problems include divergence and extremely slow convergence, termed "stagnation".
To overcome this problem, a method called "preconditioning" is applied to the matrix equation. This involves multiplying
the right and left sides of the matrix equation by a common matrix

P̄
called the preconditioner.

(P̄ ⋅ Ā) ⋅ x = (P̄ ⋅ rhs)
This multiplication by

P̄
on both sides does not change the solution vector x. If the solution vector solves one equation it also solves the other.
However, this multiplication can change the convergence behavior when using an iterative method. Consider the case
when the preconditioner is the inverse of the matrix A

(P̄ = Ā−1)
. In this case, the previous equation simplifies to give us the exact solution for x.
−1
−1
¯
¯
⋅ Ā) ⋅ x = Î ⋅ x = (A
⋅ rhs)
(A

After determining the inverse of A you do not need to use an iterative method. This process, as previously mentioned,
requires kt·N3 time and Km·N2 memory. You can see that as the matrix P approaches the inverse of A, the problem
becomes easier and converges very quickly using iterative techniques.
While the Kt·N3 time and Km·N2 memory dependencies are required in order to solve a general dense matrix, many
methods have been developed which reduce these dependencies by one order of N. These methods make assumptions
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about the matrix which are not valid for a general matrix. Typically, these methods deal with a sparse matrix where the
zeros are exploited to solve the matrix faster with less memory. The formation of the preconditioner

P̄
exploits one of these methods to achieve an approximate inverse of Ā in Kt·N2 time. Modern iterative solution methods
require the following basic operations:
• An initial guess at the solution vector x is selected.
• An approximation of Ā is formed.
• The inverse of the approximate matrix is found using some method which is quicker than determining the inverse of
Ā. This matrix is termed the preconditioner

P̄
Both the matrix Ā and the right-hand side are pre-multiplied by the preconditioner

P̄
• An iterative method is used to approximate the solution based on the previous solution estimate and information
gathered from the matrix. Typically, this information is gathered via a vector matrix multiplication.

(P̄ ⋅ Ā) ⋅ x
.
• The iterative method is continued until some convergence criteria is met. For example,

(P̄ ⋅ Ā) ⋅ x − (P̄ ⋅ rhs) ≤ tolerance
The selection of the preconditioner has a huge impact on the convergence characteristics using the iterative method.
There is a trade-off: If you spend a lot of time forming and inverting the preconditioner, the iterative portion of the
solution algorithm is performed very quickly. If, however, you spend little time on the preconditioner, the convergence
is slow. Somewhere in between, a minimum in computation time exists, and this location is dependent upon the number
of right-hand sides (# of ports in our case), and the characteristics of the matrix Ā itself, which is dependent upon the
structure being modeled.
In all Iterative solver selections within EMSight, the Iterative solver itself is the same, and is based upon a Preconditioned
Krylov-Subspace Method. The difference between the solvers is how closely the preconditioner models the inverse of
the actual matrix A. For a given structure, the solution times vary between the Iterative solvers. If the matrix is not
preconditioned enough, it may not converge at all. Also, you should realize that the Iterative solvers are not going to
result in faster solve times in all instances. Sometimes it is better to use a Direct solver for a given problem.
While there are no set rules for determining which Iterative solver to use, the following observations should allow some
insight into the selection. These observations are specialized to the use of Iterative solvers as applied to Method of
Moments electromagnetic problems (EMSight). Experience you gain in selecting the correct solver can drastically affect
the solution time.
• Direct solvers are always faster for a small number of unknowns. However, for problems below a certain number, the
Iterative solvers use the Direct solvers even if you choose an Iterative solver.
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• As the condition number of the original matrix increases (approaches a singular matrix) more time is spent forming
the preconditioner. This implies that the number of unknowns at which the Iterative solver becomes faster than a Direct
solver is increased.
• Determine the optimum solver for an EM structure based upon a single frequency at mid-band.
• If you attempt to solve a matrix equation with an iterative method without using enough preconditioning, the Iterative
solver may diverge, stagnate, or show extremely slow convergence. If this occurs, change the solver to one with more
preconditioning.
• The solution time for Iterative solvers is proportional to the number of solutions required. Unlike Direct solvers which
effectively create the inverse of the MOM matrix, Iterative solvers determine the current for each required excitation
(or in mathematical terms, for each right-hand side "rhs"). In EMSight, the number of rhs's equals the number of ports.
The time spent in the iterative portion of the solver for an EM problem that has 4 ports with 3000 unknowns takes
four times longer than a problem having 1 port with 3000 unknowns.
• The preconditioner is only formed once, regardless of the number of ports (right-hand sides), so for a simulation with
many ports, a better preconditioner is warranted.
• An Iterative solver is by its name and nature an iterative process. Like the HB simulator, it can have problems with
slow- or non-convergence. The convergence is determined by several parameters including the preconditioner, the
nature of the matrix to be solved, and the initial guess at the solution. As expected, the convergence behavior degrades
as the condition number of the matrix increases (a larger condition number indicates that the matrix is closer to singular).
• In an EM environment, a well conditioned matrix has a strong diagonal component and the magnitude of the elements
of the matrix decay as you move away from the diagonal. Each element in the matrix represents the coupling between
each unknown basis function. The diagonal term is the self impedance or the coupling to itself, which is almost always
larger than the coupling to any other elements. The magnitude of each element depends on several things, including
the distance between the two basis functions in terms of wavelengths and the orientation of the basis function (x, y,
or z directed currents). If the magnitude of the matrix elements does not decay quickly as you move from the diagonal,
you can assume the matrix is ill-conditioned and the Iterative solvers will not perform well unless they are highly
preconditioned. Based upon these observations, you can draw several conclusions.
• Structures which are small compared to wavelength have larger coupling between basis functions and decay less as
you move away from the diagonal, thus they are less well conditioned. You can conclude convergence behavior is
slowed because of this and requires increased preconditioning.
• If the structure is a multi-layer structure with many basis functions near each other in the z-direction, the coupling is
relatively high between these elements, and the magnitude of the coupling decays less as you move away from the
diagonal in the matrix. You can conclude convergence behavior is slowed because of this and requires increased
preconditioning.
• If you must over-grid the structure to accurately represent it (grid size is much smaller than the macro dimension of
the structure being modeled), then a large portion of the basis function is spaced closely together and is small in terms
of wavelength. In this case, the decay of the magnitude of the off-diagonal MOM matrix elements is slow because the
proximity of the majority of the elements in terms of wavelength is small. You can conclude convergence behavior
is slowed because of this and requires increased preconditioning.
• As preconditioning increases, memory requirements increase because more memory is needed to invert the approximation
of A.
• The amount of preconditioning applied by the Iterative solvers in EMSight is dependent on both the solver selection
and the nature of the matrix to be solved. As the nature of the matrix is not know prior to attempting the solution,
accurate estimates of the memory required to store the preconditioner and the time required to create it are not available.
Estimates are made for the Information dialog box.
• EMSight automatically writes accurate solution times to the em_time.txt file.
• Creation of the preconditioner occurs during the Factor Matrix Operation in the timing file.
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• The Iterative portion of the solution algorithm occurs during the Solve Operation for each port in the timing file.
• You can set the convergence tolerance which determines when the Iterative solver stops in Iterative solver tolerance
on the EMSight tab of the EM Options dialog box.
The Iterative solvers available in EMSight vary only in the amount of preconditioning which is applied to the original
impedance matrix. The following is a list of the available Iterative solvers:
• Iterative Large (Dim. > 0.1 Lambda) - Low Preconditioning
• Iterative Medium (Dim > 0.01 Lambda) - Medium Preconditioning
• Iterative Small (Dim < 0.001 Lambda) - High Preconditioning
• Iterative Custom - Custom Preconditioning
The size labels arise from the guideline that the decay of off-diagonal coupling is slower for structures that are smaller
in wavelength. However, as mentioned previously, this is not the only reason a MOM matrix may be ill conditioned.
The Iterative Large solver has the parameters set to quickly form the preconditioner, while the Iterative Small solver has
the parameters set such that a poorly conditioned matrix converges.

14.7.2. De-embedding the Solution
The purpose of the de-embedding algorithm is to find the S-parameters of a structure using the reference planes defined
for the structure. The length of line from the enclosure edge to the reference plane is called the "feedline". When
de-embedding is turned off, the reference planes coincide with the enclosure boundaries where the ports are located and
the solution contains the effects of the port discontinuities (excess shunt capacitance at the ports). When de-embedding
is enabled, an automatic de-embedding algorithm is used to remove the effects of the port discontinuities and feedlines.
The de-embedding algorithm requires the solution of two additional problems that are referred to as "standards". A pair
of standards is required for each side of the enclosure that has ports attached. For many problems the standards used to
de-embed one side are electrically equivalent to the standards used to de-embed another side. The solution for the standards
for one side are automatically re-used to de-embed other sides when EMSight detects that they are electrically equivalent.
A standard is a uniform length of line (or coupled lines when there is more than one port on a side) that has the same
cross-section as the lines attached to the ports on the side that is being de-embedded. To de-embed one side, two standards
are used where one standard is exactly twice the length of the other. The length of the line used for the standard depends
on the type of de-embedding algorithm that is used, as described in the following section.
The Default De-embedding Algorithm
The following simple example illustrates the default de-embedding algorithm EMSight uses.

To de-embed port 1 of the simple circuit shown here to the right, two de-embedding standards are automatically created
and solved for. The shorter standard is the same length as the feedline attached to port 1, and the other standard is twice
that length. The following figure shows the two de-embed standards. You can use the same moment tables for the solution
of both of the following standards, although the required moment tables are different than those used for the main structure
(unless the reference plane is exactly half the length of the enclosure).
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Different moment tables are needed because the moment tables are dependent on the enclosure dimensions. As a
consequence of the longer standard being exactly twice the length of the shorter standard, the moment table for the longer
standard contains all the required information needed to solve both standards.
An assumption used in the de-embedding algorithm is that the ports on each end of the de-embedding standard are far
enough apart that they do not have any significant electrical interaction. For microstrip type circuits, a guideline is that
the ports should be separated by a distance of at least two substrate heights for negligible electrical interaction between
the ports. For the default de-embedding algorithm, this means that the reference planes should be at least two substrate
heights from the edge of the enclosure. An exception to this is when the reference planes are zero length. For zero length
reference planes, the standards are equal to the length of the enclosure, so the rule for zero length reference planes is that
the enclosure should be at least two substrate heights long (along the direction of the line attached to the port).
Another problem that can affect the accuracy of the de-embedding is when the electrical length of the de-embed standard
(the long standard) is very close to a multiple of a half wavelength (EMSight issues warnings if it detects this problem).
For more information on the recommendations and restrictions involved with de-embedding see “De-embedding”.
The Fast De-embedding Algorithm
The principal difference between the default de-embed algorithm and the fast de-embed algorithm is that the fast de-embed
algorithm always uses de-embedding standards where the longer standard is the same length as the enclosure (along the
direction of the line attached to the port). The fast de-embed algorithm is faster because the solution process for the
de-embed standards can use the same moment tables as those used in the solution of the main structure. The computation
of the moment tables for the de-embed standards is often more time-consuming than the rest of the solution process for
the standards since the standards are relatively simple structures.
A restriction of the fast de-embed algorithm is that in the current release of EMSight, you can only use the fast de-embed
algorithm when there is no more than one port on the side of the enclosure that is being de-embedded. When you select
Use fast de-embed (1 port/side) and there is more than one port on a side, EMSight automatically uses the default
de-embedding algorithm. EMSight only uses Use fast de-embed (1 port/side) when there are two possible ways to de-embed
the solution.
Another drawback of the fast de-embed algorithm is related to the "half wavelength" problem that was mentioned in
“The Default De-embedding Algorithm”. Since the fast de-embed algorithm typically uses longer standards, it is much
more likely that the electrical length of the standard is close to a multiple of half of a wavelength. Further, the fast
de-embed algorithm is more sensitive to the "half wavelength" problem.

14.7.3. Low Frequency (DC) Solution
EMSight does not have a low frequency solver. The minimum frequency setting is 1 MHz; any frequency below this
value is averaged with this value. For example, if you enter 0 for a frequency, the actual frequency simulated is 500 kHz.
When you need to have a good DC solution for an EMSight structure, you should first try using 0 as a frequency. After
the simulation is complete, you should view the response of the structure to make sure the DC response looks correct by
viewing S-parameters or applying a DC source (using DC annotations is the simplest means). In some cases, the minimum
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frequency can still have numerical problems, especially in very large unknown structures. If so, you should make your
lowest point higher, starting at 10 MHz and then increasing by a decade until you obtain a good response. You should
have two points at lower frequency so when the circuit simulators need to extrapolate to exactly DC, there are two points
near DC to help achieve an accurate answer. To change the interpolation options choose Options > Project Options to
display the Project Options dialog box, then click the Interpolation/Passivity tab. Change the interpolation Method from
Linear to Rational function. You can also try using the Cadence AXIEM® 3D planar EM simulator since it has a built-in
low frequency solver that can help if you have problems at DC.

14.7.4. Minimizing Solution Time
The solution time generally depends on three steps in the solution process. The first step is the creation of the moment
tables, the second step is the actual moment matrix creation, and the third step is the moment matrix solve.
Moment Table Creation
For small problems, the moment tables EMSight uses consume the majority of the solution time, while for larger problems
the solution time is usually dominated by the matrix solve time. To speed the solution process (especially for smaller
problems), EMSight uses a caching algorithm that allows transparent re-use of the moment tables from one problem to
the next. When a moment table for the problem being solved is not found in the cache, EMSight automatically creates
one. When EMSight is able to use a moment table from the cache, virtually no time is needed to load and initialize the
table. The amount of time spent creating the moment tables depends on the following factors:
Number of Enclosure Divisions
The number of divisions (the number of grid points in the x or y direction) has an effect on the time required to compute
the moment tables. The moment table creation is performed in two steps. The first step computes the spectral domain
Green's functions needed to create the tables, and the second step computes the tables from the Green's functions using
an FFT algorithm. The computation of the Green's functions is usually the more time consuming step in this process,
and the amount of time required to perform this step is proportional to the area of the enclosure in cell units. For example,
an enclosure that uses a grid with eight divisions in the x direction and eight divisions in the y direction takes four times
as long to compute the Green's functions when compared to an enclosure with four divisions in the x direction and four
in the y direction.
The FFT algorithm used in the second step is most efficient when the number of divisions is a power of two, and it is
also relatively fast when the number of divisions is the product of small prime numbers (for example, 2*2*5*5*3 = 300).
For enclosures with a large number of divisions, or when the number of divisions is not a multiple of small prime numbers,
the FFT algorithm can require a significant amount of time. In particular, if you choose a large prime number for the
number of divisions then the FFT algorithm is relatively slow.
Number of Dielectric Layers
The number of dielectric layers has an effect on the time required to compute the spectral domainGreen's functions in
the first step in the moment tables creation. The more layers there are, the longer it takes to compute the Green's functions.
The number of layers does not affect the time required for the FFT.
Number of Metal Layers and Layers with Vias
For a structure that has a single conductor layer, three moment tables are created. The tables are used to compute the
coupling from x to x, y to y, and x to y. If there are vias, additional tables are created for the x to z, y to z, and z to z
coupling. If there are multiple layers, tables are created to compute all of the combinations of all x, y and z coupling for
all layers. The moment tables are only computed for layers where there are conductors or vias. The more layers that have
conductors and vias, the more tables there are to compute. Since the tables are computed for all combinations of coupling,
the time required to compute all the moment tables increases with the square of the number of conductor layers.
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Lossy Dielectric
If all of the layers in the enclosure are lossless, then real math can be used to compute the moment tables (instead of
complex math) and a significant time savings is realized. If just one layer has loss (a non-zero loss tangent or bulk
conductivity), then complex math is required to compute the moment tables. If one of the layers has loss then there is
no savings in making the other layers lossless.
Lossy Boundaries
If the boundaries for the top and bottom cover of the enclosure are set to anything but Perfect Electric Conductor (PEC),
the boundaries are lossy and require complex math in the computation of the moment tables. If the boundaries are lossy,
there is no advantage to making all the dielectric layers lossless.
Filling the Moment Matrix
The creation of the moment matrix involves the filling in of all the entries using data computed from the moment tables.
The moment matrix entry that corresponds to the coupling between two primitive basis functions can be computed by
summing four entries from the moment matrix tables. For non-primitive basis functions (basis functions that are larger
than one cell by two cells) the moment matrix entries are computed by summing the coupling contributions from the
primitive basis functions that are used to construct the larger basis functions. Basis functions that cover a very large
number of primitive cells can require a very large number of summing operations to compute the moment matrix entry.
This is most noticeable when a very fine grid is used relative to the conductor dimensions. If the "Fill Moment Matrix"
step is consuming a large amount of time as indicated in EMSight's progress indicator, this may be the reason.
Optimizing Cache Usage
The moment table cache greatly speeds many problems, so if possible, it is a good idea to use the same analysis frequencies
and enclosure configurations when several different problems are to be solved. If there is a particular enclosure
configuration that is suitable for many different problems to be solved, it is a good idea to save the enclosure as an empty
EM structure (no conductors) that can be read in and used as a starting point for a new analysis. All the options, frequency
points, substrate layers, and boundaries are saved in the empty document. To save an EM structure as a separate file,
right-click the EM structure in the Project Browser and choose Export EM Structure. You can then read the structure back
in using the Import EM Structure option.
Minimizing Solution Time
For EMSight, the moment table creation and the moment matrix solve consume the majority of the time in the solution
process. The actual creation of the moment matrix from the moment tables is usually relatively fast, although for some
problems this step can be relatively time consuming. If the moment tables are loaded from the cache, then the moment
table generation step does not contribute significantly to the overall solution time, and the moment matrix solve time
becomes the only significant factor. If the problem is very small (for example, the mesher does not create very many
unknown basis functions), then other factors consume a significant part of the solution time, although the overall solution
time is very short (less than a second/frequency for small problems where the moment tables are loaded from the cache).
Since the moment table generation time grows with the square of the number of unknowns, and the matrix solve time
grows with the cube, the matrix solve time always dominates the solution time for very large problems, while the moment
table generation takes longer than the matrix solve for very small problems.
Since the solution time scales linearly with the number of frequency points, when solving the problem with EMSight
you should use no more frequency points than necessary. The post-processing in EMSight can interpolate the frequency
response points between the discrete points using function interpolation. Interpolation of the solution results is performed
when the evaluated frequency set is not equal to the solutions set performed by the solver. For this to occur, you should
change document level frequency set to be a subset of the project level frequencies. See “Setting Frequencies” for details.
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Further, when setting up measurements to be performed on the EM structure, you should change the frequency range to
use the project frequency set. See “Add/Modify Measurement Dialog Box” for details.

14.7.5. Modeling Vias
In EMSight, z-directed currents are represented by columns of z-directed current with no x or y components as shown
in the following figure.

The vias are always assumed to be perfect electric conductors (no loss is modeled in the via), so the true current distribution
on the square via should be infinitely thin currents on the face of the via. Empirical results show that modeling the via
as a continuous uniform cross-section of current generally gives a good approximation to the via when the via is electrically
small.

Each via extends from the top to the bottom of the dielectric layer. The current in the via is modeled as a continuous
current in the z direction. Vias are usually used to connect conductors on different layers, and for connecting conductors
to the ground plane. Some typical uses for vias are shown in the following figure.
The assumption that the current is continuous in the z direction is valid when the height of the via is small relative to a
wavelength. If the layer is not short relative to a wavelength, then a continuous current does not accurately model the
true sinusoidal nature of the current. If the via to be modeled is not short relative to a wavelength, the via can be modeled
more accurately by being broken into several shorter vias. In the following figure, a long via is split into two shorter
vias, requiring the dielectric layers to be split also. To split a dielectric layer, create two layers with the same properties
that have the combined height of the original layer. If the via is more than about a tenth of a wavelength long, you should
split it into multiple vias as follows.
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Another significant assumption used with vias is that there is only z directed current in the via. All x and y currents are
assumed to be zero in the via. For the typical use of a via (interconnecting conductors on different layers and connecting
conductors to ground), this assumption does not introduce any significant error. If the via is used to model a
three-dimensional structure where the true solution would have significant x or y currents on the via faces, then the results
are not as expected. For example, using a long row of vias to represent the side walls of a shielded conductor is not a
valid use of the via because the true solution would have x and y currents on the side walls. The following figure illustrates
an invalid use of vias.

When a via that covers a large number of cells is used, EMSight automatically models the via by meshing its four sides
and leaving the center empty, since the true current is all on the outer cells anyway. The following example shows a
preference for the via on the left over the via on the right. The via on the left is constructed of four separate vias on the
perimeter of the square area. Both give almost identical answers, but the via on the left simulates slightly faster and uses
less memory because EMSight does not have to calculate it over as much area as the via on the right, which has more
area.
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For small vias the difference is negligible, but for larger vias the difference may be noticeable. By default, EMSight
models large vias like the one on the left.

14.7.6. Avoiding Resonances
There are two possible types of resonances. The first is a resonance in the actual circuit. For example, a uniform two-port
transmission line that is a half wavelength long is resonant because the solution process shorts the port at one end, and
applies a voltage to the port at the other end. Because the far end port is shorted, the half wavelength line transforms the
short on the far end to a short at the port on the end where the voltage is applied. When all conductors are perfect electric
conductors, this should lead to a solution with infinite current (this is a result of the half wavelength line being resonant
at the simulation frequency). This type of resonance is often a problem encountered when the de-embedding standards
are being computed, and this is why it is difficult to accurately de-embed reference planes that are a half wavelength
long.
The other type of resonance is a cavity resonance. Since EMSight analyzes the problem inside of a conducting rectangular
enclosure, you can choose an analysis frequency that is close to one of the resonant cavity modes of the enclosure. For
electrically small structures, this is generally not a problem because the resonant frequencies are usually much higher
than the analysis frequency. For electrically large structures, it is more likely that the analysis frequency is at a cavity
resonance. If lossy dielectric layers are used, or if a lossy boundary is used for the top or bottom of the enclosure, a box
resonance may not be much of a problem. The box resonance problem is most severe when there is no loss in any of the
layers or boundaries. In the completely lossless case, an analysis at a cavity resonance frequency should give a solution
with infinite values. In practice, the results are not infinite, but they are probably not correct either. One method for
reducing resonance problems is to use a lossy dielectric to help dampen the resonance or set the top or bottom of the
enclosure to a lossy boundary. Also, changing the size of the enclosure slightly shifts the resonance frequency, so you
can often avoid a resonance by changing the thickness of one of the layers (for example, the top air layer in a microstrip
problem).
Potential resonance problems can also be detected by measurements applied to an EMSight structure. With EMSight,
the mode resonances can be viewed for the enclosure over a range of frequencies somewhat wider than the analysis
frequency range.

14.7.7. Modeling Loss
Loss can easily be accounted for with EMSight, although the use of loss may have a significant impact on the analysis
time. When you use a lossy dielectric or lossy boundary, the moment tables must be computed using complex math,
which is significantly slower than real math. If the conductors have loss, or if there is a lossy dielectric or lossy boundary,
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the moment matrix is complex and the time required to fill and solve the matrix is significantly slower (see “Minimizing
Solution Time”).
Dielectric Loss
You can model dielectric loss by using a non-zero value for the loss tangent or for the bulk conductivity. The material
properties for the dielectric layers are set in the Substrate Definitions Properties dialog box on the Dielectric Layers tab.
The loss tangent, which is a dimensionless quantity, is typically used to model the loss in the dielectric. The value of
loss tangent is frequency-dependent, although the same value is commonly used over a wide range of frequencies. The
bulk conductivity can be used to model the loss associated with conducting substrates.
Sometimes in the manufacturing of microwave circuits, absorbing material is placed on the top cover of the circuit
enclosure. This material can be modeled in EMSight by adding a dielectric layer to the top of the dielectric stackup that
has the same thickness and material properties as the absorbing material.
Lossy Boundaries
On the ENCLOSURE Properties dialog box Dielectric Layers tab you can specify three different types of lossy boundaries
for the top and bottom of the enclosure:
• Specified material: Allows you to specify for boundary conditions materials defined on the Material Defs. tab as
conductor or impedance. This type of boundary is used most often to model the effect of an actual material boundary,
such as a top cover that is not a perfect electric conductor. You can also set the material properties to simulate the
effect of an open boundary or a lossy absorber.
•

Approx Open:

Using this option is equivalent to assigning the boundary to a material that has a DC resistivity of 377
ohms, which is the impedance of free-space. When simulating an open boundary, the top cover should be far enough
away from the circuit that any near-fields from the circuit do not interact significantly with the boundary. The use of
a 377 ohm boundary is an approximation for free space that should provide sufficient accuracy for most problems.
This option would be used when analyzing an antenna type structure in EMSight.

•

Inf WG:

This option models the top (or bottom) layer as an infinitely long waveguide using the same dielectric as the
top (or bottom) layer. You can use an infinite waveguide boundary to model a microstrip to rectangular waveguide
transition, or to terminate the top of an enclosure for an antenna. Unlike the approximate open boundary condition,
the infinite waveguide boundary condition does not absorb energy from the near-fields of the simulated structure.

Conductor Loss
Conductor loss is used to model the loss associated with conducting traces and thin film resistors. The conductor loss is
modeled using the following two parameters in the Add Impedance dialog box (click Add in the Impedance Definitions
area of the ENCLOSURE Properties dialog box Material Defs. tab):
•

Low frequency resistance:

The low frequency resistance specifies the DC resistance of the planar conductor (in
ohms/square). The DC resistance is the resistance of the conductor, assuming a uniform current distribution in the
cross-section of the conductor.

•

High frequency loss coef.:

The high frequency loss coefficient specifies the loss associated with the conductor at
frequencies where the thickness of the conductor is significantly thicker than the skin depth. Since the loss associated
with the skin depth effects is proportional to the square root of frequency, the skin depth loss coefficient is multiplied
by the square root of frequency to provide an ohms/square value that is used for loss computations.
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14.7.8. Thick Conductors
EMSight models the conductors as infinitely thin x and y directed currents. For many structures, such as printed microstrip
structures, this assumption does not contribute a significant amount of error to the solution. For structures that have gaps
between conductors that are comparable to the conductor thickness, the assumption that the conductors are infinitely
thin becomes a less valid approximation. This is often the case in Monolithic Microwave Integrated Circuit (MMIC)
structures where the conductors are relatively thick. A technique used to model thicker conductors is to create two
conductors that are stacked on top of each other on different layers. Since the currents on a thick conductor are on the
surface of the conductor, the dual conductor approximation gives a similar result. The following figure shows an example
of using this technique to model a pair of coupled lines.
The potential on the two conductors used to model a thick conductor must be equal, so you should use vias to "short"
the two conductors together. It is not necessary (nor desirable) to short the conductors everywhere, rather you should
short the conductors at the ends or corners, and at regular intervals no more than about an eighth of a wavelength apart.
You should not use vias for the entire area because the vias are meshed (using a variable sized mesh), and the use of too
many vias increases the size of the problem unnecessarily. For the following problem, it may seem like a good idea to
place vias along the entire edge of the line where the coupling is occurring, but this does not provide an increase in
accuracy because the vias can only carry z directed current, while the actual current flowing in this situation would be
in the direction parallel to the lines (x or y).

When de-embedding a conductor using the technique discussed previously, special consideration is needed. The
de-embedding algorithm always assumes that the conductors are infinitely thin, and there is currently no method for
having the de-embedding algorithm compute de-embedding standards that use two conductor layers to model thickness.
For this reason, Cadence recommends that the length of line leading up to the reference plane be modeled using a single
layer as shown in the previous figure. Also, it is important to NOT extend the extra conductor layer all the way to the
edge where the port is located, otherwise that conductor is shorted to the edge. Also, for the same reason, you should not
place vias at the port edge. The following port shown on the left is shorted to the edge, while the one on the right is
correct.

14.7.9. Coplanar Waveguide
You can model coplanar waveguide in EMSight as shown in the following figure. Only the even mode of the coplanar
waveguide can be excited at the ports. The odd mode of the coplanar waveguide is short-circuited at the port. The
automatic de-embedding in EMSight can de-embed the even mode only.
Generally you should model ground planes using a strip of conducting material as shown in the following top figure
instead of extending the conductor all the way to the edge of the enclosure as shown in the lower figure. The large amount
of conductor area in the lower figure can lead to excessive memory usage and solve time.
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14.8. Advanced Frequency Sweep (AFS)
The purpose of the advanced frequency sweep (AFS) is to speed up the EM simulations of EM structures through an
optimal choice of the frequencies at which to perform the EM simulations. The values of the N-port parameters at all
other frequencies of interest within the specified frequency range are then calculated through a rational
approximation/interpolation constructed utilizing the EM calculations at the selected points. AFS saves time by significantly
reducing the number of points at which the EM simulations need to be performed while still maintaining the required
accuracy.
The AFS algorithm is used only if the number of frequency points for the EM structure exceeds six; it cannot provide
increased speed for a smaller number of points.

14.8.1. AFS Algorithm
Input: AFS input consists of the list of frequencies given for a particular EM structure, and several parameters specified
on the EM Options dialog box EMSight tab. The AFS parameters are:
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• The frequency range (Start (GHz), Stop (GHz)). This is either the range of frequencies specified for the EM structure,
or the AFS band if the Specify AFS Bandcheck box is selected.
• The number of grid points (# Grid Pts) at which to perform quality evaluation and passivity assessment/enforcement.
The default is 200.
• The convergence tolerance (Error Tol (dB) ) in terms of approximation error. The default is -40 dB (see the following).
• The method to determine convergence (Error Type) that can be either Absolute or Relative: (a) Absolute error in dB,
max {20 lg (||Sijk-1-Sijk||)}, where k is the iteration index, and indices i, j specify the element of
the S matrix. The maximum is found over all the points of the frequency grid (from Start (GHz) to Stop (GHz), with the
number of points specified by # Grid Pts. (b) Relative error, in dB, max {20 lg
(||Sijk-1-Sijk||)-20lg[0.5*(||Sijk-1||+||Sijk||)]}.
Output: The rational approximation of the S matrix for the frequency range [Start (GHz), Stop (GHz)] demonstrated to be
within Error Tol (dB) from the EMSight results. This approximation can be evaluated very fast at as many frequencies as
desired within the range [Start (GHz), Stop (GHz)] thus helping you pinpoint the exact location of the resonances.

14.8.2. Algorithm Outline
1. If the estimated number of requested frequency points is less than or equal to six, perform EM simulations at the
specified frequencies. There is no benefit in using AFS. Otherwise go to step 2.
2. Calculate S(f) at f=Start (GHz), f=1/2(Start (GHz)+Stop (GHz)), and Stop (GHz).
3. Construct rational interpolation of the order 1.
4. While the interpolation error is more than -10 dB, add an additional point between each two available frequency points
and construct a new interpolation/approximation. When the interpolation error is less than -10 dB, go to step 5.
5. Add two more frequency points where there is the greatest difference between rational approximations obtained at
iteration k and iteration k-1.
6. Construct a new interpolation/approximation using the EM simulations at the two additional frequency points added
in step 5. The order of approximation/interpolation is incremented by 1 compared to the previous iteration.
7. On the comparison grid, evaluate passivity of the last interpolation/approximation. Find the frequency of the greatest
passivity violation if any. Perform an EM calculation at that frequency, and go to step 6.
8. Compare interpolation/approximation obtained at iteration k to that obtained at iteration (k-1) using either absolute
or relative error criterion.
9. If the criterion is satisfied, terminate. Otherwise, return to step 5.

14.8.3. Warning Messages
If the S matrix calculated by EMSight at a particular frequency is non-passive, a warning message displays to this effect.
You should check the setup of the EM structure, such as de-embedding, grid density, and the presence of other errors.
Note the EMSight warning message "Port Eeff and Gamma computation warning-- check results at ;x GHz". This warning
usually indicates a serious problem with the EM structure setup, and the EM results for this structure obtained with or
without AFS will be inaccurate of incorrect. AFS is likely to converge slowly, or fail convergence.
Recommendations for Efficient Use
You should use an Error Type of Absolute, and Error Tol (dB) of ≥ -40 for the fastest convergence. The accuracy of the
results is entirely satisfactory in most cases. AFS generally requires more EM simulations for an Error Type of Relative.
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You can add as many frequencies as desired between Start (GHz) and Stop (GHz) to resolve the resonances. This does not
increase the processing time by any significant amount.
There is no benefit in specifying # Grid Pts <200.
If using the AFS band, select it wisely, as changing Start and Stop parameters causes AFS to start over. Note that the
Max # Sim Pts only applies to AFS itself, and not to the frequency points outside [Start (GHz), Stop (GHz)].
The lowest reasonable frequency for AFS is f0=1e6 Hz (1 MHz). If the specified frequency f<f0, EMSight performs
simulation not at frequency f but at 1/2*(f+f0).
Even if each EM simulation takes a long time, it is usually undesirable to specify Max # Sim Pts as < 10.

14.9. Determining Proper Cell Size for Accurate Simulation
The details discussed in this section apply specifically to EM structures that use EMSight as the EM solver. If you specify
a third-party solver, you should check the vendor documentation for details on the method(s) used for EM simulation.

14.9.1. Cell Size Definition
Cell size definition is probably the most misunderstood part of an EMSight analysis. Many times it is a matter of experience
and intuition that determines cell sizes for experienced EM users. Many of these users have a good understanding of the
physical properties of the structure they want to analyze. They know the effect of dimensional tolerances on the structure
at the analysis frequencies because they have built and tested similar structures. For the novice EMSight user, proper
cell size definition can be very ambiguous. This section defines proper cell size as a cell size that creates a sufficient
mesh density for the accuracy of the simulation for a particular structure. Each structure is different, so the required
accuracy for the solution varies. This section presents some guidelines in determining proper cell sizes and gives examples
to illustrate each point. The discussion is divided up into the main guidelines called FDS or Frequency, Dimension, and
Structure so you can easily remember the main guidelines and can access a specific subject without needing to read the
entire section.

14.9.2. Guidelines to Determining Proper Cell Size: FDS
There are many guidelines that determine the proper cell size for a structure. The most important guidelines can be
divided into three categories: Frequency, Dimension, and Structure:
1) Frequency - The cell dimension is inversely proportional to the analysis frequency. As frequency increases, wavelength
decreases, and therefore the cell size shrinks. Typically, the cell size is chosen to fit the highest frequency. This is the
most important guideline because it is taken into consideration in all other guidelines.
2) Dimension - This guideline describes how dimensional tolerances affect a structure at the analysis frequency. You
should answer the following questions:
a) How does the dimension of the width of the transmission line affect the impedance?
b) What is the dimensional tolerance of the physical structure to be built and tested?
c) What are the critical areas of the structure that must be held to a tight tolerance?
3) Structure - Complexity of structure and type of structure determines cell size. A Lange coupler requires much more
precision than a step discontinuity in microstrip. Also, any coupling between discontinuities must be included in the
simulation, therefore coupling drives the complexity of the structure.
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Frequency
The first step in determining a proper cell size is to determine the wavelength of the transmission media. If the structure
is of a standard transmission media like coplanar waveguide, microstrip, or stripline, you can use the Cadence Microwave
Office® software Cadence TX-LINE® calculator to determine the propagation wavelength at a specific frequency. An
approximate guideline for definition of cell size is 1/100th of the propagation wavelength for medium complexity circuits.
For example, a microstrip tee with a width of 20 mils on ports 2 and 3, with a width of 72 mils on port 1. It is best to
find a common denominator for both widths so that the cells cover the entire width of each transmission line. At 10 GHz
the propagation wavelength is about 720 mils. A common denominator for the two widths is 4 mils, which is equal to
about 1/200th of the propagation wavelength. On port 1 an 8 mil cell width is used (72/8=9). Since port 1 width is in the
x direction and ports 2 and 3 widths are in the y direction, the final cell size is 8mils in x and 4 mils in y. This example
runs in 3 minutes with a frequency range from 1 to 20 GHz in 1 GHz steps. It is compared to the following various cell
definitions that vary from very coarse to fine:
Very coarse 4 mils in y, 8 mils in x. (memory required = .414MB, simulation time = 42secs)
Coarse 4 mils in both x and y. (memory required = .868MB, simulation time = 1min 45secs)
Medium 2 mils in x and y. (memory required = 3.237 MB, simulation time = 4min 20secs)
Fine 1mil in x and y. (memory required = 16.54 MB, simulation time = 27min)
The data shows that the divergence of the different cell definition solutions is small, out to 20 GHz for the magnitude of
S11. The overall error is plotted in the following figures. At 20 GHz, the error between the coarsest grid and the fine
grid is only about 1.5%. As evident in the data, using cell sizes of 1/100th, the propagation wavelength is very conservative
for cell size definition.
Figure 14.1. EMSight Simulation Data (mesh density comparison).
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Figure 14.2. Error in Simulation Data (comparison of fine mesh vs. medium mesh, coarse mesh, and very coarse
mesh individually).

Dimension
The dimensions of lines and spaces in a structure are very critical in the cell size definition. An understanding of the
effect of dimensional tolerances on impedance and coupling effects of a structure is required to make wise decisions on
cell size. Again the Txline program can help determine some of the important information needed to make those decisions.
Many times transmission line dimensions are not of a cell size that is easily divisible by an integer number. For instance,
the width of a 50 ohm line on 10 mil alumina at 10Ghz is 9.8 mils. 9.8 mils is not divisible by an integer number. A 10
mil line on the other hand has an impedance of 49.5 ohms and it is divisible by 2 or 5 mils. The difference between a
49.5 ohm line and a 50 ohm line introduces insignificant errors in the analysis, but a 10 mil line that can be divided by
an integral number significantly reduces the EM solution time. For coupling effects, you may want to do quick studies
on the effect of line widths and spacing on the linear simulator. By comparing the results of coupled lines of various
space and widths using a simple, faster technique, insight into a proper cell size can be deduced.
Dimensional tolerances of the actual structure to be built are also very important for cell size definition. A knowledge
of the limitations and tolerances of processes used to fabricate a circuit can be very helpful in determining what dimensions
you can change in an EM analysis to define an integral cell size. For example, if a circuit is built using a process where
the etching tolerances of the material for a microstrip line are plus or minus one mil, it is not necessary to define any cell
size that includes 10ths of a mil resolution. Knowledge of this type tolerance information also allows adjustment of the
cell size to speed up the simulation.
Cell size definition is driven by the most critical part of a circuit. You can gain knowledge of the critical areas of a circuit
by following this guideline.
A guideline is if lines or discontinuities are separated by more than two substrate widths (see the discussion in the PWB
example) the coupling between them is insignificant and the lines or discontinuities can be separated and simulated
individually.
Once the critical areas are determined, the cell size should be defined by the dimensions of the lines or discontinuity in
question. All the guidelines discussed previously should apply to this critical area.
Structure
Structure complexity along with frequency drives the cell size definition. The following figures demonstrate this concept.
Figure 14.3, “High Complexity Structure (cell size 2mils in x 2mils in y and frequency = 20Ghz)” shows a close-up of
the fingers of a Lange coupler. The Lange fingers determine the performance of the circuit and therefore the dimension
of the finger widths determine the cell size. In this case the finger widths are 2 mils, so the cell size was defined as 2 x
2 mils. The Lange coupler can be considered a high complexity circuit because the finger widths and spaces are very
critical to the performance of the coupler. The cell size used is the coarsest cell definition. For very complex circuits you
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should coarsely mesh the initial simulation to determine if the circuit is working properly. After the initial simulation,
you can refine the mesh to see how the simulation changes.
Figure 14.3. High Complexity Structure (cell size 2mils in x 2mils in y and frequency = 20Ghz)

A medium complexity structure is shown in Figure 14.4, “Medium Complexity Structure (cell Size 5 x 15 mils and
frequency = 2 GHz)”. The combline filter response is dependent on the lengths and coupling of each resonant line. In
this example, the cell definition was determined by the resonant line length and width. At 2 GHz the cell size can be
much coarser than if this structure was being analyzed at 20 GHz. The cell definition is 5 x 15 mils. The 15 mil length
is in the y direction and is defined that way because of the long length of the resonator. The 5 mil definition was made
because of the sensitivity of the structure to the spaces and widths of lines in the x direction. This is considered a coarse
mesh but it was sufficient for the accuracy required for its application.
Figure 14.4. Medium Complexity Structure (cell Size 5 x 15 mils and frequency = 2 GHz)

The low complexity structure is shown in Figure 14.5, “Low Complexity Structure. (cell size 4 x 4 mils and frequency
= 20Ghz)”. The structure is a simple microstrip tee with chamfered lines. This structure is low complexity because it
does not have coupling width or spaces that are critical to the performance. At 20 GHz, a cell size of 4 x 4 mils was
sufficient for the accuracy of the solution. Typically, low complexity circuits are discontinuities in transmission lines
and require less meshing density for sufficient accuracy.
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Figure 14.5. Low Complexity Structure. (cell size 4 x 4 mils and frequency = 20Ghz)

In summary, defining cell size for particular structures requires knowledge of three factors:
1. The accuracy required for the application of the circuit. For example, if a structure is complex and the application
requires very tight specifications, then the meshing density may be high.
2. The affect of parts of the structure on the overall performance. For example, the Lange couplers performance is
determined by the widths and spaces of the coupling fingers.
3. Frequency of analysis. Higher frequency means smaller cell sizes in general.

14.10. Partitioning Large Structures
The details discussed in this section apply specifically to EM structures that use EMSight as the EM solver. If you specify
a third-party solver, you should check the vendor documentation for details on the method(s) used for EM simulation.
"Divide and conquer" is a term used to describe the partitioning of electrically large structures into smaller independent
simulations that are recombined using the linear simulator. The following examples describe this method.

14.10.1. Coupled MTEEs Example
The original structure for simulation is seen in Figure 14.6, “Three Microstrip MTEE Sections Joined by MLINS”. The
structure consists of three microstrip tees (MTEE) sections that are joined by microstrip lines (MLINS). All of the MTEEs
have input and output MLIN widths of 10 mil. The first MTEE from the left has a branch width of 50 mils and is called
mtee50. The other two MTEEs both have branch widths of 20 mils and are called mtee20_1 and mtee20_2. The MLIN
between mtee50 and mtee20_1 is 10 mils long, while the MLIN between mtee20_1 and mtee20_2 is 55 mils long. The
microstrip lines are on a 25 mil thick alumina substrate er=9.8.
Figure 14.6. Three Microstrip MTEE Sections Joined by MLINS

A common guideline for determining the coupling between discontinuities is that you can partition into a separate
simulation any discontinuity spaced more than two substrate widths apart. In this structure the first two MTEEs are
spaced only 10 mils apart, which is less than double the substrate thickness of 50 mils. Mtee20_1 and mtee20_2 are
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separated by 55 mils, and therefore you can simulate mtee20_2 separately. Figure 14.7, “Partition 1: Coupled MTEEs mtee50 and mtee20_1.” and Figure 14.8, “Partition 2: Isolated MTEE mtee20_1.” show the new partition of the structure.
Figure 14.7. Partition 1: Coupled MTEEs - mtee50 and mtee20_1.

Figure 14.8. Partition 2: Isolated MTEE mtee20_1.

The combined simulation of the new partition is done using the linear simulator. Each partition becomes a subcircuit
that can be placed in a schematic and connected together to simulate the combined effect of both structures (see Figure 14.9,
“Schematic for Combined Simulation of Partitions 1 and 2.”).
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Figure 14.9. Schematic for Combined Simulation of Partitions 1 and 2.
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The entire structure and the partitioned structure are simulated for comparison. The data shows negligible differences
that verify the accuracy of this method.
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PCB Example
This example illustrates how a very complicated circuit can be simulated by judiciously choosing which parts of the
structure are critical to the solution, and reducing the structure into smaller parts. A microstrip circuit is analyzed for two
separate cases. Case 1, the "fullckt" case, is the lower part of the original structure with all insignificant vias deleted. All
vias that are preceded by other vias on a ground pad have almost no effect on the main signal and are deleted. Also, any
via further than two substrates' thickness from the main signal line are deleted.
Case 2 is a simplified version of Case 1. The following guidelines are used to simplify the circuit:
1. Any metal patterns that are spaced more than one and a half times the substrate height are deleted. In this case, the
substrate is 25 mils thick so any line more than 37.5 mils from the main signal line is excluded. Typically, any line
that is spaced more than twice the substrate height away from another line has an insignificant coupling affect on the
main line. This example illustrates that even 1.5 the substrate thickness is insignificant for this solution.
2. All ground vias are deleted.
The following is the original circuit.
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The following is Case 1:

The following is Case 2:

The grid size for both cases is 5mils in the x-direction and 20 mils in the y-direction. The enclosure dimensions for Case
1: x=1500mils, y=1500mils, layer1=225mils er=1, layer2=25mils er=6.15. For Case 2: x=1500mils, y=1200mils,
layer1=225mils er=1, layer2=25mils er=6.15. Case 1 uses 98 MB RAM. Case 2 uses 39 MB RAM. The results for both
cases are shown on a Smith Chart for S-parameter data and on a rectangular grid for transmission and reflection in db.
From the data it is obvious that simplifying the circuit has little or no effect on the solution for the structure.
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In summary, when performing EM simulations it is important to understand what parts of your structure are critical in
the coupling of electromagnetic energy from the main transmission line to the other conductors or ground planes. The
"double the substrate thickness" is a guideline approximation for how to decide when coupling is occurring. To better
understand the coupling it is easy to just isolate part of your structure to get an insight into what structures are critical in
the final solution. It is also advantageous to break up the structure into pieces by excluding extended uniform transmission
lines, and breaking up the simulation into smaller parts where there is an absence of coupled discontinuities in the
structure. You can output the results of each part to an S-parameter file that you can connect together in a schematic to
create the solution for the entire structure. This simulation method can drastically reduce computational time.

14.11. Tips to Speed Up Simulations
The details in this section apply specifically to EM structures with EMSight selected as the EM solver, however the
methods discussed should be applicable to any EM solver. You should check the documentation for third-party solvers
to determine if there are potential problems with applying the techniques discussed here.
1. Analyze a few frequency points. Use a few test frequencies to see if the circuit is set up properly before solving many
frequency points. You can add frequency points later incrementally without resolving the initial points. The Status
Window displays the simulation time for each frequency and estimates the time to completion.
2. "Divide and conquer" - EMSight simulations grow exponentially as problem size increases. Whenever possible, break
electrically large structures into smaller independent simulations. Re-combine the EM structures at the schematic
level.
3. Always view the simulation before simulating. Double-click the Information node below the EM structure name in
the Project Browser to see how much RAM is required for a given simulation, and for an estimate of the simulation
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time. A more accurate estimate of the time is available by running one frequency point and viewing the status to see
how long it took to complete.
4. Experiment with the Solver, Grid, and Mesh options. Choose View > Information to change the grid, solver, and meshing
options without resimulating the structure. Change the options and view the number of cells, RAM requirement, and
estimated time for each possible simulation.
5. Use a coarse grid initially. Try to limit the number of cells to less than 3000. You can usually accomplish this by
changing the mesh and/or grid size. Novice users typically over-mesh problems by using an extremely fine grid.
6. Proper selection of the matrix solver can greatly influence the simulation time of large EM problems. For extremely
large problems you should use the Direct Full (Out-of-Core) solver. For smaller problems (#unknowns < ~2000) you
should use the Direct Full matrix solver, as it has minimum set up time required each time you use it.
7. Set the mesh options differently for individual polygons. You can do so by selecting the polygon and then changing
the mesh option by right-clicking. Typically, you can mesh most elements with the Low setting. You can manually
set more critical polygons to Normal or High mesh.
8. To double the simulation speed, use lossless dielectrics and perfect conductors. This does not adversely affect the
frequency response and it reduces computation time and RAM requirements by half.
9. Use different grids for the X and Y axes. For many structures, such as Lange couplers, you can use a much coarser
grid in either the X or Y dimension. Do not hesitate to take advantage of these circumstances. The XY grid spacings
are independent for this reason.
10. Upgrade your hardware to the highest level you can.
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Chapter 15. EM: AXIEM
The Cadence® AXIEM® 3D planar EM solver is a Method of Moments solver that solves for the currents on conductors
that can be embedded in a stackup of planar dielectric layers. The dielectric layers are of infinite extent in the x-y plane
as shown in the following figure. The dielectric layers are defined above an infinite half-space. The half-space below
the dielectric is typically a conductor or PEC (perfect electric conductor), but it can also be an infinite open boundary if
needed. The half space above the dielectric layers is typically an infinite open boundary which correctly models free-space
radiation, but it can also be a conducting plane.

Currently, all conductor shapes in AXIEM software must be planar in the x-y plane and they can be arbitrarily extruded
orthogonally in the z direction. The extrusion of the conductors in the z-direction is referred to as the "thickness" of the
conductors. There are no restrictions on the thickness of the conductors. They can be infinitely thin, or they can have
finite thickness. The thickness is allowed to protrude through one or more dielectric layers as well. There are also no
restrictions on the shapes relative to the grid (they do not need to fall on a grid, as is the case with the EMSight solver).
A typical model built in AXIEM software contains conductors and vias. Conductors can be of any thickness, and they
always start (in the z direction) from the EM layer they are drawn on and extend upward. Vias on the other hand, always
protrude downward from the layer they are drawn on, and they always extend through complete dielectric layers (one
or more). Since there are no restrictions on the height of conductors, you can draw vias using thick conductors. You
should use vias when appropriate, as there are some options in the mesher that treat a via differently from a thick conductor
that spans the same z extent.
AXIEM software uses a mesh defined on the surface of the conductors as the basis for the solution. The effects of the
dielectric layers is taken into account mathematically (through Green's functions), which allows the solution to be found
from a much smaller set of unknowns. The surface currents modeled by AXIEM software include all x, y and z components.
For any conductor that can be created in AXIEM software, there are no restrictions on how current flows on the surfaces.
The ability to model all surface currents accurately allows accurate analysis of conductor traces of any thickness (even
lines that are much thicker than they are wide).

15.1. Using the AXIEM Solver
This chapter provides information on setting up and using the AXIEM solver.

15.1.1. Frequency Setup
To set the desired analysis frequencies, right-click the EM document in the Project Browser and choose Options to display
the Options dialog box, then click the Frequencies tab. See “Setting Frequencies” for more information. You can enter
any frequency, including DC. You should always include the DC point when the results of the simulation are to be
included in a nonlinear circuit simulation, as it is needed to compute the DC component of the circuit solution. Any of
the Auto configure solvers automatically select the correct solver when sweeping from DC to high frequencies.
If you delete the highest frequency after simulating, you can still retain that frequency as the meshing frequency. The
following dialog box displays after you click OK to save your frequency deletion on the Options dialog box Frequencies
tab. Click Yes to retain the deleted frequency as the meshing frequency and prevent a resimulation at all frequencies.
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15.1.2. Simulation Information
You can use the Solver Information dialog box to check the number of unknowns and ensure they are within a solvable
range. Iterative solvers can usually solve up to approximately 50K to 150K unknowns (the limit is problem and solver
dependent) for the 32-bit platform, while the 64-bit solver can handle much larger problems. Direct solvers are usually
limited to approximately 8K unknowns on a 32-bit platform. When the number of unknowns is large, you should reduce
them by adjusting the meshing parameters. Note that the structure must be meshed to get this information, so you may
have to wait for the mesher to complete to see the results. If the meshing parameters are set very poorly, and the structure
is very complex, the mesher might run out of memory (or take a very long time) before the information displays.
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15.1.3. Viewing the Mesh
You should always view the mesh before simulating your structure. Using the EM_MESH mesh annotation, you can
look for unintentional opens or shorts in your structure. The mesh can also show you how well you have configured your
circuit for simulation. The most common problem is over-meshing a structure, resulting in significantly longer simulations
than necessary. See “EM Annotations and Cut Planes” for more information on viewing the structure mesh.

15.1.4. Simulation Status
You can monitor progress in the Output log section of the Simulation dialog box. The "Estimated Time to Completion"
message provides a good estimate of time remaining before completion when AFS (Advanced Frequency Sweep) is not
enabled. This information is not available when using AFS, as the number of additional frequencies required for AFS
convergence is unknown.

15.1.5. Thick Metal Setup
AXIEM software can simulate metal traces with or without thickness. In either case, the loss of the metal can be calculated
accurately. However, coupling between lines that are close cannot be approximated with thin metal, so thickness may
be necessary. In order to simulate with thickness, you must define your metal properties as conductances with thicknesses

Simulation and Analysis Guide 15–3

Solvers
and NOT impedances. Even with the proper conductor setup, the default in AXIEM software is to simulate as thin metal.
From the mesh properties, you must tell AXIEM software to simulate with thick metal. This option can be set per EM
structure or per shape. To change the settings per EM structure, right-click on the EM structure in the Project Browser,
choose Options and click the Mesh tab. Clear the Model as zero thickness check box. To change the setting per shape,
right-click the shape in the EM structure, choose Shape Properties and click the Mesh tab. Clear the Use default properties
and Model as zero thickness check boxes. You can always verify in the 3D view of the EM structure whether it simulates
with thin or thick metal. For example, the following figure shows a line set up to simulate as thin metal.

The following figure shows the same line set up to simulate with thickness.

15.2. Solvers
AXIEM software uses several different internal solvers. By default, there are auto configurations that attempt to pick
the optimal solver for the situation. For example, there are solvers that work well for low frequencies (down to DC), and
there are solvers that work well for higher frequencies. The range in which the low frequency and high frequency solvers
work well overlaps significantly, so for many problems, either solver should work. When a solver is selected using the
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option, it is automatically selected based on frequency, to allow seamless simulation of structures from
DC to very high frequencies (DC to daylight).
Auto configure

The ability to simulate DC accurately is very important when the results of the simulation are used in a nonlinear circuit
simulation, as the DC solution is needed to correctly compute the DC component of the solution. Since AXIEM software
has dedicated solvers for low frequency, you can add a 0 frequency point to yourAXIEM simulation frequency list and
be confident the answer is accurate. You should always verify the DC response, however, by viewing S-parameters or
injecting a DC source and making sure DC currents and voltages look correct for your structure.
NOTE: Both the low and high frequency solvers solve the same system of equations (no quasi-static approximations
are made in the low frequency solvers).
AXIEM solvers are categorized as follows:
• Low frequency solvers
• Direct solvers
• Iterative solvers
• High frequency solvers
• Direct solvers
• Iterative solvers
Direct solvers are used for relatively small problems, as they do not scale as well as the problem size grows larger (O(N^2)
for the fill, and O(N^3) for the solve). Iterative solvers (often referred to as "fast solvers"), are better suited for large
problems. The following table summarizes the scaling for the various solver types. On the EM Options dialog box AXIEM
tab, you can select Auto configure as the Solver type to automatically choose the solver based on frequency and problem
size.
Solver Type

Frequency Range

Memory Usage

Matrix Fill

Matrix Solve

Direct

Low frequency

O(N^2)

O(N^2)

O(N^3)

Direct

High frequency

O(N^2)

O(N^2)

O(N^3)

Iterative

Low frequency

O(N*Log(N))

O(N*Log(N))

O(N*Log(N))

Iterative

High frequency

O(N*Log(N))

O(N*Log(N))

O(N*Log(N))

In addition to the solvers listed in the table, there are Iterative solver types with different speed/convergence robustness
qualities. See “AXIEM Solver Options” for a discussion of these options.

15.3. AXIEM Ports
Ports are two-terminal devices used to model the input and output terminals of the structure. Physically, a port represents
a gap voltage source that excites current in the structure. The solution for the current is found during the simulation
process. The linear port parameters (S-parameters, for example) are then calculated from the computed currents.
AXIEM software supports two kinds of port drawing types: edge ports and internal ports. An unrestricted number and
combination of ports is allowed. This section provides additional information on how ports are modeled and used in
AXIEM software.
See “Adding EM Ports” for details on how to add and edit ports in the EM Editor.
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15.3.1. Editing Ports
The default edge port type in AXIEM software is auto port. It is a self-configurable port that determines port settings
such as de-embedding reference plane distance, ground reference, and port grouping based upon the geometry and
stackup. No user input is needed on auto ports. See “Auto Ports” for details on auto ports. Auto port settings can be
overwritten by manually editing options on the port. See “Editing EM Ports” for details on how to change port settings.

15.3.2. Setting the Reference Planes
Reference plane extensions are sometimes used when very high precision is needed. For many situations, reference plane
extensions are not necessary, as the ports in AXIEM software introduce relatively small discontinuities. You can use
de-embedding to significantly reduce the parasitic effects of the port further (note that de-embedding is required if you
use reference plane extensions). See “Port De-embedding” for more information on port de-embedding. See “Setting
Reference Planes” for details on how to set the reference plane.

15.3.3. Setting Explicit Ground Reference
Type changes how edge ports are excited. See “Edge Ports” for details on edge port excitation. When using auto ports,
Type is set to Auto, and auto ports determine the best setting. You can also manually specify None or Connect to lower,
upper, or both by double-clicking on the port to open the Properties dialog box. The port symbol changes to indicate the
selected setting. In the following figure Type is set to Auto for Port 1, None for Port 2, Connect to upper for Port 3, Connect
to lower for Port 4, and Connect to both for Port 5.

15.3.4. Auto Ports
The default port type in AXIEM software is auto port. It is a self-configurable edge port that automatically determines
port settings based on geometry and stackup. See “Edge Ports” for details on edge ports.
Auto ports set:
•

Type (Connect to upper, Connect to lower, Connect to both,

or None), accounting for local grounds and/or enclosure

boundary
• Port grouping (none, coupled, or mutual)
• Reference plane extensions for exterior ports if possible
Only ports with Type set to Auto are self-configurable. Auto ports do not apply to Cadence Analyst™ 3D FEM EM
simulations. If an AXIEM document is converted to Analyst, any ports set to Auto are converted to Connect to lower.
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Auto port does not apply if:
• A port is a multi-terminal port
• A port is a finite gap port
•

Type

is set to any setting other than Auto

• Any Port Group is specified
• Any Ref. Plane Distance is specified
Auto port options are included under AXIEM solver options. You can set these options for each document by right-clicking
the EM document in the Project Browser and choosing Options to display the Options dialog box. On the AXIEM tab
under Auto Port Setup the three auto ports operations (Grounding, Extension, and Grouping) operate independently. Click
the Show Secondary button to view advanced settings.
To see the port options automatically set by auto ports you need to select the EM document in the Project Browser,
right-click and choose Preview Geometry. In the Preview Geometry window that displays, auto ports are converted to
standard edge ports, with port settings automatically determined by auto ports. The Mesh annotation also displays
reference plane extensions and explicit ground references, but not port groupings. For additional information on auto
port calculations, add the VERBOSE_STATUS 1 rule to the Rules tab of the Enclosure settings for an EM document.
Additional details display in the Status Window. See “Element Options-(EM) STACKUP Properties Dialog Box: Rules
Tab” for more information on the Rules tab.
Determining Ground Planes
The first step in the auto ports methodology is to determine eligible ground planes for each port. This step always occurs,
even if the Grounding option is disabled. Eligible ground planes can either be conductive Top/Bottom Enclosure boundaries,
or internal conductive shapes. There cannot be any obstructions between the port and eligible ground plane. For shapes
to be eligible, the projection of the port on the shape must be entirely enclosed by the shape. There cannot be any edges,
slots, or cutouts along the projection of the port.
When there is both a top and bottom conductor that can potentially be ground planes, the Dual Gnd Ratio determines
whether only one, or both conductors are considered ground. The primary ground is the one with the higher capacitance
per unit area between the trace and the grounding surface. If the capacitance per unit area ratio between the secondary
and primary ground is greater than Dual Gnd Ratio, then both conductors are considered eligible grounds. If Dual Gnd
Ratio = 1, only the primary conductor is considered ground. If Dual Gnd Ratio = 0, then both conductors are always
considered grounds. By default Dual Gnd Ratio = 0.5.
Capacitance per area for multilayer dielectrics is calculated as the total series capacitance of all the layers, as shown in
the following figure.
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is used to determine whether a metal0-via1-metal1-via2-metal2-...-metalN structure should be
considered a plated line. If so, the entire plated structure is modeled as thick metal for capacitance calculations, so the
distance from the bottom metal layer to lower ground and the distance from the topmost metal layer to upper ground is
used for capacitance calculations. The default value is 0, meaning no plated line structures are modeled as thick metal
for capacitance calculations.
Max Plated Inset Distance

is used to determine whether a shape is wide enough to be considered an eligible ground. The default
value of 0 means all shapes are eligible.
Max Trace Width

Applying Auto Grounding
After ground planes are determined, auto ground occurs. If Grounding is enabled, auto port determines whether explicit
ground reference is needed. If the ground plane is a local ground plane, then explicit ground reference is always used.
If the ground plane is an Enclosure boundary, then ground reference is dependent on λ and h, where λ is the wavelength
of the highest simulated frequency, and h is the distance between the port and the nearest ground. If h<(Max length for
implicit grounding)·λ, then implicit grounding is used because explicit ground reference offers no benefit when the distance
between port and ground is electrically very short, and results in longer simulation time. When auto port determines that
explicit ground reference is needed, then Dual Gnd Ratio (as previously described) determines whether the explicit ground
reference connects to lower/upper/both when there are two potential ground surfaces.
If a port is located too closely to a via and uses Enclosure boundary as ground, explicit ground reference is not added
since the explicit ground strap can couple to the via. Auto port sets ground reference to implicit if a via is detected within
the clearance distance of (Via Clearance Ratio)·h, where h is the distance to the nearest ground. This clearance distance
is measured from the midpoint of the port.
By default, interior edge ports do not support explicit ground references. You can enable ground references by selecting
the Allow explicit grounding of interior ports, check box, however, the explicit ground strap on interior ports cannot be
de-embedded. Also, interior ports cannot support both up/down ground straps on plated line structures. Only the primary
ground supports a ground strap.
The following example illustrates several auto ground concepts. Port 1 is attached to a line with a via. Port 3 is located
in the interior of the line.
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The following figure shows the 3D Preview Geometry view. Based on the substrate height and frequency, all ports should
use explicit ground references. However, because Port 1 is located too close to a via, implicit ground reference is used
instead. With the Allow explicit grounding of interior ports check box cleared, Port 3 also uses implicit ground reference.

Applying Auto Grouping
After port grounding is determined, auto grouping occurs. If Grouping is enabled, closely spaced ports are automatically
assigned to mutual groups for de-embedding. All ports in a mutual group must share the same ground plane, but do not
need to have the same ground reference type. The main use of mutual ports is simulating the interconnect lines attaching
to a component that is not included in the EM simulation. Auto port first identifies potential groups based on the pattern
of port arrangement, and then checks how closely the ports are spaced. If the ports are spaced within a circle with radius
of (Max. Cluster Radius Ratio)· h, they are mutually grouped for de-embedding, where h is the distance to the closest
ground. The following figure represents a typical layout where vias and lines connect to a transistor that is not shown.
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The four ports are auto-grouped together in a mutual group based on their proximity. As shown, the distance between
ports is calculated from port midpoints.
For mutual grouping:
(d1, d2, d3, d4, d5, d6)< 2 · RCL where RCL = (Max. Cluster Radius Ratio)·h, and h = distance to closest ground.

Applying Auto Extension
After auto grouping has occurred, auto extension can occur. If Extension is enabled, auto port adds reference plane
extensions where possible. Extensions are first determined for non-grouped ports, and then for grouped ports.
For non-grouped ports, the desired extension distance for each port is determined by (Optimal Extension Length
Multiple)·max(port width, h), where h is distance to nearest ground. Based on this distance, port width, and other extension
options (Horz. Clearance Ratio, Clearance Exclusion Angle, Vert. Clearance Up, and Vert. Clearance Down), a three-dimensional
(tapered cuboid) keep-out region is created. In order for ports to auto extend, the ground plane must be continuous in the
keep-out region, and no other obstructions may lie in this region. Obstructions also include extensions from other ports.
If you cannot add the desired extension distance, it is incrementally shortened until the keep-out criteria of continuous
ground plane and no obstructions are met. If extensions from two or more ports are interfering with each other, all port
extensions are incrementally shortened until the keep-out criteria is met for all of them. The extensions only shorten to
a length determined by Min. Extension Multiple. Extensions under this length are considered too short to be useful, and
when this limit is reached due to shortening, no extension is added for the port.
By default, the three-dimensional keep-out region for port extension is drawn in the 3D Preview Geometry view. It is
drawn on the "AutoPortsKeepOut" drawing layer, which is a Cadence AWR Design Environment® platform generated
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drawing layer that is not included in the simulated geometry. To turn off the clearance region, turn off the
"AutoPortsKeepOut" layer in the Layout Manager Drawing Layers pane.
The following example illustrates various auto extension options. The first figure shows an unobstructed line above a
finite ground plane.

This following figure shows the Preview Geometry view. The ports are extended by distance Lext. In this case, the ports
are unobstructed, and the ground plane is large enough to extend the ports by the optimal distance (Lopt):
Lext = Lopt = (Optimal Extension Length Multiple)·h, where h = max(port width, distance to closest ground)
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The keep-out region is visible in the 3D Preview Geometry view as the shaded green region, as show in the following
figures.
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The side view in the following figure illustrates how the vertical extent of the keep-out region is calculated. By default,
the vertical extent extends from top to bottom enclosure, but in this example, Vert. Clearance Up = Vert. Clearance Down
= 2. The upper vertical clearance distance is:
VCup = Vert. Clearance Up·h, where h = distance to closest ground
In this example, VCup = 2·h
Because the distance from the port to the lower ground plane is less than the calculated vertical extent based on Vert.
Clearance Down, the lower vertical extent of the clearance region is simply the distance to ground. h<Vert. Clearance
Down·h, thus:
In this example, VCdown = h

The following top view illustrates how the horizontal extent, and angle of the taper of the clearance region are defined.
θ = Clearance Exclusion Angle
HC = (Horz. Clearance Ratio)·h, where h = distance to closest ground
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The following figures illustrate how obstructions affect auto port. The first figure shows that there are two additional
shapes, which are not on the same EM layer as the line. Also, a hole is cut in the ground plane.
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This next figure shows the Preview Geometry view of the same structure. Port 1 is not extended at all because it is blocked
by the shape on the left. Port 2 extension length is less than optimal because the hole in the ground plane prevents further
extension.

It is easier to understand the port extensions when looking at the 3D Preview Geometry view as shown in the following
figure. The shape to the left of Port 1 is not on the same EM layer, but is within the vertical clearance distance for Port
1, so that shape is considered an obstruction for Port 1. On the other hand, the shape on top of Port 2 is outside of the
vertical clearance region, so it is not considered to be either a possible ground for Port 2, or obstruction for Port 2. Note
that the hole in the bottom ground plane is considered an obstruction, and prevents further extension of Port 2. With the
exception of cut-lines, ground planes must always be continuous across the clearance region.
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The top view of the following 3D Preview Geometry view shows the horizontal extent of the keep-out region. The
minimum extension length (Lmin) is set by Min. Extension Multiple:
Lmin = (Min. Extension Multiple)·Lopt, where Lopt is calculated above.
In the following figure, the extension length for Port 1 (Lext) is calculated as:
Lext = Lobs - HC, where HC is the horizontal clearance distance calculated above.
In this example, Lext<Lmin. Because the calculated extension length (Lext) is less than the minimum extension length, no
extension is added for Port 1.
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Lastly, auto extension is applied to grouped ports. Ports in mutual groups only extend if Allow mutual group extensions
is enabled. Furthermore, Group Clearance Ratio and Via Clearance Ratio options limit how far the grouped ports can extend.
Group Clearance Ratio is the equivalent of Horz. Clearance Ratio for non-grouped ports. Group Clearance Ratio determines
the unobstructed horizontal clearance distance for grouped ports. The next set of figures illustrates an example of mutually
grouped ports with extensions. The first figure shows four ports that auto ports grouped together due to their proximity.
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The next two figures show the Preview Geometry 2D and 3D views. Allow mutual group extensions is enabled, so Ports
1 and 2 are extended. Ports 3 and 4 do not extend, since extending them brings them closer the via.
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The top view with the "AutoPortsKeepOut" drawing layer turned on shows how the horizontal extent of the keep-out
region for grouped ports is calculated.
GC = (Group Clearance Ratio)·h, where h = distance to closest ground

Auto Ports on Coupled Lines
If ports are initially determined to be coupled, they remain coupled after Auto port modifications. See “Coupled Line
De-embedding” for details on the requirements for coupled line de-embedding. If ports are detected as coupled, then:
• Auto ports attempts to keep extensions the same length.
• Clearance regions of coupled ports can overlap.
• Coupled ports are excluded from mutual groups.
The following example illustrates auto ports on coupled lines.
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The top 3D Preview Geometry view shows how the clearance region for each port can overlap, since the extensions are
de-embedded using coupled line de-embedding.
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Auto Ports on Plated Lines
Cadence recommends utilizing geometry simplification rules with plated lines to eliminate insets in the line structure. If
there are rules, auto ports determine port settings based on the simplified geometry. See “Geometry Simplification” for
details on writing rules.
For plated lines structures that are not simplified with rules, the Max Plated Inset Distance determines whether or not the
inset layers of the line are recognized as a plated line. Layers inset less than this distance are recognized as being part of
the plated line structure, while layers inset greater than this distance are considered obstructions for auto ports. By default,
Max Plated Inset Distance = 0, so no plated line structures are recognized.
For valid plated line structures, the following figures illustrate how auto ports extensions are applied. The plated line
consists of metal-via-metal layers. The following 3D view has the vertical scale expanded to better show the details.

When auto extension is applied, the extension line is composed of all of the layers. The cross-section of the original line
is not maintained across the extension. Instead, widths of all the plated line layers are made equal so that the extension
line has a rectangular cross section, as shown in the following Preview Geometry views.
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15.3.5. Port Types
The AXIEM solver can use a number of different ports. See “Adding EM Ports” for details on how to add ports in the
EM Editor.
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Edge Ports
Edge ports are the simplest and most commonly used port in AXIEM software. The default port type is auto, which is a
self-configurable edge port. See “Auto Ports” for more details about auto ports.

1
ACVS

Ground at ∞

An implicit edge port, with no ground reference, is defined in terms of voltage and current. The voltage is defined from
the edge where the port is located, to the infinite ground plane (or infinity, if no ground plane is specified). The implicit
edge port uses a path-independent voltage for its definition, which works well for low frequencies or transmission lines
that support quasi-static modes. The implicit ports can introduce some error for structures where the transmission lines
have significant dispersive effects. Where dispersion is an issue, a Type option is available to connect the port to a ground
plane either above and/or below the edge with a vertical strip of conductor. The Connect to lower, Connect to upper, or
Connect to both options for Type automatically insert a vertical strip of conductor that extends from the port edge to the
nearest conductor or ground plane that is encountered. For Connect to lower or Connect to upper, a delta gap port is added
between the bottom of the strip that extends to the nearest conductor (or ground) and the shape to which it is connected.
For Connect to both, the delta gap port is added in the middle, between the upper and lower strips. The effect of the strip
introduces more of a discontinuity than the implicit port with None selected as the Type, so you should enable de-embedding
when using Type. See “Setting Explicit Ground Reference ” for details on editing the ground reference.
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1
ACVS

Δ

Δ=0

An internal edge port is surrounded (overlapped) by metal on the same layer. Internal edge ports cannot be de-embedded,
even if De-embed is selected (the simulation issues a warning indicating this). If the Type of an internal edge port is set
to any of the Connect to options, the ground straps are not de-embedded.
Point Ports
AXIEM software models point ports as a small internal edge port located at the center of the shape, with no de-embedding.
By default, the Type is set to None, meaning implicit ground reference, with the same details and restrictions as implicit
edge ports. However, point ports differ from internal edge ports when Type is changed to one of the Connect to options.
In this case, the point port becomes a differential port, with the positive terminal on the original layer and the negative
terminal(s) on the first layer with metal directly beneath and/or above the port.
Differential Ports
Differential ports are a group of edge ports where you can define the return location as any arbitrary point in the circuit.
To do so, make one or more ports the negative terminal of the port groups by specifying the Port Number as the same
number with a negative sign preceding the number. Differential ports must have ground reference Type set to None.
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1
ACVS

-1
Some common uses for differential ports are to create CPW lines

and finite gaps.
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Like an internal port, a differential port appears as a single port on the SUBCKT block when the EM structure is placed
in a schematic as a subcircuit. To connect a circuit element between the positive and negative sides of the differential
port, connect it between the one port in the schematic, and ground. The same restrictions as internal ports apply to
differential ports.
Series Ports
The series port grouping is a convenience port which allows you to access a differential (finite gap) port as a two-terminal
device. AXIEM software actually converts a series port into a differential port for electromagnetic simulation via the
Method of Moments. After this simulation is complete, a linear circuit simulator is used to attach an ideal 1:1 transformer
to the differential port, resulting in a positive and negative terminal for the series port group. It is easiest to think about
these two external ports as being excited/terminated in differential and common mode. The differential excitation sees
the same impedance as the finite gap port in the EM simulation. The even mode excitation sees an open circuit.
The underlying simulation of a series port is a differential port simulation, thus, series ports are subject to the same
guidelines and restrictions as differential ports.
In the Properties dialog box you must configure two ports to be part of a group in order to be considered a series port.
In the Port Group section, select Series as the Type. Name can be either a new name or an existing name selected from
the drop-down list.
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Series port groups have the following limitations:
• They must contain only ports with positive indexes.
• They must contain only ports with exactly two port indexes (not one, or more than two).
• The lowest port index in a series port group is considered the positive terminal of the differential (finite gap) port.
The most common use for series ports is the simulation of a gap, across which a series component is placed, as shown
in the following figure. Ports 3 and 4 are part of the same series port group, and represent one port.

When the EM structure is used as a subcircuit in a schematic, nodes 3 and 4 represent the series port.

SUBCKT
ID=S1
NET="EM_Series_Port"
3
PORT
P=1
Z=50 Ohm

1

2

4

PORT
P=2
Z=50 Ohm

CAP
ID=C1
C=1 pF

The equivalent differential port simulation of the gap is shown in the following figure. Again, Ports 3 and -3 represent
one port.
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The equivalent schematic with the differential port subcircuit is shown in the following figure. Unlike the series port,
only one node is exposed for the differential port. Ports 2 and 3 on the transformer in the following figure are equivalent
to ports 3 and 4 on the SUBCKT block in the previous schematic. This is not the recommended way to use differential
ports, but only an illustration of the difference between differential and series ports.

SUBCKT
ID=S1
NET="EM_Diff_Port"
PORT
P=1
Z=50 Ohm

1

PORT
P=2
Z=50 Ohm

2

3

SRC_CONV
ID=X1
1

2
+

+

V

V
3
-

CAP
ID=C1
C=1 pF

Multi-terminal Ports
Multi-terminal ports are similar to differential ports except that you can define two or more locations to share the same
source. You can think of this as exciting multiple location in a circuit in common mode. For multi-terminal ports, their
return can be infinity (Type set to None), a ground plane (Type set to other than None), or a negative terminal port (Type
set to None and another port with the same number but a negative sign in front). The following figure shows the
configuration with no ground reference.
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1

ACVS

1

Ground at ∞

The most common use for multi-terminal ports is to help make the extraction flow work efficiently. There are times that
several lines overlap one area and it is more efficient to make the end of the lines use the same port instead of individual
ports. This is valid as long as the area they are overlapping is electrically small. For example, if there are three iNets
overlapping an area pin, but the area pin metal is not extracted, the EM document displays as shown in the following
figure,
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and if the metal of the pin is extracted, it displays as shown in the following figure.

Typically, area pin areas are small electrically, so either configuration provides the same answer.
An edge port can be on any edge of a conductor even if the conductor is touching or overlapping other conductors. This
is different from an internal port in that the return path for this port is either infinity (Type set to None) or a ground plane
(Type set to other than None). The following figure shows the configuration with no ground reference.
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1

ACVS

Ground at ∞

This port cannot currently be de-embedded. This is primarily support for extraction work when ports must be added to
shapes in several situations.
Internal ports are connected between two polygons that are adjacent to each other as shown in the following figure.

+1

ACVS

Because of this small gap, there is some small parasitic of this port that is not currently removed in a de-embedding
process. The difference between this port and a differential port with a ground return defined is that this port has a very
small gap between the conductors that is excited, where the differential port can define any gap you want that is excited.
Internal Ports
Internal ports are the most complicated of the ports, and should be used with caution. To use the internal ports effectively
requires a good understanding of both the implementation of the internal ports and the concept of a local ground reference.
The resulting S-parameters from a simulation that uses the internal ports is not a general S-parameter and there is a
relatively non-intuitive methodology that you must follow to get meaningful results.
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See the EMSight description of internal ports in “Description of Internal Ports” since the issues are similar.

15.3.6. Port Accuracy
Even with no de-embedding, AXIEM edge ports have a very low discontinuity because the excitation is handled as if
the port were pulled away from the structure and the port reference plane were extended back to the port location. This
is different than EMSight, which has higher port discontinuities because the excitation occurs directly at the port location,
and it takes some distance for the current flow to spread out into the real operating mode on the line, as shown in the
following figures. The x dimension AXIEM current flow from the port reflects the actual propagation mode of the line,
while the EMSight x dimension current flow shows uniform current across the entire port edge.
AXIEM x dimension current:

EMSight x dimension current:
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Similarly, the AXIEM y dimension current flow is nearly 0 (as expected) but the EMSight y dimension current flow is
non-zero in the first few mesh as the current has to “spread out” to account for the real propagation mode on the line.
AXIEM y dimension current:

EMSight y dimension current:
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15.3.7. Port De-embedding
The de-embedding option performs an additional post-processing step on the data to remove the effects of parasitics
associated with the ports. The parasitics associated with the ports in AXIEM software are relatively small, so it is not
always necessary to de-embed. De-embedding is recommended for simulations that require very high precision (such as
the simulation of a very small discontinuity like a bend), or when a reference plane shift is desired for the port solution
(when a reference plane shift is specified on a port, it is only used if de-embedding is enabled).
By default, an AXIEM data set excludes the de-embedding network data, which can result in a significantly smaller data
set file size. You can modify this behavior by altering the Store De-embedding Network option.
In the following specific cases, de-embedding network data is automatically stored within the data set:
• When antenna or in-situ antenna measurements or annotations are specified.
• When current annotations are specified.
• On the EM structure Options dialog box General tab, when the Currents or Antenna check box is selected under Save
Results in Document.
• On the EM structure Options dialog box AXIEM tab, when Store De-embedding Network is selected. (This option displays
when Enable De-Embedding (Global) is selected and secondary options are displayed.) If you change the Store
De-embedding Network selection, a resimulation occurs to add or remove de-embedding data from the existing current
data set.
Note that de-embedding can lead to causality issues, but it does not mean the solution is incorrect. For example, in the
following structure, if the substrate height is large relative to the width of the line, the electrical length of the two lines
connected by the corner can actually be shorter than the total electrical length of the two lines added together. The energy
associated with the transmission line mode “cuts the corner” and the effective electrical length of just the corner can be
negative. The de-embedded solution for the corner is non-causal, because it has negative electrical length, but it is the
correct solution, because it correctly predicts the electrical length when each edge of the corner is connected to a
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transmission line. The solution for the corner only makes sense when viewed in the context of what it is connected to (a
line-corner-line combination).

Port de-embedding is accomplished by creating one or more standards (separate EM structures), analyzing them to
understand the discontinuity, and then subtracting (or negating) the effect of the discontinuity at every port. AXIEM
software currently supports three different de-embedding types.
1. Single Line
2. Coupled Line
3. Mutual Groups
Single line de-embedding is used for edge ports with any grounding type that currently can be de-embedded. See the
following list for configurations that cannot be de-embedded. No user input is needed for coupled line de-embedding.
Coupled Line De-embedding
Coupled line de-embedding occurs where any ports that share a common reference plane location can be de-embedded
with a coupled line de-embedding standard. AXIEM software automatically uses coupled line de-embedding if two
conditions are met:
The first condition is that the reference planes must be along a co-linear line. Lines can be on different layers and have
different reference plane shifts as long as the end of the reference plane is along the same line. The following figures
show valid coupled line de-embedding situations.
Case 1 - no reference planes:

Case 2 - with reference planes:
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Case 3 - different reference plane lengths:

Case 4 - lines rotated:

The second condition is that the lines are close enough together to be included in a coupled line standard. AXIEM software
determines this by first finding the furthest distance to ground for any of the ports and then multiplying this distance by
the Coupled Ratio set in the EM Options dialog box on the AXIEM tab. This multiplication produces a coupling distance.
Any ports that have an edge-to-edge spacing that is less than the coupling distance are automatically included in a coupled
line de-embedding standard. The following figure further illustrates this process.
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S1

H1

S2

H2

H3

Ground
In this case, H3 is the furthest distance to ground, so this distance is multiplied by the coupled ratio. If S1 or S2 are less
than the coupled ratio, those lines are all included in a coupled line de-embedding standard. You can always set the
Coupled Ratio to 0 if you do not want any coupled line de-embedding. At low frequencies (near DC), no coupled line
de-embedding is ever used.
Mutual Group De-embedding
Mutual group de-embedding occurs where ports are close together and the ports themselves can couple together, especially
if using an explicit ground. In the Properties dialog box you must configure ports to be part of a group so they can be
de-embedded as a group. In the Port Group section, select the Type as Mutual. The Name can be either a new name or an
existing name selected from the drop-down menu.
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At low frequencies (near DC), no mutual de-embedding is used.
The most common use of mutual ports is when simulating the interconnect into some component that isn't EM simulated.
For example, the following figure shows a FET surrounded by shapes on all four sides that should be EM simulated.
Obviously, the FET cannot be included in the EM simulation.

The EM layout for this scenario is shown in the following figure (which is easily created using extraction).
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For maximum accuracy, the ports are connected to the bottom ground. In this case the distance to the ground is 100um,
similar to the distance between these ports, so there is coupling between these ports. Mutual group de-embedding can
remove the coupling from the simulation results.
The de-embedding standards created for mutual groups have to extend metal in the opposite direction of the port number,
so there are many situations that are not valid for mutual group de-embedding. The simplest example is a simple bend
discontinuity.

The two ports are about 80um spaced on a 100um substrate, so with explicit grounds (for maximum accuracy) these
ports will couple significantly. This situation produces a simulation error because the mutual de-embedding standard has
overlapping metal (metal extended from Port 1 to the right and from Port 2 down). For this simple example, the solution
is to add reference planes so the ports are spaced far enough apart and they won't couple.
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Viewing De-embedding Standards
When setting up your ports for de-embedding, you can use an annotation to view the de-embedding standards. This
allows you to verify you will get the de-embedding type you expect before your simulation runs. To use an annotation,
right-click your EM structure in the Project Browser and choose Add Annotation. Specify the Measurement Type and
Measurement shown in the following figure.

The most important settings are the EM Simulation Document, the Port Number and the Standard Number. For this check,
you should always use a standard number of 1. The following figure shows an example of a single line de-embedding
case.
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The relative location of the shape being meshed is not important, but the number of lines drawn is important; in this case,
one. The following figure shows an example of a coupled line de-embedding case.

Note that there are now two lines drawn showing coupled line de-embedding. The following figure shows an example
of a mutual group de-embedding case.
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Note that there are now four lines drawn showing the mutual grouping.
Port De-embedding and Status
By default, AXIEM software attempts to de-embed all ports. You can turn off port de-embedding for each port by
double-clicking the port and then selecting the De-embed check box in the Properties dialog box. See “Port Attributes
Dialog Box” for details. You can turn off port de-embedding for the entire AXIEM structure by right-clicking the AXIEM
document in the Project Browser, choosing Options to open the Options dialog box, and then clicking the AXIEM tab.
Clear the Enable De-Embedding (Global) check box. The setting on the AXIEM document overrides the settings made per
port.
During simulation, you can view the Simulation status dialog box to see the de-embedding type for each port, as shown
in the following example.

Ports 7 and 4 use single line de-embedding, ports 2 and 3 use coupled line de-embedding, and the rest are set up for a
mutual calibration group. During the simulation, notice that each port's de-embedding type displays.

Simulation and Analysis Guide 15–43

AXIEM Ports

The same information is stored with each AXIEM structure in the Simulation Log.
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For any de-embedded ports, the reason is listed as a warning in the Status Window. The following figure shows an
example of these warnings.

The following list explains the current port configurations that are not de-embedded:
1. Internal ports.
2. Edge ports with an explicit ground that is blocked from the chosen ground by another shape.
3. Differential ports.
4. Edge ports on an internal edge (touching other shapes or inside other shapes).
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De-embedding Process Overview
A stylized view of the subtraction (negation) of the de-embedding matrices from the raw EM matrix is shown in the
following figure (this process applies to all ports in an N port EM matrix).

Final EM Solution
De-embedding
discontinuity
(Port 1)

Generic N-port
EM Matrix (illustrated
as a two port)

De-embedding
discontinuity
(Port 2)

(-)

(-)

The first de-embedding standard generated is shown in the following figure. The IND and CAP elements in the standards
represent the port discontinuity, and the TLIN elements are automatically inserted based on the length of user-defined
reference plane shift, the dielectric height, the metal width, and other values.

L=L

L=L

This structure is driven in an even mode and then an odd mode, which places a perfect electrical short or open at the
exact center of the structure. Using this knowledge, the matrix can be perfectly divided in half (the symmetry is assumed
here in the de-embedding standard), which results in the y-matrix represented by the topology as shown in the following
figure.

Port with reference plane discontinuity
L=L
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If there are user-defined reference plane shifts, the length of the TLIN element (L) is equal to the reference plane shift.
In this case the y-matrix result from the first standard is sufficient to remove the port discontinuity and shift the reference
plane when “subtracted” from the direct EM results. If there is no user-defined reference plane shift, the effect to the
TLIN element needs to be removed so that only the port discontinuity remains. In this case, a second de-embedding
standard is required, as shown in the following figure.

L=L

L=L

L=L

By subtracting the final result from the first de-embedding standard (which includes the IND, CAP, and TLIN) from
both ends of the second de-embedding standard, the y-matrix is reduced to simply one TLIN of length L. Then, if this
TLIN is subtracted from the final result from the first de-embedding standard, the result is simply the effect of the port
discontinuity as shown in the following figure.

Port discontinuity

Either the final result from the first standard (if there are user-defined reference plane shifts) or the second standard are
used to de-embed the port effects from the raw EM matrix.
De-embedding Limitations
• Higher order modes that exist in the structure or the de-embedding standards can cause problems.
• There should be no shapes drawn at the same location as a port and its reference plane. The reference standard is
always the width of the line at the port and a length determined by the de-embedding process. If the real structure has
other geometry under the reference plane extension, this geometry is not included in the de-embedding standard.

15.3.8. Recommended Port Usage
The following sections include AWR port usage recommendations for specific structures.
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Differential Lines
Differential lines are excited by Differential ports, as shown in the following figure. The common mode of the two lines
is not excited by the differential ports, and the effective load impedance for this mode at the ports is an open circuit.
Differential excitation/termination of line in this manner is only recommended if a local ground is NOT present. If a
local ground is present, excitation by normal single-ended ports is suggested, as this addresses excitation/termination of
both differential/common (odd/even) modes.

Coplanar Waveguide
You can also set up Coplanar waveguide (CPW) excitation using Differential ports. It is assumed that only one mode of
propagation is allowed at each port (the port width is much smaller than the guided wavelength). Thus, if the ground
plane widths are electrically very large, it is better to attach the negative ports across a subsection of the ground plane,
as shown in the following figure.
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Thick Substrates Relative to Frequency
Edge ports with implicit ground reference (default port with Type set to None) work best when the distance between Port
and ground reference (Top or Bottom boundary) is short compared to wavelength. As the electrical distance gets larger,
ground return currents are not well-specified, and can result in passivity and accuracy problems. In these cases, use Edge
ports with Type set to Connect to upper or Connect to lower, depending on the structure.
Vias
For microstrip structures (with infinite ground plane) the most accurate de-embedding is obtained with Edge ports with
explicit ground reference. If the port is placed too close to a via, however, the port ground strip couples with the via,
which cannot be de-embedded. For accurate simulation results, you should separate the port from the via by a minimum
distance of four times the thickness of the substrate or width of the trace, whichever is greater. You can then use Reference
plane extensions to de-embed back to the via.
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When simulating a via, you should always simulate it with a connecting line. If the reference plane is placed too close
to the via, even if the port is sufficiently distant, the S-parameters obtained can be slightly non-passive. When de-embedding
the portion of the microstrip line that runs from the port up to the specified reference plane, it is assumed that the line is
in an ideal environment (the line is the only EM structure in the considered layered media). If the reference plane is too
close to the via, however, the properties of the line along the path from the port to the via are not uniform. Best results
are obtained when the reference plane is placed no closer than two times the thickness of the substrate or width of the
trace, whichever is greater.
Device Interconnects
Closely spaced ports placed across the gap of an interconnect pad to an external device can couple to each other, and
result in inaccurate de-embedding if not set up correctly.
To set up the ports correctly, the first option is to use Differential ports or Series ports. Both port types result in equivalent
simulation. Both ports are not de-embedded, and explicit connection to the lower/upper ground is not allowed. By
definition, the current going into one terminal of the Differential/Series port must equal the current coming out of the
other terminal. You should not, therefore, use this option if the external device is active.
The second option is to use Edge ports with mutual group de-embedding with or without explicit ground reference. The
ports are then de-embedded together, and account for the coupling between each other. You can use this approach for
both passive and active externally connected devices.
Local Ground Plane
If there is an infinite ground plane, using a port with explicit ground reference provides a clear physical definition of the
return current path and allows an accurate de-embedding of the port, so simulation results are very accurate. In many
situations, however, the return current path does not go through the infinite ground plane or there is no infinite ground
plane defined. Also, ports may be blocked from the infinite ground by design components and it is not possible to connect
ports explicitly with the ground.
The following example of a two-plate capacitor above a finite conducting plane illustrates several options for setting up
simulation ports with a finite local ground plane.
The first option is to use an Edge port with explicit ground reference to the local ground plane. The local ground plane
should be infinitely thin. A metal strip that connects from the port to the local ground is included, thus a small amount
of extra inductance and capacitance is added to the structure. You should enable port de-embedding to remove this extra
parasitic reactance due to the metal strip.

15–50 AWR Design Environment

AXIEM Ports

The second option is to use Differential ports with negative reference ports defined on the nearest edge of the local ground
plane. If the ground plane width(s) are electrically very large, it is better to attach the negative ports across a subsection
of the ground plane. It is important to realize that current travels from the negative to the positive terminal with zero
delay. To minimize errors caused by this effect, you should place the positive and negative ports as physically close to
one another as possible.

The third option is to place a rectangle on the ground plane directly below the port and define the negative reference port
on the edge of the rectangle. Note that the return current flows through the ground plane into the defined negative reference
plane. Usually, width of the ground rectangle is equal to the width of the corresponding trace above it, however widths
can be increased. This configuration results in a minimum distance between positive and negative ports, thus minimizing
error due to the zero delay. Also, this type of excitation introduces a less parasitic reactance compared with Edge ports
with explicit ground reference. However, this port currently cannot be de-embedded.
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NOTES:
• Differential ports are not de-embedded.
• If there is no global infinite ground plane, do not use ports with implicit ground connection (default Edge ports). The
return currents are not well defined and can cause inaccurate results.
Disable Ground Strap

When using the third method above, an alternate method is to place the ports only on the signal layers, as shown in the
following figure.
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In the “Port Attributes Dialog Box”, set Type to Connect to lower, Connect to upper, or Connect to both, as appropriate for
the structure.
Clear the GND Strap check box to create the same port type as described above, where differential ports are created with
the minus port placed on a rectangle on the ground plane directly below the signal trace. This is not a new port type, but
rather a convenience to create a differential port without requiring the placement of minus ports on the ground plane.

15.4. AXIEM Meshing
The AXIEM mesher automatically generates a hybrid mesh consisting of mixed triangular and rectangular cells. The
mesh is a full surface mesh that can accurately model both thin and thick conductors.

The mesher uses heuristic knowledge of how currents flow on the conductors to help generate a very efficient mesh that
allows very high accuracy while minimizing the number of unknowns. You can also control various aspects of the
meshing process, both globally (for the entire mesh) and locally (per shape).

Since AXIEM software makes no assumptions on how currents flow on the surfaces of the conductors, it is well suited
for simulations of very thick conductors. The solutions for thick conductors account for all x-, y-, and z-directed currents
on all surfaces.
See “EM Annotations and Cut Planes” for details on how to view your AXIEM structure mesh.

15.4.1. Meshing Terms Defined
The following terms are used to define how geometry meshing works.
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Meshing Density
Meshing density defines how many mesh elements are in a given area. This is easily demonstrated with a single line
changing settings to alter how the mesh is created. The following figure shows the line with a low mesh density that has
74 unknowns.

The following figure shows the line with a medium mesh density that has 167 unknowns.

The following figure shows the line with a high mesh density with 518 unknowns.

Most new AXIEM software users tend to over-mesh a structure (use too high a density of mesh). In the following example,
the graph of S11 magnitude shows results for the different meshing densities are almost identical.
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Decimation
Decimation is the process of simplifying the vertices of shapes before they are meshed to simplify the meshing. It is very
important to understand that the shapes in the EM structure layout are not changed by decimation. The decimation process
uses the shapes in the EM structure layout, and applies heuristics to slightly change the vertices before the mesher operates
on the decimated shapes. There are a number of ways to control this simplification process discussed in later sections.
The following figure shows a simple line with a small piece of metal attached to the top of the line.

Without decimation, the extra metal on top is meshed.

With decimation configured to ignore shapes about this size, the extra metal on top is not meshed.
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This example is somewhat contrived because this geometry would have some small affect on the response of the circuit.
Decimation typically works on much smaller geometries than that demonstrated here.

15.4.2. Setting Global or Document Mesh Options
You can set AXIEM mesh options globally by choosing Options > Default EM Options and clicking the Mesh tab. A new
AWR AXIEM structure can use these settings or you can override these settings on the document itself by right-clicking
an EM structure in the Project Browser and choosing Options and then clicking the Mesh tab. You can clear the Use
Project Defaults check box to control the mesh per EM structure. You can set these options per shape by right-clicking
any shape in the EM structure and choosing Shape Properties, and then clicking the Mesh tab. You can clear the Use
default properties check box to control the mesh per shape.

15.4.3. Meshing Dependencies
The mesh created for an AXIEM structure depends on many different settings.
Geometry
In AXIEM software, the shapes in the EM structure determine what gets meshed. The shapes do not need to be drawn
on grid to be accurately meshed. In some simulators, such as EMSight, the mesh can only be drawn on the grid points
for the structure. For example, see the following line.

Notice the shape vertices are not touching the grid, yet the mesh is perfectly covering the line. The same line in EMSight
has a mesh that looks similar to the following figure.

Notice that the mesh drawn is not perfectly on top of the shape.
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Frequency
The largest geometry allowed in a single mesh is determined by either the maximum frequency for the structure or the
Meshing Frequency you enter. See “Options Dialog Box: Frequencies Tab” for details. If you set the Meshing Frequency,
you must set it to a frequency higher than the highest frequency currently set up for the EM structure. The largest frequency
determines a wavelength and then a fraction of this number is used as the maximum mesh size. The Meshing Density
setting controls the fraction by determining a number of mesh elements per wavelength.
Because the largest mesh size is determined by frequency, if you have completed a simulation and then change your
highest frequencies, it is possible that ALL the frequencies will need to simulate again (because the mesh has changed).
However, if you add any frequency lower than the maximum, only that frequency should need to be simulated. For
example, the following figure shows a line with a maximum frequency of 1 GHz.

The following figure shows the same line with a maximum frequency of 100 GHz.

Meshing Density
You can change the mesh options for various levels of mesh density. The Low, Normal or High options adjust the number
of elements relative to a wavelength (Low is set to give the minimum required for a reasonable solution, High is intended
for improved accuracy, and Normal is a good default for both). This option is set for each EM structure. The following
figure shows the line with a Low setting.

The following figure shows the line with a Normal setting.
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The following figure shows the line with a High setting.

The following figure shows the line with a No Variable Mesh setting. In this case the maximum mesh size is one grid size.

Enclosure Settings
The Enclosure Grid_X and Grid_Y values control the snap grid for the EM layout. They can also affect mesh if the Mesh
Units option on the Mesh tab is set to Relative to cell grid. In general, the minimum of Grid_X and Grid_Y is used to
determine the smallest mesh size drawn (with several exceptions) and the size of geometry to be simplified by decimation.
You can set the Enclosure Grid_X and Grid_Y by double-clicking the Enclosure node under your EM structure. In the
ENCLOSURE Properties dialog box, click the Enclosure tab. See “Element Options-(EM) ENCLOSURE Properties:
Enclosure Tab” for details. For example, the following figure shows a line with Grid_X and Grid_Y set to 0.5 mils.

The following figure shows the same line with Grid_X and Grid_Y set to 5 mils.
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Max Aspect Ratio
The Max aspect ratio controls the typical aspect ratio of the elements used in the mesh (in particular, it has a strong
influence on the edge meshing). Wavelength at the highest frequency determines the maximum mesh size, however,
often if that were the only criteria, you might have many long, thin mesh sections, which are not desirable. This setting
limits the maximum aspect ratio (length/width) that a mesh cell can have. If you use a higher aspect ratio you see longer
and skinnier mesh elements. Typically, the default value is used for this setting, but advanced users may want to experiment
with other settings. Cadence does not recommend setting the max aspect ratio to a value higher than 20 as it can lead to
long, thin mesh slivers. This is set for each EM structure. For example, the following figure shows a line with the default
setting of 10.

The following figure shows the same line with the setting changed to 20. Both of these were for a maximum frequency
of 1 GHz.

The following figure shows the same line with the setting at 20, but the maximum frequency of 100 GHz, which would
be the same with this setting 10 or 20. At this frequency the largest cell is determined by frequency, not the max aspect
ratio.

Simulation and Analysis Guide 15–59

AXIEM Meshing
Mesh Units
Your selection determines how the Enclosure grid settings affect meshing. If you select Relative to Drawing Grid, all mesh
settings are set relative to grid size, so the mesh cell size changes if the grid size changes. If you select Absolute Dimensions,
all mesh settings are set as absolute values, and do not depend on the grid.
Mesh Size
The Min Edge Length value determines the minimum mesh cell size. This value multiplied by the Max aspect ratio on the
Mesh tab determines the maximum mesh cell size. Essentially, a smaller value results in a denser mesh. You can specify
this value relative to Enclosure grid (as a multiple of the grid size), or as an absolute length.
Maximum and Minimum Grid Size
Based on the previous settings, you can define the maximum and minimum mesh sizes for a structure. For the maximum
mesh size, two numbers are calculated. The first is the maximum mesh for the frequency specified, where a wavelength
for the highest frequency is calculated and the Meshing Density adjusts the number of mesh elements per wavelength.
The second is the Min Edge Length value, multiplied by the Max aspect ratio. The smaller of these two numbers is used
as the maximum mesh size. The minimum mesh size is the Min Edge Length value.
Edge Meshing
Edge meshing options ensure that there is a small mesh located on the edge of each shape being meshed. Since currents
want to flow on the edges of conductors at microwave frequencies, an edge mesh is important to get accurate simulation
results. Cadence does not recommend turning off this option. You can turn on or off edge meshing for each EM structure.
For example, the following line uses edge meshing.

The following figure is the same line without edge meshing.

The thickness of the edge mesh is the minimum mesh size determined for the structure.
Edge Meshing when Using Thickness
By default, no edge mesh is included with thick metal shapes. When thickness is being modeled with currents on the
vertical sides of the conductors, the edge current singularity is modeled fairly well by these vertical side currents, and
edge meshing is less important for an accurate solution. Clear the No Edge Mesh for Thick Metal (Top/Bottom) option on
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the Mesh tab of the Options dialog box to include an edge mesh. Note that this option is only significant if you specify
edge meshing. The following figure shows a magnified view of a line without this setting.

The following figure is the same line, but with the edge mesh turning on for thick metal.

Minimal Z Meshing (sidewalls)
This option is selected by default, and reduces the number of mesh elements in the z-direction if possible. Without this
option, the z-direction mesh works the same way as the xy-direction mesh. The following figure shows a line with thick
metal (very thick for demonstration purposes) and a via with this setting selected (the default).
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The following figure is the same structure, but the setting is turned off.

Edge Mesh Vias (Top/Bottom)
Select this option to see if you get more accuracy for your vias. The following figure shows a line with thick metal (very
thick for demonstration purposes) and a via with this setting turned off (the default).
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The following figure is the same structure, but with edge meshing vias turned on.

15.4.4. Decimation Strategies
There are two complementary methods to simplify structures to help achieve an efficient mesh. The following sections
describe these methods and the settings that apply to each. Note that you can set mesh and decimation settings at various
levels (globally, per EM document, and per shape). See “Setting Global or Document Mesh Options” for details.
Rules Based Geometry Simplification
You can write rules to simplify geometry before it is sent to the EM simulator. This is not just an AXIEM software
feature, but is a powerful (and recommended) method for simplifying geometries to be simulated. See “Geometry
Simplification” for details.
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Decimation
Decimation is a complementary method to geometry simplification using rules. The difference is that rules are applied
to the EM layout before the geometry is sent to AXIEM software, whereas decimation is part of the AXIEM mesher. If
rules are used for geometry simplification, AXIEM software receives the rules-simplified geometry and then applies
decimation during the meshing operation.
You can set the decimation level from None to Very High, with Medium as the default. When set to None, the mesher
meshes the shapes exactly as they are drawn in the EM structure layout. This mode generates the most accurate mesh.
When set to Very High, an extreme level of geometry modification is applied to reduce the number of mesh elements. If
rules are used to simplify the geometry, then the default setting is to use the lowest level of decimation on the already
simplified geometry.

15.4.5. AXIEM Meshing Example
This example demonstrates how the mesh is configured with AXIEM software. The following definitions are included
to better understand the mesh:
• Edgemesh = [Minimum of (Grid_X,Grid_Y)] * [Min Edge Length grid multiple] if Mesh Units is set to Relative to cell
grid.
or Edgemesh = Min Edge Length value if Mesh Units is set to Absolute dimensions.
• Meshmin_set = Edgemesh * k
where k=2 for Low mesh density, k=1 for Normal mesh density, and k=0.5 for High mesh density. This is the minimum
mesh size calculated from the Min Edge Length setting. This value is also the width of the edge meshing cells, if the
option is enabled.
• Meshmax_set = Meshmin_set * Max Aspect Ratio. This is the maximum mesh size calculated from the Min Edge Length
setting.
• Meshmax_freq = lambda/N
where lambda is described as follows, and N=8 for Low mesh density, N=16 for Normal mesh density, and N = 32 for
High mesh density. This is the maximum mesh size determined by mesh frequency. By default, mesh frequency is the
highest simulated frequency, but can be set higher.
• Meshmin_freq= Meshmax_freq/Max Aspect Ratio. This is the minimum mesh size determined by mesh frequency.
• Lambda (mesh frequency wavelength) is defined as:

λ =

εr =

c
f

εr
ε21 + ε22 + ... + ε2n
n

n is the number of layers

where c is speed of light, f is the meshing frequency, and en is the dielectric constant of layer n in the stackup.
• If Meshmax_set > Meshmax_freq, then Meshmax_set = Meshmax_freq, so the maximum mesh size is always the
smaller of the two values determined by Min Edge Length or frequency.
• The length of the meshed cells cannot be smaller than Meshmin or larger than Meshmax.
The following figure is a 50 mils wide line drawn on a 5 x 5 grid, on a substrate with dielectric er=10.
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The following mesh options are set for the line:
•

Mesh Density

is set to Normal.

•

Edge Mesh Thin Metal

•

Mesh Units

•

Min Edge Length

is set to 1 * grid.

•

Max Aspect Ratio

is set to 2.

is selected.

is set to Relative to cell grid.

• The mesh frequency is set to 2 GHz.
Using these definitions, Edgemesh = (1 * grid) and Meshmin_set = (Edgemesh * k). Since the grid is 5 mils x 5 mils,
the minimum of these two values is 5 mils, and that makes the Meshmin_set = 1*5 mils *1 = 5 mils (k=1 because Normal
mesh density is selected), so 5 mils is the minimum mesh size.
Meshmax_set = (Meshmin_set * Max Aspect Ratio) = 5 mils * 2 = 10 mils, so 10 mils is the max mesh size.
Since Edge Mesh Thin Metal is enabled, Meshmin_set determines the width of the mesh elements along the edge of the
line, and the remainder of the line width is meshed with respect to Meshmax_set. The width of the line is 50 mils; there
are 5 mils on each side used for edge meshing, so there are 40 mils left along the width of the line to be meshed. The
remaining line width (40 mils) is divided by the maximum mesh size (40 mils/10 mils=4) to yield 4 mesh cells across
the middle of the line width. Therefore, there are a total of 6 cells across the width (2 edge cells + 4 interior cells), as
shown in the following figure. Note also that Meshmax_set (10 mils) is less than Meshmax_freq (lambda/16=116 mils)
in this case, so there is no need to recalculate the mesh relating to frequency.

If the Mesh Density is set to Low, Meshmin_set = 10 mils (Edgemesh*2) and Meshmax_set = (10 mils * 2) = 20 mils.
With edge mesh cells 10 mils wide, there is 30 mils in the remainder of the line width to mesh (50 mils - 20 mils = 30
mils). The remaining width is divided by the maximum mesh size to determine the number of interior mesh cells. Since
30 mils/20 mils = 1.5, and is not an integer number, it is rounded up to 2 so that the mesh size is not larger than
Meshmax_set. This calculation results in two interior mesh cells (30 mils/2 = 15 mils), for a total of 4 cells across the
wide of the line, as shown in the following figure.
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If you change the Mesh Density to High, Meshmin_set = (5 mils* 0.5) = 2.5 mils and Meshmax_set = (2.5 mils * 2) = 5
mils. There are 2.5 mils edge mesh cells on each side of the line, and the remaining 45 mils are divided into 5 mils cells,
for a total of 2 + 9 = 11 cells across the entire width of the line, as shown in the following figure.

If you change the Mesh Density to No variable mesh, Meshmax_set=Meshmin_set=Edgemesh. Since Edgemesh is 5 mils,
you get 10 cells across, as shown in the following figure.

To see how the frequency can affect the mesh, reset the Mesh Density to Normal and set the frequency to a Single point
of 50 GHz. All other settings remain the same. Using the equation previously defined, lambda is 88.61 mils, and since
the Mesh Density is Normal, n = 16, Meshmax_freq = lambda/16 = 5.538 mils, and Meshmin_freq = 5.538 mils/ 2 = 2.769
mils, so the maximum mesh size due to frequency is 5.538 mils and the minimum mesh size due to frequency is 2.769
mils. Since this Meshmax_freq < Meshmax_set, Meshmax_set is reset to equal Meshmax_freq and Meshmin_set is reset
to equal Meshmin_freq. Now the new Meshmax_set = 5.538 mil and Meshmin_set = 2.769 mil. With these new numbers,
both edges of the line are meshed with 2.769 mils wide edge cells, and the remaining width (50 mils - 2 * 2.769 mils =
44.462 mils) is divided by the maximum mesh size to determine the number of interior cells 44.462 mils/5.538 mils =
8.02. Rounding this up to 9 results in 9+2=11 cells across the width of the line as shown in the following figure.

If Mesh Units is set to Absolute Dimensions, all the previous rules apply except that Meshmin_set is equal to the Min Edge
Length absolute value.

15.5. AXIEM Solver Options
You can set AXIEM solver options for each document. To access these options, right-click the EM document in the
Project Browser and choose Options. The Options dialog box AXIEM tab includes settings.

15.5.1. Solver Type
The following AWR AXIEM solvers are available:
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•

Auto Configure: This solver automatically chooses either Iterative Default or Direct Default, depending on the size of the

problem (small problems less than a few thousand unknowns use the Direct solver). This setting is the default, and it
should work reasonably well for most problems.
•

Iterative Default: This solver automatically chooses either Iterative A++ or Iterative B, depending on the frequency relative

to the mesh element size. The solver is selected for each frequency point, so you can use this option to do a direct
simulation from DC to very high frequencies. If the Iterative B solver is chosen and the solution fails to converge, the
Iterative D solver is automatically tried in a second pass.
•

Direct Default:

This solver automatically chooses either Direct (low frequency) or Direct (high frequency), depending on
the frequency relative to the mesh element size. The solver is selected for each frequency point, so you can use this
option to do a direct simulation from DC to very high frequencies.

•

Iterative A: This solver is primarily used for relatively low frequencies (down to DC), although there should be no loss

of accuracy at higher frequencies. The disadvantage of using this solver at high frequencies is that the convergence is
often not as good.
•

Iterative A+:

This solver is similar to the Iterative A solver, except it uses a different preconditioner that has better
convergence for selected problems (the preconditioner is more expensive though).

•

Iterative A++:

•

Iterative B: This solver is the default Iterative solver for higher frequencies. The performance and convergence properties

This solver is similar to the Iterative A solver, except it uses a different preconditioner that usually has
better convergence, potentially at the expense of longer preconditioner creation times, and more memory usage. This
solver has the best convergence properties of the Iterative A family of solvers, but it is also the most expensive.
for this solver are quite good, so this solver is often the preferred solver for most problems except at very low frequencies
(where one of the A solvers must be used).

•

Iterative C:

This solver is similar to Iterative B with a different preconditioner that might work better for selected

problems.
•

Iterative D:

This solver is similar to Iterative B with a different preconditioner that might work better for selected

problems.
•

Direct (low frequency): This solver is a Direct solver that you can use down to DC. The Direct solvers use significantly

more memory and time than the Iterative solvers for large problems. The Direct solvers make fewer approximations
though, so it is sometimes useful to use them to verify the accuracy of the Iterative solvers (when the problem size is
small enough to run in a Direct solver). Also, if none of the Iterative solvers converge to a solution, then the Direct
solver might be the only option available.
•

Direct (high frequency):

This solver is a Direct solver that should work well for all problems that are not simulating at
a very low frequency. The Direct solvers use significantly more memory and time than the Iterative solvers for large
problems. The Direct solvers make fewer approximations though, so they are sometimes useful for verifying the
accuracy of the Iterative solvers (when the problem size is small enough to run in a Direct solver). Also, if none of
the Iterative solvers converge to a solution, then the Direct solver might be the only option available.

15.5.2. Matrix Entry Accuracy
This setting controls the accuracy of the matrix entries. Increasing the accuracy of the entries can improve the accuracy
of the solution at the expense of longer simulation times. The default value is conservative and usually gives good overall
accuracy. Structures with very tight coupling (such as a thin film capacitor) require relatively accurate matrix entries for
an accurate solution. Problems that involve signal lines without any tightly coupled geometries can often have the matrix
accuracy reduced without significant degradation of the overall solution accuracy, and a significant reduction in the
matrix fill time.
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15.6. Advanced Frequency Sweep (AFS)
Advanced Frequency Sweep (AFS) speeds up EM simulations of EM structures through an optimal choice of the
frequencies at which to perform the EM simulations. AFS saves time by significantly reducing the number of points at
which the EM simulations need to be performed, while still maintaining the required accuracy.
The following AFS options are available. You may need to click the Show Secondary button in the Element Options
dialog box to see all of the options.

15.6.1. Enable AFS
You can use the AFS option to compute the solution at a large number of frequencies by computing the solution at a
much smaller set of frequencies. To use AFS, specify all of the frequencies at which you desire a solution. Choosing
more frequency points does not significantly affect the solution time, so it is usually better to specify a relatively large
number of frequencies (a few hundred for example). If you specify too few frequency points, there may not be enough
points to fit the solution. If AFS simulates all of the specified frequencies, however, then an AFS fitting is not used (the
same as running without AFS). Only the frequencies simulated are stored in your project, so the number of frequencies
requested does not affect the file size. If you request a very large number of frequency points, you should also limit the
number of frequency points to simulate by setting a Max # sim pts value.
When switching AFS options (such as Max # sim pts or Tol (dB)), the previously simulated frequencies are not resimulated.
You can also add more frequencies and previously simulated points are used, unless you add a higher frequency to the
frequency list. In this case, the mesh will likely change and therefore all the frequencies must be recalculated.

15.6.2. Tol (dB)
The tolerance is a relative number (in dB) that controls the accuracy of the AFS solution. A lower tolerance setting
requires fewer frequency points, but the accuracy of the solution might not be acceptable. Also, if the tolerance is too
loose, the AFS result may have a "false convergence". If you adjust this option, 5 dB steps are recommended.
During simulation, you can watch the Simulation status dialog box to see the status of AFS convergence. AFS must first
simulate three frequencies; after these frequencies you can view a status window that looks similar to the following
figure.

15–68 AWR Design Environment

Advanced Frequency Sweep (AFS)
This line includes the number of points out of the total grid points (frequencies specified for the AXIEM structure). You
can then see the convergence error and brackets ([* * * *]). For AFS to converge, the convergence error must be less
than the tolerance specified. Additionally, there are four checks for convergence that are specified in the brackets. When
the individual checks are met, that entry in the brackets displays a letter instead of the "*" symbol. The checks and
corresponding letters used are:
• D = Data points. The data points criterion requires the fitting error between the data samples (computed points) and
the rational macromodel to be less than a specified tolerance.
• R = Reflective functions. The reflective functions are a set of rules that evaluate the correspondence of the magnitude
and phase of the best two rational macromodels.
• H = Heuristics. The heuristic criterion requires a minimum number of data samples (computed points) before
convergence.
• P = Passivity. The passivity criterion requires the passivity of the rational macromodel to be close to the passivity of
the data samples (computed points).
In this example, the last frequency looks similar to the following figure.

The same information is stored with each AXIEM structure in the Simulation log so you can see the history of what AFS
did after the simulation is complete. You may need to subdivide the simulation band into sub-bands for AFS fitting. The
simulation log reports multiple messages from the simulation of each of the sub-bands.

15.6.3. Max # sim pts
The AFS algorithm always chooses its sampling points at requested frequency points, but you can use this option to limit
the maximum number of frequency points chosen. .

15.6.4. Enable Band Limit
AFS band limiting allows you to perform AFS in a specified frequency range. Any frequency outside of the range is
individually simulated. The Start Freq and Stop Freq options define the frequency range for the AFS band limits. During
the simulation, the frequencies outside the band are simulated first and then the frequencies inside the band get simulated.
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You can apply this option when simulating very wide bandwidths of structures. This is commonly done for structures
simulated with harmonic balance, where accurate impedances are needed up to many harmonics of the fundamental
frequencies. In this case, the impedances seen at the fundamental frequencies need to be accurate, so AFS is used in that
band. It would be problematic using AFS for the full band to find the accurate fit, so the frequencies for the higher
harmonics can be done point by point, resulting in a more efficient overall simulation.
The following graph demonstrates the effect of the AFS band limit. The graph has two plots of the S21 phase of the same
line with AFS band limit turned on for the top plot and turned off for the bottom plot. The AFS band limit is from 30 to
80 GHz; note that the bottom plot has more points inside the band than the top plot does, because the top plot is performing
AFS inside the band.
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15.6.5. Plotting Currents and Antenna Measurements with AFS
When AFS is enabled, only a small subset of the frequency list is simulated. As a result, EM currents, antenna annotations,
and antenna measurements are plotted for the simulated frequencies only, not the entire frequency list. When plotting
any of these measurements, you must choose FSAMP for the Sweep Freq option in the Add/Modify Measurement dialog
box, as show in the following figure. Because the FSAMP frequencies are not determined until after a simulation, the
frequency list for FSAMP displays "Freq = 0 GHz". After simulation, the annotation or measurement automatically plots
for the first FSAMP frequency. At that point, you can choose any of the FSAMP frequencies.
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15.7. Using Preset Options
The following preset options are available:
•

Fastest:

Sets all the options to the values that make the solver as fast as possible, although the accuracy might not be
acceptable. In general, the results with nominal option values set should be used to validate the solution when all
options are set for fastest execution.

•

Defaults: Resets all AXIEM software options to default values, including user-accessible and internal options. Internal

options can change from one version of the software to the next, so for older projects, it is often beneficial to reset the
defaults for better performance. (If you have a project created with beta software, you should reset the defaults.) If
any of the AXIEM software dialog box options display a [Custom_Setting] value, you should select this option to return
them to a user settable value. If you have EM structures that worked in a previous version but do not work in a newer
one, try resetting the defaults before contacting Cadence AWR Support.
•

Most Accurate:

Sets all the options to the values that give the most accurate solution. In most cases, the values set are
too conservative, and simulation times are much slower than with default values, but this can be useful for verification.

15.8. Iterative Solver Options
The following Iterative solver options are available:
•

Compression Accuracy:

The Iterative solvers compress the matrix to solve. A lower compression accuracy can result
in a faster simulation and less memory, at the expense of accuracy. If you suspect accuracy issues with the Iterative
solvers, try using a higher compression accuracy. For some problems, using a lower accuracy only has a minimal
effect on the total solution accuracy, but you should be careful to validate this when using lower accuracy settings.

•

Pre-conditioner Efficiency:

Using a larger preconditioner size can often reduce the number of iterations needed per
solve, at the expense of more memory usage and potentially longer simulation times. If the preconditioner size is
larger, then the time spent creating the preconditioner is longer (and uses more memory), but there is a time savings
in the solve phase if there are fewer iterations. For structures with many ports, it might be beneficial to use a larger
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preconditioner, as a solver is needed for each port, although the preconditioner only needs to be created once. If the
Iterative solver is not converging (or converging with a large number of iterations), then increasing the size of the
preconditioner is recommended.
•

Max Iterations:

This option sets the maximum number of iterations allowed before non-convergence is determined. If
a solver is not converging, you can try doubling the number of iterations a few times. After this value reaches about
5000, if the problem is still not converging, it is likely that continuing to increase it won't help, and it is better to try
other options (such as increasing the size of the preconditioner, increasing the subspace size, or changing the solver
type).

•

Subspace Size:

•

Convergence Tolerance: The convergence tolerance controls the tolerance at which the solution is considered converged.

This option controls the size of the Krylov subspace the Iterative solver uses. Using a larger size can
help convergence, although at the expense of memory. Very large subspace sizes can consume a great deal of memory
when used on large problems, so you should be careful not to set this option too large for large problems. An upper
limit of a few thousand is recommended.
Using a looser tolerance should require fewer iterations, at the expense of accuracy. If you change this option, you
should change the value by order of magnitude increments.

15.9. Iterative Solver Convergence Issues
The following are the most common Iterative solver convergence issues.

15.9.1. Causes of Poor Convergence
When using the Iterative solver, you may encounter convergence problems. This information does not apply to the Direct
solvers.
Frequency Related Causes
One cause of convergence issues is low frequency break down. Low frequency break down occurs at frequencies where
the mesh elements are very small relative to a wavelength, so the frequency at which this occurs depends on the size of
the structure relative to a wavelength. AXIEM software uses specialized solvers that avoid the low frequency breakdown
problem, but it is important that the correct solver is used. All of the Auto configure solver choices automatically choose
the correct solver based on frequency and mesh element size. All of the "A" Iterative solvers are suitable for low frequency
problems, as well as the Direct (low frequency) solver. At DC, low frequency solvers are the only viable option. For high
frequency solvers, the conditioning of the problem worsens (which causes poor convergence) as the frequency is lowered,
and at DC, the system is not solvable by the high frequency solvers. For low frequency solvers, the conditioning of the
problem worsens as the frequency increases, so at very high frequencies, the low frequency solvers may encounter
convergence issues. For a fairly broad range of frequencies that are not too high or too low, both solver types work well
(for some problems, the low frequency solvers work well up to very high frequencies). It is important to note that the
low frequency solvers are solving the same problem as the high frequency solvers, so there is no approximation involved
with one or the other. The choice of the solver is driven by convergence issues (except at frequencies at or near DC,
where only the low frequencies solvers are applicable). You can experiment with the different solvers to see how they
perform on particular problems.
Geometry Related Causes
Some geometries lead to poorer conditioned problems than others. It is not always possible to predict which geometries
will have convergence issues, but there are a few common situations that cause more difficulty for the Iterative solvers.
One of these situations involves closely spaced conductors, such as a parallel plate capacitor with a very thin spacing
between the plates. AXIEM software has very robust preconditioners that often solve these problems without any issues,
but the number of iterations might be significantly higher than in easier cases. Another related situation which can cause
convergence issues is when relatively thin conductors are modeled with all surfaces (Model as zero thickness is off). This
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problem is very similar to the capacitor problem, because the top and bottom surface of the conductors is very close. The
convergence issues for this situation are often worse than for a thin capacitor, likely because for a conductor modeled
with thickness, there is a higher proportion of the problem that has very closely spaced surfaces. For this reason (and
also because the number of unknowns is much higher), Cadence recommends that conductors be modeled with zero
thickness, unless the thickness of the conductors is large enough to have a significant effect on the solution (for many
common geometries, the zero thickness approximation works very well). When the conductors are very thick, the negative
effect on convergence is diminished, although it still requires significantly more unknowns.
Another option for conductors that are not too thick is to model the thickness but exclude the top surface . This option
can work well when the conductor is not too thick, but the performance of the circuit is very sensitive to precise modeling
of edge coupling effects (such as in a filter or coupler). Enabling this option both improves convergence (by eliminating
the closely spaced top surface), and reduces the number of unknowns. When using this option, you should experiment
to see how it affects the problem types being analyzed.

15.9.2. Possible Convergence Remedies
Try Different Solvers
The solver choice can have a significant impact on convergence. As discussed previously, at DC or very low frequencies,
only the low frequency solvers are applicable, but for other problems, you can try either low or high frequency solvers.
The solvers that generally converge best are the Iterative A++ for low frequencies, and Iterative B for high frequencies,
although the reverse may also provide the best results. There may be situations where other solvers work better as well,
so if you encounter convergence issues you should try other solvers. For problems where convergence is not an issue,
other solvers may be significantly faster (for example, Iterative A is usually faster on problems that converge well).
Pre-conditioner Efficiency
Many of the Iterative solvers allow you to adjust the amount of information in the preconditioner. Having a larger
preconditioner (more information), usually improves convergence, at the expense of longer preconditioner creation time
and more memory usage. Problems with multiple ports require an iterative solution for each port, but the preconditioner
only needs to be formulated once, so it is often advantageous to use a larger preconditioner when the structure has many
ports. In this case, the preconditioner takes longer to create, but there is a time savings in the iterative solution for each
port due to fewer iterations. Not all solvers implement variable size preconditioners though (Iterative A uses a diagonal
preconditioner, so this setting has no effect when using this solver). The default Iterative solvers do implement variable
size preconditioners (Iterative A++ and Iterative B).
Max Iterations
Increasing the maximum number of iterations can sometimes lead to convergence. The progress of the lower Status bar
in the Status Window displays the error function value (in dB), so you can see how close the solver came to converging
by noting how far to the right the Status bar moves during the iterative solve step. Once the bar reaches 100%, the problem
should have converged.
Subspace Size
Using a larger size can help convergence, at the expense of memory. Very large subspace sizes can consume a great deal
of memory when used on large problems, so you should be careful not to make this setting too large for large problems.
An upper limit of a few thousand is recommended. Each time the iteration count reaches the subspace size, the solver
'resets', which can cause stagnation in convergence. If you suspect this is occurring, try increasing the subspace size (if
memory permits).
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Convergence Tolerance
Usually, this setting does not have a large effect on convergence, as once the solution starts to converge, it usually
converges very well to very high accuracy. Nevertheless, there might be situations where the Status bar indicator shows
that the problem nears convergence but never quite gets there. For these situations, try loosening the tolerance in steps
of a factor of 10 to see when it converges. This setting can be set as loose as 0.01 with reasonable result accuracy. A
convergence tolerance looser than 0.01 is generally not recommended.

15.10. Accuracy/Performance Issues
The accuracy of the solution is equated with the accuracy of the S-parameters the solver computes, and is very
problem-dependent. The defaults in AXIEM software are chosen to give good accuracy across a wide range of problem
types, thus they are often overly conservative for many problems. Having more accuracy than needed is usually not a
problem, but the settings that provide extra accuracy cause longer simulation times and use more memory. Therefore, it
is often better to lower some of the accuracy settings to make the simulation faster or to save memory.

15.10.1. Problem Specific Accuracy
The accuracy required from AXIEM software is very problem-specific. Certain types of problems are inherently more
sensitive to errors than others. For example, distributed filters (particularly ones with high Q resonators), are often very
sensitive to the accuracy related settings. Parallel plate capacitors are also quite sensitive to accuracy settings, particularly
when the gap between the plates is very small. At the other extreme, structures that represent interconnect routing, where
coupling is more of a parasitic effect as opposed to a circuit component, are relatively insensitive to the accuracy settings.
With a structure that is insensitive to the accuracy settings, you can significantly speed the simulation time and reduce
the memory requirements by appropriately adjusting the settings.

15.10.2. Compression Accuracy
The compression level affects simulation time, accuracy, and memory usage. In general, you should set this to just enough
accuracy to achieve the desired solution accuracy. Setting the compression accuracy higher than needed does not improve
the accuracy, but it can have a dramatic effect on memory usage and simulation time, therefore it is important not to use
more accuracy than needed. You should also be very careful when decreasing the accuracy, as the overall solution
accuracy tends to degrade very quickly once it gets below the 'just enough' accuracy point. To provide a margin of safety,
by default, the accuracy is set to a level about one step above the setting that provides just enough accuracy. For many
problems, reducing the accuracy by one step has a minimal impact on accuracy, but you should verify this on the problem
being simulated.

15.10.3. Matrix Element Calculation
Setting Matrix entry accuracy to Medium (the default) works well for most problems, including those that are sensitive to
accuracy issues. For all but the most sensitive problems (for example, a parallel plate capacitor with a very small gap
between the plates), Medium- also works well, and is much faster. For structures such as interconnects that are not sensitive
to the accuracy settings, you can often achieve good results using Low-.

15.10.4. Pre-conditioner Efficiency
The preconditioner size does not affect accuracy, but it affects performance. As discussed in the prior convergence
section, it is often advantageous to use a larger preconditioner when the structure has many ports. The preconditioner
takes longer to create, but there is time savings in the iterative solution for each port due to fewer iterations. In general,
it is difficult to predict how changing the preconditioner size affects performance, as using a larger preconditioner
increases the time spent creating the preconditioner, while typically decreasing the time spent in the Iterative solver.
Whether this is a net gain or loss is problem-dependent, so you may need to experiment to optimize performance.
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15.10.5. Recognizing AXIEM Limitations
The following are current AXIEM software limitations for dielectric and magnetic materials:
• No support for general anisotropic dielectrics. Supports only uniaxial dielectric materials in the dielectric stack-up.
• No support for finite dielectric brick, which is considered a 3D planar shape. (Shape in the layout cannot be assigned
the property of a dielectric.)
• No support for using conductor material in the stackup definition as the material of a stackup layer.
• Material properties of the layout shape can be either a conductor or an impedance definition. When a conductor, only
the bulk conductivity is used for computing the metal loss. The dialog box allows you to modify Er, Ur, Tand and
TanM for a conductor definition, however AXIEM software does not use these parameters, nor does AXIEM software
support anisotropic conductivity.

15.11. Passivity Enforcement
Sometimes the results from AXIEM software are non-passive. Typically this is a result of very small numerical noise in
the de-embedding process. You can force the data to be passive at every frequency, however, before you use this option,
you should check your structure for the following:
1. Are you using explicit grounding for all your ports where possible?
2. Does your structure have any loss (loss tangent of dielectrics and metals other than perfect conductor)?
3. Are the top and bottom enclosures set properly? If you are simulating microstrip, the top of the structure should be
set to Approx Open.
4. Does your mesh look reasonable?
The Enforce Passivity option applies a minimal change to the simulated data to enforce the passive data.
Passivity enforcement is controlled in the Options dialog box on the AXIEM tab. Right-click the AXIEM document in the
Project Browser, choose Options to display the Options dialog box, click the AXIEM tab, and select the Enforce Passivity
check box.
The best way to check the passivity of your structure is to use the passive linear measurement. See “ Passive: PASSIVE”
for details.

15.12. Advanced AXIEM Topics and Practical Design Considerations
This section provides helpful hints and advice for improving the accuracy of your results, and presents issues you should
be aware of when working with AXIEM software.

15.12.1. Enclosure Setup
The first step in defining an EM structure is to set up the Enclosure. The Enclosure defines the physical properties of the
EM structure such as dielectric and conductor properties, and it includes parameters that affect simulation as follows:
• Grid: The Enclosure grid parameters (Grid_X, Grid_Y) define the drawing snap grid and determine the meshing size
if Mesh Units is set to Relative to cell grid. For more information, see “Mesh Quality”. Generally, you should set the
grid size to correspond to the desired mesh cell size. A grid size that is too small results in over-meshing and long
simulation times, and a grid size that is too large results in under-meshing and loss of accuracy.
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• Boundary Conditions: AXIEM is an open boundary solver that can correctly solve radiation into open space. The EM
structure is not defined within a metallic box; however, you can define conducting Top and Bottom Boundary conditions.
Generally, it is best to define the Top Boundary as Approx Open unless you are trying to model the effects of a top
cover.
• Stripline: Set the Top and Bottom boundaries to Perfect Conductor or to a metal with conductivity specified on the
Material Defs. tab of the Element Options - ENCLOSURE Properties dialog box.
• Approx Open Top/Bottom Boundary: It is important to note that if the top layer specified in the dielectric stackup
is not "Air", and the Top Boundary is set to Approx Open, the media above the top dielectric layer is modeled as
"Air" with the relative dielectric permittivity equal to 1.0. Similarly, if the bottom layer specified in the dielectric
stackup is not "Air", and the Bottom Boundary is set to Approx Open, the media below the bottom dielectric layer
is modeled as "Air" with the relative dielectric permittivity equal to 1.0.
See “Enclosure Settings” for more detailed information.

15.12.2. AXIEM Ports
There are many types of ports in AXIEM software (see A Plethora of Ports: Making Sense of the Different Types of
Ports in EM Planar Simulators” by Dr. John M. Dunn and “AXIEM Ports ” for more information.
Each of the AXIEM software ports belong to either the Regular (Edge) ports or Differential ports groups.
Regular (edge) ports may have a connection to the ground (infinite upper/lower/both, finite). You may need in this
connection to specify explicitly the return current path, so edge ports can have explicit or implicit ground reference.
There are sets of mutual ports and sets of serial ports. Edge ports can belong to one of these sets, a mutual set, or a series
set. All major properties of differential ports are related to the enforced Kirchhoff's current law that addresses the
conservation of charge. It is therefore very important to remember that active devices and passive devices with internal
ground connection (for instance, transmission line models) cannot be connected to the differential ports. Internal ports
are actually differential ports with very small gaps between the “+” and “-” nodes. Series ports (two edge ports that
belong to the same group where the “Type” of the group is “Series”) are actually differential ports with two nodes.
AXIEM software can de-embed only edge ports and internal "gap" ports. The most accurate de-embedding algorithm
was developed for edge ports with explicit reference to the ground. You cannot de-embed differential ports (including
series ports) and edge ports that set up on internal (or "cut-in") edges, or on edges that are shared with vias. The best
practice is to turn on de-embedding (the default) for a particular port only if you can de-embed the port. To do so, select
the De-embed check box in the Port Attributes (Properties) dialog box. See “Port Attributes Dialog Box” for more
information on this option.
You can also specify de-embedding for all ports in the EM structure by selecting the Enable De-Embedding (Global) check
box on the Options dialog box AXIEM tab.
When you select this check box, AXIEM software de-embeds all ports for which the De-embed check box is individually
selected, and which are legitimate for this operation. If Enable De-Embedding (Global) is not selected, AXIEM software
does not de-embed any port regardless of its individual settings. After simulation, you should check the Status Window
to verify whether or not the port is de-embedding, and the type of de-embedding applied.
The AXIEM software edge port de-embedding technique is based on the simulation of an additional EM structure
comprised from two identical segments of a transmission line. The thickness and the width of the transmission line are
defined by the width of the edge and the thickness of the metal on the corresponding layer. The length of the traces
depend on the width of the substrate and the width of the edge. You can see and examine the additional EM structures
created for port de-embedding by using the AXIEM EM_DEEMBED_MESH annotation. See “Viewing De-embedding
Standards” for more information.
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See also “Port De-embedding” for more information.
De-embedding Ports on Lines that have Common Edges with Vias
Plated (Single-layer) Line Structures
In Monolithic Microwave Integrated Circuit (MMIC) technologies, plated line structures are commonly modeled as a
metal-via-metal combination. This structure needs additional attention in order to de-embed correctly.
For example, consider the following plated line structure:
• Top metal (M2) is 4um
• Via (VIA1) between M1 and M2 is 2.5 um
• Bottom metal (M1) is 2 um
• Ground Plane is below M1
You can attach a port to any metal layer in the structure, however you should always attach the port to the metal layer
closest to Ground. In this case, Port1 is set up on M1 as shown in the following figure.

Via is Inset from Metal
In this case, geometry simplification is not applied, so VIA1 is not snapped out to M1 and M2, as shown in the following
figure. Port 1 is de-embedded. The structure used in the de-embedding algorithm is comprised of the traces on M1 (with
the thickness of the corresponding metal). The mesh, however, is not desirable because it contains many extra small
elements due to the slight inset of VIA1 from M1 and M2, leading to more unknowns for the solver. In addition, the
mesh quality can potentially be very bad ("Mesh Sqrt(Area) Ratio" and/or "Mesh Aspect Extremes" can be high values).
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Via is Coincident with Metal
VIA1 is snapped to the M1 and M2 shapes by Shape Pre-Processing, as shown in the following figure. The mesh quality
is very good because of snapping. If set up correctly, Port 1 can still be de-embedded. The most accurate de-embedded
results are obtained if the width of de-embedding standards equals the total width of the plated line structure, which in
this cases equals the thickness of VIA1 + thickness of M2.

The Mesh Options dialog box includes a Max thickness for plated line port option for de-embedding ports on plated lines.
You should specify a value for this option that is greater than the thickness of the plated line (in this case the thickness
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of the plated line = thickness of VIA1 + thickness of M2). For instance, if the thickness of VIA1 is 2.5u and the thickness
of the upper metal plate is 4u, you can set the Max thickness for plated line port value to 7um to properly de-embed ports.
If you set this value to anything smaller than the thickness of the plated line, the port de-embedding procedure is not
performed. For instance, if you set Max thickness for plated line port to 1um, AXIEM software does not de-embed ports
with snapped vias.
See “Viewing De-embedding Standards” for more information.

15.12.3. Conductor Loss Modeling
Ohm's law works at low frequency when the volume current fills the conductor section. The resistance at low frequency
is defined as RDC = 1/σt Where t is the metal thickness and σ is the conductivity.
Skin effect shows that at high frequency when the current constrained to the area adjacent to the metal surface, the
penetration depth is defined as skin depth:

δ =

2
ω μ σ

Since most current flows through a smaller cross-section, the high frequency resistance is rewritten as:

RRF =

ω μ
2σ

The overall impedance is composed from low frequency and high frequency resistance.
In AXIEM software, conductors are modeled either as thin or thick. A thin model has mesh only on the conductor bottom
(where the unknown current is solved); a thick model has mesh on all metal boundaries.
Thin Metal Modeling
AXIEM software only meshes the bottom of the conductor, therefore the unknown current is in only one layer. This
results in fewer unknowns and faster problem solving.
You can turn on thin metal modeling in the Options dialog box on the Mesh tab by selecting Model as Zero Thickness.
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Thick Metal Modeling
AXIEM software meshes all the metal surfaces in thick metal modeling, so the unknown current is on all sides of the
metal surface. When the frequency is high enough, the skin depth is a fraction of the metal cross-section. At low frequency,
the current is uniformly distributed inside the metal. The DC surface resistance must be doubled for current on the top
and bottom layers, such that when they are in parallel, they give the correct DC resistance.

RDC−top = RDC−bottom = 1 /( σ t / 2) = 2 / σ t
RDC−top|| RDDC−bottom = RDC
Enhanced Thin Metal Modeling
At high frequency, due to the skin effect, surface current flows on all sides of the conductor. In a thin metal model, since
only the conductor bottom is meshed, all of the current is forced to flow on the bottom surface. This reduces the area in
which current flows and the loss is over-estimated. To imitate the real current flow, we reformulate the high frequency
resistance.
In AXIEM software, you can turn on the enhanced thin metal model by selecting the secondary option Enhanced loss
model for thin mesh. This option only applies to metal defined by conductivity and thickness. It does not apply to metal
modeled by an impedance definition.
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Enhanced Thick Metal Modeling
For thick metal modeling, at low frequency, a common practice in commercial EDA software is to redefine
RDC=1/(σt/2)=2/σt. However this does not correctly represent the currents on the sidewalls and tends to under-estimate
the loss.
To solve this problem, you need to investigate the volume current density and model it correctly with unknowns on all
sides of the trades. So RDC is no longer a constant.
In AXIEM software, this enhanced thick metal modeling is the default.
Loss Model for Conductor Surface Roughness
In the manufacturing procedure, copper foils are treated for roughness to increase adhesion. Conductor surface roughness
has undesirable effects on the loss and dispersion (frequency dependence of ε eff) at high frequency, when the skin depth
approaches the height of the roughness grooves. AXIEM software can correctly capture these effects.
You can define effective conductor surface roughness (RMS) in the Element Options - ENCLOSURE Properties dialog
box on the Materials tab.
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Loss Modeling for Vias
Vias can be in any shapes, however most commercial software only uses the metal thickness defined in the material type
to get DC resistance, which is often incorrect. AXIEM software can calculate the DC resistance for vias in arbitrary
shapes. You can select the secondary Alternative via resistance calculation option to better calculate loss for vias.

15–82 AWR Design Environment

Advanced AXIEM Topics and Practical Design
Considerations

15.12.4. Mesh Quality
The numerical method used in AXIEM software depends on a good surface mesh that is formed by triangles (or rectangles)
with sides of approximately equal length (the ratio between the longest and shortest sides should be low). Conversely,
if there is a very long triangle in the mesh where one side is much shorter than the others, the system of linear equations
that need to be solved becomes ill-conditioned, and the Iterative solver may fail to converge.
AXIEM software displays mesh statistics when the Output mesh element extremes check box is selected in the Mesh
Features area of the Options dialog box Mesh tab. The statistics include the ratio of the area of the biggest mesh element
to the area of the smallest element and the ratio of the side lengths of worst triangle in the mesh.
If there are no problems with Iterative solvers and the number of iterations is small, the mesh is fine. However, it is
always good to check the mesh element extremes. If the reported values are small, the mesh is good and no other steps
are needed. However, if the mesh ratios are large (> 1000), then the mesh can potentially cause problems. The first
indication of a poor mesh is that AXIEM software fails to converge with default settings. If this occurs, try increasing
the accuracy setting. The Iterative solver uses more iterations and the obtained solution may be acceptable. If the frequency
range is not large (from DC to frequencies when the dimensions of the EM structure are about several wavelengths) and
the Iterative solver takes more then 20-25 iterations to converge, verify that the resulting S-parameters are acceptable
and are smooth with respect to frequency. You should also check passivity, symmetry of the S-parameter matrix (reciprocity
condition), and energy conservation. To verify the passivity of the simulation results use the Cadence Microwave Office®
software PASSIVE measurement in the Linear measurements group. To verify the energy conservation law use the
Microwave Office SUMPWR measurement with the corresponding Port Index in the Linear measurements group.
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See “AXIEM Meshing” for more information.

15.12.5. AXIEM Solvers
For information about AXIEM solvers, see “Solvers”.
Advanced Frequency Sweep (AFS)
AFS is designed to simulate fewer frequency points than the requested frequency list while delivering accurate S-parameter
data at all points (simulated or not). When simulating simple components with relatively small mesh (for example, with
the number of unknowns less than 1000), AFS is not necessary. The S-parameters as functions of frequency are relatively
smooth functions, there is no need to sweep frequency with very small steps, and the EM simulations per frequency point
are not time consuming. However, if the EM structure has unknown counts above 50000, there is no alternative to AFS;
you must use it in frequency sweeps.
If AFS does not converge within the specified number of frequency points:
1. Increase the accuracy level settings for the Iterative solvers. In the Options dialog box on the AXIEM tab, set the Matrix
entry accuracy to High+, and the Preconditioner Efficiency and Compression Accuracy to High . S-parameter function
may have some steps or oscillations that are the result of an ill-conditioned system of linear equations and/or relaxed
accuracy settings. AFS cannot differentiate between the real physical resonances and artificial numerical effects.
2. Divide the whole frequency sweep into smaller regions.
3. Increase the Max # sim pts.

15.12.6. Simulation Issues
Stripline Setup
Cadence has very good, accurate EM-based models for stripline, coupled stripline, and stripline inhomogeneities. These
models may be sufficient for your design; they are located in the Elements Browser under the Circuit Elements Stripline
category. Use AXIEM software only if you need to take into account the EM effects of finite ground planes, coupling
effects with other components in designs, or reflection from other obstacles or inhomogeneities (for example, vias to
other levels).
• Stripline Port Setup with Infinite Ground Planes: In stripline, the return current to the ports flows on both the upper
and lower ground planes. However, using a port with an unbalanced explicit ground reference (Connect to lower or
Connect to upper ) results in non-symmetric current return (only to top or bottom ground planes), which causes incorrect
simulation results. The most accurate results are obtained by selecting Connect to both as the Type in the Port Attributes
dialog box.
• Stripline Port Setup with Finite Ground Planes: Ports with implicit ground reference should only be used with infinite
ground planes (Top or Bottom Boundary), and should not be used to simulate stripline with finite ground planes. In
this case, you should use differential ports with ground returns placed on both the upper and lower finite ground plane.
If necessary, a small patch can be drawn on the ground planes to create an edge to which the negative terminal of the
port can attach.
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• Thick Metal: Unlike microstrip, the input impedance of stripline depends on the thickness of the conductor. The
distributed capacitance between the stripline and the ground plane depends on the distance between the line and ground
planes. If the thickness of stripline is increased, the distance from the top surface of the line to the upper ground
decreases, and consequently the capacitance is different. For instance, the characteristic impedance of a thin stripline
(0.1um) structure is 57 ohms, and the characteristic impedance of the same structure with conductor thickness of 35um
is 52 ohms.

15.12.7. Antenna Simulations
Including Resistive Losses
You should select the Include Resistive/Dielectric Losses option in the Add/Modify Measurement dialog box to calculate
antenna gain for antenna radiation pattern measurements. You can determine the losses from the following calculation.
The original energy generated by the source, Pin, is a known quantity, since the source in AXIEM software is a power
source, and not a voltage source. You can also calculate both the reflection coefficient and the amount of energy transferred
into the antenna (Pin - Prefl). In addition, you can also calculate the total energy radiated into free space, Prad. As a
result, using simple math, you can determine the losses in the antenna: Pin - Pref - Prad. This value also includes the
losses in the dielectric.
Phase Center of Antennas
AXIEM antenna measurements Con_EPhi, Con_ETheta, PPC_EPhi, and PPC_ETheta return complex values. In addition
to magnitude, you can plot the phase far-field pattern. Phase angles are measured relative to the phase center of the
antenna (the reference point where the phase angle is 0).
The phase center for antennas in AXIEM software is always located at the origin of the layout coordinate system
(X=Y=Z=0). It is important to know that the plane Z=0 is located at the bottom of the lowest layer specified on the
Dielectric Layers tab of the Element Options - ENCLOSURE Properties dialog box. If the lowest layer is free space ("Air")
and the Bottom Boundary is Approx Open, then the Z=0 plane is at the bottom of the free-space layer. The thickness of
the free space layer is irrelevant for all antenna measurements except for phase patterns.
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NOTE: The Approx Open Top/Bottom Boundary condition implies that there is an open half-space above/below the
first/last layer defined in the dielectric stackup. The electromagnetic properties of the half-space are the same as free-space.
Radiation Pattern Along the Horizon (theta=90degree)
When the stackup contains any dielectric layer other than air, the radiation pattern along the horizon (theta=90degree)
should be ignored. For an AXIEM simulation, the assumption is that the stackup extends to infinity along the horizon
(directions parallel to the substrate interface). When the stackup contains a non-air layer, the surface wave is excited for
an antenna problem that contains an open boundary. Otherwise, if both the top and bottom boundaries are closed, parallel
plate mode exists. Both surface wave and parallel plate mode have magnitudes that are inverse proportional to the square
root of distance from the source r. They are not considered part of the far-field which is assumed to be inverse proportional
to the distance r.
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Chapter 16. EM: Analyst 3D
This chapter describes configuration of and simulation using the Cadence® Analyst™ 3D FEM EM software. The Analyst
software is compared to the Cadence AXIEM® 3D planar EM analysis software, and results and post-processing are
also discussed. The Analyst software uses the frequency-domain Finite-Element Method (FEM) on a tetrahedral mesh
in a three-dimensional volume that may include metal, air, and dielectric. It adaptively refines the mesh over several
iterations to optimize the quality of the solution for a given computational burden. The Analyst simulator makes no
assumptions or approximations regarding the geometry, so you can use it for essentially any model. You can generally
use it on structures set up for AXIEM simulation with no (or minimal) model changes, although it has a longer run time
for most problems and uses more computer memory and resources. It also produces larger datasets than AXIEM analysis
software, particularly when field output is turned on.

16.1. Analyst 3D Editor Help
This chapter focuses on using the Analyst 3D Editor from the Layout Editor within the Cadence AWR Design
Environment® platform. Documentation for the Analyst 3D Editor is found within the 3D Editor environment. In the
3D Editor, you can access Help in several ways:
• Press the F1 key
• Click the question mark symbol located at the top right of the 3D Editor window

• Click the Application button located at the top left of the 3D Editor window, then choose Help

16.2. Setting Up Analyst Simulation
This section is for experienced users who want a reminder of the items to consider when setting up an Analyst software
simulation.
1. Are the ports properly configured? See “Analyst Ports” for details. A common mistake is to include internal implicitly
grounded ports. These are not supported and cause the simulation to fail
2. Are the proper boundary conditions set and is the boundary spaced far enough away from your geometry? See
“Specifying Simulation Boundaries” for details. Both of these are common mistakes that can have dramatic effects
on your answers.
3. Have you set a good AMR frequency for your structure? See “Adaptive Mesh Refinement Options” for details. This
is especially important for filters or resonant structures.
4. Have you set the appropriate frequencies to save the field outputs? See “Solver Options” for details.
5. Have you changed your port impedances for the EM document? See “Understanding Port Impedance” for details. A
common mistake is to change these values and expect them to change the simulation results.

16.3. Choosing a Simulator: Analyst or AXIEM
You can follow these guidelines when determining whether to use the Analyst or simulator.
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Use the Analyst 3D simulator for:
• All true 3D problems, for example, waveguides and connectors.
• 3D pCells, for example, bond wires and ball grids.
• “Planar” problems with 3D effects such as thick metal problems where skin depth is comparable to thickness (for
example, inductors), many ground planes (3D FEM may have speed advantage), metal enclosures, and dielectric
bricks.
Use the AXIEM software for:
• Problems that contain only planar metal and dielectrics and open boundaries, particularly when modeling the metal
as zero-thickness. The presence of thick metal and vias slows AXIEM analysis, but it is often faster than 3D FEM for
such problems.
• Planar radiators; these are more efficiently analyzed with AXIEM software, as its formulation assumes radiation
boundaries, whereas in 3D FEM, radiation boundaries must be synthesized using special boundary conditions or
computationally expensive materials.

16.3.1. Differences in AXIEM and Analyst Structure Setup
You need to consider the model configuration, basic setup parameters, meshing, and basis set differences when setting
up a problem for AXIEM or Analyst analysis.
• You must specify overall boundary for 3D calculations (since the air volume around the structure is explicitly meshed
and included in the finite-element simulation).
• Analyst software simulation supports a subset of the port types AXIEM software simulation supports, but also allows
the use of wave ports, which AXIEM software does not support. A wave port is a planar surface, usually oriented so
that signal conductors or waveguide crosses the surface at right angles, and is analyzed for propagating modes that
are subsequently used to excite the port in the full EM solve.
• A variety of 3D pCells exist that only the Analyst simulator can use.

16.4. Recognizing Analyst Limitations
The following are current Analyst limitations:
• No DC solution: “Low” frequency is used in place of true DC. The default value for Minimum Solved Frequency is 10
MHz. The solution at (and above) the Minimum Solved Frequency is extrapolated to any frequency below this value.
As a result, losses and other quantities may not be correct at DC with this approximation.
• No lumped port de-embedding.
• No support for arbitrary orientation of child EM structures.

16.5. Converting AXIEM Projects to Analyst Projects
To convert an AXIEM project to an Analyst 3D project:
1. Right-click the project name in the Project Browser and choose Set Simulator. In the Select a Simulator dialog box,
choose Analyst 3D EM - Async.
2. By default, a boundary shape draws slightly larger than the geometry of the structure. Resize the boundary appropriately
for your structure. For more information on choosing the boundary size, see “Boundary Size”. You typically define
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the boundary size so it is 10x the thickness of your dielectric, away from any conductors on the sides without wave
ports. If you use wave ports, you must have the boundary touch the ports on those sides.
3. Ensure that the port types are correct. Analyst software simulation supports the same ports as AXIEM software except
for implicitly grounded internal ports. See “Analyst Ports” for details.
4. Right-click the project name in the Project Browser and choose Options. In the Options dialog box on the Mesh and
Analyst tabs, set the desired options. Typically, the defaults are sufficient.

16.6. Setting Up Analyst Geometry
The geometry that Analyst software simulation uses is defined with the same editor that defines geometry in any other
EM solver (such as AXIEM or EMSight solvers) in the AWR Design Environment platform. For example, any structure
defined for AXIEM analysis can easily be used as an Analyst document. Analyst documents also allow support for
additional 3D constructs. There are 3D parameterized cells (pCells) you can use to add 3D components such as bond
wires, ball grid arrays, tapered vias, and others. Within an Analyst EM document, you can define extruded 2D shapes
and vias as conductors or dielectrics (in AXIEM, software only conductors are supported).

16.6.1. Using the Drawing Grid
You can control the drawing grid for Analyst EM documents. Double-click the Enclosure node under an Analyst document
to display the Element Options - ENCLOSURE Properties dialog box , then click on the Enclosure tab. The Grid_X and
Grid_Y parameters set the drawing grid for the document.

16.6.2. Drawing Shapes
When drawing shapes, you use the mechanisms used for any of the other simulators. See “Drawing Shapes in EM
Structures” for details on drawing shapes in the EM Layout Editor.
Adding Dielectric Shapes
Since the Analyst solver is a full 3D FEM solver, it can simulate finite dielectrics. In the STACKUP you define dielectric
layers that are continuous over the entire structure. You do not need to draw shapes to define these layers. If you want
to define a smaller region that has different dielectric properties, the process is the same as adding a conductor shape
except that the material definition is a dielectric material instead of a conducting material.
Defining Frequency-Dependent Materials
Frequency-dependent materials are listed in “Frequency-dependent Material Definitions ”. For a given material, the
individual properties may be frequency-dependent or constant, and they can also be either scalar or anisotropic, in any
combination.
Material Priority with Overlaps
For a true 3D FEM solver like the Analyst solver, all space within the simulation boundary must be completely defined
by a collection of non-overlapping 3D solids. The detail of creating the non-overlapping shapes is handled automatically
using a few simple rules that define which material takes precedence when two 3D shapes overlap completely or partially.
You do not typically need to be concerned with this automated process, however, in certain situations where extruded
dielectrics are used, or where conductors with different material properties overlap, it is helpful to understand how the
rules work. The rules are based on a spatial priority, where bodies with higher priority take precedence over bodies with
lower priority:
• Extruded dielectric layers defined by the stackup are considered background layers; these have the lowest priority.

Simulation and Analysis Guide 16–3

Setting Up Analyst Geometry
• Extruded dielectric shapes and vias have the next highest priority. Dielectrics with higher Er have a higher priority
than lower Er dielectrics.
• Conductors and vias have the highest priority. Conductors with higher sigma have a higher priority than lower sigma
conductors.
The following scenarios illustrate the priority rules:
• When normal conductors are created from extruded 2D shapes within the EM document, these conductors automatically
'cut' away the space from the dielectric layers defined by the stackup because the conductors have a higher priority
than the background dielectrics.
• If you add an extruded dielectric shape, it also 'cuts' away the space from the dielectric layers because it also has a
higher priority than the background dielectrics.
• If a conductor overlaps the same volume as an extruded dielectric, the conductor 'cuts' out the space from the extruded
dielectric.
• If a conductor with higher sigma overlaps a conductor with lower sigma, the higher sigma conductor 'cuts' out the
space from the lower sigma conductor.
For more information, see “Material Priority in Hierarchy”.

16.6.3. Viewing the 3D Model Used by the Simulator
When the geometry contains overlapped materials and structures, or when you are not sure how the solver will interpret
the geometry, it is helpful to see how the intersecting materials are treated before the system is simulated. To view the
structure as it is input into the simulator, choose View > Visual > Merged 3D Model. The 3D geometry displays with all
pre-processing steps completed. You can use this view to verify that the structure under test is designed as intended.

16.6.4. Using 3D EM Elements
3D EM elements are specialized elements for use with the Analyst 3D Electromagnetic simulator. For these elements,
layout parameters control the 2D projection of the element in the Layout Editor (such as x-y location and orientation)
while element parameters control the 3D properties of the element.
To add 3D elements to an Analyst EM document layout:
1. In the Elements Browser, expand the 3D EM Elements node as shown in the following figure.
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Select the 3D element you want to add, then drag it from the Elements Browser to the EM layout window. NOTE:
You must be online to access these elements from the Cadence website. See “Offline 3D EM Elements” for details
on how to use these parts when offline.
After dragging to the layout, you are in placement mode. A ghost image of the layout displays.
2. Click to place the element, then right-click to rotate it 90-degrees. To flip the cell about the y-axis, hold down the Ctrl
key and right-click. To flip the cell about the x-axis, hold down the Shift key and right-click.
3. Each element knows on which EM layer it is located. When you add an element, it is added to the active EM layer.
Click the Layout tab to open the Layout Manager and set the active layer by clicking the arrows on the right of the EM
Layers pane to open it. As shown in the following figure, the EM Layer sets the active layer.

You cannot add 3D elements to the top of the structure, so if this layer is set to "1" or "EM layer undefined", the pCell
is added to the bottom layer. The following sections describe how to change a pCell's EM layer after you add it.

Simulation and Analysis Guide 16–5

Setting Up Analyst Geometry
After adding the element to the 2D layout, you can edit the 2D properties of the pCell the same way you edit any other
pCell layout. You must then configure the 3D properties of the element and the Z position of the cell in the stackup.
Each 3D element has parameters that control its basic 3D properties. For example, a bond wire has parameters for loop
characteristics, and a capacitor has the dielectric thickness. You can edit these properties by selecting the element in the
EM layout, right-clicking and choosing Element Properties. The values of all of the parameters relating to height are
relative to the Z position specified for the element.
In this dialog box you also specify the material properties for the element such as dielectric constants and metal
conductivity. The AWR Design Environment software then creates all the appropriate materials needed to simulate these
elements. This is different than other shapes where you must set up the EM mapping to map a layer name to an EM layer
and material.
You must also specify the Z position for each 3D element. Select the element and click the Move Up or Move Down buttons
on the toolbar to move the pCell up or down one EM layer.

You can also select the element, right-click and choose Shape Properties to display the Cell Options dialog box. On the
Layout tab, under Z Position specify on which EM layer to place the element, or enter a Z Offset. Typically you use the
EM layer for the move and only use the Z offset if you need more control over the pCell movement. You can also rotate
the pCell about the x, y, or z axis.
In an AWR Design Environment platform layout, 3D elements do not have to be set up the same as other pCells. These
elements only exist in EM documents, and all the material information for conductors and dielectrics are contained in
the elements. Layers and materials are automatically created for these elements. The layers display in the Layout Manager
on the Drawing Layers pane. These layers control visibility in the 2D and 3D shapes for these elements. The Visibility by
Material/Boundary pane shows the auto-generated dielectric and/or conductor materials used for simulation. The following
are the drawing layers generated by a subset of the 3D elements:
• Bond Wire: BondWires
• BGA: BGA
• Ribbon: Ribbon
• Tapered Via: TVIA
• Thin Film Capacitor: CHPCAMP for the cap metal and CHPCAPD for the dielectric.
Each of the 3D pCells defines its conductivity relative to gold. If RHO is 1, the material name is "Gold". For any other
Rho, the material name is "Gold_x_A" where A is the number set to Rho. For example, if RHO is set to 0.7 the material
is "Gold_x_0.7". The thin film capacitor also creates a dielectric material with the syntax "Die_ER_A_Tand_B", where
A is the relative dielectric constant (Er) and B is the loss tangent (Tand) set as the element parameter on the pCell.
Updating 3D Parts
Cadence creates and maintains many generic 3D parts for customer use. These parts are primarily accessed via the
Cadence website. Cadence may need to update 3D parts as issues are discovered and fixed. This section describes how
to determine if an update is available, and how to update the part.
A script that checks for updates is available by choosing Scripts > EM > Check_For_Update_3D_Parts.
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When you run the script, a new data file is loaded into the project and opened for viewing. It lists any parts that need an
update, with information about what has changed and what may be needed to update that part. The following figure
shows a window displaying an available update.

The file name includes the date and time. The Browser Path line displays the path needed for the update process. If all
parts are current, the window displays as follows:

To update the 3D parts:
1. Open an EM document that contains the 3D part.
2. View the schematic of the part by clicking the View EM Schematic toolbar button.

NOTE: If this toolbar is not visible, with the 2D EM layout active, right-click in the current toolbar and choose EM
Design.
3. Select one of the subcircuit instances in the EM schematic that has the NET parameter of the part being updated.
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4. In the Elements Browser, browse to the location of the part as listed in the update window. For example, the previous
example shows: Browser Path = BP:\3D EM Elements\Libraries\3D Parts\Test Versioning\Test. Right-click the
element and choose Update Subcircuits.

Download and configuration of the new part might take some time.
Note the following when updating a 3D element:
• The update mechanism does NOT work if you rename the EM subcircuit for the part. If renamed, a message box
similar to the following displays.

• The update mechanism updates ALL instances of the same subcircuit, not just those in the current EM document.
• The update mechanism should maintain all the other properties of the part, such as the parameter values and the shape
properties (for example, EM layer and rotation).
Offline 3D EM Elements
On a computer with internet access, you can directly download an offline library of 3D EM elements. On a computer
without internet access, you can install a local copy of the library.
Downloading the 3D EM Elements Library

To download the 3D EM Elements library from the Cadence website, choose Project > Download 3D Elements while
online. A copy of the 3D EM Elements library is saved locally for your use when you are offline.
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If you are offline and try to use a 3D EM element from the Cadence website library, the following window displays.

Optionally select a check box for one of the options and then click Yes. Note that your cached copy may not be the latest
version. You should periodically run the "Check_For_Update_3D_Parts" script when you are online to ensure the latest
version. See “Updating 3D Parts ” for details. You can choose Project > Download 3D Elements to update the cached
copies.
Installing a Local 3D EM Elements Library

A local copy of the 3D EM Elements library is available from the Downloads page of the Cadence website. Once
downloaded, you can install this library on computers that have no internet access. Note that the
"Check_For_Update_3D_Parts" script does not work for local library parts; it only works for downloaded or cached
parts.
To install a local copy of the 3D EM Elements library:
1. On a computer with internet access, download the "AWR 3D Parts Library" from the Cadence website under the
Vendor Libraries section of the Downloads page. The download is a .zip file that you can transfer to other computers.
2. To install the library, extract the contents of the .zip file to the 3D EM Elements directory. The path to this directory
is operating system dependent. To find this directory, choose Help > Show Files/Directories. Double-click XmlUser in
the list of directories. The 3D EM Elements directory is one of the sub-directories listed in the new window that
displays. You should extract the .zip file so the AWR_local_3dparts_xx.xml file is located directly in the 3D EM
Elements directory.
3. Start a new AWR Design Environment software session to use the newly installed local library. The library displays
under the 3D EM Elements > Libraries node in the Elements Browser.
Creating Custom 3D Parts
You can use the AWR 3D Editor to make your own 3D parts. To make your own 3D part:
1. Right-click the EM Structures node in the Project Browser and choose New Arbitrary 3D EM Structure.
2. Enter the structure name and select an Initialization Option for the structure, then click the Create button.
3. Right-click the new EM structure and choose Open in 3D Editor.
The 3D Editor opens and you can create your arbitrary 3D structure. The details for using the editor are provided in
the editor documentation. See “Analyst 3D Editor Help” for details on accessing Help in the 3D Editor.
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Creating a Library of 3D Parts
You can build a library of the 3D parts created in the AWR 3D Editor. This process requires only simple file management
and some XML file editing.
This section describes how to create a library of 3D structures using XML. When building your library, you need to
create a folder structure. You will have XML files to pull the library together and additional files that define your 3D
geometry. The following example shows the process to create an 3D part with a project that contains an arbitrary 3D
EM Structure modelling a SMA connector.
1. Create a folder named "3D XML" on your PC.
2. Inside the "3D XML" folder create a subfolder named "connectors".
3. Export the arbitrary 3D EM structure by right-clicking the arbitrary EM document under the EM Structures node and
choosing Export EM Structure.
4. Choose the "connectors" folder, specify "SMA" as the File name, and then click Save.

Note that you can only save the file as a .gml file, however, this creates five files with .apz, .gml, GP.m3d, .prop and
.sat extensions, as shown in the following figure. You need all of these files to create the library.
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5. Open any text editor (such as Windows® Notepad), type the following content, and save the file as connectors.xml
in the "3D XML" folder. For more information on the Cadence AWR XML Schema description, see Appendix A,
Component Libraries.
<?xml version="1.0"?>
<XML_COMPONENT_DATA xmlns="urn:awr-lib-data">
<COPYRIGHT>AWR</COPYRIGHT>
<SUMMARY>AWR 3D Parameterized Models</SUMMARY>
<FOLDER Name="Preferred Connectors" Icon="Connectors">
<COMPONENT Name="SMA Edge Mount">
<MODEL/>
<DESC>In Jack Connector</DESC>
<PARTNUMBER>SKDSMA2P</PARTNUMBER>
<SYMBOL>SMA@EM3D.syf</SYMBOL>
<HELP>HelpSMA.pdf</HELP>
<DATA DataType="awrschematic" Inline="no" LinkToFile="no">connectors/SMA.gml
<PARAM ParamUnits="length" Name="ContactLen">508e-6</PARAM>
</DATA>
<SUBFILE DataType="downloadonly" Inline="no" LinkToFile="no"
>connectors/SMA.apz</SUBFILE>
<SUBFILE DataType="downloadonly" Inline="no" LinkToFile="no"
>connectors/SMA.sat</SUBFILE>
<SUBFILE DataType="downloadonly" Inline="no" LinkToFile="no"
>connectors/SMA.prop</SUBFILE>
<SUBFILE DataType="downloadonly" Inline="no" LinkToFile="no"
>connectors/SMA.GP.m3d</SUBFILE>
</COMPONENT>
</FOLDER>
</XML_COMPONENT_DATA>

When this XML library is added to the AWR Design Environment platform as described in the following steps, it
displays as shown in the following figure:
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In the XML, the <SUMMARY> and <FOLDER> sections are optional. The library name, as shown in the previous
example, My Custom Connectors is defined by the XML file name. The subnode Preferred Connectors is defined in the
<FOLDER> section.
The <COMPONENT> section is mandatory and is used to define the type of component. For example, SMA Edge
Mount, which displays under the Models column.
The <MODEL> section is ignored since it is not used in this library.
The <DESC> section is mandatory and the value describes this component. For example, "In Jack Connector" which
displays under the Description column.
The <PARTNUMBER> section is optional and is used to define the part number for this component. If defined, it
displays in the Element Options dialog box for the component.
The <SYMBOL> section is mandatory. You can use existing symbols from the AWR Design Environment platform,
for example, SMA@EM3D.syf. The symbol is displayed next to the component name in the Elements Browser as
shown in the following figure, and is placed in the EM schematic window when the component is added to the EM
document.
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The <HELP> section is optional. It points to a file that contains Help for this component. The file is specified as a
relative pathname or full URL.
The <DATA> section is mandatory. NOTE: For this type of library the DataType must be set to "awrschematic" and
the value must be the .gml file. Set Inline="no" and LinkToFile="no".
The <PARAM> section is optional, and defines a parameter for the component. There is a PARAM entry for each of
the component's parameters. Name is set to the parameter name, such as "ContactLen" or "CoaxLen". ParamUnits is
set to, for example, length, and the value must be in base units (for length, it is meters). Other ParamUnits supported
are angle, resistance, capacitance, conductance, voltage, current, and power.
The <SUBFILE> section is mandatory. There must be a separate <SUBFILE> section for each of the .apz, .sat, .prop,
and .GP.m3d files. Set DataType="downloadonly", Inline="no", and LinkToFile="no" for all of them.
6. After your connectors.xml file is ready, add the file to your XmlUser\3D EM Elements folder. In this example, the
file paths define in the <SUBFILE> section of the XML file were defined relative to the XML file location, so you
also need to copy the "connectors" subfolder to the XmlUser\3D EM Elements folder.
To find the XmlUser folder, choose Help > Show Files/Directories to display the Directories dialog box. Double-click
the XmlUser folder, as shown in the following figure. Open the 3D EM Elements folder and add the XML to this
folder.
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7. Start the AWR Design Environment program or open a new project to update the Element Browser.
8. In the Elements Browser, expand the 3D EM Elements > Elements node. The newly added library displays.
9. Click the library name to display its elements in the bottom pane of the Elements Browser, as shown in the following
figure.
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If you are building your own library of parts, you can add versioning to the 3D part use the Check_For_Update_3D_Parts
script that checks for updates. See “Updating 3D Parts ” for details.
Versioning the EM Part

Version information is stored as text on the EM schematic for the Arbitrary 3D EM document added to the AWR Design
Environment platform. This 3D part information is accessible by the Check_For_Update_3D_Parts script. You must add
the versioning information before exporting arbitrary 3D EM structure when creating an XML library. To add versioning
information:
1. With the Arbitrary 3D EM document window active (your 3D part), view the schematic of the part by clicking the
View EM Schematic button on the toolbar.
NOTE:: If this button is not visible, right-click the toolbar and ensure that the “3DEM Layout” toolbar is selected
for display.
2. To add version information, choose Draw > Add Text to add text using the convention "Version:X" where X is the
version number of your part. Cadence recommends starting with "Version:1". You should increase this version number
when there is an update.
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3. Export the arbitrary 3D EM structure by right-clicking the arbitrary EM document under the EM Structures node and
choosing Export EM Structure. Proceed with the XML library creation process.
To update the version on an existing part, repeat the same procedure, except increment the version number in the EM
schematic text. Replace the old .apz, .sat, .prop, and .GP.m3d files with the newly exported files.
Versioning the XML

The Check_For_Update_3D_Parts script determines the version of a 3D part stored in the project from the versioning text
in the 3D part EM schematic. The script also determines the XML file location from which the 3D part came. The script
then queries this XML file looking for the current version and any release notes, and then determines whether the part
saved in the project is up to date.
NOTE: If you change the structure of the XML, the update mechanism does not work unless you write scripting code
to map the old locations to the new.
In order for the Check_For_Update_3D_Parts script to work, you need to add the versioning information to the XML file
defining the library part. You must update the version number set in the XML file when the version number in the 3D
part EM schematic is updated. When running the Check_For_Update_3D_Parts script, the "Version" value set in the XML
is checked against the "Version:X" number of the 3D part used in the project to determine if an update is available.
The following example shows a part configured with version number and release information, where relevant information
for the update is listed in the last four <PROPERTY> lines.
<COMPONENT Name="Test">
<!-- Model name appearing in project list -->
<MODEL>test</MODEL>
<DESC>Test Part</DESC>
<PARTNUMBER/>
<SYMBOL>ParRLC@system.syf</SYMBOL>
<HELP/>
<DATA DataType="awrschematic" Inline="no" LinkToFile="no"
>resonators/DISK_RESON.gml</DATA>
<SUBFILE DataType="downloadonly" Inline="no" LinkToFile="no"
>resonators/DISK_RESON.apz</SUBFILE>
<SUBFILE DataType="downloadonly" Inline="no" LinkToFile="no"
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>resonators/DISK_RESON.sat</SUBFILE>
<SUBFILE DataType="downloadonly" Inline="no" LinkToFile="no"
>resonators/DISK_RESON.prop</SUBFILE>
<SUBFILE DataType="downloadonly" Inline="no" LinkToFile="no"
>resonators/DISK_RESON.GP.m3d</SUBFILE>
<PROPERTY OnInstance = "no" Name="Version" Value="3"/>
<PROPERTY OnInstance = "no" Name="RN1" Value="Updated Scaling for the H Parameter."/>
<PROPERTY OnInstance = "no" Name="RN2" Value="Added proper help link."/>
<PROPERTY OnInstance = "no" Name="RN3" Value="testing update."/>
</COMPONENT>

The "Version" <PROPERTY> line is required for the update script, where "Version" case is not important. You can then
optionally add release note <PROPERTY> lines using the syntax "RNX" where X is a number indicating the changes
from X-1 to X. For example, "RN1" is the change from version 0 to version 1; case is not important.
NOTE: The OnInstance attribute is user-defined and specifies whether or not the information is stored on the instance
in the AWR Design Environment platform. In this example it is not, because the information is not needed on the part
and it increases the size of the AWR platform project file.
If you change the Name to use User:Version and omit the OnInstance attribute, this information displays on the Element
Options dialog box User Attributes tab. You can use "User:*Version" syntax and the User Attribute is read only. See
“Adding User Attributes in XML Files” for details.

16.6.5. Importing Layout Geometry
You can directly import GDSII and DXF layout formats to an EM structure. See “Importing GDSII/DXF as an EM
Structure” for details.

16.6.6. Creating Hierarchical EM Documents
You can design EM structures hierarchically using other EM documents as submodels. This approach greatly simplifies
the setup for complex dielectric stackups. If you have a structure on a GaAs chip that has two dielectric layers, GaAs
and Air, and you want to use this chip on top of a board or package with an interconnect, you typically specify the PCB
dielectric layers (two layers in the simple case, one for the board and one for Air). You can then use the chip EM structure
as a subcircuit in the PCB structure with no additional dielectric layer setup. The simulation for the PCB resolves all of
the dielectric layers and conductors for any shapes in the PCB structure as well as the chip subcircuit. This allows the
individual pieces to be simulated separately and then quickly integrated to simulate together with minimum setup.
You can add any EM structure as a subcircuit to any other EM subcircuit. With an EM structure 2D layout window
active, choose Draw > Add Subcircuit or click the Subcircuit button on the toolbar. Select the subcircuit you want to add,
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then place it on one of the EM layers in the current structure. The rules for the initial placement and editing of the Z
position of the subcircuit are the same as those for 3D pCells. See “Working with Hierarchy” for more information about
EM hierarchy.

16.6.7. Specifying Simulation Boundaries
Each Analyst structure must have specified boundary conditions. Only the shapes inside the boundary are simulated, and
all ports must be inside or on the perimeter of the boundary. The port type is determined in part by the position of the
port with respect to the system boundary; see “Analyst Ports” for more information. The boundaries are defined by the
shape in the 2D layout of the EM structure that encompasses the rest of the geometry. You choose the boundary condition
to use for the boundary top, bottom, and sides. Boundaries without assigned conditions default to the Approx Open
boundary condition.
Editing Boundary Shapes
When you first create an Analyst EM structure or convert an EM structure to an Analyst structure, a boundary shape is
added by default. There are two options for editing boundary shapes:
• Edit an existing boundary shape by double-clicking it to place it in edit mode, then click and drag any vertex or edge
midpoint.
• Draw any shape or select any shape in the EM layout. Choose Draw > Create 3D EM Simulation Boundary or click the
Create Simulation Boundary button on the toolbar to make the shape a boundary shape.

When using this command, more than one boundary shape might be defined. If so, an error message displays and no
simulation occurs. You should delete any extra boundary shapes prior to simulating.
NOTE: If you have more than one boundary shape, you cannot perform Boolean operations on them to make a more
complex boundary shape. (You might have already set different boundary conditions on each edge of the boundary shape,
and the result of the Boolean operation would not know how to keep those changes.) Therefore, if you want to make a
complex shape for a boundary condition, first make the shape on any other layer. In this layer, you can perform any
complex editing such as Boolean operations or notches, and then use the first option listed above to convert the shape
to the boundary condition.
Boundary Size
The boundary size can significantly impact the quality of the simulation results, particularly if the boundary is too close
to metal shapes. For non-radiating structures, if the boundary is far enough away that the fringing fields are near zero,
the boundary is electromagnetically isolated from the structure of interest and the solution should be insensitive to the
choice of boundary condition. Generally, for simple cases you can place the sidewalls and top surface at least 10x the
substrate thickness away from the nearest metal. At this distance the solution is largely unchanged whether you use PEC,
PMC, or approximate open boundary conditions. For more complex geometries, you may need to experiment to determine
minimum safe boundary sizes. This spacing requirement applies to all sides of the domain that do not contain ports. On
sides with ports, the field is forced to a particular mode solution and the choice of boundary condition has no impact on
the simulation results.
For radiating structures, the PML boundary condition gives the most accurate results, but the less-accurate Approximate
Open boundary condition may also be used in the design phase. Place PML boundary conditions on either the boundaries
of a rectangular volume or on the exterior of a spherical volume. Approximate Open boundary conditions may be placed
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on boundaries of any shape. Generally the nearest boundary walls should be, at minimum, one quarter of a wavelength
away from the nearest metal, but not more than a few wavelengths away.
Choosing Boundary Conditions
Boundary conditions are chosen based on a given problem. Fields are modeled only within the enclosure, and treatment
of the fields on the boundary of the enclosure is determined by the choice of boundary conditions. In general, boundary
conditions can specify values of particular components of the electric or magnetic fields, or they can define relationships
between E and H.
The following table summarizes the types of boundary conditions that the Analyst simulator supports. The table also
indicates the effect that each boundary condition has on both the electric and magnetic fields at the boundary. Further
details on each type of boundary condition are listed after the table.
Boundary Condition Effect on Effect on Boundary Size Recommendations Use Notes
Type
E
H
Perfect Electric
Conductor (PEC)

E∥ = 0

H⊥ = 0

Typically used to model a structure
in a conducting enclosure, so define
the size to match the size of the
actual device.

Perfect Magnetic
Conductor (PMC)

E⊥ = 0

H∥ = 0

5-10x substrate height away from An alternative to Approximate
metal shapes.
Open for non-radiating structures.

E∥/H∥ = Z

Typically used to model a structure These choices have names that
in a conducting enclosure, so define correspond to material definitions
the size to match the size of the
such as Tantalum or Cap Bottom.
actual device.

Approximate Open

E∥/H∥ = 376.7Ω

5-10x substrate height away from Used on non-radiating structures to
metal shapes.
approximate free space, and on
radiating structures when speed is
paramount.

Perfectly Matched
Layer (PML)

see below

Impedance

Place > λ/4 away from metal
shapes.

Intended for use in true radiating
structures. Computationally
expensive.

Electric Symmetry

E⊥ = 0

H∥ = 0

n/a

Used only when geometric and
electromagnetic symmetry are
present. Must bisect all ports.

Magnetic Symmetry

E∥ = 0

H⊥ = 0

n/a

Used only when geometric and
electromagnetic symmetry are
present. Must bisect all ports.

The Perfect Electric Conductor (PEC) boundary condition defines the material with infinite electrical conductivity, so the
tangential component of the electric field and the normal component of the magnetic field go to zero on the boundary.
In many cases this idealized material is a good approximation for highly-conductive metals, and allows for faster
computation time.
The Perfect Magnetic Conductor (PMC) boundary condition is assumed to have infinite magnetic conductivity, so the
tangential component of the magnetic field and the normal component of the electric field go to zero on the surface.
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If you choose to terminate your geometry with a material of finite conductivity, you have applied the Impedance boundary
condition. The Analyst solver uses both the conductivity and the thickness of this material to determine the impedance
at the boundary.
The Approx Open boundary condition is a zero-conductivity impedance boundary condition with the impedance of free
space. It is a good choice for non-radiating systems that are not bounded by conductors. It may also be used as a alternative
to PML, when some level of accuracy may be sacrificed for solver speed. As noted in the previous section, you should
ensure that the boundaries of such systems are far enough away from the structures of interest that the fringing fields are
attenuated to near-zero at the boundary. The approximate open boundary condition is useful because it does not fully
reflect the low fields at the boundary, as PEC and PMC do, although some reflections still occur.
The Perfectly Matched Layer boundary condition defines an auxiliary mesh that adjoins the main FEM mesh at the surface
that has the PML boundary attribute. This auxiliary mesh is filled with a graded lossy medium that is impedance-matched
to the adjacent main mesh, so that incident fields penetrate the PML mesh with low reflection, and those fields are
attenuated in the PML material. Field attenuation within the PML depends on the incident angle of the fields that intersect
the PML boundary. Normally-incident fields experience optimal attenuation, while glancing fields experience less
attenuation. Materials that intersect the PML go to infinity. PML may be applied to either planar or spherical surfaces,
but not both within the same geometry. Using PML boundary conditions on a spherical boundary may result in a faster
simulation than using PML on a rectangular boundary, because the auxiliary mesh will usually add fewer elements to
the system than it would in the rectangular case. In the 3D editor, define a spherical simulation domain instead of a
rectangular one, and apply the PML to the exterior surface. See “Using Boundaries Defined in Arbitrary 3D EM Structures”
for more details.
Electric Symmetry and Magnetic Symmetry boundary conditions reduce the computational size of a problem, or allow you

to get more accurate and detailed mode data for a set amount of computer resources. Use of symmetry also thins the
mode spectrum, as it prohibits modes that do not exhibit the specified symmetry. Although the electric symmetry plane
is electromagnetically equivalent to PMC, and the magnetic symmetry plane is the same as a PEC, the Analyst solver
treats them differently from PMC and PEC planes. Symmetry planes are intended to let you decrease the physical size
of a system by exploiting natural symmetries in the fields. You cannot specify symmetry on two surfaces that are parallel
but offset in their normal directions. Symmetry planes do not have to be orthogonal to each other, although only one pair
of planes is allowed to be non-orthogonal. If the combination of planes is too complex for the solver to compute a volume
fraction, it outputs a warning and ignores symmetry in field normalization and mode parameter calculations. When using
symmetry planes with spherical PML, the center of the PML sphere must be coplanar with the symmetry plane. If you
have a symmetry plane in a simulation with either a wave or lumped port, the symmetry plane must pass through the
port. So, you can use symmetry planes to increase the size of a port and thus show the symmetry within the port solution,
but you cannot use symmetry planes to duplicate ports.
Editing Boundary Conditions
There are two options for editing boundary conditions:
• Select the boundary shape, right-click and choose Shape Properties to display the Properties dialog box, then click the
Boundary Conditions tab.
• Double-click the Enclosure node under the EM document in the Project Browser to display the Properties dialog box,
then click on the Boundary Conditions tab.
By default, each side uses the Side Boundary setting. You can set each side individually by clearing the Use Side Boundary
check box and then setting each edge of the boundary independently below this option. When doing so, open the 2D EM
layout so you can see the edge you select highlighted, as shown in the following figure.
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Viewing Boundary Conditions
Cadence recommends visualizing the boundary conditions for an Analyst structure in the 3D view to make sure they are
set up as intended. With the 3D view open, click the Show Boundary Conditions button on the toolbar.

An "EM3D_SURF_BC" annotation is added below the EM document in the Project Browser. You can double-click the
annotation to see the available options. See “Surface Boundary Conditions for 3D Models: EM_3D_SURF_BC” for
details. Click the toolbar button again to turn off the boundary condition display. The Layout Manager Visibility by
Material/Boundary pane can quickly show/hide boundaries by material type, which is useful for verifying that all the
material properties are set up as expected.
Using the Boundary Shape to Truncate Structures
You can use the boundary shape to simulate a subset of the drawn geometry. Only shapes that are located inside the
boundary shape are simulated. Any ports used for simulation need to be inside or on the edge of the boundary shape or
a simulation error occurs. You may have to add shapes to attach ports when moving the boundary condition.
The following example demonstrates this concept. This figure shows a simple line where the boundary shape encloses
the entire geometry.
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You can edit the boundary shape to only include some of the geometry as shown in the following figure. Here, port 2 is
outside the boundary area so a simulation error occurs.

Port 2 is added to a valid region in the following figure, so the structure now properly simulates.
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If you view the mesh of this structure, you see that only the region inside the boundary shape will mesh.

Using Boundaries Defined in Arbitrary 3D EM Structures
You can define an arbitrary 3D EM structure entirely in the AWR 3D Editor, including the boundary conditions for the
simulation. If the boundary conditions are defined in the arbitrary 3D EM structure, the extruded 2D enclosure might
not be required when using this structure in an Analyst 3D EM structure. If so, you can choose to ignore the enclosure
defined in the Analyst document by right-clicking the EM structure in the Project Browser and choosing Options to
display the EM Options dialog box. On the Analyst tab, click the Show Secondary button, select the Ignore Enclosure
check box, and then click OK.
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16.6.8. Analyst Ports
See “Adding EM Ports” for information on how to add and edit ports in the EM Editor. This section provides additional
information on how ports are modeled and used in Analyst software simulations. In general, when using the Analyst
solver you can assign a port to any conducting edge in the system. All output quantities are defined in terms of port
number.
The Analyst solver supports both wave and lumped ports. You must explicitly specify the port type. Both port types can
be placed anywhere in the geometry. The extents of the wave port plane can either be determined by the geometry or
you can specify them directly by choosing the Wave Custom Size type. The lumped port type determines the presence or
absence of an explicit ground reference.
Wave Ports
Excited wave ports introduce energy into the simulated fields, in the form of the lowest-order eigenmode of the structure
defined on the port plane. For each simulation frequency, the solver performs an eigenanalysis of the system on the port
plane, and each of the resulting modes determines the amplitude profile of the excitation for that frequency. In the "Full"
solve, the finite-element matrix equation is solved once for each port eigenmode, so that the field on the port plane is
enforced for that eigenmode. The technique used in wave ports does not introduce parasitic components to the fields, as
may happen with lumped ports, so there is no need to de-embed wave ports.
Wave ports must be specified on external boundaries of the domain, except in the special case described in “Internal
Wave Ports”. If the port type is Wave, the port plane extends over the entire side of the enclosure boundary. If the port
type is Wave Custom Size, the port plane extends over only the custom extent region. To avoid undesired resonances with
the boundary or interactions between field and boundary, you should be sure the port plane boundaries are sufficiently
far from the structure to which you assign the port. You may have any number of wave ports defined on a single plane;
the Analyst solver computes results for each one independently, accounting for the coupling between them. You may
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also specify differential port pairs with wave ports, by defining one port with a given positive index, and the other port
with the negative of that index. For a given index you may have any number of negative terminals, but only one positive
terminal. You may define any number of differential port pairs, as long as each pair is indicated by a unique index.
Custom Extents

The Analyst eigenmode solver is optimized for lower-order modes, and it therefore gives best performance on port planes
with only a few conductors. Using the Wave Custom Size port can greatly speed up your simulation time without sacrificing
accuracy. You can use custom wave port extents to exclude extra conductors from the port solve eigenanalysis. You can
also use custom extents to separate wave ports that you know do not interact on the port plane. You should use care with
these techniques, to make sure you do not exclude any conductors that are relevant to the desired mode. You also need
to be sure the custom region is large enough that the boundaries do not interfere with the desired mode. The boundary
conditions at the edges of the custom extent regions are taken from the boundary conditions on the wave port plane.
In the following geometry, custom extents are used to exclude the conductor on the far left from the mode solution. The
two conductors on either side of the port are included in the mode calculation.

If you have several wave ports on the same plane and you know they do not interact in that plane, you may use custom
extents on them to divide a complex port definition into several simpler port definitions.

Simulation and Analysis Guide 16–25

Setting Up Analyst Geometry
If the custom extent of several wave ports touch or overlap, the resulting wave port plane extends over all connected sets
of custom extents, and the port solve includes all involved wave ports. This is exactly what would happen if you had not
used custom extents, except that the wave port plane is limited to the combined custom-extent region. If you mix Wave
Custom Size ports and Wave ports on the same plane, the two types of ports are treated independently in the port solve.
Lumped Ports
A lumped port introduces excitation by defining a voltage difference between two points for a given port impedance. A
lumped port must have a reference point for the port voltage, and thus the port definition must have a corresponding
negative terminal or explicit ground reference. In a differential port, the positive and negative terminals are the points
that are chosen for the voltage difference. In all other lumped ports, one terminal is on the port, and the other is on the
grounding material, as determined by the explicit ground reference. As with wave ports, for a given port index you may
define any number of negative terminals but only one positive terminal. In addition, you may define any number of
differential port pairs, as long as each pair is indicated by a unique index. In every case, all terminals must be defined
on good electrical conductors. If this condition is not met, the solver produces an error and aborts the simulation.
Note that the Analyst solver does not support de-embedding for lumped ports. Nevertheless, to compare results between
AXIEM and Analyst simulations, you should de-embed the ports in AXIEM software. Due to differences inherent to the
simulation methods, the parasitic components introduced by these ports have a much smaller impact on Analyst software
simulation results than they do in AXIEM simulation results.
Point Ports
Analyst models point ports as very narrow lumped ports that reside at the center of the shape. Lumped port details and
restrictions also apply to point ports.
Understanding Port Impedance
When you double-click a port on an EM document, the Port Attributes dialog box displays and you can edit the port
attributes. See “Port Attributes Dialog Box” for more information. You can change the port impedance and power levels.
These values are ONLY used when viewing currents and fields directly on the EM structure. They DO NOT affect the
simulation S-parameter when plotted on a graph directly from the EM document or when the EM document is used as
a subcircuit in a schematic. In this case, the data is always referenced to 50 ohms. If you want to view the results in a
different impedance system, you should use the EM structure in a circuit schematic, wire up ports to each node of the
EM structure and change the impedances of the ports in the schematic.

16.6.9. Recommended Port Usage
The following sections include port usage recommendations for specific structures.
CPW Structures
When defining CPW and other structures with multiple ground planes, you must always add the negative terminal port
when using lumped ports. The following figure shows the correct CPW lumped port setup.
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When using wave ports, only the positive port terminal is required. For GCPW (grounded coplanar waveguide), if the
side grounds are connected to the bottom ground with a via, it is important to have the via on the port plane so that the
effect of it is included in the 2D cross-section port solve. Otherwise, if there is no via on the port face, the port solve sees
four conductors that are disconnected from each other and the mode is different from that of the GCPW.
Internal Wave Ports
Internal wave ports can be useful if a port with low parasitics is needed in a geometry that does not easily allow termination
of the structure on the geometry boundary. A wave port sources the fields that would exist if the structures on the wave
port plane extended to infinity. Because of this, it is nonphysical to use a wave port in the geometry interior, so the
internal wave port should be used with care to ensure the geometry is still reasonable.
Internal wave ports are defined differently on waveguides and traces. To define an internal wave port on the end of a
dielectric waveguide, simply apply the wave port attribute to the dielectric face at the end of the waveguide as usual. If
the waveguide has metal walls, the Analyst solver automatically determines the direction of propagation and extent of
the wave port.
To define an internal wave port on metal, you must also define the extents of the port plane. First, apply the wave port
to the appropriate interior face or edge inside the enclosure. Then, if you are working with an arbitrary 3D EM structure,
define the extents in the 3D EM Editor by applying the same port attribute to a dielectric surface that surrounds the metal
edge or face. Define such a surface if one does not already exist. The dielectric surface must coincide with the metal
edge or face. This surface, and the port attribute applied to it, tells the Analyst solver how large to make the port plane
around the metal structure. If you are not working with an arbitrary 3D EM structure, use the Wave Custom Size port
type to indicate the size of the port plane.
In all internal wave ports, the solver adds a PEC backing to ensure the wave is propagated toward the side of the port
with the most metal. Therefore, the wave port should be located at the end of the trace or waveguide, and not in the
middle.

16.6.10. Working with Hierarchy
Using EM subcircuits to define hierarchical EM structures often simplifies designs. See “Creating Hierarchical EM
Documents” for more information on this setup. When an EM structure is utilized as an EM subcircuit, it does not
automatically simulate when you choose Simulate > Analyze. Instead, an EM subcircuit only simulates if it is the source
of a measurement or annotation.
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Material Priority in Hierarchy
The rules that define precedence when materials overlap, as described in “Material Priority with Overlaps”, also apply
to hierarchical EM structures, with the exception of Air layers defined in a subcircuit stackup. Non-air dielectric layers
defined in subcircuit stackups are treated as extruded dielectrics when the subcircuit is placed into another EM structure.
Air layers, however, are ignored when a subcircuit is placed into an EM structure, and the region previously defined by
the Air layer is replaced with material defined at the EM structure level of hierarchy. This special case does not apply
to extruded air regions, which are defined by drawn shapes instead of stackup layers.
The following example illustrates how material overlaps are resolved in hierarchical EM structures when there is an Air
layer defined in the subcircuit. The following figures show the 2D and 3D views of a child subcircuit defined by two
dielectric layers. The top layer is Air, which by default is not set to be visible in the 3D view. The bottom layer is defined
with a dielectric constant er = 2.

The following figure shows the resulting structure when the child subcircuit is inserted into a parent structure with a
background dielectric constant er = 10. Material overlap rules are applied to the subcircuit as if the subcircuit dielectric
layers are extruded shapes, with the exception of the Air layer. Even though the child subcircuit dielectric layer has a
lower dielectric constant (er = 2) than the parent (er = 10), the subcircuit dielectric 'cuts' away from the parent background
dielectric because extruded shapes have higher priority. The Air layer defined in the child subcircuit, however, is ignored
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in the parent structure, and the region formally occupied by Air is replaced with the background dielectric of the parent
structure.

The following example is similar to the previous example, except that an Air box is drawn as an extrude shape, as follows.
The 3D view is identical to the previous figure, because the drawn Air box is created at the same size as the Air layer of
the previous example.

The following figure shows the resulting structure when the above child subcircuit is inserted into an identical parent
structure as the previous example. Because the Air box is defined as an extrude shape, it is not ignored in the parent
structure, and it 'cuts' a region out of the background dielectric.
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Boundary Conditions in Hierarchy
Open type boundary conditions applied to child subcircuits are not applied when the subcircuit is placed into a parent
circuit. Open type boundaries include Approx Open, Perfectly Matched Layer (PML), and Perfect Magnetic Conductor (PMC).
With one exception, all other boundaries are preserved when a child subcircuit is placed into a parent structure. For
example, you can define a Perfect Electric Conductor (PEC) bottom enclosure and side walls on a child subcircuit. When
the child subcircuit is placed into a parent structure, the child ground plane and sidewalls are retained. The one exception
occurs when the child subcircuit boundary is contacting Air in the child structure. In that case, when that subcircuit is
placed in a parent structure, any portion of the child boundary that was in contact with Air is removed in the parent
structure. See “Specifying Simulation Boundaries” for more information on Analyst boundary conditions.

16.6.11. Setting Up Parameterization
You can set up Analyst EM documents to parameterize the geometry. The AWR Design Environment software has
several modes of using parameterized EM structures. See “Parameterizing EM Structures” for details.

16.6.12. Simplifying Geometry
The AWR Design Environment software has a general approach to simplifying geometry before simulating. Often you
know details about a specific process where the shapes are needed for manufacturing but can be simplified for simulation.
You can write rules to simplify the geometry before simulation. See “Geometry Simplification” for details.

16.6.13. Setting Analyst Structure Default Options
Analyst documents behave the same way as other EM structures in the AWR Design Environment platform. See “Simulator,
Mesh, and Simulation Frequency Options” for details.

16.7. Setting Up an Analyst Simulation
You need to set up the mesh, Job Scheduler, and solver options prior to an Analyst simulation.
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16.7.1. Mesh Options
You can configure various mesh options for each Analyst simulation document. These options only impact the initial
mesh generated for use in the AMR (Adaptive Mesh Refinement) process, so the defaults are a good place to start.
Mesh options can be set on a global or per-shape basis. To access global mesh options, right-click the Analyst document
in the Project Browser and choose Options to display the Options dialog box, then click the Mesh tab.
When different settings are required to, for example, produce a finer initial mesh locally, some of the options can be set
on a shape-by-shape basis. To access shape mesh options, select the shape, right-click, and choose Shape Properties to
display the Properties dialog box, then click the Mesh tab.
The following options are important to consider:
• Model As Zero Thickness - the Analyst solver supports zero thickness shapes where material thickness is specified
as 0.0 or when this mesh option is true (either at the document level or on a shape-by-shape basis). To compare AXIEM
and Analyst simulation results, ensure that both solvers use the same conductor thickness settings. Note that the default
global setting for this option is "Off" for Analyst simulations and "On" for AXIEM simulations.
• Size Type - Determines whether the largest allowed element size is defined as a relative or absolute size. Element size
is also limited by the AMR frequency and simulation basis set, to ensure sufficient sampling at the highest AMR
frequency.
• Relative Mesh Size - Maximum element edge length relative to 1/10th the diagonal of the bounding box of the
structure. To produce a finer initial mesh, lower this value.
• Absolute Mesh Size - Maximum element edge specified in working length units. To produce a finer initial mesh,
lower this value.
• Size Propagation Factor - Controls element size transition rate from coarse to fine areas. Valid values are between
0.0 and 1.0, with smaller values resulting in faster transitions.
• Curvature Refinement Type - Determines whether the curvature refinement is determined by the relative element
size or in working length units.
• Absolute Curvature Refinement Size - Controls the accuracy with which the mesh represents curved surfaces and
edges. Valid values are larger than 0.0 and specified in working length units.
• Relative Curvature Refinement Size - Controls the accuracy with which the mesh represents curved surfaces and
edges. Valid values are larger than 0.0 and less than or equal to 0.5. Smaller values more accurately represent curved
surfaces and edges but may result in longer meshing times.
• Anisotropic Curvature Refinement - If selected, curvature refinement is mostly confined to curved directions. This
can drastically reduce element counts in structure containing long, small diameter cylinders such as bond wires.
• Relative Minimum Curvature Size - Defines a floor for the smallest element to be produced by the Curvature
Refinement Level. The value is relative to the global maximum element size.
• Absolute Curvature Refinement Size - Defines a floor for the smallest element to be produced by the Curvature
Refinement Level. The value is specified in working length units.
• Enable Small Feature Suppression - Can help alleviate meshing problems particularly with complex and/or imported
geometry.
• Absolute Small Feature Suppression Tolerance - Tolerance is a length. Recommended values are on the order of
0.0. Making this value larger decreases the chance of meshing failures, however making it too large can alter the
geometry significantly. Visible only if Enable Small Feature Suppression is selected.
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• Enable Local Meshing Controls - If selected, meshing is governed by attributes on the geometry (bodies, faces, and
edges) that control the meshing process locally.

16.7.2. Job Scheduler Options
The Analyst solver can distribute a single job across multiple processors, with one or more processes allocated to each
physical core or processor. Each process is currently single-threaded and accesses only its own block of memory using
what is known as a distributed memory model.
To access Job Scheduler options and control use of parallel processing, right-click the Analyst document in the Project
Browser and choose Options to display the Options dialog box, then click the Job Scheduler tab. See “Setting Job Scheduler
Options” for details.

16.7.3. Solver Options
You can configure various solver options for each Analyst simulation document. Typically, the defaults are a good place
to start, although different settings might be required. To access solver options, right-click the Analyst document in the
Project Browser and choose Options to display the Options dialog box, then click the Analyst tab. The following options
are important to consider.
• Field Output Frequency - Specifies for which frequencies to save the field results from the analysis. If you do not
edit this initially, you need to resimulate to use field annotations.
• Solve Type - Choose Full to solve on the entire model, or Ports Only to solve on the ports alone. The Ports Only option
allows you to quickly characterize the ports without running the more time-consuming volumetric solve.
• Sweep Type - Choose Automatic, Discrete, or GAWE. GAWE is a fast frequency sweep. "Ports only" solves always use
the discrete frequency sweep type, so the Sweep Type does not impact those calculations. For details on the different
types of frequency sweeps available when using the Analyst solver, see “Frequency Sweeps”.
• Basis Set - Controls the level of interpolation for the fields that is used on an element in the mesh. For details see
“Basis Sets”.
• Minimum Solved Frequency - The lowest frequency solved with the finite-element method employed by the Analyst
solver for high-frequency electromagnetic simulations. Below this frequency, simulator behavior is determined by the
Extrapolate Toward DC setting. For details, see “Frequency Sweeps”
• Solve Inside Conductors - By default, the simulator uses the equivalent impedance boundary conditions on all good
electrical conductors to make the simulation faster and less resource intensive. When modeling the skin depth to
capture losses is important, change this to Always. Note that this setting results in increased resource usage and often
very rapid mesh growth in order to capture skin depth effects.
• Extrapolate Toward DC - This flag controls solver behavior at frequencies below the value in Minimum Solved
Frequency. If you choose Cubic Polynomial Fit, results at frequencies below the minimum solved frequency are
extrapolated from the results above the minimum solved frequency, using a cubic polynomial fit. If you choose None,
results at frequencies below the minimum solved frequency are found by solving at the minimum solved frequency.
For details, see “Frequency Sweeps”.
• Characteristic Impedance Method - This flag specifies how the Analyst solver should calculate the characteristic
impedance of wave ports. The characteristic impedance of a circuit port is given by the user-defined port impedance.
A wave port's characteristic impedance can be computed using several methods: the Power Current method (computed
with P/I2), the Power Voltage method (computed with P*V2), the Voltage Current method (computed with V/I), and for
homogeneous waveguides, the Wave impedance. For most single-moded transmission lines the first three methods
give similar values, while in waveguides all four options can be quite different and the proper one to use depends on
the problem. The Wave impedance calculation is not valid for inhomogeneous solutions. If you select Wave for a
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simulation that includes either wave ports on traces or inhomogeneous waveguides, the Analyst solver reverts to using
the Power Current method for all wave ports.
• Port Solver > Basis Set - Controls the level of interpolation for the fields used on an element in the port mesh. Automatic
ties the port basis set to one order higher than that used in the volume.
• Port Solver > Eigensolver > Method - Controls whether the eigensolver uses a direct or iterative method. The Direct
method identifies all of the eigenmodes and then selects the appropriate ones based upon sorting criteria. This method
is very robust, but it scales poorly with mesh element count. The Iterative methods converge only one, to at most a
few modes of interest, but do so rapidly and in a way that scales well with mesh element count. Except for very small
problems the Iterative methods are typically the best choice, and the Automatic selection is equivalent to Iterative.
• Linear Solver > Method - The finite-element method requires the solution of a matrix equation. RF simulations use
a direct linear solver method.
• Linear Solver > Direct > Method - The default "Direct" linear solver method forces the solver to use one of two
methods that rely on an LU factorization of the system matrix: "MFLU" and "HMLU". The Automatic selection
invokes the appropriate option based upon the computer and configuration.
• Linear Solver > Direct > HMLU > Factor Accuracy Level - The HMLU linear solver produces an inexact LU
factorization of the system matrix that is subsequently used in an iterative loop to determine the solution vectors for
port/mode excitations. The accuracy of the factor can be determined by the Factor Accuracy Level. The "Perfect" setting
yields a factor with accuracy equivalent to that obtained using the MFLU solver, and results in the iterative loop
converging in a single step. A lower factor accuracy is faster to compute and takes less system memory compared to
a higher accuracy, but it can also lead to more iterations required in the iterative loop.
• Remote Simulation for Refine Solution - When selected, the Analyst refine solution can run on a remote machine.
This is a secondary option. If it does not display, click the Show Secondary button in the dialog box. See “Utilizing
Remote Computing” for details on remote simulation.
• Archive Refine Solution Files to Project - Controls whether to save in the Microwave Office project file the auxiliary
files generated in an initial Analyst software simulation or previous refine solution. When the auxiliary files are archived
in the project, you can copy the project file to another folder or machine while preserving the ability to refine solution.
Note that this can substantially increase the size of the project file. This is a secondary option. If it does not display,
click the Show Secondary button in the dialog box.
Adaptive Mesh Refinement Options
The Analyst solver uses an Adaptive Mesh Refinement (AMR) algorithm that solves the problem multiple times with
progressively finer meshes. The mesh refinement is determined by which areas of the current solution contribute the
most error to the final solution. The AMR process continues until the change in the convergence metric is less than a
user-defined tolerance, or the maximum specified number of AMR iterations is reached. In "Ports only" solves, the
convergence metric is either Zc or Kz, depending on availability, and in "Full" solves the convergence metric is the
S-parameters (magnitude or magnitude/phase). Since the number of AMR iterations affects both accuracy and solution
time, the options that control AMR (particularly the convergence tolerance) are among the most important solver options.
The Target Mesh Growth Fraction is universal to the simulation, but you can set the other options independently for "Ports
only" solves and "Full solves".
•

Maximum Iterations - The maximum number of AMR iterations permitted in each phase of the simulation. If the sequence

has not terminated by reaching the convergence tolerance, it terminates after this number of iterations are complete.
•

Minimum Iterations

- The minimum number of AMR iterations permitted in each phase of the simulation, regardless
of the convergence status.

•

Minimum Converged Iterations

- The minimum number of consecutive iterations with error less than the convergence
criterion, before the AMR process is terminated.
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•

Frequency Modifier - By default, the AMR process only solves at a single frequency point, and the full frequency sweep

is only done for the final step. For example, if the frequency setup specifies solving at 1, 2, 3, 4, and 5 GHz, and the
Frequency Modifier is set to Mid, then the initial AMR results are performed at 3 GHz. You can choose All if you want
to use all frequencies, although this slows the simulation time significantly. You can also specify any AMR frequency
you want by choosing Custom.
•

Result Convergence/Target - Only visible for the "Full solve" part of the AMR process. Controls if AMR stops on either

the magnitude of the S-parameters or both the Magnitude and Phase of the S-parameters.
•

Result Convergence/Tolerance

- Controls the stopping criterion for the "Ports only" part of the AMR process; it is a
fractional tolerance. A value of 0.01 indicates that the solution is considered converged once the convergence metric
changes by less than 1% from one iteration to the next.

•

Result Convergence/Maximum Delta Magnitude S

•

Result Convergence/Maximum Delta Phase S - Only visible if the Target is Magnitude and Phase S. Controls the stopping

- Controls the stopping criterion for the "Full solve" part of the AMR
process; it is a fractional tolerance. A value of 0.01 indicates that the solution is considered converged once the
magnitude of the S-parameters changes by less than 1% from one iteration to the next.
criterion for the "Full solve" part of the AMR process; it is an angle tolerance. A value of "5 Deg" indicates that the
solution is considered converged once the phase of the S-parameters changes by less than 5 degrees from one iteration
to the next.

•

Result Convergence/Ignore Phase When Magnitude Less Than

- Only visible if the Target is Magnitude and Phase S. If
the magnitude of a term in the S-parameters is less than this value, the phase of this term is not considered in determining
AMR convergence.

•

Coarsening Enabled

- Controls whether the elements can be made larger in any portion of the mesh during adaptive

mesh refinement.
•

- Controls how rapidly the mesh grows with some exceptions related to wavelength and
skin-depth based refinement. A value of 0.2 indicates that the element count generally does not increase by more than
20% from one iteration to the next.
Target Mesh Growth Fraction

You should choose your AMR frequency wisely. The AMR frequency and basis set choice place a cap on the initial
mesh element size, to ensure that the system is properly sampled for the highest AMR frequency at the beginning of the
simulation. The mesh refines at this frequency until the specified accuracy is obtained. If you are simulating a filter and
your AMR frequency is outside the bandwidth of the filter, you do not get an accurate answer. There is generally no
signal through the filter at this frequency, so the mesh converges quickly since there is little change in the solution. For
example, consider a simple bandpass filter centered at 4.4 GHz with about 10% bandwidth. The return loss of the filter
for an AMR frequency of 4.4 GHz and 5.0 GHz is shown in the following figure.
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You can view the final mesh to see if it looks reasonable. In this case the 4.4 GHz mesh looks good.

The 5.0 GHz mesh does not look good.
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16.8. Running Analyst Simulations
Analyst EM documents simulate the same way as other EM structures in the software. After creating or editing a structure,
you simulate it by clicking the Analyze button on the Standard toolbar, or by choosing Simulate > Analyze. You can also
right-click an Analyst EM document in the Project Browser and choose Simulate to simulate only the selected document.
You are prompted for the name of the data set.

16.8.1. Refining a Solution
After an Analyst structure simulation finishes because the solution converges to a tolerance you specify, or the simulator
completes the number of adaptive mesh refinement (AMR) iterations you set, a Refine Solution option is available by
right-clicking the document in the Project Browser.
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If there is no change to the convergence option, this command runs one more iteration of the adaptive mesh refinement.
It reuses the mesh and field solutions at the last AMR sequence, saving the time it took to get to the last AMR step.
If the Maximum Delta Magnitude S option is reduced after the simulation terminates and then you run the Refine Solution
command, the Analyst solver performs one or more iterations of mesh refinement until the new convergence tolerance
is met.

16.8.2. Understanding Simulation Progress and Feedback
Adaptive Mesh Refinement Process
Analyst software simulations start the same way as other simulations in the AWR Design Environment platform, however
unlike AXIEM software simulations, in Analyst software the AMR process controls the simulation. As the AMR process
proceeds, results are sent back to the AWR Design Environment software, allowing you to monitor the AMR progress.
The AMR process is broken into three phases:
Phase 1: Ports Only AMR

This step refines the mesh until a converged port solution is obtained. The Ports Only AMR is only relevant to wave
ports, but it executes and converges immediately if only lumped ports are present. The convergence criterion is either
the propagation constant Kz or the characteristic impedance Zc, depending on availability. The AMR Phase 1 (Ports only)
category includes options that affect this step. Typically the defaults are sufficient for this type of solution.
Phase 2: Full Solve AMR

After the "Ports only" AMR terminates, the simulator moves into a full volumetric solve. Here the convergence criteria
is based on the scattering matrix. This criteria computes the maximum change in the magnitude of S (across all AMR
frequencies and all terms in S), or at user discretion, in the magnitude and phase of S. The AMR Phase 2 (Full Solve)
category includes options that affect this step.
Phase 2 also calculates an estimate of the memory needed for the next step. If it determines that further iterations will
cause you to run out of memory, it aborts this phase with an appropriate message and moves to phase 3. You should get
a result if this occurs, but the result is not fully converged, so use it with caution.
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Phase 3: Final Solve

After the "Full solve" AMR terminates, the simulator runs one final solve across all frequencies using the final mesh.
On the structure Options dialog box Analyst tab, the Solver category includes options that affect this step, although many
of the options in this category are also used during the AMR process. The Analyst solver automatically skips this step
if it is unnecessary due to the requested set of frequencies and associated Frequency Modifier option selections in the
AMR categories. If every simulation frequency was used during the AMR process, the final solve is not necessary and
is skipped.
Status Window
The Status Window displays any messages from the solver as the simulation runs. Some of the messages also display in
the Output log. Inconsistencies in the geometry or assumptions that the solver is required to make are listed in the warning
messages. For all simulations, you should view any warning messages listed here to ensure that the setup and geometry
are defined as intended.
In the event of simulation failure, details of the output errors are listed in the Status Window. Errors typically result from
problems in the geometry that the solver cannot automatically resolve, such as improper use of ports or boundary
conditions. These errors should help you determine the cause of the failure so you may correct the problem and restart
the simulation.
Output Log
The Analyst software simulation log shows details about the current state of the simulation, as the calculations are
performed. Most information on the AMR process displays in the run table, which provides an overview of the progress
and current state of the simulation during the AMR sequence. The following is an example run table.

This table represents the middle of an ongoing simulation. The information included is summarized as follows:
•

Iteration: The iteration number and type. The text indicates whether each iteration was a "Ports only" solve, or a "Full

solve".
•

Elements:

The number of mesh elements used to find the solution. Depending on the geometry and materials, this
number may be smaller than the total number of elements in the system. Elements inside metals or in electrically
isolated regions of the geometry do not impact the final solution, and as a result are not used in the FEM calculation.
This value indicates the number of elements that are used in the FEM calculation; so the value is less than or equal to
the number of elements generated in the system.

•

Delta Zc/Kz (0.01):

Either the characteristic port impedance (Zc) or the propagation constant (Kz) is used as a metric
for convergence in the port solve, depending on the port configuration. As the solution converges, the change of Zc
or Kz from one solution to the next decreases. The value in parentheses (here, 0.01) indicates the threshold for
convergence required by the solver. Once Delta Zc/Kz reaches this threshold, the port solution is considered converged
and an asterisk displays next to the value as shown, circled in red.
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•

Delta S (0.001):

The system S-parameters are used as a metric for convergence in the "Full" solve. During the "Ports
only" solves, S is not calculated so the value in this column is "n/a". Once the solver performs the "Full" solves, the
value in this column indicates the change in magnitude S (and also phase S if appropriate) from one iteration to the
next. The value in parentheses (here, 0.001) indicates the threshold for convergence required by the solver. Once Delta
S reaches this threshold, the full solution is considered converged and an asterisk displays next to the value. In this
example, the full solution is not yet converged.

•

Time (min):

•

Peak Memory (MB):

The elapsed time since the start of the simulation, in minutes.

The first value indicates the maximum amount of memory in MB used so far for the simulations.
The value in parentheses indicates the same quantity in terms of percent of allotted memory.

In each new iteration, the results of the previous iteration are used to refine the mesh. Details of the mesh changes are
presented after the run table, showing the number of elements refined or coarsened, and giving the resulting final element
count. This element count indicates the full number of elements in the mesh, including those that do not participate in
the field solve.
After the AMR sequence is complete and the solver is performing the final solve, the Output log shows the progress of
the final solve. The contents of the progress window during the final solve depends on the type of frequency sweep, as
described in “Solver Options”. For both the discrete frequency sweep and the fast frequency sweep, each active process
reports each frequency as it begins processing it. For the fast frequency sweep, this frequency corresponds to f0 in
“Frequency Sweeps”.
Solution Convergence
When a simulation converges, an asterisk displays next to the convergence metric in the run table, as described in the
previous section. The asterisk is a visual indicator that the convergence metric is below the threshold. In the previous
example, Delta Zc/Kz is "0.00939" in Ports only 4, which is lower than the threshold of "0.01". As the solver performs
"Full" solves, you can see that Delta Zc/Kz continues to decrease, indicating that convergence in the port solves is maintained
throughout the mesh refinements in the "Full" solves.
The convergence threshold in the "Full" solves is set to "0.001" in this example. In the four "Full" solves shown here,
Delta S reaches a value of "0.01382", which must decrease by a full order of magnitude before it is considered converged.
At this rate of convergence, you can reasonably expect this simulation to require several more iterations before it converges.

16.9. Viewing Simulation Results
This section describes using simulation data sets, viewing the Analyst structure mesh, adding 3D EM specific annotations,
and controlling visibility based on the assigned EM layer.

16.9.1. Data Sets for Analyst
Data Sets for Analyst software simulation are mostly identical to other simulation data sets. See “Simulation Data Sets”
for details on using simulation data sets. Analyst software simulation is slightly different in that during the simulation
phase, there is data available at each AMR sequence because each sequence produces its own sub-data set. For example,
the data sets display similar to the following figure when a simulation runs or is complete.
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The sub-data set node icons include a "P" to indicate a Port Only AMR sequence. After the simulation is complete, you
can update the data to each sub-data set to see the graph data as well as mesh and any current of field annotations displayed
on the 3D view. This is a good way to view the mesh being refined at each AMR step.
NOTE: The sub-data sets are never saved in the project because they can require significant disk space and are typically
only needed directly after the simulation is complete, to see its progression. They are still available if you close and
reopen the project, however, they are no longer available if you save the project and move it to a new location.

16.9.2. Viewing the Mesh
You can view the Analyst structure mesh in the EM structure 3D view. With a 3D view window active, click the Show
3D Mesh button on the toolbar. If the structure is not previously simulated, an initial mesh is generated.

A "MESH_3D" annotation is added under the EM document in the Project Browser. Double-click the annotation to view
the available options. See “Volumetric 3D Mesh: MESH_3D” for annotation details. Click the Show 3D Mesh button
again to turn off the mesh display. The Layout Manager Visibility by Material/Boundary pane allows you to quickly
show/hide mesh elements by material type and verify that all the material properties are set up as expected.
When you view the mesh before a simulation runs, you see the initial mesh used during simulation. If you keep the 3D
view open with the mesh turned on during simulation, you see the mesh update after each AMR iteration. If you view
the mesh after the simulation runs, you see the final mesh for the structure.
Cut planes are a useful tool when looking at a mesh. One side of the plane shows the mesh, while the other side does
not, and the plane location is easily moved. See “Cut Planes” for details.

16.9.3. Viewing the Fields
The following are 3D EM specific annotations you can add to an Analyst document. See “EM Annotations and Cut
Planes” for details on adding EM annotations.
• EM_FIELD_CUT - Click the Show Currents/Fields button on the toolbar to add this annotation. You can use it to
visualize fields on cut planes. See “EM Field on Cut Plane: EM_FIELD_CUT” for details.
• EM_FIELD_CARPET - Allows visualization of field-based carpet plots. See “EM Field Carpet Plot on Cut Plane:
EM_FIELD_CARPET” for details.
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• EM_FIELD_CONT - Allows surface contour plots to be created. See “EM Field Surface Contours: EM_FIELD_CONT”
for details.
• EM_FIELD_VECT - Allows visualization of field vectors. See “EM Field Vectors: EM_FIELD_VECT” for details.

16.9.4. Viewing Annotations by Material
You can use the Layout Manager Visibility by EM Layer pane to control visibility based on the assigned EM layer. The
Visibility by Material/Boundary pane is useful for selectively viewing boundary condition setup and mesh properties. It
only changes visibility of the 3D view of the structure. The following figure shows this pane.

In this dialog box you can:
1. Click a column header to sort by that column's values.
2. Click a specific color and use the drop-down menu to change the color for that visibility.
3. Click the Visible column next to a material to turn the visibility for that material on or off.
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16.10. Analyst Simulator Operations
This section provides details on Analyst simulator operation.

16.10.1. Basis Sets
The Analyst solver is based on the finite-element method, in which the solution of Maxwell's equations is expanded on
each tetrahedron in terms of basis functions. These basis functions have local support (they are zero outside the element),
and they have unknown amplitude inside the element. These unknown amplitudes are determined by the finite-element
method. Analyst software simulation uses an electric field formulation on hierarchical vector basis functions in tetrahedrons
with flat sides. Each set of basis functions is called a basis set. The basis sets in Analyst software simulation are defined
in terms of the accuracy of the field interpolation expected from each group of basis functions. Included within Analyst
software simulation are basis sets which may represent the field with up to fifth-order accuracy.
Based on historical and academic precedent, the basis set of order x+1 accuracy is designated "hx.5" within Analyst
software simulation, with the interpolation order for the electric field given by x+1, and the interpolation order for the
magnetic field given by x. In general, as you increase x, you obtain higher accuracy in the field solution at the cost of
an increased computational burden in the calculation. The first order, linear basis set consists of six functions, one
associated with each edge in the tetrahedron. This basis set is designated h0.5; it represents the electric field to first-order,
and the magnetic field (obtained by taking the curl of the electric field) to zero-th order. The second order basis set (h1.5,
representing the electric field to second-order and the magnetic field to first-order) contains the six linear functions of
the h0.5 set, as well as 14 additional functions (one for each edge and two for each face on the tetrahedron). This
composition is a characteristic of hierarchical basis sets. Similarly, there are 45 functions in the cubic set h2.5, 84 in the
quartic set h3.5, and 145 in the quintic set h4.5.
Because the number of functions and associated unknowns depends on the basis set, so too do the computer resources
required to solve a problem using the basis set. Generally, the time needed to solve a problem increases in multiple for
each increment in the basis set order. For example, if it takes X seconds to solve a problem using the h0.5 basis set on a
given mesh, it generally takes 5X to 10X to solve on the mesh using h1.5, and 10X to 20X for h2.5. Direct timing
comparisons are difficult as there are other factors that affect run times, such as how fast the AMR process converges,
so the choice of basis set is often made on other grounds. Often the choice is determined by experimentation to discover
what works best on a given class of problem. When in doubt, start with the quadratic h1.5 basis set.
Analyst software simulation includes capacity for hybrid basis sets, in which the accuracy of the basis set may vary
within the mesh depending on the system geometry. These hybrid sets are designated as "cx.5", and they are hierarchical
vector basis sets. They are equivalent to the h0.5 basis set in regions of the model away from conducting corners and
edges, but use higher orders (up to hx.5) basis sets on corners and edges. Hierarchical basis sets generally give solution
accuracies similar to the corresponding hx.5 basis sets, but at a lower computational cost.
Note that, in Analyst software simulation, the basis set for the "Ports only" solve is automatically one order higher than
the chosen "Full" solve basis set. Since the default basis set for the "Full" solve is h1.5 (quadratic), the default for the
"Ports only" solve is h2.5 (cubic).

16.10.2. Frequency Sweeps
Analyst solves for the fields and circuit parameters in the model at a set of discrete frequency points, using either a
separate analysis at each frequency or an asymptotic method that evaluates a set of adjacent points with one analysis.
When performing the discrete frequency analysis, the Analyst solver determines the fields and associated circuit parameters
by solving a separate finite-element problem at each frequency. For each frequency the user-specified number of modes
are extracted at each port using an eigenanalysis of the port, and the finite-element matrix equation is solved once for
each mode at each port. Each resulting solution vector contains both the fields that result from the excitation of the
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corresponding port/mode, and also the associated column in the generalized S-matrix. In a discrete sweep, each frequency
is effectively treated as a separate problem, and as such, discrete sweeps make efficient use of multiple processors since
solving for each frequency can proceed independently.
In addition to discrete analysis, the Analyst solver can compute results at a set of frequency points using an asymptotic
method known as the Galerkin Asymptotic Wave Expansion (GAWE). This technique allows much faster treatment of
problems with a large number of frequencies, where discrete frequency treatment would be prohibitive. Processing
associated with individual GAWE expansion points is independent, so when multiple processors or cluster nodes are
used each can work on a distinct expansion point, which allows for efficient parallel processing. In preparation for a fast
sweep the system analyzes any waveports over the complete frequency spectrum using a subset of the total number of
frequency points and creating expansions that are used in the sweep. The sweep itself initially does discrete solves at the
frequency endpoints and also at a point near the middle of the band. An expansion is done about the middle point and
evaluated/compared at the endpoints to determine if additional expansion points are needed. If the agreement is not good
enough at the low frequency end, then an additional discrete solve/expansion frequency point is added in the interval
below the mid-point, and likewise for the interval above the mid-point. Interval subdivision continues until the solution
is sufficiently accurate over the entire band. Individual expansion points can be solved independently so if multiple
processes are being used, the first three frequency points are done concurrently. After that the number of concurrent
expansions is determined by the process evolution, but generally the more expansion points required, the more parallelism
can be exploited.
To set a particular frequency sweep type, on the EM Options dialog box Analyst tab choose a Sweep Type option. If you
specify the sweep type as Automatic the solver uses either GAWE or Discrete, depending on which is likely to be faster
for the simulation frequency count, port count, and parallel configuration. You can also force the use of one or the other
by specifying it instead of Automatic. GAWE is usually faster than the discrete sweep when the frequency count is large
compared to the number of ports, especially when only a few processors are available. Even with GAWE, however, you
generally do not want to ask for more frequencies than you need, as even for fast sweeps there is an additional
computational burden for each frequency point. GAWE also requires more computer memory than the discrete sweep
because of the need to store matrix expansions and basis vectors. The amount of time it takes for the fast sweep to finish
is a function of the number of ports/modes, since expansions must be formed for each source in the problem.

16.10.3. Low Frequency/DC
The finite-element method used by the Analyst solver is appropriate for high frequencies; it loses accuracy at very low
frequencies. To protect against simulation at frequencies that are too low, the Analyst solver defines a minimum solved
frequency (the default value is 10 MHz) below which it does not apply the finite-element method. You can change the
Minimum Solved Frequency in the EM Options dialog box on the Analyst tab. Adjust this value with care; results for
simulations run at very low frequencies may lose accuracy. If you attempt to simulate at a frequency below the minimum
solved frequency, the Analyst solver extrapolates the results from above the minimum solved frequency using a cubic
polynomial fit. Previous versions of the Analyst solver simply replaced all frequencies below the minimum solved
frequency with the minimum solved frequency. To obtain this behavior, set Extrapolate Toward DC to None. Since the
results below the minimum solved frequency are obtained by extrapolation and not through application of electromagnetic
principles, you should view the low-frequency results with some skepticism. These results are provided for convenience
only and are not intended to provide true physical insight. Nevertheless, if the lowest frequency you request is close to
the minimum solved frequency, the extrapolation often provides good results.

16.11. Advanced Analyst Topics
This section provides details on the higher level functionality of the Analyst simulator.

Simulation and Analysis Guide 16–43

Advanced Analyst Topics

16.11.1. Antenna Simulations in Analyst
You can calculate the radiation patterns of antennas using the Analyst solver, and plot them as a 3D annotation or 2D
graph by adding the appropriate antenna measurement. Antenna pattern is not calculated by default because it adds
simulation time and increases the size of the simulation results stored. This section guides you through the setup to obtain
antenna patterns in Analyst software simulation.
Enabling Antenna Far Fields
Far field patterns are calculated from the fields within the EM structure. Right-click the Analyst structure for which you
want to make antenna measurements and choose Options to display the Options dialog box. On the Analyst tab, under
Antenna Far Fields set Output Frequency to All Frequencies to output antenna patterns at all solve frequencies, to AMR
Frequencies Only to output antenna patterns at the AMR frequencies, or to None to avoid calculating far fields.
NOTE: Outputting the fields results in longer simulation times and significantly larger data sets. To minimize this effect,
be cautious when choosing the frequencies of the EM structure.
Setting the Sphere Sampling Increment
The sphere sampling increment gives the spacing between field solve points on the far field sphere. By default, the sphere
sampling increment for each direction (Theta and Phi) is set to 5-degrees. To override this setting, right-click the Analyst
structure and choose Options to display the Options dialog box. On the Analyst tab, click the Show Secondary button and
change the Sphere Sampling Increment, Theta and the Sphere Sampling Increment, Phi to the desired step.
Boundary Conditions
To obtain antenna measurement results in Analyst software simulations, you must apply radiation boundary conditions
so that energy is not trapped within the enclosure. For best results the domain exterior should be a combination of open
boundary conditions, symmetry planes, and ground planes. It is best to avoid contact between any other structure and
the open boundaries, in general. For the most accurate results you should change any Approx Open boundary condition
to Perfectly Matched Layer. The Analyst solver allows for using both PML and Approx Open boundary conditions in one
structure for general simulations, but when calculating antenna results only one may be used in a geometry. For more
information about the different boundary conditions see “Specifying Simulation Boundaries”. If a boundary is used as
a ground plane for an antenna structure (for example, a patch antenna), then you can set the boundary to proper material
or it can be simulated as a PEC.
You can use the Electric Symmetry boundary condition to lower the number of elements and simulation time of an antenna
structure where there is natural symmetry in the fields. There are limitations on the Electric Symmetry boundary condition,
such as two boundaries that are parallel to one another cannot both be set to this boundary condition. For more information
on the electrical symmetry boundary condition see “Choosing Boundary Conditions”.
Applying Excitation
When you use the Analyst solver for computing far field patterns, the radiating structure should be at least a quarter
wavelength away from the radiation boundary. You need to carefully set up waveport excitation when located on a
boundary. A waveport assigned on an enclosure face overwrites any other boundary condition, including the Perfectly
Matched Layer boundary condition. To avoid this problem you should use internal wave ports. You can also avoid this
problem by creating the antenna using the Analyst 3D Editor and applying the waveport and radiation condition on
different areas of a boundary face. This is illustrated in the following figure where red indicates the waveport at the end
of a coaxial waveguide, and blue denotes PML boundary. In this case it is necessary to assign the waveport to the dielectric
layer. Notice that this designation is impossible using the AWR Design Environment platform Layout Editor because
the waveport would have to occupy the entire enclosure face.
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You can also set up the enclosure so the waveport lies outside, as shown in the following figure. Here, the gold color
indicates the portion of the waveguide that extrudes outside the enclosure face. Since the waveport is no longer coplanar
with the PML, the waveport has been assigned to the center conductor of the coax as is preferred.

Simulation and Analysis Guide 16–45

Advanced Analyst Topics

Setting up an Antenna Measurement
When plotting an Antenna measurement (for Measurement Type, choose Electromagnetic > Antenna) for an Analyst
structure, ensure that the Sweep Freq is set to FSAMP as shown in the following figure.
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NOTE: If you set up the measurement before the structure is simulated, the frequency list for FSAMP does not contain
the frequencies specified for the antenna measurements. If you set up the measurement after the structure is simulated,
FSAMP contains the specified field output frequencies and is initially set to the first frequency in the list. Also, for Analyst
antenna measurements, you must select the Use Interpolated Data check box.
For information on a particular measurement, click the Meas Help button on the Add/Modify Measurement dialog box.

16.11.2. Loss Model for Conductor Surface Roughness
Analyst software simulation can model the loss effects of conductor surface roughness for both thick and thin metal.
Surface roughness is specified as a material property in the same manner as for AXIEM simulation. See “Loss Model
for Conductor Surface Roughness” for details.
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Chapter 17. EM: External Solvers
The Cadence® AWR Design Environment® platform supports the automated flow of layout data from AWR Design
Environment software into external solvers. Supported solvers include Cadence Clarity™ 3D Solver, Cadence EMX®
Planar 3D Solver, and Cadence Celsius™ Thermal Solver.

17.1. Configuring External Solvers
Follow the standard installation procedure for installing external software. To connect the AWR Design Environment
software to the external simulator:
1. In the AWR Design Environment platform choose Tools > Configure External EM Solvers to display the Register External
EM Solvers dialog box.

2. Click on the name of the desired solver and then click the Register button. Note that the check boxes indicate registration
status; they are not interactive.
3. In the following dialog box, select the version of the simulator to which you are connecting, then click OK to close
the dialog box.
4. Click OK to close the Register External EM Solvers dialog box, and restart the AWR Design Environment program.
Only one connection to an external solver is allowed at any time. Repeat the preceding procedure to switch to another
version.
To remove the connection to the external software:
1. In the AWR Design Environment platform choose Tools > Configure External EM Solvers to display the Register External
EM Solvers dialog box.
2. Select the external solver you want to disconnect and then click the Unregister button.
3. Click Yes in the dialog box that displays to confirm deletion of the external schema.xsd file.
4. Click OK to close the Register External EM Solvers dialog box and restart the AWR Design Environment program.
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17.2. Creating and Simulating Documents
The method for creating and editing EM structures is the same for external solvers as it is for Cadence AXIEM® 3D
planar EM and Cadence Analyst™ 3D FEM EM solvers in the AWR Design Environment platform. Geometry
simplification rules are also applied to external solver documents. When creating a new EM structure, simply select the
external solver as the simulator. You can simulate from the AWR Design Environment platform, and data sets are returned
to it.
You can use extraction with external solvers. The general procedure for extraction is detailed in “Extraction Setup Basics”,
and the general procedure for 3D EM extraction is detailed in “3D EM Extraction”.

17.2.1. Clarity 3D Solver
The AWR Design Environment platform connection to the Clarity 3D Solver enables EM structures created in the AWR
Design Environment platform to be simulated with the Clarity 3D Solver, with simulation results returned to the AWR
Design Environment platform as simulation data sets.
Creating and simulating with the Clarity 3D Solver is similar to creating an Analyst EM document. The procedure for
drawing finite dielectrics and resolving material priority with overlapped shapes is the same for both simulators. See
“Drawing Shapes in EM Structures” for details on using the EM Editor.
Geometry simplification using shape pre-processing rules is also supported for the Clarity 3D Solver, and you can use
Preview Geometry to visualize the simplified geometry in the AWR Design Environment platform EM Editor. Viewing
geometry in the Native Editor is also supported to allow viewing/validating/debugging/post-processing in the Clarity 3D
Workbench layout editor.
Simulation data sets are automatically returned to the AWR Design Environment platform and contain S-parameter
results, mesh, original input geometry, translated geometry, and simulation logs from the Clarity 3D Solver.
All 3D pCells supported by Analyst 3D FEM EM analysis are also supported by the Clarity 3D Solver.
Ports
The following configurations are not supported:
• Wave ports
• Waveguide ports
When converting a document from a solver that supports auto ports to the Clarity 3D Solver, auto ports are converted
to lumped ports with explicit ground reference. Group settings (serial/mutual) on ports are ignored. Ports on boundaries
are supported.
Hierarchy
The AWR Design Environment platform EM Editor supports using EM subcircuits to create hierarchical EM structures.
See “Working with Hierarchy” for details. The Clarity 3D Solver supports EM hierarchical EM structures in the same
manner as the Analyst tool does.
Viewing Geometry in Clarity
In the Project Browser, right-click the Clarity EM document and choose Open in Native Editor to view the converted
geometry in Clarity 3D Workbench. This command is used only for viewing geometry before or after simulation. You
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should not edit the geometry in the Clarity 3D Workbench layout editor as edits are not saved back to the AWR Design
Environment platform.
Running the Clarity Solver
Clarity EM structures simulate the same way that Analyst EM structures simulate in the AWR Design Environment
platform. After creating or editing a structure, simulate by clicking the Analyze button on the Standard toolbar, or by
choosing Simulate > Analyze. Right-click an EM document in the Project Browser and choose Simulate to simulate only
the selected document.
Running the Clarity Solver Remotely
Similar to Analyst 3D FEM EM and AXIEM 3D planar EM simulation, remote simulation with the Clarity 3D Solver
is supported by the AWR Design Environment Job Scheduler. Real-time status feedback from the Simulation Status
dialog box is also supported, and remote simulation via VPN is supported as well. See “Utilizing Remote Computing”
for details on how to set up and use the Job Scheduler for remote computing. The Clarity 3D Solver is installed on the
remote computer using standard installation procedures. Remote Clarity 3D Solver simulation is only supported for the
Windows operating system. Support for the Linux operating system is for future implementation.

17.2.2. EMX Planar 3D Solver
The AWR Design Environment platform connection to the EMX Planar 3D Solver is a limited release feature which
enables EM structures created in the AWR Design Environment platform to be simulated with the EMX Planar 3D
Solver, with simulation results returned to the AWR Design Environment platform as simulation data sets.
EMX Setup
Creating and simulating with the EMX Planar 3D Solver is similar to creating an AXIEM EM document with the additional
requirement that the EMX document is initialized from a PDK STACKUP that was generated by importing a Virtuoso
PDK using the Cadence Unified Library Import Wizard. The STACKUP should have the paths specified for the EMX
process file (*.proc) and layer map file (*.layermap) in the EmxProcProps and OalayerMapProps parameters on the
Parameters tab. See “Drawing Shapes in EM Structures” for details on using the EM Editor.
EMX Restrictions
EMX Solver limitations:
• GDSview is not supported.
• EMX RLGC mode is not supported.
• EMX modelgen is not supported.
• Simulation of Microwave Office GaAs and GaN PDKs is not supported.
• Port de-embedding and reference plane shifting is not supported.
Unsupported models:
• Vias that are not covered by conductor on top and bottom.
• Metal conductors that abut each other.
• Microwave Office style internal ports.
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Running the EMX Solver Remotely
Similar to Analyst 3D FEM EM and AXIEM 3D planar EM simulation, remote simulation with the EMX Planar 3D
Solver is supported by the AWR Design Environment Job Scheduler. Real-time status feedback from the Simulation
Status dialog box is also supported, and remote simulation via VPN is supported as well. See “Remote Linux Simulations”
for details on how to set up and use the Job Scheduler for remote computing. You can download the EMX Planar 3D
Solver from the Cadence Downloads site and install it on the remote computer using standard Installscape installation
procedures. Remote EMX Planar 3D Solver simulation is only supported for the Linux operating system.

17.2.3. Celsius Thermal Solver
The AWR Design Environment platform connection to the Celsius Thermal Solver enables EM structures created in the
AWR Design Environment platform to be simulated with the Celsius Thermal Solver, with temperature results returned
to the AWR Design Environment platform.
The creation of a Celsius Thermal Solver document is similar to creating an Analyst 3D FEM or Clarity 3D Solver EM
structure. The Celsius Thermal Solver is listed as a simulator option when creating a new EM document. The Celsius
Thermal Solver is also listed as a simulator option on the EM EXTRACT block.
Viewing geometry in the Native Editor is also supported to allow viewing/validating/debugging/post-processing in the
Celsius 3D layout editor.
Simulation data sets are automatically returned to the AWR Design Environment platform and contain temperature,
mesh, original input geometry, translated geometry, and simulation logs from the Celsius Thermal Solver.
Celsius Setup
NOTE: Download the "Microwave Office + Celsius Thermal Simulation" Rapid Adoption Kits (RAKs) available from
Cadence Online Support for additional details.
The following are additional setup requirements for the Celsius Thermal Solver:
1. A thermal drawing layer(s) using the "HEAT_" naming convention
• These layers identify where to apply the power dissipation. See “Drawing Layers and Model Layer Mapping” for
details on how to add drawing layers.
2. A thermal power table to set how much power to apply to the thermal drawing layer(s). The table can be manually
added or automatically generated from a simulation.
• To manually add a thermal power table, add a new text data file. Enter the thermal power table in the data file. Add
a row for each unique thermal drawing layer. The first column is the thermal drawing layer name and the second
column is the power dissipation in watts. Multiple instances of the same drawing layer name in a layout only need
one row for the drawing layer name and power dissipation. If you need a different power level, add another drawing
layer.
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• To automatically generate the thermal power table, use the TOT_PWRF output files measurement. Select the Write
into Project Data Files check box to write the thermal power table into a data file. The table is generated for one
specific frequency and RF power level.

• On the Celsius EM Structure Options dialog box Celsius tab, specify the Thermal Power Table name.

3. A thermal boundary condition for the bottom boundary
• On the Celsius EM Structure Options dialog box Celsius tab, specify the bottom boundary temperature in C for the
BC Temperature.
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4. A thermal materials properties file.
• The thermal materials property file is either specified as a path to the file, or imported as a data file and specified
by the data file name.
• When specifying the path to a thermal materials property file, use a relative path if using a PDK or an absolute path
to the materials.cmx file.
• You can specify the materials.cmx file either on a STACKUP element used to initialize the Celsius EM structure,
or directly on the Celsius EM structure itself.
• To specify the thermal materials property file on the STACKUP element, open the STACKUP Element Options
dialog box. On the Parameters tab, specify the data file name or path to the local materials.cmx file for the
ThermalMatProps parameter.
• To specify the path on the Celsius EM structure, double-click the Enclosure node under the EM structure in the
Project Browser to display the Element Options dialog box. On the Parameters tab, specify the data file name or
path to the local materials.cmx file for the ThermalMatProps parameter.
Hierarchy
The AWR Design Environment platform EM Editor supports using EM subcircuits to create hierarchical EM structures.
See “Working with Hierarchy” for details. The Celsius Thermal Solver supports hierarchical EM structures in the same
manner as the Analyst and Clarity 3D Solvers do. Utilizing EM hierarchy makes it easy to simulate a chip on package
by creating the package in a separate EM structure from the chip EM structure and combining them in a Celsius EM
structure.
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Running the Celsius Solver
Celsius Thermal Solver structures simulate the same way the Analyst tool EM structures simulate in the AWR Design
Environment platform.
To simulate a Celsius Thermal Solver structure after creating or editing the structure:
1. Click the Analyze button on the Standard toolbar, or
Choose Simulate > Analyze, or
Right-click the Celsius EM structure in the Project Browser and choose Simulate to simulate only the selected document.
In the dialog box that displays, enter the name for the simulation data set or use the default name.
2. Right-click the Celsius EM structure in the Project Browser and choose Open in Native Editor. From the Celsius menu,
choose Simulation > Operation > Start. After the Celsius simulation is complete, expand the Results node in the Project
Browser. Right-click on Field-Plot and choose Field Plot to see the 3D thermal temperature distribution. Select the
Structure check box to see temperatures for all of the materials. Click the "X" in the upper right corner to close the
Celsius native editor and send all material temperatures to the AWR Design Environment platform.
Running the Celsius Solver Remotely
Similar to Analyst 3D FEM EM and AXIEM 3D planar EM simulation, remote simulation with the Celsius Thermal
Solver is supported by the AWR Design Environment Job Scheduler. See “Utilizing Remote Computing” for details on
how to set up and use the Job Scheduler for remote computing.
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Appendix A. Advanced Analysis Topics
This appendix includes advanced analysis topics for users who want more detailed information on these methods.

A.1. Load Pull
A.1.1. Simulated Load Pull
Simulated load pull functionality supports the AWR multi-dimensional A/B Wave load pull file format. Variable sweeps
(for example; input power, bias, or frequency) are controlled via the Load Pull Template schematic. For more information
see “Load Pull Script”.

A.1.2. Using Load Pull Files
Several load pull file formats encompassing both swept and non-swept data are supported. You can import all of these
file types using the Scripts > Load Pull > Import_Load_Pull_File script. This file supports the following file types:
• Swept load pull formats
• *.cst
• *.spl
• *.lpc
• *.mdf, *.mdif (“A/B Wave Format”)
• Non-swept load pull formats
• *.sp
• *.lp
• *.lpd

A.1.3. Load Pull File De-embedding
The Cadence® AWR Design Environment® platform supports applying a de-embedding network to the output pin of a
load pull file DUT, allowing the data reference plane to be moved to either side of the specified de-embedding network.
For example, moving from an external device pin, through a package model, to an internal device pin. The de-embedding
is done at the load pull data file level so all measurements applied to that document show the de-embedded result. See
“Project Options Dialog Box: Interpolation/Passivity Tab ” for details on configuring the de-embedding network.

A.1.4. Using Load Pull Measurements
Load Pull measurements are often more easily visualized through a marker-defined reference, allowing the coupling of
measurements together and quickly parsing through the individual sweeps. For information on setting up a marker-defined
reference, see “Using a Marker to Define a Sweep Index”.
Load Pull measurements are differentiated by a naming convention that separates swept and non-swept based measurements.
The measurement names are interpreted as follows:
• Swept Load Pull measurements are prefixed with "G_", while non-swept measurements have no prefix.
• Measurements that align data to a specified value end in “A”.
• Measurements that plot a single value contain “_V”.
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• Measurements that plot a real value contain “_R”.
• Measurements that plot a complex value contain “_C”.
The following is a list of commonly used measurements:
• For plotting contours
•

Load_Pull > “Generalized Load Pull Contours: G_LPCM”

plots contours

•

Load_Pull > “Generalized Load Pull Contours Aligned to a Value: G_LPCM_A”

plots contours aligned to a specified

value (for example: 1 dB compression)
•

Load_Pull > “Generalized Load Pull Contours from Combined Values: G_LPCM_C2” plots the intersection between two

contours
• For plotting contour interpolated min or max value
•

Load_Pull > “Minimum Value for Generalized Load Pull Data: G_LPCMMIN”

•

Load_Pull > “Max Value for Generalized Load Pull Data: G_LPCMMAX”

plots the contour min value

plots the contour max value

To plot a single contour at a specified value
•

Load_Pull > “Generalized Load Pull Contours at Specified Value: G_LPCM_V” plots a single contour at a specified value

• For plotting all the gamma points in your load pull file
•

Load_Pull > “Plot Load Pull Gamma Points from Measured Load Pull File: G_LPGPM”

plots gamma points for a swept

load impedance
• For plotting swept data on a rectangular plot (like PAE vs. output power)
•

Data > “Plot Real Data from Multi-dimension MDIF File: PlotMD_R ”

plots real data with a derived value chosen for the

x and y axis in the measurement setup
For measurement details, click the Meas Help button in the Add/Modify Measurement dialog box.

A.2. APLAC HB Simulator Convergence
When working on convergence problems, you need to change Cadence APLAC® HB simulator settings. You can set
simulator-specific settings globally (choose Options > Default Circuit Options) or locally for each schematic (right-click
a schematic in the Project Browser and choose Options, and for each option tab you can clear Use project defaults to
override the global options.)
APLAC simulator settings are controlled on the Circuit Options or Options dialog box APLAC Sim tab as shown in the
following figure.
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The dialog box splits the simulator settings into Common Simulator Options, and APLAC Simulator Options. Select an
option to view additional information about it in the lower window of the dialog box.
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Always begin with default settings, as these are most commonly successful. If you copy an existing project as a starting
point for a new one, the new project may "inherit" simulator settings that are inappropriate for your new design(s).

A.2.1. DC Analysis
DC convergence problems are very rare as various approaches are taken to achieve DC convergence.
A common problem arises when using S-parameters for models that do not have a DC point defined, and the simulator
must extrapolate to DC. You can try to change the extrapolation settings. Choose Options > Project Options and click the
Interpolation/Passivity tab. You can try Rational function as the interpolation method or switch between Polar and Cartesian
coordinate systems.

A.2.2. APLAC Harmonic Balance
Harmonic balance can have convergence problems in some cases. If this occurs you can use the following steps to try
to help the circuit converge.
1. Ensure that all nodes of every element are connected.
• You can inspect your circuit visually or use the Design_Checker script to check for you.
• To access the Design_Checker script choose Scripts > Project > Design_Checker and configure the settings as follows.
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2. Change the HB Matrix Solver to Sparse or GMRES (whichever is not currently selected).

3. The default HB Algorithm setting is Auto select, which analyzes the circuit topology and then uses either Piecewise or
Nodal. You can switch to each of these settings specifically to see if it helps.
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4. Use a power sweep. Instead of using power levels that force the circuit into strongly nonlinear modes of operation
with a port set to a single power, use a port that sweeps power from a small signal region of operation into the strongly
nonlinear region.
5. Try changing the Maximum Voltage or Current Change parameter to "1e6" or decreasing it to "1e-3".

6. Use transient assisted harmonic balance by selecting the Transient Assisted HB check box.
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7. Answer these simple questions to help determine why the simulator is not converging:
• Are your models valid at the highest frequency at which harmonic balance needs to simulate, at the highest tone
product specified by your number of tones and highest tone order? One way to check is to make a plot of Pharm
of a simple circuit (maybe just a resistor) to see the highest frequency the simulator needs.
• If you have an APLAC Transient simulator license, use it with enough periods to reach steady state to see if the
answers look reasonable in that simulator. If the answers don't look good, it could signal that there is a model
problem.

A.3. APLAC Transient Simulator Convergence
When working on convergence problems, you need to change APLAC simulator settings. You can set simulator-specific
settings globally (choose Options > Default Circuit Options) or locally for each schematic (right-click a schematic in the
Project Browser and choose Options, and for each option tab you can clear Use project defaults to override the global
options.)
APLAC simulator settings are controlled on the Circuit Options or Options dialog box APLAC Sim tab as shown in the
following figure.
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The dialog box splits the simulator settings into Common Simulator Options, and APLAC Simulator Options. Select an
option to view additional information about it in the lower window of the dialog box.
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Always begin with default settings, as these are most commonly successful. If you copy an existing project as a starting
point for a new one, the new project may "inherit" simulator settings that are inappropriate for your new design(s).

A.3.1. DC Analysis
DC convergence problems are very rare as various approaches are taken to achieve DC convergence.
A common problem arises when using S-parameters for models that do not have a DC point defined, and the simulator
must extrapolate to DC. You can try to change the extrapolation settings. Choose Options > Project Options and click the
Interpolation/Passivity tab. You can try Rational function as the interpolation method or switch between Polar and Cartesian
coordinate systems.

A.3.2. Transient Analysis
Transient analysis can have convergence problems in some cases. If this occurs you can use the following steps to try
to help the circuit to converge.
1. Change the truncation error method by changing the Truncation Error Mode to either Voltage or Charge.
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2. Change the integration method by changing Integration Method to either Euler or Gear.

3. Try increasing the Maximum Voltage or Current Change parameter to "10 ... 100" or decreasing it to "0.5".
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4. Change the Step time under Transient Options to smaller or larger time steps.

5. Use fixed time steps by changing Time Stepping to Fixed and specifying the fixed step size by typing "TMIN" in Free
Text under Miscellaneous Options; otherwise the Step time under Transient Options is used.
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6. Answer these simple questions to help determine why the simulator isn't converging:
• Are there potentially bad component values (for example, unrealistically large capacitors or inductors)? For example,
for a DC block, you could use a very large capacitor (such as 1 mF) for harmonic balance and it simulates correctly.
For transient analysis, this large capacitor causes problems.
• Are there short transmission lines in the circuit that limit the time step? Can you replace these with RLC networks?
The lines might be inside models so you may need to check the input netlist.
• Are there huge voltages in your design? If so, you may need to increase Maximum Voltage or Current Change.
• What does HB say about the circuit? If the answers do not look correct, this could signal a model problem.

A.4. HB Simulator Convergence
Convergence failures, though rare, are usually a consequence of very strongly nonlinear circuit behavior. In such cases,
one difficulty encountered by the simulator is a lack of a "good guess" at the solution. Some of the common causes for
convergence failure are circuit instabilities, too few frequency components, discontinuities in nonlinear device modeling,
and too few simulation iterations.
Some of the most common messages in the Status Window are "Simulation only partially completed" and "Step size for
source stepping has decreased below a minimum allowed value". The following figure shows an example warning
message for a circuit that has failed convergence.

The following section is a generic procedure for finding convergence problems. These are basic guidelines based on
Cadence AWR experience.
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A.4.1. Circuit Operation Checks (Not changing simulator options)
1. Simulate a DC annotation to test if the circuit is converging at DC, and to provide a check for the proper operating
condition of your circuit (for example if you accidentally specified 50 volts for the supply voltage instead of 5 volts).
See “Creating a New Annotation” for information about adding an annotation.
2. Simulate at low input levels (for example, -30 dBm for power, 1mV) to see if you get a solution at low powers.
3. If the previous step works, try sweeping your input source. Many times a circuit converges better if you sweep from
a low input level to a high power rather than just setting a high input level.

A.4.2. Harmonic Balance Settings Options
1. Verify whether your Harmonic Balance settings use the project default settings or are set at the schematic level.
Right-click the top level schematic in the Project Browser, choose Options and then click the appropriate simulator
tab in the Options dialog box. If Use project defaults is selected in the Harmonic Balance Options section, the schematic
uses the project settings. You can access project settings in the Circuit Options dialog box (choose Options > Default
Circuit Options).

2. In Iteration Settings, increase the Max iterations to 100 or 200 and see if it helps. For strongly nonlinear circuits you
may need to set this value higher. Another way of increasing the number of iterations is by increasing the number of
sweep steps. For example, a power sweep from -20 db to 20 db in steps of 1 db is more likely to converge than that
with steps of 5 db.
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3. Increase the number of harmonics. If the circuit you are analyzing is strongly nonlinear, it is important for both
accuracy and convergence to specify a sufficient number of frequencies in the simulation. This is the first step in
troubleshooting convergence problems.
4. Add a small conductance across the nonlinear elements. Choose Options > Default Circuit Options and on the Circuit
Options dialog box AWR Sim tab under Convergence Aids verify your results are correct.

5. Also under Convergence Aids, remove voltage limiting by clearing the Limit step size check box.
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6. Use a predefined set of convergence settings. In many cases selecting some of these predefined convergence settings
along with tolerance settings helps the circuit to converge. If the circuit always needs to source step, you can speed
up the simulation by selecting Start with source stepping under Configuration Wizard.

7. Under Advanced HB Options, select any linearization method along with a degree of tolerance to speed up the
convergence in Linearization Mode and Linearization Tolerance.

8. Change the simulation accuracy. The simulation terminates when the absolute current error at each nonlinear element
and at each harmonic is below Absolute Tolerance, or when the Relative Tolerance criterion is satisfied. The default
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value of Absolute Tolerance is "1e-9" and sometimes this number is very low for highly nonlinear circuits. You can
increase this number to a value such as "1e-7" while leaving Relative Tolerance as is.

A.5. Stability Analysis Methods
The standard method for checking the stability of an active two-port is to use the stability factors K and B1 or some other
measure of stability.
Although these measures are useful for analyzing the stability of a two-port, there are many situations where the satisfaction
of the standard criteria for stability (K and B1) do not guarantee that the circuit is stable. Cadence Microwave Office®
software offers some alternative stability analysis techniques to reduce the likelihood of an unstable design.
CAUTION: Stability analysis methods try to prove a negative-- the absence of instability. No one method, or even
collection of methods, can guarantee stability. Cadence does not claim that the following approaches find all stability
issues. You should consider all stability analysis approaches.
The following table displays at a glance the characteristics of various stability analysis techniques.
K, Mu

NDF

Stability
Envelope

Loop Gain Loop Gain STAN
Envelope

Modified
Gamma
Probe

Multiple-device
compatible?

No

Yes

Yes

Yes

Yes

Yes

Yes

Stability Margin

No

No

No

Yes

Yes

No

No

Nonlinear?

No

No

No

Yes

Yes

Yes

Yes

Fast?

Yes

No

Yes

No

Yes

No

No

Easy to use?

Yes

Yes

Yes

Yes

Yes

No

Yes/No

Root cause analysis?

Yes

No

No

Yes

Yes

Yes

Yes
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K, Mu

Works with all models? Yes
*internal nodes must be
exposed

NDF

Stability
Envelope

Loop Gain Loop Gain STAN
Envelope

Modified
Gamma
Probe

Yes

Yes

*No

Yes

*No

Yes

A.5.1. Normalized Determinant Function (NDF) Analysis
Two examples of circuits where K and B1 do not detect instability are described in the article by Platzker and associates.
1
The article demonstrates how NDF detects the instability of these circuits (NDF finds poles in the right half plane).
The basics of NDF analysis in the Microwave Office program are:
• NDF analysis is only available with the APLAC simulator, so all models must function with APLAC.
• NDF is a complex measurement vs. frequency at schematic load impedance. It must be measured over a very wide
frequency range ("DC to daylight"). At low frequencies and as the frequency approaches infinity, NDF is real. The
circuit is unstable if the measurement circles the origin of a polar grid more times clockwise than counter-clockwise;
i.e. if the change in the unwrapped phase (AngleU) of the NDF measurement (from near DC to approaching infinity)
decreases by more than 360 degrees.
• For optimization, use Output Equations to calculate the difference between the initial and final values of AngU(NDF),
and set a goal for this value to be less than 360 degrees.
• IMPORTANT: Like other measurements, the frequency sweep for NDF is set on the schematic, or in the project
options, so it is "fixed", not adaptive. You should set the frequencies to ensure that the measurement is well resolved,
and encirclements of the origin can be detected for each simulation, even over parametric sweeps and optimization.
The most efficient frequency sweep may involve varying step sizes over different frequency ranges. For this reason,
it is usually best to have a separate frequency sweep for the NDF measurement. There are two ways to do this:
• Create a new top level schematic with its own frequencies for the NDF measurement, and place the circuit of interest
in it as a subcircuit.
• Add a FRQSWP block, and set its Values parameter to an equation that concatenates multiple sweeps together. (See
the table at “Built-in Functions ”). The frequencies are automatically collated for simulation.
• To function properly, NDF needs to identify individual dependent (voltage- or current-controlled) sources in the circuit.
• Active S-parameter files, or compiled linear models with controlled sources inside them do not allow this and are
therefore not included in the measurement calculation.
• Non-ideal controlled sources like VCCS (Voltage Controlled Current Source) do not work either. Use ideal controlled
sources, like VCCS_IDEAL.
• The schematic on which NDF is measured must include a PORT element. If the schematic is drawn with the (source
and) load impedances represented by other elements, you need to place a PORT element anywhere on the schematic,
without anything connected to it.

A.5.2. Stability Envelope Analysis
The basics of stability envelope analysis are:
• Stability envelope analysis is only available with the APLAC simulator, so all models must function with APLAC.
1

A. Platzker, W. Struble, and K. Hetzler, “Instabilities Diagnosis and the Role of K in the Microwave Circuits,” IEEE MTT-S International Microwave
Symposium Digest, pp. 1185–1188, 1993.
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• APLAC simulation computes the envelope of the NDFs corresponding to all possible passive source and load impedances
at the ports.
• StabEnv is the complex envelope of the NDFs corresponding to all possible passive source and load impedances at
the ports. The circuit is stable if, at each frequency, StabEnv does not circle the origin of a polar grid (if the unwrapped
phase (AngleU) of the measurement has a range of less than 360 degrees).
• For optimization, use Output Equations to calculate the difference between the maximum and minimum values of
AngU(StabEnv), and set a goal for this value to be less than 360 degrees.
• The number of points used to approximate the impedances is set by choosing Options > Default Circuit Options to display
the Circuit Options dialog box. Click the APLAC tab and under Stability in StabEnvelopePoints, increase this number
to ensure the measurement is well resolved, and encirclements of the origin can be detected for each simulation, even
over frequency/parametric sweeps and optimization.
For more information see the following source: T. Narhi and M. Valtonen, “Stability Envelope - New Tool For Generalized
Stability Analysis,” IEEE MTT-S International Microwave Symposium Digest, pp. 623–626, June 1997.

A.5.3. Loop Gain
The complex loop gain of a feedback network, such as an amplifier, can be used to check for instability. When loop gain
is all real (angle=0) and greater than 1, the circuit is unstable. The LoopGain and NLLoopGain measurements calculate
small-signal (linear) loop gain under DC bias or large-signal drive conditions, respectively. These measurements work
without modifying the design, by accessing the internal controlled source of nonlinear transistor models. Consider the
following linearized model for a FET transistor:
Cgd

Lg

Ld

+
Vgs

Cgs

gm*Vgs

Rds

Cds

-

Ls

Loop gain measurements internally break the feedback loop that includes this transistor by replacing the controlling
voltage of the transconductance gm with a test signal, Vin, and measuring the resulting output voltage, Vgs, where the
controlling voltage should be:
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Cgd

Lg

Ld

+
Vout

Cgs

gm*Vin

Rds

Cds

-

Ls

The loop gain is defined as the voltage gain Vout/Vin. All the other measurements see the unmodified circuit, allowing
other measurements to work normally for the same schematic. You are required to point to the place in the circuit where
the feedback loop is broken by selecting an internal branch of a nonlinear device as the Measurement Component in the
Add/Modify Measurement dialog box. For example, the CURTICE nonlinear FET model has three internal branches:
"ds", "gd" and "gs". The drain-source branch "ds" is a good place to break the loop for a FET amplifier. Note that the
feedback loop can be formed by internal elements like Cgd in the previous example, by external elements like biasing
networks, or both.
To add a loop gain measurement, begin by selecting the appropriate top level schematic as the Data Source Name. To
identify the internal branch of a nonlinear transistor model as a Measurement Component, click the browse button ("...")
as shown in the following figure:

See “Measurement Location Selection” for information on using the window that opens to navigate hierarchy and open
the subcircuit schematic (or netlist) containing the desired transistor. Next, select the appropriate branch of that transistor
as the Testpoint. For example, select the collector-emitter branch of the BJT model in a subcircuit netlist, as shown in
the following figure.
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LoopGain measurements are only possible if the selected transistor exposes its internal branches, so that the
transconductance branch can be selected. Some transistors do not expose these branches so therefore cannot be used for
a LoopGain measurement.
Non-ideal controlled sources like VCCS (Voltage Controlled Current Source) cannot be used as a Measurement Component.
When needed, use ideal controlled sources, like VCCS_IDEAL.
LoopGain and NLLoopGain Measurements
The linear LoopGain measurements work as described in “Loop Gain”. As with any linear measurement on a nonlinear
circuit, an initial DC bias analysis is performed to determine the operating point of all nonlinear devices. This allows the
nonlinear transistors to be linearized (represented by an equivalent linear network like the one shown previously), so
that a LoopGain measurement can be made using a linear small-signal analysis. For more information see “Loop Gain:
LoopGain”.
NLLoopGain is a nonlinear extension to LoopGain that takes into account the large-signal drive of the circuit. First, the
nonlinear steady-state solution of the circuit is determined with Harmonic Balance. The circuit is linearized at this
operating point and the feedback loop is broken at a user-specified point. Next, a linear small-signal analysis is performed
to compute the loop gain. NLLoopGain measurements require that an NLSTABILITY control element be placed in the
schematic, and can only be used with the APLAC HB simulator. For more information see “Nonlinear Loop Gain:
NLLoopGain”.

A.5.4. Microwave Office Approach to Internal Stability Analysis
Another example of the K and B1 requirements not ensuring stability is that of a two-stage amplifier. K and B1 may
indicate the amplifier is stable, but it is still possible for the amplifier to be unstable due to oscillation conditions that
may exist between the two amplifier stages. This "internal" instability in the interstage of the amplifier may not be
detectable by a simple measure of K and B1 of the entire amplifier.
One approach to solving this problem is to make each device unconditionally stable before adding the matching. This is
usually accomplished by adding lossy matching or feedback to the potentially unstable device. Although this may work,
there are a drawbacks to this approach.
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The first drawback is that it does not guarantee that the amplifier remains stable if there is any amount of feedback
between the two stages. Although there is usually not any intentional feedback between the stages, there is often
unintentional feedback that arises from the bias circuitry that may be connected together with less than ideal isolation.
A thorough stability analysis should attempt to include the bias network as part of the analysis. The standard K and B1
stability factors do not detect instabilities caused by this type of feedback.
The second drawback is that the addition of the lossy matching (or feedback) usually reduces the performance of the
device significantly. If a more thorough technique is used to analyze the stability of the interstage circuitry, then it is
usually possible to get much better performance from the same devices with an acceptable margin for stability. One such
method for predicting internal stability is presented in an S-probe article.2. This method requires the measurement of
internal reflection coefficients within the circuit, and it also requires the ability to analyze the circuit with arbitrary
termination impedances.
Microwave Office software has several unique features that greatly simplify the analysis of the internal stability:
• An element for sampling the internal reflection coefficients at internal nodes in a circuit.
• The ability to terminate any port with an arbitrary reflection coefficient (not restricted to two ports).
• Built-in measurements that compute the stability without needing to use output equations.
Internal Stability Background
Some background information on internal stability is useful for understanding the analysis method. The following figure
shows two networks connected together. The network on the left has S-parameters [S] and the network on the right has
S-parameters [S']. The lower part of the figure shows a portion of the signal flow graph that includes the interface between
the two networks. The use of a signal flow graph allows the stability to be analyzed using the same techniques as those
used for analyzing the stability in control systems.3

You can determine the stability of the previous system by viewing the loop in the signal flow graph as a feedback loop.
This allows the Nyquist stability criteria to be applied to the open loop frequency domain response given by
G=-Γ1Γ2

(A.1)

The Nyquist stability criteria states that if the open loop function G, when plotted on the complex plane, encircles the -1
point in the clockwise direction, then the closed loop system will be unstable. The following polar grid of G shows an
unstable system (G encircles the -1 point in a clockwise sense).

2

Wang, K., Jones, M., Nelson, S., "The S-Probe. A New, Cost-Effective, 4-Gamma Method for Evaluating Multi-Stage Amplifier Stability", IEEE MTT-Symposium
Digest,1992, p. 829-832.
3
Truxal, J. "Introductory Systems Engineering", McGraw Hill, 1972.
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The Microwave Office STABN_GP2 measurement allows the function G to be plotted on a polar grid for inspection of
the stability. When plotting STABN_GP2, the frequency should be swept over the entire range where instability could
occur.
An approximate simplification of the Nyquist stability criteria allows the computation of a single stability index that can
be plotted as a single real number over frequency. The use of a real stability index makes it easier to include internal
stability as an optimization goal.
The meaning of the stability index is shown in the following figure.

The stability index is taken to be the negative of the component of G along the real axis. A value of the stability index
greater than 1 is then used to indicate possible instability. The term "possible" is used because it is possible for the stability
index to be greater than 1 without an encirclement of the -1 point, as shown in the following figure.

Although the stability index may indicate instability when the device is actually stable, it is still a very useful measure
in practice since it does not predict that the circuit is stable when the Nyquist criteria indicates that the circuit is not stable
(it is a conservative measure). Usually if the stability index predicts that a stable circuit is not stable, then margin of
stability for the circuit is not very high (minor changes in the response could cause instability). Also, if the stability index
predicts an instability, then the more rigorous Nyquist criteria can be used to verify the instability. The stability index
indicated here is the same as the stability index presented in an S-probe article.2. You can use the Microwave Office
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STAB_GP2 measurement to plot this stability index (STAB_GP2 <1 indicates stability). For more information see
“(Obsolete) Stability Index Measured with Gamma-Probe: STAB_GP”.

A.5.5. Performing Internal Stability Analysis
The following schematic shows the GPROBE element inserted into the schematic at an internal node where the stability
is to be analyzed.
Gamma 1
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GA=76.875Deg

Gamma 2

TLIN
ID=TL1
Z0=50 Ohm
EL=15 Deg
F0=10 GHz
1

2

1

Excitation
Port for
Gamma 2

SUBCKT
ID=S1
NET="RXD832"

GPROBE2
ID=GP1
1

PORTG
P=2
GM=0.9
GA=72.8Deg
2

2
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Gamma
Probe
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R=-18.7 Ohm
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Port for
Gamma 1

ReferencePlane for InternalStability Analysis

The GPROBE element is used to measure the internal reflection coefficients at the reference plane indicated. The stability
measurements STAB_GP2 and STABN_GP2 and the internal gamma measurements made with GAM_GP2 require that
you select a specific GPROBE2 to identify the reference plane.

A.5.6. Termination Impedances
One of the drawbacks of the proposed method used to analyze the stability is that it is only valid when the circuit is
terminated with the same termination impedances that are used during the analysis. The termination impedances that
make the circuit the "most unstable" are generally the impedances with a reflection coefficient of magnitude one, so you
should test the stability when the circuit is terminated with impedances that lie on the edge of the Smith Chart.
The port element PORTG allows the termination impedance of the port to be specified as a magnitude and angle of the
reflection coefficient. In practice, it is not possible to compute the response of the circuit with perfect magnitude one
reflection coefficient on the ports, so a value close to one (0.99 for example) is used instead. You can change a normal
port to a PORTG port by editing the port element and selecting the Specify Source Gamma check box on the Port tab of
the Port properties dialog box. You can also add the PORTG element through the Elements Browser.
One method for testing the stability for a wide range of port terminations takes advantage of the yield analysis feature.
If all the terminal ports use PORTG elements, and the magnitudes of the reflection coefficients are set to something close
to 1 (0.99 for example) then the angle parameter can be set to 180 degrees, and the statistical properties can be set so the
angle has a uniform distribution with a tolerance of 180 degrees. When the yield analysis is run, the angle takes on random
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values from 0 to 360 degrees which covers all points on the outer radius of the Smith Chart. The stability index can be
plotted during the yield analysis and any trace that exceeds a value of one indicates that the circuit can become unstable.

A.5.7. Nonlinear Internal Stability Analysis
Linear internal stability analysis can be generalized to nonlinear circuits. First, a large-signal solution is computed using
the APLAC HB simulator. Next, the circuit is linearized at the found HB solution and the internal reflection coefficients
are solved at each small-signal frequency. If there are sweeps in the simulation setup, the large-signal solution and the
following internal stability analysis are performed at each sweep point. This allows analyzing the stability of the circuit
as a function of some swept quantity, for example input power.
The NLGAM_GP2, NLSTABN_GP2, and NLSTAB_GP2 measurements are straightforward nonlinear generalizations
of their linear counterparts. They can only be used with the APLAC HB simulator. Analyzing nonlinear stability requires
that control element NLSTABILITY is placed in the schematic. The Fstart, Fend, and Fsteps parameters define the range
of small-signal frequencies to sweep over. Note that these are absolute frequency values, not offsets to the large-signal
fundamental frequency. SwpType defines the type of small-signal frequency sweep (linear or log).

A.6. Antenna Analysis Methods
By default, the Microwave Office program places a perfect electric conductor (PEC) on the top and bottom of the
enclosure. Since the side-walls are always PEC, the default configuration is completely enclosed by the perfect conductor
and no radiation is possible. To allow radiation into an infinite region, you must model the top of the enclosure as an
open boundary.
If the top of the enclosure is made to have a boundary condition that approximates the boundary condition of an open
box, then you can use the tangential electric field at the top of the enclosure (the tangential field at the absorbing boundary)
to compute the far-field radiation pattern. A detailed description of the method used for determining the radiation pattern
from the tangential electric field is included in Chapter 12 of Antenna Theory Analysis and Design.4 This process involves
two steps:
1. The first step is the computation of the tangential electric field. This is performed using an approximation to the
aperture boundary condition at the top (and/or bottom) of the enclosure (currently there are two different types of
boundaries you can use). Using these boundary conditions, the currents on the internal conductors are determined for
a given excitation using standard EMSight methods. After these currents are known, the tangential E-fields are
determined on the top surface of the enclosure. These fields are used in step two of the process.
2. The second step in the process involves re-radiating the equivalent currents of these tangential electric fields into the
upper hemisphere, assuming that these equivalent currents are present upon a perfectly conducting half plane. Using
the equivalence theorem and the image theorem, you can represent the radiation problem as a sheet of magnetic current
that is infinitely close to a perfectly conducting half plane. From this sheet of magnetic currents, you can obtain a
far-field radiation pattern.
Note that the problem used to find the sheet of equivalent currents is not exactly the problem used to compute the radiation.
As a result, errors in the problem solution can result from these differences. You can minimize these errors by properly
selecting the enclosure size and the location of the free space boundary or boundaries.

A.6.1. Selection of the Boundary Condition
The first type of boundary is a resistive boundary. You can use a resistive material of 377 ohms per square to provide
an approximation to the free-space boundary. The 377 ohms is an approximation because the boundary would only have
an impedance of 377 ohms at normal incidence and without the presence of the side-walls. A problem that can arise
4

C. A. Balanis, Antenna Theory Analysis and Design (2nd Edition), John Wiley & Sons, Inc.,1997.
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when using this type of boundary condition involves the absorption of power from the near fields of the antenna. This
occurs when the resistive boundary is located too close to the radiating structure, artificially absorbing the stored energy
of the structure. Nevertheless, the use of the 377 ohm boundary condition seems to give reasonable results when it located
an appropriate distance from the radiating conductors. To test that this boundary is not absorbing stored energy, you
should conduct two simulations with the boundary located at slightly different (for example λ/10) distances from the
radiating structure. If no significant impact is seen in the S-parameters of the structure, then you can assume that the
boundary is not absorbing substantial amounts of stored energy.
The second type of boundary is the boundary condition that you would see if the side-walls extended to infinity. This
boundary condition is equivalent to the boundary seen looking into an infinitely long waveguide.
What is important for getting an accurate radiation pattern is that the computed tangential E-field at the top of the enclosure
looks as much like the E field of an equivalent problem radiating into free-space. The infinite waveguide termination
provides a reasonable approximation for the tangential E-field as long as the boundary is not too far from the radiation
element. The tangential E-field far from the radiating element always tends to the field pattern of the dominant waveguide
modes as the distance between the enclosure top and the radiator increases. When the radiator is far enough away, you
always obtain the radiation pattern of an open-ended rectangular waveguide when using the infinite waveguide termination.
Since the EM simulator solves for the fields inside a conductive box, several assumptions are made that allow for the
computation of the radiation pattern. One of these assumptions is that the side-walls of the enclosure are far enough away
that they do not have a significant effect on the electric field on the top boundary of the enclosure. You should always
view the electric field on the top of the boundary when working with antennas. This allows a quick check on the validity
of this assumption. If the electric field has a very low magnitude near the edges of the enclosure, then the assumption is
valid. If the electric field is relatively high near the edges, then the fields are interacting with the side-walls and the
assumption is not valid.

A.6.2. Re-Radiation of Equivalent Currents into Free Space
The second part of the solution involves the determination of the radiation pattern from the tangential E-field present on
the top surface of the enclosure. Using the equivalence theorem and the image theorem, you can represent the radiation
problem as a sheet of magnetic current that is infinitely close to a perfectly conducting half plane. From this sheet of
magnetic currents, you can obtain a far field radiation pattern. Again, note that the problem used to find the sheet of
magnetic currents is not exactly equivalent to the problem used to compute the radiation. As a result, difficulties arise
in forcing conservation of power, so the far-field radiation patterns are normalized to an average radiated power which
is determined via an integration of all of the power radiated in the upper hemisphere. The normalization does not account
for mismatch or resistive losses and thus results in a polarization sensitive directivity for the antenna.
Unfortunately, while the S-parameters of the structure reveal the mismatch losses of the antenna, the resistive losses
associated with the antenna cannot be determined due to the previously mentioned lack of conservation of power due to
the imposed boundary condition. For antennas constructed with perfect conductors, the radiated power equals the power
into the structure (easily computed from the S-parameters). If you want to compute the ohmic or dielectric loss of an
antenna, two problems should be solved. One of the problems should use a PEC radiator (and no dielectric loss) and the
other should use the lossy conductor and/or lossy dielectric that the true antenna uses. You can use the difference between
the radiated power in the two cases to estimate the ohmic or dielectric losses in the antenna.

A.6.3. Antenna Measurements and Drawing Coordinate Systems
Two coordinate systems are used in an EM antenna simulation, one for drawing the structure and another for the radiation
patterns. The second coordinate system is conforms to the standard coordinate system used in antenna analysis.
The coordinate system for the antenna measurements is shown in Figure A.1, “3D View of Coordinate System Used For
Antenna Measurements”. This system is a right-hand coordinate system with the origin located at the center of the top
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of the enclosure. When viewing a two-dimensional image, the y-axis of the antenna coordinate system extends upward,
the x-axis extends to the right, and the z-axis extends out of the image toward the viewer.
Figure A.1. 3D View of Coordinate System Used For Antenna Measurements
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The antenna coordinate system is in contrast to the coordinate system used to draw structures in the Microwave Office
program. The drawing coordinate system is a Left Hand Coordinate system with its origin located in the upper left-hand
corner of the Microwave Office enclosure as viewed in a two-dimensional view of an EM simulation. Figure A.2, “2D
View of Structure Showing Antenna and Drawing Coordinates ” contrasts these two coordinate system in a two-dimensional
view.
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Figure A.2. 2D View of Structure Showing Antenna and Drawing Coordinates

Physically, an antenna radiates energy at all frequencies in all directions simultaneously. To visualize the radiation,
measurements that fix all but one of the independent parameters (Freq, θ and φ) must be implemented to allow a
two-dimensional plot. Further, the phase and magnitude of the radiation is affected by the polarization of antenna used
to measure the antenna under test. For this reason, you can make three basic types of antenna measurements that fix all
but one of the independent axes. Further, each of these measurements can be performed for five common polarizations.

A.6.4. Antenna Measurement Types
The following are the antenna measurements types:
• Principal Plane Cut (PPC): Also known as a Theta or an Elevation Cut, this antenna measurement type fixes the values
of Frequency and φ to user-specified values. Theta is then swept to cover an entire sweep of the upper hemisphere
(-90 to 90 degs or -π/2 to π/2 rads) if there is an infinite ground plane below the antenna, or to cover an entire sweep
of the lower hemisphere (90 to 270 degs or π/2 to 3π/2 rads) if there is an infinite ground plane above the antenna, or
from -180 to 180 (-π to π radians) if there is not an infinite ground plane. An example of a Principal Plane Cut is shown
in Figure A.3, “Example of a Principal Plane Cut”.
• Conic Cut (CON): Also known as a Phi or Azimuth Cut, this antenna measurement type fixes the values of Frequency
and θ to user-specified values. Phi is then swept to cover an entire sweep of the upper hemisphere (-180 to 180 degs
or -π to π rads). An example of a Conic Cut is shown in Figure A.4, “Example of a Conic Cut”.
• Swept Frequency (SF): This antenna measurement type fixes the values of φ and θ to user-specified values. Frequency
is then swept over a user-defined range.

A.6.5. Antenna Measurement Polarizations
The following are the antenna measurement polarizations:
• E-Phi (Eφ): This represents signals received or transmitted by the test antenna if it is linearly polarized with its E-field
aligned with the unit vector dφ in the previously mentioned antenna coordinate system. Importantly, the positive
direction of dφ is in the increasing direction of φ. You should notice the dependence of dφ on the current value of φ
and θ.
• E-Theta (Eθ): This represents signals received or transmitted by the test antenna if it is linearly polarized with its
E-field aligned with the unit vector dθ in the previously mentioned antenna coordinate system. Importantly, the positive
direction of dθ is in the increasing direction of θ. You should notice the dependence of dθ on the current value of φ
and θ.
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• Right-Hand Circular Polarization (RHCP): This polarization is a linear combination of Eθ and Eφ; it is defined as:
RHCP=(Eθ+jEφ)/√2
• Left-Hand Circular Polarization (LHCP): This polarization is a linear combination of Eθ and Eφ; it is defined as:
LHCP=(Eθ-jEφ)/√2
• Total Power (TPwr): Although this is not strictly a polarization, it is a very useful measure. TPwr represents the total
power available regardless of polarization, and is obtained by summing the powers available from Eθ and Eφ. This
measurement is purely real and does not have a phase associated with it.
• Actually, antenna measurements represent the square root of the partial directivity in the specified direction that retain
the phase of the corresponding electric field component (barring total power measurements that represent the square
root of total directivity in the specified direction).
Figure A.3. Example of a Principal Plane Cut
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Figure A.4. Example of a Conic Cut
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A.6.6. Guidelines for Antenna Analysis
Two options are available for radiation pattern analysis:
• Setting the top boundary of the enclosure to the impedance boundary condition (Approximate Open)
• Setting the top boundary of the enclosure to an Infinite Waveguide termination.
Placing Side-walls Far Enough from Antenna
Since the EM simulator solves for the fields inside a conducting box, several assumptions are made that allow for the
computation of the radiation pattern. One of these assumptions is that the side-walls of the enclosure are far enough away
that they do not have a significant affect on the electric field on the top boundary of the enclosure. It is best to view the
electric field on the top boundary after solving when working with antennas. This allows a quick check of the validity
of this assumption. If the electric field has a very low magnitude near the edges of the enclosure, the assumption is valid.
If the electric field is relatively high near the edges, then the fields are interacting with the side-walls and the assumption
is not valid.
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Approximate Open: Select Optimal Elevation of Enclosure Top Cover
If an impedance boundary condition (such as an approximate open) is used to terminate the enclosure above an antenna,
it is possible for the boundary to be close enough to interact with the near field (read: stored energy) of the antenna, thus
resistively loading the antenna and causing significant undesired changes. This undesired effect occurs when the top of
the enclosure is too close to the antenna surface.
Moving the top of the enclosure away from the antenna reduces the resistive loading, but exposes more of the metallic
side-walls for reflections. Although the input impedance of the antenna has stabilized, you are now sampling the field
for re-radiation much further from the antenna. In this region, the interactions with the side-walls is converting the radiated
fields into the modes of the waveguide.
Elevation of the enclosure top above the upper layer of dielectric stack may be crucial for obtaining correct results. You
should select this height equal to approximately one quarter of the wavelength at the central frequency of operation.
Control of the electric field on the top boundary may help to validate your choice. If the enclosure top is too close to
radiating elements, distribution of the electric field displays dips just above the radiator locations. If the enclosure top is
too far, distribution of the electric field develops pronounced oscillations from the center to the edges; whereas a reasonable
selection of enclosure height provides distribution with a smooth slope towards all edges.
Infinite Waveguide: Horizon Radiation Limitations
A better approach is to sample the fields very close to the antenna surface without resistively loading the structure with
an impedance boundary condition. You can do so by replacing the surface impedance boundary condition with an infinite
waveguide termination. This type of boundary condition does not resistively load the near field of the antenna. Since
you are sampling the electric fields very close to the antenna, they have minimal corruption due to side-wall locations.
Unfortunately, antennas that direct significant amounts of energy toward the horizon still have significant degradation
of the sampled electric field due to side-wall reflections.
Calculation of Antenna Characteristics
The following sections include information on calculating antenna far-field radiation patterns, directivity, and gain.
Calculation of the Antenna Far-field Radiation Pattern

Conic Cut or Phi Sweep (2D plot with specified constant value of θ and φ swept from -180 to 180 degrees): Use
Con_EPhi or Con_ETheta to plot the normalized radiation pattern of Eφ or Eθ components of the E-field in the far zone
correspondingly.
Principal Plane Cut or Theta Sweep (2D plot with specified constant value of φ and θ swept from -90 to 90 if there is
an infinite ground plane below the antenna, or from 90 to 180 if there is an infinite ground plane above the antenna, or
from -180 to 180 if there is not an infinite ground plane): Use PPC_EPhi or PPC_ETheta to plot the normalized radiation
pattern of Eφ or Eθ components of the E-field in the far zone correspondingly.
Calculation of the Antenna Directivity

Directivity: Use SF_TPwr to calculate the antenna directivity in a given direction (defined by specified values of θ and
φ).
Partial directivity of an antenna for a given polarization: Use SF_EPhi or SF_ETheta correspondingly for Eφ or Eθ
to calculate the partial antenna directivity in a given direction (defined by specified values of θ and φ).
NOTE: The Include Resistive Losses and Include Reflection/Coupling Losses options are not selected.
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Calculation of the Antenna Gain

Use SF_TPwr to calculate the antenna gain in a given direction (defined by specified values of θ and φ). Ensure that you
select the Include Resistive Losses option.

A.7. Using Temperature in Simulations
This section illustrates the methods you can use to perform noise and nonlinear simulations when the operating temperature
needs to be accounted for, and discusses how to create projects that use temperature as a variable in Microwave Office
simulations, including:
1. A brief discussion of how the built-in variables _TEMP and _TEMPK are used
2. A description of how component models use temperature for simulation
Temperature controls the noise generation processes and the static operating point of nonlinear components and their
dynamic behavior. With the necessary models for these components, it is possible to calculate the DC operating point,
noise figure, and both AC small and large signal properties of components as a function of temperature.
The AWR Design Environment software uses two built-in variables _TEMP and _TEMPK, and functions such as ctok(x)
and ktoc(x) to assist designers in projects to perform temperature sensitive simulations. _TEMP is a built-in variable in
the AWR Design Environment platform intended for models that have a specific temperature parameter. _TEMP uses
the units specified as global units (choose Options > Project Options and click the Global Units tab to select degree Kelvin,
degree Celsius, or degree Fahrenheit as the global units. You can overwrite the default value of this variable using an
equation; for example the equation "_TEMP = 30" sets this global variable to 30 degrees Celsius if these are the set units.
_TEMPK is in degrees Kelvin and retains these units regardless of the global units setting. This variable is used to adjust
the temperature for models without a temperature parameter. This variable only affects noise simulation of linear elements.
You can use both _TEMP and _TEMPK in equations to define the operating temperature of components. You can use
equations to tie both linear and nonlinear temperature to the same value, and to assign one temperature value to all
elements through hierarchy. Also, you can assign different temperatures to passive circuits, small signal amplifiers,
Power Amplifier drivers and Power Amplifiers, with a global temperature used to define the base-plate or housing
temperature, and equations added to define the unique temperatures of the high temperature components using dissipation
and thermal resistance calculations.

A.7.1. Displaying Temperature Values Used in Simulation
You can view the current value of any variable with the "variable:" notation. To return or expose the value of
_TEMP, create the following equation in the Global Definitions window or any schematic window: "_TEMP:" and then
simulate. The variable _TEMP is set to 25 and interpreted as 25 degrees Celsius. Now change the global units for
temperature to degree Kelvin and resimulate. _TEMP is set to 298.1 degrees Kelvin. As previously explained, you can
define the value of _TEMP by using the equation "_TEMP = 30". To see the default value, overwrite this value with a
user-specified value, and confirm the new value, create the following equations:
_TEMP:
_TEMP=30
_TEMP:

and simulate. The value of _TEMPK always returns the current value in degrees Kelvin. If no value is explicitly set, the
value is 290 degrees Kelvin.
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A.7.2. Different Temperature Situations in AWR
How these components use the built-in variables for temperature and derived temperatures depends upon the origin of
the model parameters for the component. There are four different situations when setting temperature in simulation:
• passive elements
• nonlinear elements without _TEMP assigned
• nonlinear elements with _TEMP assigned
• netlists.

A.7.3. Temperature and Noise for Passive Structures
The AWR Design Environment platform supports both implicit and explicit methods when using temperature in
simulations. The implicit method uses the built-in variable _TEMPK; the use of this approach is illustrated in the following
figure. The schematic consists of an attenuator whose shunt and series elements are designed using the standard equations
for a PI attenuator. This particular building block is chosen for this example because the NF equals the insertion loss
when the physical temperature of a matched attenuator is set to the reference temperature. Here you can see that the
resistors responsible for loss and noise generation do not have an explicit temperature defined. The built-in global variable
_TEMPK controls the temperature of all such elements that possess loss, and therefore can generate noise.
The simulation uses a local copy of the built-in variable _TEMPK which is controlled by the Swept Variable (SWPVAR)
element. The temperature is swept between 0 and 400 degrees K. The X axis of the graph is set to use the sweep variable,
_TEMPK. See “Swept Variable Control: SWPVAR” for more information about SWPVAR.

Simulation Control
Swept Noise

4

_TEMPK=0
SWPVAR
ID=SWP1
VarName="_TEMPK"
Values=stepped(0,400,20)
UnitType=None

NF dB

3

2

DB(NF())[2,X]
B Implicit Use of _TEMPK

1

0
0

100

Xo

290.1
3 dB

200
300
Temperature degree K

. . . Xn

400

PORT
P=1
Z=50 Ohm

RES
PORT
ID=IN1
P=2
R=Rseries Ohm Z=50 Ohm

Attenuator Design Equations
Loss=3
C = 0.00001 + 10^ (Loss / 20)
C: 1.413
Zo=50
Rshunt = Zo * ( C +1 ) / (C - 1 )
Rseries = Zo * (( C^2 - 1) / ( 2 * C))
Rshunt: 292.4
Rseries: 17.62
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When a specific temperature of an element needs to be defined other than that defined by the built-in global variable
_TEMPK, you can create local variables and use elements with an explicit temperature parameter. In the following
schematic the REST element is used in place of the RES element. The REST element has a parameter for the temperature
of the resistor. The localTemp variable is used to control the temperature of the element and uses the global units
setting, which in this example is in degrees Celsius. Since the sweep is still in degrees Kelvin, a conversion is used for
the temperature setting for each resistor, T=ktoc(localTemp). The ktoc function converts from Kelvin to Celsius.
Note that you can use the built-in _TEMP variable, or alternatively, you can not use the ktoc conversion and sweep the
localTemp variable in degrees Celsius instead of degrees Kelvin. In every other respect, this design is identical to the
previous design. The simulation results for these schematics are identical.

Simulation Control
localTemp=0
SWPVAR
ID=SWP1
VarName="localTemp"
Values=stepped(0,400,20)
UnitType=None

Explicit Swept Noise
4
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3

2
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C Explicit Use of Temperature

1

Xo

. . . Xn

0
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300
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400
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PORT
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1

Loss=3
C = 0.00001 + 10^ (Loss / 20)
C: 1.413
Zo=50
Rshunt = Zo * ( C +1 ) / (C - 1 )
Rseries = Zo * (( C^2 - 1) / ( 2 * C))

1

PORT
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2

2

T

Attenuator Design Equations

T

1

REST
ID=IN2
R=Rshunt Ohm
T=ktoc(localTemp) DegC

REST
ID=IN3
R=Rshunt Ohm
T=ktoc(localTemp) DegC

T

0

2

Rshunt: 292.4
Rseries: 17.62

For passive devices defined by port parameter data files, like S-parameters, use the NPORT_F or NPORT_F_MDIF
element, which has a secondary parameter for setting its temperature. SUBCKT blocks that refer to passive port parameter
data files use the global _TEMPK setting, which you can change in the Global Definitions document. (Note that the
Default Linear simulator overrides the global setting if the schematic in which the SUBCKT block is placed has an equation
that sets _TEMPK;. The APLAC Linear simulator only uses the global setting.)
EM structures have schematics in which their individual _TEMPK can be specified using an equation, as previously
described.
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A.7.4. Temperature and Active Device Operation
The principle of defining the temperature of circuit elements can be extended to active devices. The following is a
schematic for a bipolar amplifier used later in the system noise figure calculations. The device is modeled using the
nonlinear model and several elements to define the package parasitics. The schematic that defines the device model is
shown following the test schematic. The top level schematic has _TEMP defined as a variable, and then the swept variable
block is used to sweep the temperature from -270 to 100 degrees C in steps of 10 degrees C. The variable is set to be
passed down through hierarchy designated by the solid red line surrounding the variable. (You can toggle this setting by
using the Tune Tool and holding down the Shift key).

_TEMP=0
SWPVAR
ID=SWP1
VarName="_TEMP"
Values=stepped(-270,100,10)
UnitType=None

Xo

DCCS
ID=I1
I=0.52 mA

DCVS
ID=V1
V=4.18 V

. . . Xn

IND
ID=L2
L=1000 nH

IND
ID=L1
L=1000 nH

PORT
P=1
Z=50 Ohm

2

CAP
ID=C2
C=1000 pF

C

SUBCKT
ID=S1
NET="BFR360F"

1

B
CAP
ID=C1
C=899 pF

3

E

The following schematic defines the transistor parasitic elements.
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ID=C1
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2
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ID=C6
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S

B
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ID=C5
C=0.047 pF

CAP
ID=C3
C=0.123 pF

4

1

CAP
ID=C2
C=0.066 pF

C

3

E
GBJT
ID=GP_BFR360_1
TEMP=_TEMP DegC

IND
ID=L2
L=0.556 nH

PORT
P=3
Z=50 Ohm

The following is the transistor model. The _TEMP variable replaces the default value of the device temperature (TEMP
= _TEMP).
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The assignment of the temperature displays (it is hidden by default) by changing the display options of the parameter on
the Display tab of the Element Options dialog box. You can change the default (hidden) by clearing the Default column
check box as shown in the following figure.
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Many of the device models for Monolithic Microwave Integrated Circuit (MMIC), RFIC and hybrid circuit design use
this form when defining temperature. The model variable TEMP is the universal variable used by models within SPICE
and other EDA simulations.
The AWR Design Environment platform supports the simulation of linearized noise figure, whereby the temperature
and bias point dependent operating point is calculated before the small signal noise properties are calculated. The following
graph shows the noise and gain for the previous transistor circuit.
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In this example, the Gummel-Poon model is used from the AWR Design Environment platform Elements Browser under
Nonlinear > BJT category. The appropriate model parameters are entered to model this part and _TEMP is assigned to the
TEMP parameter. In the PDKs available for Cadence AWR, the temperature parameter is set to _TEMP by default.
In this example you can set the temperature to any variable name. Cadence recommends that you use the _TEMP variable
to maintain consistency between designs. If you want to assign different temperatures to different elements in the design,
you should set a different variable name, however.

A.7.5. Temperature and Active Device Operation with a Device Defined by a SPICE Netlist
Often the device model is found from a component manufacturer's web site in the form of a SPICE compliant netlist.
The following netlist was imported into the AWR Design Environment platform. Note that on import, the syntax of the
file is modified to conform to the AWR Design Environment platform netlist standard. The netlist contains both a circuit
description of the transistor and an inline device model section with the normal BJT parameters. In SPICE syntax, the
units are always assumed to be in base units (Farads, Amps, Henrys, etc). The base unit for temperature in SPICE is
Celsius. The units for each type of variable are shown as follows.
.subckt qNE52418_v161 c b e s
*---- Intrinsic NPN Model --------------------------------q1
c b e s qmod
.model qmod npn
+ level= 3 afn= 3.2
+ ajc= -0.5 aje= -0.5
+ ajs= -0.5 avc1= 3
+ avc2= 200 bfn= 1
+ cbco= 5.46E-15 cbeo= 8.34E-15
+ cjc= 4.62E-15 cjcp= 2.64E-14
+ cje= 3.78E-14 cjep= 1.04E-14
+ cth= 3.26E-10 ea= 1.133
+ eaic= 1.133 eaie= 1.133
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+
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+
+
+
+
+
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+
+
+
+
+
+
+
+
+
+
+
+
+
+
+
+

eais= 1.133 eanc= 1.133
eane= 1.133 eans= 1.133
fc= 0.95 gamm= 1.50E-11
hrcf= 1 ibci= 8.22E-20
ibcip= 0 ibcn= 7.37E-15
ibcnp= 0 ibei= 1.77E-19
ibeip= 2.49E-18 iben= 1.10E-15
ibenp= 0 ikf= 2.51E-02
ikp= 9.96E-02 ikr= 5.90E-03
is= 2.87E-17 isp= 1.99E-19
itf= 6.59E-02 kfn= 1.96E-09
mc= 0.18 me= 0.2
ms= 0.47 nci= 1.002
ncip= 1.005 ncn= 1.5
ncnp= 1.9 nei= 1.02
nen= 1.9 nf= 1.015
nfp= 1 nr= 1.01
pc= 0.86 pe= 0.92
ps= 0.55 qco= 1.47E-16
qtf= 0 rbi= 3.4088
rbp= 1 rbx= 13.111
rci= 316.11 rcx= 0
re= 0.68275 rs= 50
rth= 644.03 tavc= 8.50E-04
td= 9.17E-13 tf= 1.17E-12
tnf= 5.00E-05 tr= 2.50E-11
tref= 25 vef= 90
ver= 2.25 vo= 100
vtf= 0.3 wbe= 1
wsp= 1 xii= 3
xin= 2.2 xis= 1.9
xrb= 0 xrc= 0
xre= 0 xrs= 0
xtf= 10 xvo= 0

.ends qNE52418_v161

Typically, the model does not explicitly define the temperature of the device. The SPICE standard temperature variable
is dtemp. You must add this to the netlist to simulate at temperatures other than the default. Also, to enable this variable
to pass into the netlist from the parent schematic that owns the netlist, you must add an additional equation to the line
that specifies the element node numbers.
.subckt qNE52418_v161 c b e s DeviceTemp=1
*---- Intrinsic NPN Model --------------------------------q1
c b e s qmod dtemp=DeviceTemp
.model qmod npn
+ level= 3 afn= 3.2
+ ajc= -0.5 aje= -0.5
+ ajs= -0.5 avc1= 3
+ avc2= 200 bfn= 1
+ cbco= 5.46E-15 cbeo= 8.34E-15
+ cjc= 4.62E-15 cjcp= 2.64E-14
+ cje= 3.78E-14 cjep= 1.04E-14
+ cth= 3.26E-10 ea= 1.133
+ eaic= 1.133 eaie= 1.133
+ eais= 1.133 eanc= 1.133
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+

eane= 1.133 eans= 1.133
fc= 0.95 gamm= 1.50E-11
hrcf= 1 ibci= 8.22E-20
ibcip= 0 ibcn= 7.37E-15
ibcnp= 0 ibei= 1.77E-19
ibeip= 2.49E-18 iben= 1.10E-15
ibenp= 0 ikf= 2.51E-02
ikp= 9.96E-02 ikr= 5.90E-03
is= 2.87E-17 isp= 1.99E-19
itf= 6.59E-02 kfn= 1.96E-09
mc= 0.18 me= 0.2
ms= 0.47 nci= 1.002
ncip= 1.005 ncn= 1.5
ncnp= 1.9 nei= 1.02
nen= 1.9 nf= 1.015
nfp= 1 nr= 1.01
pc= 0.86 pe= 0.92
ps= 0.55 qco= 1.47E-16
qtf= 0 rbi= 3.4088
rbp= 1 rbx= 13.111
rci= 316.11 rcx= 0
re= 0.68275 rs= 50
rth= 644.03 tavc= 8.50E-04
td= 9.17E-13 tf= 1.17E-12
tnf= 5.00E-05 tr= 2.50E-11
tref= 25 vef= 90
ver= 2.25 vo= 100
vtf= 0.3 wbe= 1
wsp= 1 xii= 3
xin= 2.2 xis= 1.9
xrb= 0 xrc= 0
xre= 0 xrs= 0
xtf= 10 xvo= 0

.ends qNE52418_v161
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_TEMP=0
SWPVAR
ID=SWP1
VarName="_TEMP"
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UnitType=None
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IND
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PORT
P=1
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2

CAP
ID=C2
C=1000 pF

C

SUBCKT
ID=S1
NET="qNE52418_v161"
deviceTemp=_TEMP

1

B
CAP
ID=C1
C=899 pF

PORT
P=2
Z=50 Ohm

3

E

The transistor is defined by a subcircuit (a netlist in this example) and the deviceTemp variable has in turn been equated
to a _TEMP variable.
The following graph shows the results of the gain and NF simulations.
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In this case, the project units for temperature are degrees C so assigning _TEMP to the deviceTemp parameter set the
correct temperature in the netlist. If the project units for temperature are other than degrees C, the temperature passed to
the netlist must be converted to Celsius. For example, the same results can be achieved when the global unit for temperature
is set to degrees K with the schematic as follows. This schematic is shown in the following figure.
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_TEMP=0
SWPVAR
ID=SWP1
VarName="_TEMP"
Values=stepped(73,313,20)
UnitType=None
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IND
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IND
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PORT
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NET="qNE52418_v161"
deviceTemp=_TEMP
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B
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PORT
P=2
Z=50 Ohm

3

E

The differences to note are that the swept values are now from 73 to 313 in steps of 20 since the units are degrees K. The
deviceTemp value passed to the netlist is now converted to degrees C using the ktoc function. So deviceTemp =
ktoc(_TEMP) converts _TEMP from Kelvin to Celsius before the value is passed to the netlist.
Again, you can use any variable value to pass temperature, however you should use _TEMP to maintain consistency
between designs.

A.7.6. How to Sweep Passive and Active Temperature Through Hierarchy
In IC design, the temperature of each component is normally set to the same value. In this situation, each nonlinear model
typically has its explicit temperature set to _TEMP in the PDK model set. The best approach is to assign the temperature
at the top level schematic and pass the values down through the hierarchy. Assign _TEMP and _TEMPK to use the same
swept values. Because _TEMP uses the temperature units set for the project and _TEMPK is always in Kelvin, built-in
equations are used to make the two temperatures the same.
In this example, the unit for temperature is set to degrees Celsius. In the top level schematic, the value for _TEMP is set
to sweep its value and pass down its value using the SWPVAR block _TEMP variable. Again, the global temperature
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unit is Celsius so the swept values are in Celsius. _TEMPK is assigned to follow the _TEMP value, but you must use
the "_TEMPK = ctok(_TEMP)" equation to convert it from degrees Celsius to degrees Kelvin. Note that the temperature
conversion depends on the global unit setting for temperature.

SWPVAR
ID=SWP1
VarName="_TEMP"
Values={ -273,0,1 }
UnitType=None
Xo

_TEMP = 0
_TEMPK = ctok(_TEMP)

. . . Xn

The following schematic shows the lower level in the hierarchy where a resistor is added at the input to show the effects
of _TEMPK.
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GBJT
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TEMP=_TEMP DegC

CAP
ID=C5
C=0.047 pF

IND
ID=L2
L=0.556 nH

PORT
P=3
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The following graph shows the swept Noise Figure versus temperature.
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Note that different results are achieved if the different temperature settings are not passed down through the hierarchy.
When neither _TEMP nor _TEMPK are passed down, the result is shown on the following graph.
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The noise figure is flat because the swept temperature is not passed, and so the default values of 25 degrees C for _TEMP
and 290 degrees for _TEMPK are used in simulation.
When just _TEMP is passed through hierarchy, the result is shown on the following graph.
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When just _TEMPK is passed through hierarchy, the result is shown on the following graph.
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A.7.7. Group Design Issues
When sharing designs between different designers or different projects in the AWR Design Environment platform, units
can be an issue. If you do not use any variables in a design, there are no issues. However, variables do not use unit scaling
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and so it is possible for designs to be passed between Cadence AWR projects that are not identical. The following are
some techniques to address this issue:
• Set up a common set of global units to use in all projects.
• Agree to use base units for all projects.
• Agree to select the Dependent parameters use base units check box on the Schematics/Diagrams tab of the Project
Options dialog box prior to doing any design.
The following example demonstrates. Assume a designer uses capacitance units of nF and a variable assigned to a
capacitance of 0.01. If this schematic is exported and then imported to a project with units of pF, the software does not
know how to scale the value of a variable (variables can be combination of equations, etc. so this cannot be done in a
general sense). When this schematic is imported the variable still has a value of 0.01. However, now that units are pF,
the value is off by three orders of magnitude. Using base units for dependent parameters (Farads) in this example allows
for easy design sharing.
You can set Dependent parameters use base units globally by choosing Options > Project Options and clicking the
Schematics/Diagrams tab, or you can set it locally for each schematic. This option is not set by default. This setting sets
any parameter using a variable value to base units. Base units are any unit type without a modifier, such as Farads,
Henrys, and Amps, instead of the specified units in the global units setting. When designers share designs, the software
does not know what the global units setting are in the original design. Always using base units for any parameter using
a variable ensures that values are set appropriately any time a design is shared.
If you use the Dependent parameters use base units setting, the units for temperature display as degrees Kelvin, and you
should sweep temperature values in Kelvin. If using a hierarchical design, you should make this setting for the entire
project, if not you need to make the setting for any schematic in the hierarchy with a temperature setting. If using this
setting in this example, _TEMP is always in degrees Kelvin and should use those values to sweep. This setting also keeps
_TEMP and _TEMPK in the same units and no conversion is necessary.
To demonstrate the Dependent parameters use base units option, the linear simulation is repeated with the explicit
temperature model. However, now this option is set locally (right-click on the schematic in the Project Browser, (choose
Options and click the Schematic tab), overriding the default setting. Now the temperature units display in base units and
the equation to convert from Celsius to Kelvin is not required. Again, the simulation results are identical.
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Simulation Control
localTemp=0
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A.7.8. Conclusions
The AWR Design Environment platform supports several methods to define and manipulate the temperature of electronic
devices, and therefore to enable comprehensive simulation of noise processes, device operating point parameters such
as gain and full nonlinear behavior.

A.8. Simulating in a Non 50 Ohm System
By default, the Microwave Office program assumes that you design in a 50 ohm system. Microwave Office software is
not limited to 50 ohm systems, however, and changing the characteristic impedance of your design is easy. The following
sections discuss how to operate in a non 50 ohm system.

A.8.1. Setting the Characteristic Impedance of a Schematic
When working in a schematic in the AWR Design Environment platform, the impedance specified on the ports determines
the characteristic impedance of that system. To change the impedance parameter you can either double-click the Z
parameter or right-click the port and choose Properties, then change the Z parameter in the Element Options dialog box.

A.8.2. Non 50 Ohm Data Files
Creating non 50 Ohm Output Files
You can generate output files in various formats. See “Working with Output Files ” for more information about generating
output files. When creating these files, you must set the reference impedance to match the system impedance of the
structure that it represents. If the reference impedance is not set correctly, there are unexpected results. See “Generate
Touchstone, MDIF, or MATLAB File: NPORTF” for details on setting up this output file, particularly the Ref. Impedance
setting.
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The Ref. impedance sets the characteristic impedance of the circuit and overrides the impedance set by the ports in the
structure that is simulated. For example, if the ports in the schematic are set to 75 ohms, but the reference impedance is
set to 50 ohms, the results are based on a 50 ohm characteristic impedance, not 75 ohms. This is equivalent to changing
the port impedance in your schematic to 50 ohms rather than 75.
Plotting from Data Files
In the Microwave Office program, you can plot Port Parameters measurements directly from data files if the impedance
specified in the file is normalized to the default characteristic impedance, 50 ohms. If the data file is normalized to a
different impedance, you must place it in a schematic as a subcircuit, where the ports are set to the corresponding
impedance of the data file. See “Adding Subcircuits to a Schematic or System Diagram ” for information on using a data
file as a subcircuit in a schematic. When plotting directly from a data file, the characteristic impedance is always 50
ohms.
For example, if you have an S-parameter file normalized to 75 ohms for use in a 75 ohm system, plotting a measurement
directly from this file is equivalent to placing it in a schematic with a 50 ohm characteristic impedance (50 ohm ports)
and making the measurement. To achieve the desired measurements, you must place the data file in a schematic with 75
ohm ports and make the measurements from this schematic, not the data file directly.

A.8.3. Measurements on Non 50 Ohm EM Structures
If EM analysis is required in your design and the characteristic impedance of the EM structure is not 50 ohms, plotting
Port Parameters measurements directly from the EM structure yields seemingly incorrect behavior. Plotting directly from
an EM structure, like plotting directly from a data file, sets the characteristic impedance to 50 ohms. Although you can
set the termination impedance for each port in the EM structure, these are not used when calculating the port parameters,
but are instead used for computing the currents in the structure. See “Setting the Port Excitation or Termination” for
more information.
To set the characteristic impedance for an EM structure to something other than 50 ohms for Port Parameters measurements,
you can place the EM structure as a subcircuit in a schematic and change the impedance of the ports to the desired
impedance.

A.8.4. Load Pull Analysis in non 50 Ohms Systems
Load pull analysis in Microwave Office software is simple when using the Load Pull Script. See “Load Pull Script” for
more information on using this script to perform a load pull analysis. Performing load pull on a non 50 ohm system only
requires a few extra steps.
1. Set the system impedance for the schematic by changing the impedance of all the ports used in the schematic to the
new characteristic impedance. See “Setting the Characteristic Impedance of a Schematic” for information on how to
make these changes.
2. Set the System Impedance parameter (Z0) on the load pull tuner you are using (for example, LTUNER, LPTUNER,
or HBTUNER). To change the system impedance parameter you can either double-click the Z0 parameter or right-click
the tuner, choose Properties, and change the Z0 parameter in the Element Options Dialog Box.

A.8.5. Denormalizing Impedance on a Smith Chart
Generally, when you view port parameters on a Smith Chart they are normalized to a specific impedance. You can,
however, view the un-normalized impedances directly on the Smith Chart. To change this option, right-click on the graph
and choose Properties to display the Smith Chart Properties dialog box. Click the Markers tab and change the Z or Y display
from Normalized to Denormalized to. By default, the normalization impedance is set to 50 ohms. For the impedances to
be correct, it is important to change this to the characteristic impedance of your system.
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